Polyspace® Code Prover™ Release Notes

/) MathWorkse



X B

How to Contact MathWorks

Latest news: www .mathworks. com

Sales and services: www.mathworks.com/sales_and_services
User community: www .mathworks.com/matlabcentral
Technical support: www . mathworks.com/support/contact_us
Phone: 508-647-7000

The MathWorks, Inc.
1 Apple Hill Drive
Natick, MA 01760-2098

Polyspace® Code Prover™ Release Notes
© COPYRIGHT 2013-2022 by The MathWorks, Inc.

The software described in this document is furnished under a license agreement. The software may be used or copied
only under the terms of the license agreement. No part of this manual may be photocopied or reproduced in any form
without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation by, for, or through
the federal government of the United States. By accepting delivery of the Program or Documentation, the government
hereby agrees that this software or documentation qualifies as commercial computer software or commercial computer
software documentation as such terms are used or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014.
Accordingly, the terms and conditions of this Agreement and only those rights specified in this Agreement, shall pertain
to and govern the use, modification, reproduction, release, performance, display, and disclosure of the Program and
Documentation by the federal government (or other entity acquiring for or through the federal government) and shall
supersede any conflicting contractual terms or conditions. If this License fails to meet the government's needs or is
inconsistent in any respect with federal procurement law, the government agrees to return the Program and
Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www .mathworks . com/trademarks for a list of additional trademarks. Other product or brand names may be
trademarks or registered trademarks of their respective holders.

Patents

MathWorks products are protected by one or more U.S. patents. Please see www.mathworks.com/patents for
more information.


https://www.mathworks.com
https://www.mathworks.com/sales_and_services
https://www.mathworks.com/matlabcentral
https://www.mathworks.com/support/contact_us
https://www.mathworks.com/trademarks
https://www.mathworks.com/patents

Contents

R2022b
Verification Setup . ... ......... .. ... .. ... ... 1-2
Compiler Support: Set up Polyspace analysis for code compiled with Intel C
++4 Compiler Classic (icc/icl) compilers . ........................ 1-2
Updated Clang Compiler Support: Set up Polyspace analysis for code
compiled by using Clang version 12.x .......................... 1-2
C++ Container Support: Faster analysis of code that uses C++ containers
such as std::vectorand std:xmap . .......... ... ... .. .. ... .. ... 1-3
AUTOSAR Support: Improved troubleshooting assistance for project setup
...................................................... 1-3
Object Size Limitation Removed: Analyze code containing large data
SETUCTUTES . . .o e 1-4
Reviewing Results . ........... ... ... ... . . . . 1-5
Results Export: Updated color property when you export Code Metrics
results to JSON SARIF format ............. ... ... .. ... 1-5
Changes in the polyspace-access Command Options ................. 1-5
polyspace-access Command: Manage review information and compare
PTOJECETUNS . . vttt e e e e e e e et e et e 1-6
Polyspace Access: Import review details and justifications from existing
PrOJECES o v v ottt e 1-7
R2022a
Verification Setup . ......... ... . ... . ... 2-2
Updated Clang Compiler Support: Set up Polyspace analysis for code
compiled by using Clang versions 6.xto 11.x .................... 2-2
Configuration from Build System: Import compiler macro definitions
automatically without tracing build . .................. ... .. ... 2-3
Simulink Support: Polyspace updates generated code when model changes
...................................................... 2-4
Simulink Support: Analyze generated code by bounding number of calls to
stepfunction . ... .. 24
MATLAB Coder Support: Polyspace analysis takes into account MATLAB
Coder settings for nonfinite numbers .......................... 2-4
Ignoring Code Annotations: Perform a worst-case analysis to see all results
including previously justifiedones . ........... ... ... ... .. ... 2-5

Functionality Being Removed: Coding standards checking and code metrics
computation with Code Prover ... ........ ... ... ... ... ... .... 2-5

iii



iv

Contents

Functionality Being Removed: Polyspace desktop integration with Eclipse

IDE . 2-6
Functionality Removed: Polyspace stubs for Standard Template Library
...................................................... 2-6
Functionality Removed: Compilation assistant ..................... 2-6
Changes in analysis options and binaries ......................... 2-7
Changes in MATLAB function, options object and properties ........... 2-8
Verification Results ............... ... ... ... .. ... 2-9
Improved Pointer Analysis: New pointer analysis mode that keeps better
records of pointers and pointed variables ....................... 2-9
Reviewing Results ... ........ ... ... ... .. ... . . . . . . . 2-10
Results Export: Generate more accurate keys to track results across
analySiS TUNS . . . oot 2-10
Polyspace Access: Redesign of Ul dashboard design for consistency and
efficiency ....... ... . e 2-11
Polyspace Access: Improved performance when viewing aggregate data
from large project folders .. ....... ... .. ... ... . 2-12
Polyspace Access: View code covered by verification in new graph .. ... 2-12
Polyspace Access Project Runs: Add labels to analysis runs that you upload
B0 @ PrOJeCt . .ot 2-13
polyspace-access Command: Assign SQO levels, move or delete a project,
and view list of runs foraproject .. .............. .. ... .. .. ... 2-14
polyspace-access Command: Improved robustness and error diagnostics
..................................................... 2-15
Functionality Removed: Report generation from pre-R2015a results .... 2-16
Polyspace Access Installation . .................................. 2-17
License Management: Use a single license to review Bug Finder, Code
Prover, and Ada results in your web browser ................... 2-17
Support for X.509 certificates generated without a SAN extension removed
..................................................... 2-18
Changes in Polyspace Access docker containers ................... 2-18
R2021b
Documentation . ... ....... ... . ... 3-2
Documentation: View combined documentation for all Polyspace Code
Proverproducts .. ......... ... . e 3-2
Documentation: View web documentation by default . ................ 3-2
Contextual Help: View contextual help in web browser ............... 3-3
Verification Setup . .......... ... . ... . . . . ... . 34
Faster Analysis: Reduction in analysis time on code that uses C++
std::sstring library .. ... .. 3-4



IAR Embedded Workbench Compiler: Set up Polyspace analysis for code

compiled by using RISC-Vtarget .................. .. ... ..., 3-4
Updated GCC Compiler Version Support: Set up Polyspace analysis for code

compiled with GCC versions 9.xand 10.x . ....... ..., 3-5
C17 Support: Run Polyspace analysis on code that follows version C17 of C

standard . ... 3-5
Configuration from Build System: Copy console output to log file .. ... .. 3-5
Simulink Support: Consistent C++ version in Polyspace and Simulink . . . 3-6
Functionality Being Removed: Coding standards checking and code metrics

computation with Code Prover . ............. ... . ... .. .. 3-6
Functionality Being Removed: Polyspace stubs for Standard Template

LIDTary .« . 3-7
Functionality Being Removed: Compilation assistant . ................ 3-7

Verification Results ............... ... ... ... .. ... 3-8

String Library Function Checks: New checks on arguments to C++
std::stringmethods ... .o 3-8

Reviewing Results . .. ....... ... ... .. ... ... . . . . . . . . 3-9

Results Review: Open review history, select layout, and open additional

panes by using fewerclicks ............ ... .. ... ... . . .. ... 3-9
Results Review: View relevant information in review panes when you select
afinding ... ... 3-9
Functionality Removed: Automatic Orange Tester . .................. 3-9
Functionality Removed: Polyspace Metrics . ...................... 3-10
Functionality Being Removed: Report generation from pre-R2015a results
..................................................... 3-10
Polyspace Access Installation . .................................. 3-12
User Management: Set project permissions at the group level ........ 3-12
User Management: Update list of users and groups more quickly by
reloading web browser .......... ... . .. . . . 3-12
User Authentication: Authenticate user logins against custom identities and
LDAP identities simultaneously .............................. 3-12
Polyspace Access Services: Faster results uploads and more responsive
SOUTCE COAR VIEW . . ittt et e e e e e e e e e e e e e e e e e 3-13
R2021a
Verification Setup .. ......... ... . ... . .. ... 4-2
Configuration from Build System: Specify options delimiter and suppress
consoleoutput . ..... ... ... 4-2
Configuration from Build System: Improved detection of incompatible
SOMEWATE . . .o e 4-2
AUTOSAR Support (Software Integration): Faster and more AUTOSAR-
aware code analysis ... ... .. 4-2
AUTOSAR Support (Component Based): Determine if an RTE function or
event is supported in currentrelease ........... ... .. ... .. ... 4-3



Updated GCC Compiler Support: Set up Polyspace analysis for code

compiled with GCCversion 8.x .. ........ ... .. 4-3
Updated Microsoft Visual C++ Support: Set up a Polyspace analysis for
code compiled with Visual Studio 2019 . ........................ 4-4
Analysis of projects containing mix of C and C++ source files in Code
Prover . .. 4-4
Simulink Support: Start Polyspace analysis without an explicit code
generation step . ... ... e 4-5
polyspacesetup Function : Integrate Polyspace with MATLAB in fewer steps
...................................................... 4-5
pslinkrunCrossRelease Function : Analyze code generated in an earlier
release of Simulink by using a later release of Polyspace ............ 4-6
Functionality being removed: Compilation assistant ................. 4-6
Changes in analysis options and binaries ......................... 4-7
Verification Results ............... ... ... ... ... ... .. 4-9
AUTOSAR Support (Software Integration): New checks for compliance of
RTE API usage with AUTOSAR standard ........................ 4-9
Changes in Code Prover assumptions ............................ 4-9
Reviewing Results . . ......... ... ... ... .. ... . . . . . . . 4-10
Simulink Block Annotation : Add multiple Polyspace annotations
corresponding to multiple types of Polyspace results ............. 4-10
Code Prover Result Messages: Redundant tooltips removed from += and
similar operations . .......... ... . . . ... e 4-10
Results Review Scope : Define and share custom families of filters . . . .. 4-11
Results Review Layout : Select view to prioritize review of code or results
LSt .o 4-11
Code Quality Comparison Between Runs: Filter and view information for
previous findings fixed in the currentrun ...................... 4-13
Functionality being removed: Automatic Orange Tester ............. 4-13
Polyspace Access Installation . .................................. 4-15
License Management : Uploading of results to Polyspace Access no longer
requires a license checkout . ......... ... ... ... ... ... ... . ... 4-15
User Manager : Enable pagination when requesting large set of users from
LDAP SEIVET . . o vt i et e e e e e e 4-15
Bug Tracking Tool : Create Jira tickets for Jira projects that use single select
custom fields . ... ... 4-15
Admin Interface : Improved logging for Polyspace Access services . . . .. 4-15
R2020b
Verification Setup .. ......... ... . ... . .. ... 5-2
Compiler Support: Set up Polyspace analysis for code compiled with
Renesas SHC compilers . ....... ..., 5-2
Cygwin Support: Create Polyspace projects automatically by using Cygwin
3xbuildcommands . ........ ... .. 5-2

vi Contents



C++17 Support: Run Polyspace analysis on code with C++17 features ... 5-2

AUTOSAR Support: Analysis more resilient to ARXML errors .......... 5-3
AUTOSAR Support: Specify file and folder patterns to exclude from analysis
...................................................... 5-3

AUTOSAR Support: Specify AUTOSAR software component behaviors and

data types using more refined syntax .................. ... ..... 5-3
Configuration from Build System: Generate a project file or analysis options

file by using a JSON compilation database ...................... 5-4
Configuration from Build System: Specify how Polyspace imports compiler

macro definitions . ........... ... . . 5-4
Configuration from Build System: Compiler configuration cached from prior

runs for improved performance ................. ... ... ... ... 5-4
polyspacePackNGo Function : Generate and package Polyspace option files

from a Simulinkmodel ........... ... ... ... . 5-5
Polyspace and MATLAB Integration : Integrate Polyspace with MATLAB

programmatically without user interaction . ..................... 5-5
polyspace.ModelLinkOptions Object : Configure object to analyze code

generated asamodelreference ............. .. ... ... ..., 5-6

Offloading Analysis : Submit Polyspace analysis jobs from CI server to a
dedicated analysis cluster ........... ... .. ... . . . . 5-6

Offloading Analysis : Server-side errors reported back to client side . . . .. 5-6

Changes in analysis options and binaries ......................... 5-7

Verification Results ............... ... ... ... ... ... 5-8
Changesinrun-timechecks ........... ... ... . ... ... ... .. . ..... 5-8
Updated code metrics specifications . ............................ 5-8

Reviewing Results ... ...... ... ... ... ... ... ... . . . . . . . 5-10
Results Export: Export Polyspace results to external formats such as SARIF

JSON 5-10
Simulink Block Annotation : Annotate Simulink blocks from Polyspace user

interface to justify Polyspaceresults .......................... 5-10
User Authentication : Use a credentials file to pass your Polyspace Access

credentials at the command line ............................. 5-10
Importing Review Information: Accept information in source or destination

results folder in case of merge conflicts . ...................... 5-11
Functionality being removed: Polyspace Metrics ................... 5-12
Code Quality Improvement Progress: Compare results from current run to

previous runs and determine progress in code quality improvement ..  5-12
Code Quality Objectives: Define custom quality objectives definitions and

apply them to specific projects .. ......... ... ... ... .. ... ... 5-13
Project Selection: Find a project in the Project Explorer through a text filter

..................................................... 5-14

Functionality being removed: Automatic Orange Tester ............. 5-14

Polyspace Access Installation . .................................. 5-16
Bug Tracking Tool: Integrate with Jira Software Cloud .............. 5-16
Cluster Admin Settings: Validate values of settings on demand or on save

..................................................... 5-16
HTTPS Configuration: Configure services without specifying ports or SSL
certificates .. ... .. 5-16
Functionality Replaced: Polyspace Access embedded LDAP .......... 5-16
Changes in Polyspace Access docker containers, options, and binaries . . 5-17



viii

Contents

R2020a

Verification Setup .. .......................

Checking Initialization Code: Analyze initialization code alone before

checking remaining program ...........

Compiler Support: Set up Polyspace analysis easily for code compiled with
MPLABXC8 Ccompilers . ...t

Compiler Support: Set up Polyspace analysis to emulate MPLAB XC16 and

XC32 compilers . ............... ... ...
Source Code Encoding: Non-ASCII characters in source code analyzed and
displayed without errors ............. . ... ... . i

Simulink Support : Analyze custom C code in C Function blocks ........
Project Creation from AUTOSAR Configuration: Troubleshoot project

creation more easily with resolution hints ... ....................

Jenkins Support : Use sample Jenkins Pipeline script to run Polyspace as

part of continuous delivery pipeline . ... ...
Changes in analysis options and binaries . . ...

Changes in MATLAB functions, options object and properties: .........

Verification Results .. .....................

Checks on Initialization Code: Verify that global variables are initialized

after warmreboot . ... ... .

Changes in run-time checks . .............

Reviewing Results ... .....................

AUTOSAR Support: Navigate from Polyspace findings to AUTOSAR ARXML

specifications . ......................

Bug Tracking Tool Support: Create Redmine tickets for Polyspace Access

results and assign to developers .........

Simulink Support: Navigate from generated code in Polyspace Access to

blocksinmodel . .....................

Results Review: See review history of findings

Results Review: See the configuration options used for analysis .......

Code Quality Objectives: Customize thresholds used to track the quality of

YOUr COde . oottt et

Project Dashboard: Open results by clicking Dashboard charts .. ... ...
Bug Tracking Tool Support: Manage tickets for multiple findings ... ...

Results Review: View error call graph .......

Results Review: View variable access graph . .

Exporting Results: Export only results that must be reviewed to satisfy

software quality objectives (SQOs) .......

Report Generation: Configure report generator to communicate with

Polyspace Access over HTTPS .. .........

Report Generation: Navigate to Polyspace Access Results List from report

Polyspace Access Installation ...............

Installation and Configuration: Issue Tracker service ...............
Installation and Configuration: Change in default location of Polyspace

Access data volume and working directories

6-2

6-2

6-14
6-14
6-15
6-15
6-15
6-16
6-16
6-16
6-18

6-18



R2019b

Verification Setup . .......... ... . ... . . . . ... 7-2

Shared Variables Mode: Run a less extensive Code Prover analysis on
complete application to compute global variable sharing and usage only

...................................................... 7-2
Compiler Support: Set up Polyspace analysis easily for code compiled with
Cosmic compilers . ......... . e 7-2
Simulink Support: Analyze generated code by using contextual buttons on
the Simulink Editor toolstrip . ........... .. ... ... .. . . ... ... ... 7-3
Simulink Support: Verify custom code called from C Caller blocks and
Stateflow charts in context of model ........................... 7-3
Simulink Support: Compare two Polyspace result sets and see the effect of
changes in model or code generation parameters ................. 7-5
Configuration from Build System: Compiler version automatically detected
frombuild system .. ....... ... ... .. 7-5
Changes in analysis options and binaries . ........................ 7-6
Changes in MATLAB functions, options object and properties .......... 7-7
Verification Results . .. ....... ... ... .. .. . . . 7-9
Function Stub Improvements: See fewer orange checks from default
conservative assumptions on pointer arguments .................. 7-9
MISRA C:2012 Directive 4.12: Dynamic memory allocation shall not be used
...................................................... 7-9
Reviewing Results . . ....... ... ... ... .. ... ... . . . . . . . 7-10
Code Annotations: Justify Code Prover results by using annotations spread
overmultiplelines . ....... ... .. .. . .. . e 7-10
Polyspace Access Installation . .................................. 7-11

User Authentication : Use LDAP search filters to restrict number of users to
authenticate ... ... . e 7-11
User Management : Update list of users from LDAP database or LDIF file

..................................................... 7-11
R2019a
Verification Setup . ... ...... ... . ... .. ... e 8-2
Polyspace-only Licenses: Install Polyspace without MATLAB installation
...................................................... 8-2
New Polyspace Products Supporting Continuous Integration: Perform
automated code analysis after code submission with Polyspace Code
Prover Server and Polyspace Code Prover Access ................. 8-2

ix



X

Contents

Code Prover Analysis Engine Separated from Viewer: Run Code Prover
analysis on server and view the results from multiple client machines
Continuous Integration Support: Run Code Prover on server class
computers with continuous upload to Polyspace Access web interface
Continuous Integration Support : Set up testing criteria based on Code
Prover static analysisresults ............ ... ... ... ... . . ... ...
Continuous Integration Support: Set up email notification with summary of
Code Prover results afteranalysis ............... ... . ..........
Offloading Polyspace Analysis to Servers: Use Polyspace desktop products
on client side and server products on serverside .................
Collaborative Review Support : Upload results from Polyspace user
interface to Polyspace Access web interface and share results using web
lnks ..o
Compiler Support: Set up Polyspace analysis easily for code compiled with
ARMvbandvb compilers .. ........ ... .
Updated GCC, Clang, and Visual C++ Compiler Support: Set up Polyspace
analysis easily for code compiled with GCC versions 7.x, Clang versions
4.x or 5.%, or Microsoft Visual C++ 2017 compilers ..............
Simulink Toolstrip: Analyze generated code using contextual buttons in
Simulink Editor . . ... .
Changes in analysis options and binaries . .......................
Changes in MATLAB functions, options object and properties .........

Verification Results . . ........ .. ... . . . . .

Recursion Detection: See list of recursion cycles in C/C++ project . . . ..
Infinite Recursions: Simple infinite recursions detected by checks for non-
terminating calls . ........ .. ... . . . ...
Updated code metrics specifications . ...........................

Reviewing Results . . ....... ... ... ... .. ... ... . . . . . . . i

Source Code Navigation: Keep result pinned while navigating through
SOUTCE COAB . v v vttt et e et e et ettt e e e et e et
Report Generation: Generate Polyspace reports faster than previous
TElEASES . o ittt e
Report Generation : Generate single file for HTML reports ...........
Project Dashboard : Track progress of code quality via Polyspace results
Project Dashboard : Compare Polyspace Code Prover results against
Software Quality Objectives ... ....... ... ... .. ...
Collaborative Review Support : Review Polyspace Code Prover results and
source codeinweb browser .. ........ ... ... ... . ... .. ...
Collaborative Review Support : Share Polyspace Code Prover results using
web links ... ... e
Project Authorization Management : Create and enforce authorization
policies for access toproject . ....... ... ... ... ..
Bug Tracking Tool Support : Create JIRA issues for Polyspace Code Prover
results and assigntodeveloper ............ ... .. ... .. ... ...

8-3

8-4

8-11

8-12
8-12
8-13
8-15
8-17
8-17

8-17
8-18

8-21



R2018b

Verification Setup . .......... ... . ... . . . . ... 9-2
Configuration from Build System: Automatically generate Polyspace
configuration modules from build system . ...................... 9-2
C11 and C++14 Support: Run Polyspace analysis on code with C11 or C+
+14features . ... . 9-2
Autodetection of Concurrency Primitives: Multitasking model detected from
C11 multithreading functions . ............. .. ... ... ... ........ 9-3

Compiler Support: Set up Polyspace analysis easily for code compiled with

Renesas compilers .. ..........c.o i 9-3
AUTOSAR Support: Provide multiple root folders for sources .......... 9-4
AUTOSAR Support: Run Polyspace on AUTOSAR software components by

using MATLAB SCTipEs . . .. oo e 9-4
AUTOSAR Support: Provide compiler options by tracing your build

COMMANA . . .ttt 9-4
Function Pointer Calls: Verify functions called through function pointers

despite typemismatch ......... ... .. ... .. . 9-5

Check Behavior on Overflows: Fine-tune the behavior of checks based on
signedness of integer .. ........ ... ... 9-6

Changes in analysis options and binaries . ........................ 9-7

Changes in MATLAB option object properties and option values ........ 9-9

Verification Results . . ....... ... ... . ... .. 9-11
C++ Specific Checks: View more pertinent results for incorrect object
oriented programming and exception handling checks ............ 9-11
Checks on List-Initialization of Arrays: Detect list-initialization with excess
initializer clauses (C++11and beyond) ........................ 9-14
Reviewing Results . .. ...... ... ... ... .. .. . ... . . . . . . . 9-15
AUTOSAR Support: Focus review to specific software components with
queries based on regular expressions . ................ ... 9-15
AUTOSAR Support: See visual representation of runnables and associated
files for each software component . ............ ... ... ........ 9-16
Header Files Access: Open your project header files directly from the point
ofinclusion . ....... ... . . . ... 9-18
R2018a
Verification Setup . ........... .. ... ... ... ... 10-2
AUTOSAR Support: Set up modular Polyspace analysis for AUTOSAR
software components automatically .......................... 10-2
MATLAB Coder Support: Run Polyspace on C/C++ code generated from
MATLAB code without additional setup ........................ 10-3
Compiler Support: Set up Polyspace analysis easily for code compiled with
Texas Instruments, IAR or CodeWarrior compilers ............... 10-4

xi



xii

Contents

Updated GCC and Clang Compiler Support: Set up Polyspace analysis easily
for code compiled with GCC versions 5.x or 6.x, or Clang version 3.x

COMPIlETS . . ot e 10-4
Configuration from Build System: Include or exclude sources when
generating Polyspace project using polyspace-configure ........... 10-5
Support for IBM Rational Rhapsody to beremoved ................. 10-6
Changes in analysis options and binaries . ....................... 10-6
Changes in MATLAB option object properties ..................... 10-9
Verification Results . .............. ... ... ... ... ... ... .. 10-12
AUTOSAR Support: Check for run-time mismatch between AUTOSAR
specifications and code implementation ...................... 10-12
MISRA C++ Support: Check for overriding of standard library functions,
missing const qualifiers and other MISRA C++rules . ........... 10-13
MISRA C:2012 Directives: Detect opportunities for data hiding ... ... 10-13
Rule for Source Line Length: Constrain number of characters per line in
YOUT COUE . v v vttt et e e ettt et e ettt e e e e 10-13
Reviewing Results . .. ....... ... ... .. .. ... .. .. . . ... . . .. 10-14
Concurrency Modeling: View all tasks and interrupts extracted from code
and Polyspace configurationinoneview ...................... 10-14
Variables Reporting: Export variable list to text file for automated reading
.................................................... 10-15
R2017b
Verification Setup . ... ... ... . ... ... e 11-2
Green Hills Compiler Support: Set up Polyspace analysis easily for code
compiled with Green Hills Compiler .......................... 11-2
OSEK Multitasking Support: Detect the multitasking configuration for your
OSEK application automatically .................. ... ........ 11-2
Polyspace API in MATLAB: Configure analysis, run analysis, and read
analysis results with a single MATLAB object ................... 11-3
Compiler-Specific Keywords: Nonstandard compiler-specific keywords are
only supported when you specify compiler ..................... 11-4
POSIX and BSD Standards: Use functions from these standards without
additional setup .. ... .. 11-4
Changes in analysis options and binaries ........................ 11-4
Verification Results .. ......... ... ... .. 11-7
Stack Size Computation: Determine maximum stack usage by a C program
and individual functions .. ....... .. ... . . L 11-7
MISRA C:2012 Directive 1.1: Detect instances of implementation-specific
behaviorinyourcode ........... .. .. ... . 11-7
CERT C Support: Identify CERT C violations using run-time error checks
..................................................... 11-7
Overlapping Memory Detection: Find cases where source and destination
arguments of memcpyoverlap ........... . ... . . . 11-8



Changes to coding rule checking . ............................. 11-8

Reviewing Results . . ........ ... ... .. .. ... .. . . . . ... . . .. 11-10
Run-Time Error Cause: Navigate to and view the cause of red
nonterminating loops or functioncalls ....................... 11-10
Results Review Workflow: Sort and filter results by subtype ......... 11-11
Result Review Workflow: Hide results that you reviewed once and justified
through source code annotations ........................... 11-12
Code Annotations: Justify results or define your own format with a new
annotationformat .......... .. ... .. .. ... 11-13
MISRA Comments and Code Annotations: Import your existing MISRA
C:2004 justifications to MISRA C:2012 results . ................ 11-14
Variable Relationships in Tooltips: Check if variables in operation are
related from previous operation ............................ 11-15
Result Status: Assign statuses that directly correspond to stages of
development workflow . .......... ... ... ... ... ... ... 11-15
Function Call Hierarchy: View and navigate to function callers and callees
by clicking functionname ............. ... ... ... ... ... . ... 11-16
R2017a
Verification Setup ............ .. ... ... . ... ... 12-2
Unified User Interface: Create and maintain a single Polyspace project for
Bug Finder and Code Prover analysis ......................... 12-2
Improved Speed and Precision: Run analysis faster and receive fewer
orange checks as compared to previous releases ................ 12-5
TASKING Compiler Support: Set up Polyspace analysis easily for code
compiled with Altium TASKING compiler ...................... 12-5
Updated Visual C++ Support: Set up Polyspace analysis easily for code
compiled with Microsoft Visual C++ 2015 compiler .............. 12-5
Autodetection of Concurrency Primitives: Multitasking model detected from
Windows or pC/OS II multithreading functions .................. 12-6
Manual Multitasking Setup: Functions beginning and ending critical
sections donotneedtobedefined ........ ... ... .. ... 12-6
Manual Multitasking Setup: main Function Not Required ............ 12-6
Specifying Function Names for Options: Choose from prepopulated list in
user interface instead of entering manually .................... 12-6
Polyspace API in MATLAB: Create MATLAB objects from Polyspace projects
torun analysis . ... 12-7
Improved support for user implementations of standard library functions
..................................................... 12-8
Improvement in automatic project creation from build systems ........ 12-8
Changes in analysis options and binaries ........................ 12-9
Changes in MATLAB options object . .......................... 12-11
Change in temporary folder location ........................... 12-12
Verification Results .. ........... ... ... . 12-13
Integers in Floating Point: See improved analysis precision for floating point
variables that always take integervalues ..................... 12-13

xiii



xiv

Contents

New Code Metrics: See number of lines in header files and number of local

variables per function . .......... ... ... . . ... .. 12-13
Checks Green by Definition: Distinguish operations that are safe by
definition from operations that are provensafe ................. 12-14
Function Pointer Signature Mismatch: View orange checks instead of red
when the mismatch cannotbeproven ..................... ... 12-14
Structures with Volatile Fields: See improved analysis precision and apply
constraints if necessary ............ ... ... 12-15
Changes to coding rule checking . ............................ 12-15
Reviewing Results . .. ....... ... ... ... ... .. .. . . ... . . .. 12-17
Easier Review: View verification assumptions, see unreachable and aliased
function callsincallgraph . ............. ... .. ... ... . ...... 12-17
Folder Names in Results: Filter or group analysis results by source folder
DLAINIES & o v vt et et e e e e e e e 12-18
Code to Model Traceability: Switch easily between identifiers in generated
code and corresponding blocksinmodel ...................... 12-18
Polyspace API in MATLAB: Read Polyspace analysis results from MATLAB
.................................................... 12-20
R2016b
Verification Setup ............ .. ... ... . ... ... 13-2
Diab Compiler Support: Set up Polyspace verification easily for code
compiled with Wind River Diab compiler ....................... 13-2
Multitasking Code Verification Setup: Specify cyclic tasks and
nonpreemptable interrupts directly as verification options ......... 13-2
Improved source and include folder management .................. 13-2
Writable Examples: Modify example projects and restore original versions
..................................................... 13-3
Run verification on .psprj file from the command line ............... 13-3
Polyspace API in MATLAB: Configure and run Polyspace using MATLAB
0DJECES . e 13-3
Configuration Parameters Help: View descriptions of Polyspace options in
Simulink configuration parameters ........................... 13-4
Eclipse Build Support: Set up Polyspace verification from Eclipse build
COMMANA . . .ottt e e 13-4
Visual Studio 2010 add-in support to be removed from installation .. ... 13-5
Support for Rhapsody 8.1 . ...... .. ... .. ... . . . . . 13-5
DOS Mode Warning on Linux: Compilation warning for DOS inconsistencies
..................................................... 13-5
Faster Restart for Remote Verification: Reuse compilation results from a
previous analysis . ... . ...t 13-6
Internal Memory Limits Removed: Expect fewer analysis failures from
MEeMOry-iNtENSIVE PIOCESSES .« . v v v vt e it e it e it i e e e 13-6
Support forlocalthreads ............ ... ... ... .. .. .. .. .. .. ... 13-6
Changes in Target & Compiler analysis options . ................... 13-6
Changes in analysis options and binaries ........................ 13-7
Verification Results ... ....... ... ... .. ... ... ... .. ... .. ... 13-10



Subnormal Float Detection: Identify loss of precision from operations that

lead to subnormalresults . .............. ... .. . . . .., 13-10

Local Variable Size Estimation: Find total size of local variables in a function
.................................................... 13-10

Changes to coding rule checking ............................. 13-10
Metrics for C++ Templates: View code complexity metrics for instances of C

+4+templates . ... 13-12
Mutual Exclusion Support: View precise ranges for shared variables

protected by critical sections and temporally exclusive tasks ... ... 13-12
Improved Embedded Coder Support: View more precise results when

generated code uses lookup tables or large data structures . ...... 13-14
Precise Buffer Manipulation Functions: View more precise results on

complete copying of structures ........... .. ... ... . ... ... . ... 13-14
Assumption for Stubbed Pointers: Review fewer warnings from pointers

coming from externalcode . .............. . ... ... .. ..., 13-14
Assumption for Structures with Volatile Fields: Review fewer warnings from

partly volatile structures . .......... ... ... ... ... ... ... 13-15
Expected Infinite Loop Detection: Avoid justifying run-time errors on infinite

loops that you introduce deliberately ........................ 13-15

Mapping to Standard Functions: View precise results by mapping
imprecisely analyzed functions to corresponding standard functions

.................................................... 13-16
Reviewing Results . .. ....... ... ... .. .. ... .. .. . . ... . ... 13-17
Interactive Graphical Display: Click graphs on Dashboard to filter results
.................................................... 13-17
Float Range Display: View float variables with narrow ranges more clearly
.................................................... 13-17
Event History for Coding Rules: Navigate easily between two locations in
code that together cause a rule violation ..................... 13-17
Subcheck Display for Standard Library Routines: Determine easily from
visual inspection which subcheck failed ...................... 13-18
Results from Macros: Coding rule violations highlighted on macro
definitions instead of macro instances .............. ... ... ... 13-18
Verification Objectives in Eclipse: Create review scopes to focus your review
.................................................... 13-19
Filtered Report: Reuse result filters for generated report ........... 13-19
Results Export: Export results to text file for computing graphs and
StatistiCs . ... e 13-19
Coding Rule Graphs in Report: View breakdown of coding rules violations
by rule numberandfile ............ ... ... .. . ... .. .. 13-19
Constraints in Report: Add comments about external constraints and view
commentsS INTePOTt . . ... it e 13-20
English Reports in Non-English Locales: Generate English reports on
operating systems with a different language ................... 13-20
Improved PDF report generation ............................. 13-21
Change in report template location ............................ 13-21
Changes in Polyspace User Interface .......................... 13-21



xvi

Contents

Verification Setup ........... ... . ... .. .. ... e 14-2
Files to Review: Generate results for only specified files and folders .... 14-2
Faster MISRA Rule Checking: Check coding rules more quickly and

efficiently .. ...... . . . . 14-2
S-Function Analysis: Launch analysis of S-Function code from Simulink
..................................................... 14-2
Polyspace Metrics Tomcat Upgrade: Use upgraded default Tomcat server or
custom Tomcat version . ............iii ... 14-3
Project Language Flexibility: Change your project language at any time
..................................................... 14-3
External Constraint on Pointers: Specify certain initialization with full range
for pointer arguments and return values of stubbed functions ....... 14-3
Source Code Search: Search large applications more quickly ......... 14-4
Polyspace TargetLink plug-in supports data from structures .......... 14-5
Polyspace Eclipse plug-in results locationmoved .................. 14-5
Improvements in automatic project creation from build command . .. ... 14-5
Improvements in checking of previously supported MISRA C rules . . ... 14-6
Variables with constraints not counted as orange sources ............ 14-6
Changes in analysisoptions . ............. ... . ... 14-7
Verification Results . . ....... ... ... . . ... .. . 14-9
Floating-Point Support: Propagate ranges more precisely for long double
variables and enable verification mode to incorporate infinities and NaNs
..................................................... 14-9
Absolute address usage valid by default .. ...................... 14-11
Run-time checksrenamed ............ ... ... ... ... ... ... ... 14-11
Reviewing Results . .. ....... ... ... ... ... .. .. . . ... . . ... 14-13
Autocompletion for Review Comments: Partially type previous comment to
select complete comment .. .............. ... ... ... . ..., 14-13
Default Layouts: Switch easily between project setup and results review in
userinterface ........ ... ... .. 14-13
Persistent Filter States: Apply filters once and view filtered results across
multiple runs . ... .. e 14-13
Updated Polyspace Metrics Interface: View summary of project and metrics
.................................................... 14-14
Improved Result Display for File-by-File Verification: View combined
summary of results for all files in user interface ................ 14-14
Simplified Variable Access: View task names instead of aliases . ... ... 14-14
R2015b
Verification Setup . ........... .. ... ... ... ... 15-2



Option to Suppress Non-initialization Checks: Customize verification by
suppressing non-initialization checks ...................... ... 15-2
Autodetection of Multitasking Primitives: Analyze source code with
multitasking primitives from POSIX or VxWorks without manual setup

..................................................... 15-2
Microsoft Visual C++ 2013 Support: Analyze code developed in Microsoft
Visual C4+4+ 2013 .. ... 15-3
GNU 4.9 and Clang 3.5 Support: Analyze code compiled with GCC 4.9 or
Clang 3.5 ... e 15-3
Improvements in automatic project creation from build command . .. ... 15-3
Start Page: Get quickly familiar with Polyspace Code Prover .......... 15-4
Saved Layouts: Save your preferred layouts of the Polyspace user interface
..................................................... 15-4
Renaming of labels in Polyspace userinterface .................... 15-5
Including options multiple times ... .............. . ... .. ... . .... 15-5
Updated Support for TargetLink . .............. ... .. ... ........ 15-6
Improved handling of declspec ................ ... ..., 15-6
Changes in analysisoptions . ............. . ... ... 15-6
Binariesremoved . .. ... ... 15-11
Support for Visual Studio 2008 to beremoved . .................. 15-11
Import Visual Studio projectremoved .......................... 15-12
Verification Results . .............. ... ... ... ... ... ... L. 15-13

Improved Concurrency Detection: View more precise sharing and protection
results based on dynamic information such as data flow in branching

statements and protection on individual fields of a structure . ... ... 15-13
Additional MISRA C:2012 Support: Detect violations of all MISRA C:2012
rulesexceptrules 22.X . ... ... 15-15
Improved precision for mathematical functions . .................. 15-16
Improvements in checking of previously supported MISRA Crules .... 15-16
Change in Correctness Condition Check ........................ 15-18
Reviewing Results . .. ........ ... ... ... ... .. .. . . ... . . .. 15-19
Improved Review Capability: View result details and add review comments
inonewindow . . ... 15-19
Enhanced Review Scope: Filter coding rule violations from display in one
ClCK . . 15-19
Additional Call Graph Showing Task Creation .................... 15-19
Improvements in Polyspace Metrics workflow .................... 15-20
Improvements in Polyspace Plugin for Eclipse ................... 15-20
Improvements in Report Templates . ........................... 15-20
Configuration Associated with Result Not Opened by Default . ....... 15-21
XML and RTF report formatsremoved . ........................ 15-21
R2015a
Verification Setup . ... ...... ... . ... ... . e 16-2

Simplified workflow for project setup and results review with a unified user
interface . ... . 16-2

xvii



Improvements in search capability in the user interface ............. 16-3

Support for GCC 4.8 . . ... 16-4
Polyspace plug-in for Simulink improvements ..................... 16-4
Polyspace binaries beingremoved ............................. 16-4
Import Visual Studio project beingremoved ...................... 16-5
Verification Results ................ ... ... ... ... ... 16-6
Detection of stack pointer dereference outside scope ............... 16-6
Isolated ellipsis for variable number of function arguments supported . . 16-6
Improvement in pointer comparisons . ..............iiiii... 16-7
Improvements in coding rules checking ......................... 16-8
Reviewing Results . .. ....... ... ... .. ... .. .. . . ... . . ... 16-10
Context-sensitive help for code complexity metrics, MISRA-C:2012, and
custom codingrules . ......... ... . . ... 16-10
Review of code complexity metrics and global variable usage in user
interface . ... . 16-10
Review of latest results compared tothelastrun ................. 16-11
Guidance for reviewing Polyspace Code Prover checks in C code . . ... 16-11
Simplified results infrastructure . ............ ... ... ... ... ..... 16-12
R2014b
Verification Setup . ... ... ... .. .. ... e 17-2
Improved verification speed ... ...... ... ... . ... . ... . 17-2
SupportforMac OS . ... .. .. e 17-2
Support for CH++11 ... .. e 17-2
Code Editor for editing source files in Polyspace user interface ........ 17-3
Local file-by-file verification .. ............. ... .. ... . . ... 17-3
Simulink plug-in support for custom projectfiles .. ................ 17-3
TargetLink supportupdated .......... ... ... ... ... . . ... ... . ... 17-3
AUTOSAR supportadded ......... ... ... ... 17-4
Default verification level changed .............................. 17-4
Default mode changed for C++ code verification in user interface . . ... 17-4
Improved global menu in userinterface ............. ... ... .. ... 17-5
Improved Project Manager perspective .......................... 17-5
Changed analysis options . ........... oty 17-6
Remote launcher and queue managerrenamed .................... 17-6
Polyspace binaries beingremoved ...................... ... .... 17-7
Import Visual Studio project beingremoved ...................... 17-7
Verification Results .. ......... .. ... ... 17-8
Support for MISRA C:2012 . ... .. e 17-8
Improved verification precision for non-initialized variables .......... 17-8
New checks for functionsnotcalled ........................... 17-10
Improved precisionlevel .......... ... ... . ... 17-11
Reviewing Results . . ........ ... ... .. ... ... . . . . . . . i 17-12

xviii Contents



Context-sensitive help for verification options and checks ........... 17-12

Updated Software Quality Objectives . ......................... 17-12
Improved Results Manager perspective . ....................... 17-12
Error mode removed from coding rules checking ................. 17-14
R2014a
Verification Setup . ........... .. ... .. . ... ... 18-2
Automatic project setup from build systems ...................... 18-2
Support for GNU 4.7 and Microsoft Visual Studio C++ 2012 dialects . . . 18-2
Documentation in Japanese . .. ... ..... ..t 18-2
Preferencesfilemoved ........... .. ... . . . . . ... 18-3
Support for batch analysis securitylevels ........................ 18-3
Interactive mode for remote verification ......................... 18-3
Default texteditor ... ....... .. . .. . . 18-3
Support for Windows 8 and Windows Server 2012 ................. 18-3
Check model configuration automatically before analysis ............ 18-4
Function replacement in Simulink plug-in .. ...................... 18-4
Polyspace binaries beingremoved ............................. 18-4
Verification Results . ............ ... ... ... .. 18-6
Support for additional Coding Rules (MISRA C:2004 Rule 18.2, MISRA C++
Rule 5-0-11) . ... 18-6
Improvement of floating point precision . ........................ 18-6
Reviewing Results .. ......... ... ... .. ... .. . . . . . . . i 18-7
Results folder appearance in Project Browser .. ................... 18-7
Results Manager improvements . ..............ouuiiiineern. 18-8
Simplification of coding rules checking .......................... 18-9
Additional back-to-model support for Simulink plug-in ............. 18-10
R2013b
Verification Results .. ........ .. ... . ... .. . ... . . . 19-2
Proven absence of certain run-time errors in C and C++ code ........ 19-2
Identification of variables exceeding specified range limits ........... 19-2
Graphical display of variable reads and writes . ................... 19-2
Calculation of range information for variables, function parameters and
TEtUIN Values . . . 19-2
Reviewing Results .. ........ ... ... .. . . . . . . . i 19-3
Color-coding of run-time errors directlyincode ................... 19-3

Xix



XX

Contents

Quality metrics for tracking conformance to software quality objectives

..................................................... 19-3
Web-based dashboard providing code metrics and quality status ....... 19-3
Guided review-checking process for classifying results and run-time error

STatUS . . 19-4
Comparison with R2013a Polyspace products ..................... 19-4



R2022b

Version: 10.7
New Features
Bug Fixes

Compatibility Considerations



R2022b

Verification Setup

1-2

Compiler Support: Set up Polyspace analysis for code compiled with
Intel C++ Compiler Classic (icc/icl) compilers

In R2022Db, if you build your source code by using an Intel® C++ Compiler Classic (icc/icl)
compiler, you can specify the compiler name for your Polyspace analysis.

Target Environment

Compiler intel w

Target processor type |x86_&64 et

At the command line, you specify a compiler by using the -compiler option. For instance:
polyspace-code-prover-server -sources file.c -compiler intel ...

For more information, see Compiler (-compiler).

See also Intel C++ Compiler Classic (icc/icl) (-compiler intel).

You can now set up a Polyspace project without knowing the internal workings of an Intel C++
Compiler Classic (icc/icl) compiler. If your code compiles with your compiler, it will compile with
Polyspace in most cases without requiring additional setup. Previously, you had to explicitly define
macros that were implicitly defined by the compiler and remove unknown language extensions from
your preprocessed code.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server™
Updated Clang Compiler Support: Set up Polyspace analysis for code
compiled by using Clang version 12.x

In R2022b, Polyspace supports Clang compiler version 12.x natively. If you build your source code by
using Clang compiler versionl2.x, you can specify the compiler name for your Polyspace analysis.

Target Environment

Compiler dangl2.x e

Target processor type |x86_564 s

At the command line, you specify a compiler by using the option - compiler. For instance:
polyspace-bug-finder-server -sources file.c -compiler clangl2.x ...
For more information, see Compiler (-compiler).

You can now set up a Polyspace project without knowing the internal workings of this compiler. The
analysis can interpret macros that are implicitly defined by the compiler and compiler-specific
language extensions, such as keywords and pragmas.
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Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

C++ Container Support: Faster analysis of code that uses C++
containers such as std::vector and std::map

In R2022b, you can enable a faster Code Prover analysis of C++ code that uses Standard Template
Library (STL) containers such as std: :vector and std: :map. The analysis uses smart stubs for
methods from these containers and does not attempt to check the container implementations.

To enable stubbing of C++ containers, use stdlibcxx for the option Libraries used (-
library).

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

AUTOSAR Support: Improved troubleshooting assistance for project
setup

In R2022h, when you run a Polyspace analysis based on AUTOSAR specifications, the analysis
provides better assistance for troubleshooting errors and allows easier setup.

In particular, you can see these improvements:
* You can now include multiple custom headers to troubleshoot undefined types and macros.

When setting up a Polyspace project from AUTOSAR specifications, you can #include multiple
headers into source files only for the purposes of the Polyspace analysis. These headers can
contain data type and macro definitions that are not available in your AUTOSAR ARXML
specifications, but are needed for analyzing your code implementation.

To force inclusion of headers into sources, use the option -include fileName with the
polyspace-autosar command. The option -include works in the same way as the option
Include (-include) available with a regular Polyspace analysis (not based on AUTOSAR
specifications).

See also polyspace-autosar.
* You can locate ARXML parsing errors more easily.

The ARXML parsing phase of the analysis now starts with a preliminary check for XML validity.
Invalid XML tagging errors are shown with the precise location of the error (line, column).

* Duplicate array types in ARXML do not lead to code duplication.

The ARXML parsing phase of the analysis now handles duplicate array types in the ARXML
correctly. The analysis prints a warning if the same array type is declared multiple times in the
ARXML specifications, but enters only a single type in the generated main function. This
generated main function is used for subsequent code proving. Previously, duplicate types were
recorded differently in the generated main function leading to a large-sized main function in some
cases.

You can also disable the duplicate type declaration warnings using the option -Wno-autosar-
xmlDuplicateType.

See also polyspace-autosar.
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Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Object Size Limitation Removed: Analyze code containing large data
structures

In R2022b, Polyspace can analyze code containing large objects. Previously, objects with size greater

than 256 MB caused the analysis to stop. Such large-sized objects typically result from deep nesting
of structures containing array fields or multidimensional arrays of large structures.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Access™
(Polyspace as You Code)
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Results Export: Updated color property when you export Code Metrics
results to JSON SARIF format

In R2022b, the Polyspace Code Metrics color property is empty when you export Polyspace results to
a JSON SARIF file.

Previously, the value of this color property was BLACK. The updated value is more consistent with
the Code Metrics color for other Polyspace export formats.
Compatibility Considerations

If you pass the JSON SARIF file to a script or third party tool that uses the Code Metrics color to
manage Polyspace results, update the script or tool configuration to filter on an empty color field
instead of a BLACK field value.

Changes in the polyspace-access Command Options

Options -new-findings and -review-status will be removed in a future release
Warns

The polyspace-access command options in this table will be removed in a future release. Use the new
options instead.

Current Option Usage New Option
-new-findings Select only new findings when |-resolution new
you export or assign an owner
to unassigned findings. This new option lets you filter by

additional resolution types such
as Fixed, Unresolved, and
resolved.See also

You get an error if you use this
option with a project that
contains only one run. In this
case, all findings are new and
you do not need to specify this

option.
-review-status Unreviewed |Select findings with one of the |-status Unreviewed | "To
| "To investigate" | "To |specified review status when investigate" | "To fix"
fix" | Justified | "No you export or assign an owner || Justified | "No action
action planned" | "Not a |to unassigned findings. planned" | "Not a
defect" | Other defect" | Other

For accuracy and consistency, two filter have been updated in the Polyspace Access interface. The
filter labels changes are:

» State — Resolution
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* Review Status — Status

See “Filter Polyspace Access Results”.

Products: Polyspace Access

polyspace-access Command: Manage review information and compare

project runs

In R2022b, you can manage Polyspace Access projects programmatically by using the polyspace-
access command to perform the operations in this table.

Operation

Command

Add, edit, or remove
review information for a
finding

polyspace-access -review <textFileOrfindingID> -project-
path <fullProjectPath> <review-options> -host

Use this command to assign review information such as status, severity,
comment, owner, or bug tracking tool ticket.

To assign the same review information to multiple findings, specify the
path of a text file where you store the finding IDs of those findings.

For example, to perform a batch assignment for a large number of findings
from project public/example/Bug Finder:

1 Create a text file findingsIDs. txt where you store the finding IDs
of all the findings that you want to review. In the file, list one finding
ID per line.

2 Pass the file findingsIDs. txt to the - review command:

polyspace-access -review findingsIDs.txt -project-path
"public/example/Bug Finder" -set-status "To
investigate" -set-severity Medium -host

To assign review information to a single finding, specify its finding ID.

See also “Make Batch Edits to Review Information for New Findings”.
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Operation Command
Compare two runs from |polyspace-access -export <runIDl> -baseline <runID2> -
the same project resolution <findingResolution> -output <filePath> -
host
Here:

* runID1 is the run ID of the run that you use as a current run.
* runID2 is the run ID of the run that you use as a baseline for the
comparison.

The baseline run must be older than the current run.

The command outputs a file with a list of findings filtered by one of these
resolution types:

* New

¢ Fixed

* Resolved

*  Unresolved

See also “Comparison Mode at the Command Line”.

You can use these commands as part of automation scripts when managing your projects. Previously,
you performed the operations in this table only from the Polyspace Access user interface.

Products: .

Polyspace Access: Import review details and justifications from
existing projects

In R2022b, you can import review information between Polyspace Access projects from the Polyspace

Access interface or at the command line. For instance, if you justify findings in the file test.c in one
project, you can reuse those justifications in another project that also uses file test.c.
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Import Reviews From Another Project x

Target public/example/Bug_Finder Example
project:  (Bug Finder)

Source project:

~ 3 public
I3 example

| polyspace (Bug Finder)

Import Policy

@Source writes only when target is empty
(Source always replaces target

Click hers to get more information

[ QK ]| Cancel |

1-8

After you import the review information, you can use filters in the Polyspace Access interface toolbar
or view the Result Details pane to determine which review information was imported.

At the command-line, use option polyspace-access -import-reviews to import review
information from a source project to a destination project. For example:

polyspace-access -import-reviews <source> -to-project-path <destination> -import-strategy <strategy> -host ...

Where -import-strategy specifies whether the source always overwrites the destination or not.

After you complete the import, you can also use the command polyspace-access -export -
imported-reviews to generate a file that lists findings filtered by type of import, for instance all
findings where the review information was overwritten during the import.

Previously, to import review information, you had to download results from Polyspace Access, import
from previous results at the command line, and then upload the results again. The updated method
takes fewer steps. You can also see in the result details which review information is new in the
current result and which review information is imported.
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See “Import Review Information from Existing Polyspace Access Projects”.

Products: Polyspace Access
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Updated Clang Compiler Support: Set up Polyspace analysis for code
compiled by using Clang versions 6.x to 11.x

In R2022a, Polyspace supports Clang compiler versions 6.x to 11.x natively. If you build your source
code by using these Clang compiler versions, you can specify the corresponding compiler option
values for your Polyspace analysis.

Target Environment

Compiler dangb.x o

Target processor type | x86_64 e

clang6.x for LLVM release 6.0.0 and 6.0.1.

Target Environment

Compiler dang7.x e

Target processor type | x86_64 e

clang7.x for LLVM release 7.0.0, 7.0.1, and 7.1.0.

Target Environment

Compiler dangd.x w

Target processor type | x86_64 W

clang8. x for LLVM release 8.0.0 and 8.0.1.

Target Environment

Compiler dangd.x w

Target processor type | x86_64 w

clang9. x for LLVM release 9.0.0 and 9.0.1.

Target Environment

Compiler dang10.x w

Target processor type | x86_64 w

clangl0. x for LLVM release 10.0.0 and 10.0.1.
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Target Environment

Compiler dangll.x e

Target processor type | x86_64 e

clangll.x for LLVM release 11.0.0, 11.0.1, and 11.1.0.

At the command line, you specify a compiler by using the option - compiler. For instance:
polyspace-bug-finder-server -sources file.c -compiler clang9.x ...

For more information, see Compiler (-compiler).

Because of the native support, you can now set up a Polyspace project without knowing the internal
workings of these compilers. The analysis can interpret macros that are implicitly defined by the
compilers and compiler-specific language extensions, such as keywords and pragmas.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Configuration from Build System: Import compiler macro definitions
automatically without tracing build

In R2022a, Polyspace can import macro definitions from compilers that provide native options to list
the compiler predefined macros, for instance gcc -dm -E. Polyspace passes the relevant options to
the compiler and extracts the macro definitions from the output, without tracing your build.

With this new macro import strategy, when you use polyspace-configure to create a Polyspace
project or to generate an analysis options file from your build system, Polyspace automatically
attempts to import macro definitions by trying import strategies in this order of priority:

1 From compiler by using native compiler options to list macro definitions. This strategy is
available only for compilers that support listing macro definitions.

2  From source code tokens. Polyspace uses every non-keyword token in your source code to query
your compiler for macro definitions. This strategy is available only if Polyspace can trace your
build. This strategy is not available if you use a JSON compilation database to extract your build
configuration.

3 From a predefined allow list. Polyspace uses the allow list to query your compiler for macro
definitions.

Previously, if you used a JSON compilation database or if a third-party software prevented
polyspace-configure from tracing your build, for example System Integrity Protection on Mac
OS, Polyspace attempted only the allow list strategy to import macro definitions.

See also polyspace-configure.

Product: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Access
(Polyspace as You Code).
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Simulink Support: Polyspace updates generated code when model
changes

In R2022a, the workflow for analyzing code generated from Simulink® models is simplified. If you
have Embedded Coder®, Polyspace checks the model for any new change every time you click Run
Analysis. If you have changed the model since the last Polyspace analysis, Polyspace invokes
Embedded Coder to refresh the generated code before starting the new analysis.

Analyze Code from v
|p:l}rspace_co"trcu er_demo |i| Run
Code Generated as Top Model - Analysis

AMALYZE

See Run Polyspace Analysis on Code Generated with Embedded Coder.

Previously, to reflect an updated model in your code, you regenerated code explicitly. Now, Polyspace
detects changes in your model and regenerates code if the model changes.

Additional Considerations: After updating your model, you still need to generate code explicitly if
any of the following is true:

* You do not use Embedded Coder to generate code.

* The model is configured to generate code as a model reference.

Product: Polyspace Code Prover (Desktop).

Simulink Support: Analyze generated code by bounding number of
calls to step function

In R20224a, you can reduce the number of unproven orange checks when verifying generated code by
bounding the number of calls to the step function in the code. The step function in the generated
code corresponds to all actions performed in one simulation step of the model. If you know that a
model or subsystem will run for a certain number of steps, you can provide this information to the
Polyspace analysis and bound the number of calls to the step function.

Bounding the number of calls to the step function:

* Reduces the number of unproven orange checks. For instance, operations that might otherwise
overflow a buffer when performed an unspecified number of times remain within the bounds of the
buffer.

» Allows you to prove certain properties of the system after a certain number of simulation steps are
completed.

For more information, see -main-generator-bounded-1loop.
MATLAB Coder Support: Polyspace analysis takes into account
MATLAB Coder settings for nonfinite numbers

In R2022a, a Polyspace analysis of C/C++ code generated from MATLAB® code has better support for
nonfinite numbers. If the option Support nonfinite numbers is enabled in your code generation
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settings (default behavior), a subsequent Polyspace analysis of the generated code takes this
information into account. The analysis runs with the Polyspace option Consider non finite
floats (-allow-non-finite-floats) enabled and correctly interprets infinities and NaN-s.

Previously, the analysis ignored the MATLAB Coder™ specification and produced false positives when
the generated code explicitly used infinities and NaN-s.

Product: Polyspace Code Prover (Desktop).

Ignoring Code Annotations: Perform a worst-case analysis to see all
results including previously justified ones

In R20224a, you can run a Polyspace analysis that ignores all code annotations justifying Polyspace
results.

To avoid reviewing a result multiple times, you can add annotations specific to Polyspace to your code
with review information such as justification for a result. Later runs take into account these
annotations and show the review information in the results. In some cases, you might want to run a
clean analysis as if the results have not been previously reviewed. Starting in R2022a, you can use
the option -ignore-code-annotations to run such an analysis with no history. The analysis
ignores the code annotations and shows all annotated results without any review information from
the annotations.

See also:

*+ -ignore-code-annotations
* Annotate Code and Hide Known or Acceptable Results

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Functionality Being Removed: Coding standards checking and code
metrics computation with Code Prover

In a future release, these functionalities will be removed from Code Prover and Code Prover Server:

* Calculating code metrics other than stack use metrics.
* Checking compliance with these coding rule standards:

+ MISRA C:2004
+ MISRA-AC-AGC
* MISRA C:2012
* JSFC++
¢ MISRA C++:2008
* Custom coding rules
You get a warning when you perform any of the preceding tasks by using Code Prover. To calculate

the stack usage metrics, use the new option -stack-usage. Using the options -code-metrics and
-stack-usage together might cause an error.

See:
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* Calculate stack usage (-stack-usage)
» Use -stack-usage instead of -code-metrics to calculate stack usage metrics

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

If you used Code Prover to calculate code metrics and check compliance with coding standards,
consider using Bug Finder instead. See:

* Migrate Code Prover Workflows for Checking Coding Standards and Code Metrics to Bug Finder
* Coding Standards
* Code Metrics

Functionality Being Removed: Polyspace desktop integration with
Eclipse IDE

The Polyspace desktop product integration with Eclipse™-based IDEs will be removed in a future
release.

Product: Polyspace Code Prover (Desktop).

Compatibility Considerations

To continue running Code Prover analyses and reviewing the analysis results, use the Polyspace Code
Prover desktop product instead. See Run Polyspace Code Prover on Desktop.

Functionality Removed: Polyspace stubs for Standard Template
Library

Polyspace stubs for the C++ Standard Template Library (STL) have been removed. These stubs
conform to the older C++98 Standard and were meant for quickly getting started with a C++
analysis. In most situations, your compiler implementation of the Standard Template Library is
required for successful compilation of a C++ project with Polyspace.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

If you were using the Polyspace stubs when running an analysis, you will encounter a compilation
error. To work around the error, provide your compiler implementation of the Standard Template
Library for analysis.

Functionality Removed: Compilation assistant

The Polyspace compilation assistant is removed in R2022a. You get an error if you use option -easy-
setup-compile at the command line.

Product: Polyspace Code Prover (Desktop).
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Compatibility Considerations

If you use the compilation assistant in your Polyspace project:

* The option is automatically removed in the Polyspace user interface.
* Remove option -easy-setup-compile at the command line.

Alternatively, when you set up your Polyspace project:
* Use the Compiler (-compiler) option to specify a compiler that Polyspace supports natively if
you compile your code by using that compiler.

* Use polyspace-configure to trace your build command and to obtain your compiler
configuration. See polyspace-configure.

Changes in analysis options and binaries

Use -stack-usage instead of -code-metrics to calculate stack usage metrics
Warns

Starting in R2022a, to calculate the stack usage metrics of your code, at the command line, use the
new option Calculate stack usage (-stack-usage) instead of -code-metrics. Inthe
Polyspace Ul, select the option in the Check Behavior pane. This option calculates these metrics:
* Maximum Stack Usage

* Minimum Stack Usage

* Program Maximum Stack Usage

* Program Minimum Stack Usage

* Lower Estimate of Size of Local Variables

* Higher Estimate of Size of Local Variables

See Calculate Stack Usage .

Previously, you calculated stack usage metrics with other code metrics by selecting the Calculate
Code Metrics box in the Coding Standard & Code Metrics pane or by specifying the option -
code-metrics in the command line. This workflow is not recommended and will be removed in a
future release. To calculate the stack usage metrics, use Calculate stack usage (-stack-
usage) . For instance, when calculating stack usage metrics, replace these commands:

polyspace-code-prover -sources file name -code-metrics
with these commands:
polyspace-code-prover -sources file name -stack-usage

Using the options -code-metrics and -stack-usage together might cause an error.

For calculating other code metrics, Bug Finder is the recommended tool. See Migrate Code Prover
Workflows for Checking Coding Standards and Code Metrics to Bug Finder .

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
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Options -respect-types-in-fields and -respect-types-in-globals will be removed in a future
release
Warns

These options will be removed in a future release:

* Respect types in fields (-respect-types-in-fields)
* Respect types in global variables (-respect-types-in-globals)

The options were originally introduced in Polyspace Code Prover to detect pathological constructions
that increased the pointer analysis time significantly. For instance, the option Respect types in
global variables (-respect-types-in-globals) prevents casts of nonpointer global
variables to pointers by flagging their subsequent dereference as red or orange checks. Such casts
previously increased the pointer analysis time significantly. Because of performance improvements in
pointer analysis, these options are no longer required.

You can still detect the pathological constructions using Polyspace Bug Finder™. For instance, you
can use the Bug Finder checker for CERT C: Rule INT36-C to flag conversions from integer to
pointer.

Option -no-stl-stubs no longer supported
Errors

The option No STL stubs (-no-stl-stubs) is no longer supported. This option disabled use of
Polyspace stubs for the C++ Standard Template Library (STL). Since these stubs are no longer
provided in R20224a, there is no requirement to disable their use.

Changes in MATLAB function, options object and properties

Property NoStIStubs no longer supported
Errors

The property NoSt1Stubs is no longer supported. To disable use of Polyspace stubs for the C++
Standard Template Library (STL), you enabled this property as follows:

proj = polyspace.Project;
proj.Configuration.InputsStubbing.NoSt1Stubs = true;

Since these stubs are no longer provided in R2022a, there is no requirement to disable their use.


https://www.mathworks.com/help/releases/R2022a/codeprover/ref/respecttypesinfieldsrespecttypesinfields.html
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Improved Pointer Analysis: New pointer analysis mode that keeps
better records of pointers and pointed variables

In R2022a, you can enable a new mode for pointer analysis that can show more precise results if the
execution paths leading to the results involve pointers. In this mode, the analysis can keep a more
precise record of the relationship between pointers and pointed variables.

For instance, in this example, a pointer to a structure is cast to a pointer to char, and then its
contents are initialized. Because of the cast, the later fields of the original structure stay non-
initialized. Prior to R2022a, the analysis could not prove the non-initialized state of the later fields
and showed an orange check when those fields were read. Because of the improved pointer analysis,
you now see a red check.

struct myStruct {
int firstField;
int secondField;
b
int foo(){
struct myStruct obj;
struct myStruct *ptr = &obj;
*(char *)ptr = 1;
return obj.secondField;

}

To use the new mode for pointer analysis, use the option -improve-pointer-analysis-
precision. You might see a change in the result of a Code Prover check if the execution path
leading to the check involves pointers in some way. In most cases, the results are more precise
(orange checks becoming green or red). In some cases, you might also see an increase in grey checks
(code that was previously thought as reachable is now correctly shown as unreachable).

Because the new mode keeps more detailed record of the relations between pointers and pointed
variables, it might not scale to large applications.

See also -improve-pointer-analysis-precision.

Products: Polyspace Code Prover, Polyspace Code Prover Server
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Results Export: Generate more accurate keys to track results across
analysis runs

In R20224, if you export Polyspace results to a CSV file, you can specify whether the generated result
keys are calculated within the result function scope or the file scope. Along with the scope, the key is
calculated by using the result names and types to identify each result. You use these keys to track
results across analysis runs, for instance to remove duplicate results when you merge results from
different modules that have common files.

To specify how the keys are calculated, use option -key-mode flag at the command line with
polyspace-report-generator or polyspace-results-export, where flag is one of these :

+ file-scope(default) — The entries in the Key column are calculated by using the result name,
the result type, and the file scope. This corresponds to the current behavior when you export
analysis results.

* function-scope — The entries in the Key column are calculated by using the result name, the
result type, and the function location. If the result is not inside a function, the key is calculated by
using the file scope. When you enable this mode, the keys of results that are inside functions are
prefixed with FN.

In the Polyspace user interface:

* To export results with function-scope mode, create a menu item by going to Tools >
Preferences and entering this command on the Tools Menu tab:

$POLYSPACE_R0OOT\bin\polyspace-results-export.exe -results-dir $RESULT DIR -key-mode function-scope
-format csv -output-name $RESULT_DIR

* Polyspace Preferences x

Server Configuration Project and Results Folder  Editors  Tools Menu  Review Statuses  Miscellaneous  Character Encoding  Review Scope

Commands for Tools menu

Menu item Execution command
ExportWithFunctionkeyMode |SPOLYSPACE_ROOT \bin'polyspaceresults-export.exe -results-dir SRESULT_DIR. +key-mode function-scope -format csv -output-name SRESULT_DIR

Environment variables

When adding new items to your Polyspace Tools menu, you may use the variables below in execution commands.
For example, to allow viewing of the current preprocessed file, you can spedfy the command WordPad.exe SEXPANDED SOURCE FILE”

You can then export results by using the menu item you created from Tools > External Tools.
» To export results with file-scope mode, use the Reporting > Export menu.
When you enable function-scope mode, a new result key is generated between analysis runs only
if there are changes within the function scope of that result. You can use the more accurate

function-scope keys, along with the entries of the File and Function column to track relevant
changes.
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Previously, edits within the file could trigger a recalculation of result keys, even if there were no
changes within the function where the result was located.

See also Enable Function Scope for Exported Keys.

Product: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Access.

Polyspace Access: Redesign of Ul dashboard design for consistency
and efficiency

The Polyspace Access Dashboard has been redesigned by modernizing and enhancing consistency
and efficiency. The new global layout affects various cards, charts, graphs, numbers, and icons in
Polyspace Access.
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Polyspace Access: Improved performance when viewing aggregate
data from large project folders

Polyspace Access shows improved speed performance when opening different Polyspace Access

dashboards. This speed improvement for loading dashboards is most notable when viewing
aggregated project information for a folder that has many projects in it.

This table shows the improvements in loading times of the Defects dashboard for folders containing
500 and 2500 subprojects.

Folder Size R2021b Loading Time R2022a Loading Time
Folder containing 500 45 seconds 1 second

subprojects

Folder containing 2500 50 seconds 3 seconds

subprojects

Performance when loading dashboards was timed on a server using an Intel Xeon (Skylake IBRS) 4
core processor with 32GB of RAM and an SSD.

Polyspace Access: View code covered by verification in new graph

In R2022a, a Code Covered By Verification graph is now displayed in the Run-time Checks,
Defects, and Coding Standards dashboards.

The Code Covered By Verification graph shows the number of files that were not analyzed due to
situations such as compilation errors. For Code Prover run-time checks, the graph also shows the
number of functions and code operations that were not checked because they were proven to be
unreachable.

Run-time Checks

Summary Code Covered By Verification
Red Gray Orange Files 9/9 files analysed
Done 0% 0% 0% 100%
Open 12 16 73 )
Functions 45 [ 46 functions analysed
0 /101 done )

Checks
' 0%
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Polyspace Access Project Runs: Add labels to analysis runs that you
upload to a project

In R2022a, you can add labels to a project run that you upload to Polyspace Access.

You can use labels to, for instance, identify project runs of interest more easily, or to associate a run
with a specific branch or continuous integration build job.

To add or remove a label:

e At the command line, enter:

polyspace-access -add-label <LABEL> -run-id <RUN _ID> -host ...
polyspace-access -remove-label <LABEL> -run-id <RUN _ID> -host ...

Use the -list-project flag to obtain the run ID of the latest run, or the -list-runs flag to obtain the
run ID of older runs. See polyspace-access.

For example, to add label myLabel to a project run with run ID 1234, enter:

polyspace-access -label myLabel -run-id 1234 -host ...

In the Polyspace Access interface, select a run on the toolstrip drop-down list and click I:II_II:I in the

Project Details pane. To remove a label, select the label from the Labels list and click P
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Product: Polyspace Access.

polyspace-access Command: Assign SQO levels, move or delete a
project, and view list of runs for a project

In R2022a, you can manage Polyspace Access projects programmatically by using the polyspace-
access command to perform the operations listed in this table.
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Operation Command
Move or rename a polyspace-access -move-project <SOURCE> -to-project-path
project or folder <DESTINATION> -host ...

For example, to move project public/myProjects/foo to folder
public/myOtherProjects, run this command :

polyspace-access -move-project public/myProjects/foo -to-
project-path public/myOtherProjects/foo -host ...

Delete a project or polyspace-access -delete-project <PROJECT PATH> -host ...

folder
The command deletes the project from the Project Explorer but not from

the Polyspace Access database. To delete a project from the database, see
Delete Outdated Projects.

Assign a Software polyspace-access -set-sqo <PROJECT PATH> [-name
Quality Objective (SQO) |<SQ0 NAME>] -level <SQO LEVEL> -host ...
level to a project

The command assigns the specified <SQO LEVEL> (1 through 6 or
"exhaustive") for the current SQO definition. You can optionally use the
-name flag to assign a different SQO definition. See also Quality Objectives
Dashboard in Polyspace Access Web Interface.

View the SQO definition |polyspace-access -get-sqo <PROJECT PATH> -host ...

and level currently
assigned to a project.  |The command returns the name of the SQO definition currently assigned to

the project along with the assigned SQO level.

View list of available polyspace-access -list-sqo -host ...

SQO definitions
The command returns a list of the names of all the available SQO
definitions.

View list of runs polyspace-access -list-runs <PROJECT PATH> -host

uploaded to a project
The command returns a list of all the runs uploaded to the specified

project. For each run, you see the run ID and any labels added to that run.

You can use these commands as part of automation scripts when managing your projects. Previously,
you performed the operations listed in the table only from the Polyspace Access user interface.

Product: Polyspace Code Prover (Desktop), Polyspace Code Prover Server.

polyspace-access Command: Improved robustness and error
diagnostics

In R2022a, you can use the new -max- retry option with the polyspace-access command when
you upload results from a client machine to a server machine that hosts the Polyspace Access
database. The option specifies the number of times the client machine attempts to reconnect to the
server machine in the event of a sporadic network failure, for instance -max-retry 5. The
reconnection attempts happen at 10-second intervals. By default, the client machine attempts to
reconnect three times.

The polyspace-access command also has improved error messages to help you diagnose issues
more easily.
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Product: Polyspace Code Prover (Desktop), Polyspace Code Prover Server.

Functionality Removed: Report generation from pre-R2015a results

Report generation from pre-R2015a Polyspace results are no longer supported. In releases R2015a
and earlier, Polyspace products generated results in a format that will no longer be supported for
report generation.

Compatibility Considerations

Typically, you do not require support for report generation from earlier releases since you
presumably have archived reports generated using the earlier release. To generate reports from pre-
R2015a releases using a newer release, first rerun the analysis using the newer release and
regenerate the results in a supported format, and then generate reports. See also Generate Reports
from Polyspace Results.


https://www.mathworks.com/help/releases/R2021b/codeprover/ug/generate-polyspace-reports.html
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Polyspace Access Installation

License Management: Use a single license to review Bug Finder, Code
Prover, and Ada results in your web browser

In R2022a, Polyspace Bug Finder Access and Polyspace Code Prover Access are both renamed
Polyspace Access. You require only one license to review Bug Finder, Code Prover, and Ada results in
your web browser.

Previously, you required separate licenses to review Bug Finder results, and to review Code Prover or
Ada results.

Product: Polyspace Access.

Compatibility Considerations

In the license manager options file, typically named MLM. opt, identify all users and groups to which
you previously granted right-to-use privileges for only Polyspace Code Prover Access. For instance:

Define a group of users
GROUP ACCESS CP _users userl user2 user3

# Grant right-to-use privileges to individual users for Bug Finder
INCLUDE Polyspace BF Access USER userl
INCLUDE Polyspace BF Access USER user2

# Grant right-to-use privileges to individual users for Code Prover
INCLUDE Polyspace CP Access USER admin

# Grant right-to-use privileges to group of users for Code Prover
INCLUDE Polyspace CP Access GROUP ACCESS CP_users

For all those users and groups, replace all instances of Polyspace CP_Access with
Polyspace BF Access.

Define a group of users
GROUP ACCESS CP_users userl user2 user3

# Grant right-to-use privileges to individual users
INCLUDE Polyspace BF Access USER userl
INCLUDE Polyspace BF Access USER user2

# Grant right-to-use privileges to individual users
INCLUDE Polyspace BF Access USER admin

# Grant right-to-use privileges to group of users
INCLUDE Polyspace BF Access GROUP ACCESS CP users

If a user or group previously had right-to-use privileges for Polyspace Bug Finder Access, this user or
group now has right-to-use privileges to review Code Prover and Ada results.

See also Configure Polyspace Access License.
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Support for X.509 certificates generated without a SAN extension
removed

In R2022a, Polyspace Access no longer supports certificates that were generated without a subject
alternative name (SAN) extension. If the certificate uses only the common name (CN) field to identify
the server host, Polyspace Access considers that certificate invalid. You cannot use this certificate to
encrypt communications between the Polyspace Access server and client machines.

If you configure your bug tracking tool or LDAP server for HTTPS with certificates that were
generated without a SAN extension, those certificates are also considered invalid.

Product: Polyspace Access.

Compatibility Considerations

To encrypt communications between the Polyspace Access server and client machines with HTTPS,
generate x.509 certificates that use a SAN extension to specify the fully qualified domain name of the
server hosting Polyspace Access. See Choose Between HTTP and HTTPS Configuration for Polyspace
Access.

To generate a valid SAN certificate for your bug tracking tool or LDAP server, contact your network
administrator.

Changes in Polyspace Access docker containers

In R20224, the following docker containers have been renamed:

Previous Container Name Current Container Name
polyspace-access-web-server-main polyspace-access-web-server-0-main
polyspace-access-etl-main polyspace-access-etl-0-main
polyspace-access-db-main polyspace-access-db-0-main
issuetracker-server-main issuetracker-server-0-main
issuetracker-ui-main issuetracker-ui-0-main
usermanager-server-main usermanager-server-0-main
usermanager-ui-main usermanager-ui-0-main
usermanager-db-main usermanager-db-0-main

Product: Polyspace Access.

Compatibility Considerations

In your scripts, replace instances of the previous names with the current names.

2-18


https://www.mathworks.com/help/releases/R2022a/codeprover/install/configure-and-start-the-cluster-operator.html#mw_b7514171-e399-4302-9e7f-3577d682cc43
https://www.mathworks.com/help/releases/R2022a/codeprover/install/configure-and-start-the-cluster-operator.html#mw_b7514171-e399-4302-9e7f-3577d682cc43

R2021b

Version: 10.5
New Features
Bug Fixes

Compatibility Considerations



R2021b

Documentation

3-2

Documentation: View combined documentation for all Polyspace Code
Prover products

In R2021Db, the Polyspace Code Prover documentation covers all workflows for running a Polyspace
Code Prover analysis:

* Desktop:

The classic product Polyspace Code Prover supports desktop workflows. You can run Code Prover
in the Polyspace user interface, by using scripts, or from platforms such as Simulink.

The Polyspace Code Prover documentation continues to describe these workflows. See:

* Install Code Prover on Desktop (Polyspace Code Prover)
* Configure Code Prover Analysis on Desktop (Polyspace Code Prover)
* Review Polyspace Code Prover Results in Polyspace User Interface (Polyspace Code Prover)

* Server and Web Browser:

The newer products, Polyspace Code Prover Server and Polyspace Code Prover Access, released in
R2019a, support server-based workflows. Polyspace Code Prover Server runs a Code Prover
analysis on continuous integration platforms such as Jenkins. Polyspace Code Prover Access hosts
the analysis results on a server so that several users can review them simultaneously on a web
browser.

Previously, workflows involving Polyspace Code Prover Server and Polyspace Code Prover Access
were documented separately. The Polyspace Code Prover documentation now describes these
workflows. See:

* Install Code Prover on Server (Polyspace Code Prover)

* Set Up Code Prover Analysis on Servers During Continuous Integration (Polyspace Code
Prover)

* Review Polyspace Code Prover Results in Web Browser (Polyspace Code Prover)

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access.

Documentation: View web documentation by default

In R2021D, if you open the Polyspace documentation from the product while connected to the
internet, the web documentation opens in your default web browser. If you open the documentation
without an internet connection, or if your internet connection becomes unavailable, the same actions
point to the PDF documentation shipped with the products.

This change applies to all methods of opening the documentation:

* From the Polyspace user interface, choosing Help > Documentation.


https://www.mathworks.com/help/releases/R2021b/codeprover/install-polyspace-products-on-desktop.html
https://www.mathworks.com/help/releases/R2021b/codeprover/code-prover-analysis-on-desktop.html
https://www.mathworks.com/help/releases/R2021b/codeprover/review-polyspace-code-prover-results-in-polyspace-user-interface.html
https://www.mathworks.com/help/releases/R2021b/codeprover/install-polyspace-products-on-server.html
https://www.mathworks.com/help/releases/R2021b/codeprover/code-prover-analysis-servers-continuous-integration.html
https://www.mathworks.com/help/releases/R2021b/codeprover/review-polyspace-code-prover-results-web-browser.html

Documentation

Help

\2) Documentation

Examples >

About

» Using the -doc option of commands such as polyspace-code-prover.
See -doc | -documentation (Polyspace Code Prover).

Depending on where you open the documentation from, you see documentation pages appropriate to
the platform.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access.

Contextual Help: View contextual help in web browser

In R2021Db, all contextual help in the Polyspace products open in your default web browser. This
change applies to products such as Code Prover and Code Prover Access. Contextual help includes
help for options that can be accessed from the tooltip on the option:

Target Language

Source code language C ~

C standard version defined-by-compier ~

C standard version (-c-version)
Select the version of the C standard to use.

(2) More Help -

and help for results that can be accessed from the result details:

® Non-terminating loop '2/
The loop is infinite or contains a run-time error.
Loop fails due to a run-time error (maximum number of iterations: 10).

You can now use all facilities of your web browser to interact with a contextual help page. Note that
the contextual help buttons open pages available with your installation. You do not require an
internet connection to view these pages.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Access
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Faster Analysis: Reduction in analysis time on code that uses C++
std::string library

In R2021b, Code Prover does not analyze the implementation of std: : string methods, leading to
an improved analysis time. On average, the analysis takes half the time compared to previous
releases but in large code bases with heavy use of this library, the analysis time can reduce even
further. In specific cases, the analysis time has been observed to reduce from a few days to hours.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

Skipping the implementation of std: : string methods does not impact the analysis precision
significantly. You will not see an increase in orange checks in your files.

Issues that originated at call sites of std: : string methods but were previously shown within the
body of these methods, now appear on the call sites themselves, making them simpler to understand.
The issues are shown through an expanded definition of the check Invalid use of standard library
routine on std: :string method invocations. See “String Library Function Checks: New checks on
arguments to C++ std::string methods” on page 3-8.

To revert to the previous analysis mode, use the analysis option -analyze-library std string.
IAR Embedded Workbench Compiler: Set up Polyspace analysis for
code compiled by using RISC-V target

In R2021b, Polyspace supports the IAR Embedded Workbench RISC-V target natively. If you build

your source code by using the RISC-V target, you can specify the target name for your Polyspace
analysis.

Target Environment

Compiler iar-ew e

Target processor type | Tisow o

For more information, see IAR Embedded Workbench Compiler (-compiler iar-ew).

At the command line, you specify a compiler target by using the option Target processor type (-
target). For instance:

polyspace-bug-finder-server -sources file.c -compiler iar-ew -target riscv...

Because of the native support, you can now set up a Polyspace project without knowing the internal

workings of this compiler target. The analysis can interpret macros that are implicitly defined by the
target and compiler-specific language extensions, such as keywords and pragmas.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server


https://www.mathworks.com/help/releases/R2021b/codeprover/ref/iarembeddedworkbenchcompilercompileriarew.html
https://www.mathworks.com/help/releases/R2021b/codeprover/ref/targetprocessortypetarget.html
https://www.mathworks.com/help/releases/R2021b/codeprover/ref/targetprocessortypetarget.html
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Updated GCC Compiler Version Support: Set up Polyspace analysis for
code compiled with GCC versions 9.x and 10.x

In R2021b, Polyspace supports GCC compiler versions 9.x and 10.x. If you build your source code by
using the GCC compiler versions 9.x or 10.x., you can specify the compiler name for your Polyspace
analysis.

Target Environment

Compiler agnu9g, x e

Target processor type | x86_654 e

Target Environment

Compiler gnuld.x e

Target processor type |x86_64 v

At the command line, you specify a compiler by using the option - compiler. For instance:
polyspace-bug-finder-server -sources file.c -compiler gnu9.x ...

For more information, see Compiler (- compiler).

Because of the native support, you can now set up a Polyspace project without knowing the internal
workings of these compilers. The analysis can interpret macros that are implicitly defined by the
compilers and compiler-specific language extensions, such as keywords and pragmas.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

C17 Support: Run Polyspace analysis on code that follows version C17
of C standard

In R2021b, Polyspace supports version C17 of the C Standard (ISO/IEC 9899:2018). This version of
the standard addresses issues in the previous version, C11, but it does not introduce new language
features.

Target Language
Source code language | C w
C standard wversion cl7 w

See also C standard version (-c-version).

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Configuration from Build System: Copy console output to log file

In R2021b, you can copy the output of the polyspace-configure command to a log file. Use option
- log to specify the log file path, for example:


https://www.mathworks.com/help/releases/R2021b/codeprover/ref/compilercompiler.html
https://www.mathworks.com/help/releases/R2021b/codeprover/ref/cstandardversioncversion.html
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polyspace-configure -verbose -log pscfg.log make -B

You can review the contents of the log file to investigate possible issues with the execution of the
polyspace-configure command, especially if you run the command as part of an automation
script. Previously, to store the console output, you had to redirect the Standard Out (stdout) and the
Standard Error (stderr) to a file.

See also polyspace-configure.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Simulink Support: Consistent C++ version in Polyspace and Simulink

In R2021b, the C++ version used in the Polyspace analysis and the C++ version specified in the
Simulink Configuration Parameter window are consistent. Polyspace extracts the C++ version
specified in Simulink Configuration Parameter window and uses the version number in the
analysis. Previously, unless you explicitly set the C++ version for Polyspace, the analysis used the
default C++03, regardless of the C++ version specified in Simulink. Stating in R2021b, the C++
version specified in Simulink is also used in the Polyspace analysis.

Product: Polyspace Code Prover (Desktop).

Functionality Being Removed: Coding standards checking and code
metrics computation with Code Prover

These functionalities will be removed from Code Prover and Code Prover Server in a future release:

* Calculating code metrics
* Checking compliance with these coding rule standards:

+ MISRA C:2004

* MISRA-AC-AGC

+ MISRA C:2012

* JSFC++

* MISRA C++:2008

* Custom coding rules

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

If you use Code Prover to calculate code metrics and check compliance with coding standards,
consider using Bug Finder instead. See:

* Coding Standards
* Code Metrics


https://www.mathworks.com/help/releases/R2021b/codeprover/ref/polyspaceconfigurecommand.html
https://www.mathworks.com/help/releases/R2021b/bugfinder/coding-rule-reference.html
https://www.mathworks.com/help/releases/R2021b/bugfinder/metrics-reference.html
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Functionality Being Removed: Polyspace stubs for Standard Template
Library

Polyspace stubs for the C++ Standard Template Library (STL) will be removed in a future release.
These stubs conform to the older C++98 Standard and are meant for quickly getting started with a C
++ analysis. In most situations, your compiler implementation of the Standard Template Library is
required for successful compilation of a C++ project with Polyspace.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

If your project uses STL stubs, you see a warning. Use the option No STL stubs (-no-stl-
stubs) to prevent use of the stubs, and then provide your compiler implementation of the Standard
Template Library for analysis.

Functionality Being Removed: Compilation assistant

The Polyspace compilation assistant will be removed in a future release. You get a warning when you
enable this option and run an analysis.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

If you use the compilation assistant in your Polyspace project, clear the corresponding option. To
clear this option in the desktop interface, go to Tools > Preferences, and then select the Project
and Results Folder tab.

Alternatively, when you set up your Polyspace project:

* Usethe Compiler (-compiler) option to specify a compiler that Polyspace supports natively if
you compile your code by using that compiler.

+ Use polyspace-configure to trace your build command and to obtain your compiler
configuration. See polyspace-configure.


https://www.mathworks.com/help/releases/R2021b/codeprover/ref/nostlstubsnostlstubs.html
https://www.mathworks.com/help/releases/R2021b/codeprover/ref/nostlstubsnostlstubs.html
https://www.mathworks.com/help/releases/R2021a/codeprover/ref/compilercompiler.html
https://www.mathworks.com/help/releases/R2021a/codeprover/ref/polyspaceconfigurecommand.html
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String Library Function Checks: New checks on arguments to C++
std::string methods

In R2021b, the Invalid use of standard library routine check has been expanded to check
arguments to C++ std: : string methods:

» For methods that take a const char* argument str, the check determines if str is non-NULL
and points to a valid string.

For instance, in a call to std: :string: :append() with a const char* argument, the check is
green if the argument is non-NULL and points to a valid string:

#include <string>

void main() {
std::string str = "";

const char txtStr[4] = {'n','0','p"', '\0'};
const char txt[3] = {'n','0','p'};

str.append(txtStr); //txtStr is valid string
str.append(txt); //txt is not a valid string

}

» For methods that take a const char* argument str and a size t argument n, the check
determines if str is non-NULL and points to an n-character buffer.

For instance, in a call to std: :string: :append() with a const char* argument for the buffer
to append and a size t argument for number of characters to append, the check is green if the
const char* argument is non-NULL and the buffer has the number of characters to be
appended:

#include <string>
void main() {

std::string str = ;
const char txt[3] = {'n','0','p'};

str.append(txt,3);
str.append(txt,4); //txt points to a 3-character buffer

}

Similar considerations apply to std: :wstring, std: :ul6string and std: :u32string methods.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access

Compatibility Considerations

You can see an increase in the number of Invalid use of standard library routine
(Polyspace Code Prover) checks.


https://www.mathworks.com/help/releases/R2021b/codeprover/ref/invaliduseofstandardlibraryroutine.html
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Reviewing Results

Results Review: Open review history, select layout, and open
additional panes by using fewer clicks

In R2021b, use the new Layout menu on the toolstrip to select the layout of the Polyspace Access
interface.

To open additional panes, such as the Review History, use the Window menu and make a selection.
You can also open the Review History by clicking 'uL-' in the Result Details pane.

Previously, you used Window > Layout to select a layout and Window > Show/Hide View to open
additional panes.

Product: Polyspace Code Prover Access.

Results Review: View relevant information in review panes when you
select a finding

In R2021D, if you select a finding in the Result Details or Source Code panes, these panes are
updated with information about the selected finding (if available):

+ Call Hierarchy

* Contextual Help

* Data Race Graph

* Error Call Graph

* Variable Access Graph

Previously, except for the Result Details pane, the panes were not updated when you selected a

different finding. For instance, after selecting a different finding, you clicked "E-" in the Result
Details pane to update the Contextual Help pane.

Product: Polyspace Code Prover Access.

Functionality Removed: Automatic Orange Tester

The Automatic Orange Tester capability is removed in R2021b. If you use the Automatic Orange
Tester, you get an error at the start of the analysis.

Compatibility Considerations

If you use the Automatic Orange Tester with your Polyspace projects, the corresponding options are
automatically unset in the desktop interface.

If you use these command-line options in your scripts, remove them:

¢ -automatic-orange-tester
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*+ -automatic-orange-tester-loop-max-iteration

* -automatic-orange-tester-tests-number

*+ -automatic-orange-tester-timeout

If you use these properties in your MATLAB scripts, remove them
(opts=polyspace.Options('C')):

* opts.Advanced.AutomaticOrangeTester

* opts.Advanced.AutomaticOrangeTesterLoopMaxIteration
* opts.Advanced.AutomaticOrangeTesterTestsNumber

* opts.Advanced.AutomaticOrangeTesterTimeout

Functionality Removed: Polyspace Metrics

The Polyspace Metrics web dashboard is removed in R2021b. You get an error if you use:

* The polyspace-results-repository command.
* Option -add-to-results-repository when you run an analysis on a remote cluster.

* A configuration that attempts to start a Polyspace Metrics server automatically. The configuration
is typically stored in a . conf file in the %APPDATA% (Windows) or /etc/polyspace (Linux)
folder.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

To continue monitoring the quality of your code in a web browser, use Polyspace Access, which has a
more intuitive dashboard. With Polyspace Access you can:
* Review and justify results directly from your web browser.

* Integrate a bug tracking tool, such as Jira, through the web interface and create tickets to track
Polyspace findings.

* Monitor the quality of your code against coding standards such as AUTOSAR C++14, CERT® C/C
++, and MISRA C°.

* Define custom quality objectives definitions and apply them to specific projects.
For more information, see:

* Review Polyspace Code Prover Results in Web Browser
» Upload Results to Polyspace Access
* Migrate Results from Polyspace Metrics to Polyspace Access

Functionality Being Removed: Report generation from pre-R2015a
results

Report generation from pre-R2015a Polyspace results will not be supported in a future release. In
releases R2015a and earlier, Polyspace products generated results in a format that will no longer be
supported for report generation.


https://www.mathworks.com/help/releases/R2021b/codeprover/review-polyspace-code-prover-results-web-browser.html
https://www.mathworks.com/help/releases/R2021b/codeprover/ug/upload-results.html
https://www.mathworks.com/help/releases/R2021b/codeprover/ug/migrate-results-from-polyspace-metrics-to-polyspace-access.html

Reviewing Results

Compatibility Considerations

Typically, you do not require support for report generation from earlier releases since you
presumably have archived reports generated using the earlier release. To generate reports from pre-
R2015a releases using a newer release, first rerun the analysis using the newer release and
regenerate the results in a supported format, and then generate reports. See also Generate Reports
from Polyspace Results.
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User Management: Set project permissions at the group level

In R2021b, you can use groups to manage project permissions for large sets of users. Import groups
from your company Lightweight Directory Access Protocol (LDAP) or create custom groups in the
User Manager interface, and then assign roles to those groups to authorize or prevent them from
viewing projects in Polyspace Access. All members of the group inherit the role that you assign to the
group.

To assign a role to a group:

* In the Polyspace Access interface, right-click a project in the Project Explorer and select
Manage Project Permissions.

» At the command line, use polyspace-access with options -set-role and -group.

See Manage Project Permissions.

Previously, you managed project permissions by assigning roles to users individually.

Product: Polyspace Code Prover Access.

User Management: Update list of users and groups more quickly by
reloading web browser

In R2021b, Polyspace Access populates its list of users and groups from the User Manager database.
If you add new users or groups to the User Manager database, refresh the list of users and groups
by logging into the Polyspace Access interface or by reloading your web browser if you are already

logged in.

Previously, if you added users to the User Manager database, you had to restart the Polyspace
Access services to refresh the list of users in Polyspace Access.

Product: Polyspace Code Prover Access.

User Authentication: Authenticate user logins against custom
identities and LDAP identities simultaneously

In R2021b, you can configure Polyspace Access to simultaneously authenticate users against
credentials from your organization's Lightweight Directory Access Protocol (LDAP) and against
custom credentials. If you create custom user profiles, those users still can log into Polyspace Access
after you start using your organization's LDAP to authenticate users.

See Configure User Manager.

Previously, you configured Polyspace Access to authenticate users against custom credentials or
LDAP credentials, but not both at the same time.

Product: Polyspace Code Prover Access.


https://www.mathworks.com/help/releases/R2021b/codeprover/ref/polyspaceaccess.html
https://www.mathworks.com/help/releases/R2021b/codeprover/ug/manage-users-and-view-project-trends.html#mw_2328980b-0c53-48a9-a4be-ce7676846cf2
https://www.mathworks.com/help/releases/R2021b/codeprover/install/configure-the-user-manager.html

Polyspace Access Installation

Compatibility Considerations

If you configured Polyspace Access to use your company LDAP in a previous release, and you reuse
the settings. json file in R2021b, in the Admin interface, go to the settings and select Connect
an LDAP directory.

Polyspace Access Services: Faster results uploads and more
responsive source code view

In R2021b, when you upload results to the Polyspace Access database for review, the upload is up to
10% faster than in R2021a.

When you review the uploaded results in your web browser, the Source Code pane is more
responsive as you scroll through the code or switch between different files. In R2021a, the pane takes
up to 40% longer to display the source code when you scroll through code or switch between files.

These performance improvements are more noticeable with large files and with source code that
contains a large number of findings.

Product: Polyspace Code Prover Access.
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Configuration from Build System: Specify options delimiter and
suppress console output

In R2021a, polyspace-configure has new options to simplify the creation of a Polyspace project
or options file:

*+ -options-for-sources-delimiter — Use this option to specify an ASCII character that
Polyspace uses as a delimiter between a group of analysis options. You typically use this option in
combination with -options-for-sources, which associates a group of analysis options with
specific source files. You might want to specify a delimiter if, for instance, the default delimiter (;)
is already used inside a macro.

* -no-console-output — Use this option to completely suppress the console output of
polyspace-configure, including error and warning messages. By default, polyspace-
configure emits errors and warnings only.

See also polyspace-configure

The new options allow you to customize the polyspace-configure runs without extensive
additional scripting.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Configuration from Build System: Improved detection of incompatible
software

In R20214, if you use software that is not compatible with polyspace-configure when you trace
your build process, polyspace-configure emits a message that identifies the software and that
provides contextual help if applicable. Software that is not compatible with polyspace-configure
includes some antivirus software and certain build systems such as Bazel.

For more information, see polyspace-configure.

Previously, when polyspace-configure could not trace your build process because of incompatible
software, the command output did not identify the software. Now, you can easily check if your build
system and environment is compatible with polyspace-configure.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

AUTOSAR Support (Software Integration): Faster and more AUTOSAR-
aware code analysis

In R2021a, Code Prover runs faster on C/C++ code that uses the AUTOSAR RTE API and shows more
precise results.

If you choose autosar for the option Libraries used (- library), the analysis uses smart stubs for
functions from the AUTOSAR library instead of generic stubs. The analysis does not attempt to check
the function implementations. Using this option enables faster analysis without losing precision and
triggers library-specific checks on function calls.


https://www.mathworks.com/help/releases/R2021a/codeprover/ref/polyspaceconfigurecommand.html
https://www.mathworks.com/help/releases/R2021a/codeprover/ref/polyspaceconfigurecommand.html
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See also:

Libraries used (-library)
Noncompliance with AUTOSAR specification
Choose Between Component-Based and Integration Analysis of AUTOSAR Code with Polyspace

If you want to check only for compliance with the AUTOSAR standard (in addition to regular Code
Prover run-time checks), no special setup is required for C/C++ code that follows AUTOSAR
specifications. You can run a Code Prover analysis with a single option enabled.

Product: Polyspace Code Prover (Desktop).
AUTOSAR Support (Component Based): Determine if an RTE function
or event is supported in current release

In R20214, if you run Polyspace for AUTOSAR on a code implementation of AUTOSAR Software
Components, the results contain a list of recognized RTE API functions and events.

@ ReleaseNote

rte-api-section

© Terminology Rte_Ports unsupported ( group 'undefined ) %36.1
_ Rte_NPorts unsupported (group 'undefined'}) %3562
fessage Selection Rte_Port unsupported ( group 'undefined') % 3.6.3

@ Saved Queries
@ all sections
© RTE Events

Q Crea
© Search

%564

%3.6.3

% 5.6.6
% 5.6.7
%5.6.8

Rte_Write supported ( group 'FlowOperations' )
Rte_Send supported ( group 'FlowOperations' )
Rte_Switch supported ( group 'ModeOperations’ )
Rte_Invalidate supported ( group 'FlowOperations' )
Rte_Feedback supported ( group 'FlowOperations')
Rte_SwitchAck unsupported { group 'ModeOperations'

) %569

To open this list, in your analysis results, click the ReleaseNote link in the navigation on the left.

Using this list, you can:

Determine if the analysis emulates a given RTE API function precisely and checks the function
arguments for compliance with the AUTOSAR standard and relevant design specifications.

Navigate from an RTE API function or event name to the description of the function in the
AUTOSAR standard.

Product: Polyspace Code Prover (Desktop).

Updated GCC Compiler Support: Set up Polyspace analysis for code
compiled with GCC version 8.x

In R2021a, Polyspace supports the GCC compiler version 8.x natively. If you build your source code
by using GCC version 8.x, you can specify the compiler name for your Polyspace analysis.

Target Environment

Compiler anuad. x

Target processor type | x86_64
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For more information, see Compiler (- compiler).

Because of the native support, you can now set up a Polyspace project without knowing the internal
workings of this compiler. The analysis can interpret macros that are implicitly defined by the
compiler and compiler-specific language extensions such as keywords and pragmas.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Updated Microsoft Visual C++ Support: Set up a Polyspace analysis
for code compiled with Visual Studio 2019

In R2021a, Polyspace supports the compiler Visual Studio® 2019 natively. If you build your source

code by using Visual Studio 2019 (versions 16.x), you can specify the compiler name for your
Polyspace analysis.

Target Environment

Compiler wisual 16.x o

Target processor type |x86_64 £

For more information, see Compiler (- compiler).

Because of the native support, you can now set up a Polyspace project without knowing the internal
workings of this compiler. The analysis can interpret macros that are implicitly defined by the
compiler and compiler-specific language extensions such as keywords and pragmas.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Analysis of projects containing mix of C and C++ source files in Code
Prover

In R20214a, you can verify projects containing a mix of C and C++ source files by using Code Prover.
To specify that your project uses a mix of C and C++, use the analysis option Source code
language (-lang) with the value C-CPP. Polyspace compiles the C files of your project in C and C
++ files in C++. After the compilation, Polyspace verifies such mixed projects as C++ projects.

Previously, Code Prover did not support verifying projects that had a mix of C and C++ files. When -
lang was specified as C-CPP, Polyspace compiled all the files in the project in C++. To verify projects
containing both C and C++ source files, you had to separate the C and C++ files because C files
might fail to compile in C++. Starting in R20214a, you do not need to separate the C and C++ files. If
you have a Bug Finder project containing C and C++ files, you can now use the same project for a
Code Prover verification.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

If you want to mimic the previous behavior and compile all files in your project in C++ regardless of
their file type, use - lang with the value CPP instead.
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Simulink Support: Start Polyspace analysis without an explicit code
generation step

In R20214a, start the Polyspace analysis of generated code without having to explicitly generate the
code first. To start the Polyspace analysis of code generated from a model, Click Run Analysis in the
Simulink toolstrip.

Analyze Code from [)
|p:l}rspace_co"trcu er_demo |i| Run
Code Generated as Top Model - Analysis

AMALYZE

If you have Embedded Coder, Polyspace generates code from the model by using Embedded Coder
when there is no previously generated code corresponding to the model. After the code generation is
complete, the Polyspace analysis starts.

See Run Polyspace Analysis on Code Generated from Simulink Model.

Previously, you generated code explicitly in a separate step before starting the Polyspace analysis of
the generated code. You are no longer required to perform this step.

Additional Considerations: Before starting a Polyspace analysis, you still need to generate code
explicitly if any of the following is true:

* You do not use Embedded Coder to generate code.

* The model is configured to generate code as a model reference.

Product: Polyspace Code Prover (Desktop).

polyspacesetup Function : Integrate Polyspace with MATLAB in fewer
steps

In R20214a, you can integrate Polyspace with the current or earlier release of MATLAB in fewer steps.
When you run the function polyspacesetup at the MATLAB command prompt, the function looks
for a Polyspace installation in the default location. If the installation exists, the function integrates
Polyspace with MATLAB. Specify the installation location explicitly only when you install Polyspace in
a nondefault location.

See Also:

* polyspacesetup

* Integrate Polyspace with MATLAB and Simulink

Previously, to integrate Polyspace with Simulink, you provided the location of the Polyspace
installation folder. Starting in R2021a, providing the installation location is no longer required if you
install Polyspace in the default location.

Product: Polyspace Code Prover (Desktop).
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pslinkrunCrossRelease Function : Analyze code generated in an earlier
release of Simulink by using a later release of Polyspace

In R20214, you can run a Polyspace analysis of generated code from an earlier release of Simulink by
using the function pslinkrunCrossRelease. To use this cross-release workflow, your Polyspace
version must be later than your Simulink version and your Simulink must be R2020b or later.

See :

* pslinkrunCrossRelease
* Run Polyspace on Code Generated by Using Previous Releases of Simulink

Previously, you used the function pslinkrun in both cross-release and same release workflows.
Starting in R2021a, these two workflows are differentiated by introducing the function
pslinkrunCrossRelease explicitly for the cross-release workflow.

The compatibility of Polyspace with prior releases of Simulink is also simplified. Previously, the
compatibility of Polyspace with an earlier Simulink depended on the specific version of Polyspace and
Simulink. Starting in R2021a, you can integrate Polyspace with Simulink only if your Polyspace
version is later than your Simulink version, and you have Simulink from R2020b or later. See
Polyspace Support of MATLAB and Simulink from Different Releases.

Product: Polyspace Code Prover (Desktop).

Compatibility Considerations

The function pslinkrun no longer supports a cross-release workflow. Use the function
pslinkrunCrossRelease instead.

Functionality being removed: Compilation assistant
The Polyspace compilation assistant will be removed in a future release.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compatibility Considerations

If you use the compilation assistant in your Polyspace project, clear the corresponding option. To
clear this option in the desktop interface, go to Tools > Preferences and then select the Project
and Results Folder tab.

Instead, when you set up your Polyspace project, you can:
* Usethe Compiler (-compiler) option to specify a compiler that Polyspace supports natively if
you compile your code by using that compiler.

* Use polyspace-configure to trace your build command and to obtain your compiler
configuration. See polyspace-configure.
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Changes in analysis options and binaries

Verification level (-to) option values cpp-link and cpp-normalize checks for compile errors
Behavior change

The behavior of Verification level (-to) option values cpp-link and cpp-normalize have
changed. Previously, these options stopped a Code Prover analysis at different stages of compilation.
Starting in R2021a, when you use these options, Polyspace completes the compilation phase of a
Code Prover analysis. This behavior is equivalent to how Polyspace behaves when -to is used with
compile.

The values cpp-1link and cpp-normalize of the analysis option -to will be removed in a future
release. Use -to with compile instead.

See also Verification level (-to).
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

The pragma Inspection_point also applies to C++ code
Behavior change

Starting in R2021a, you can use the Inspection point pragma in Code Prover with C++ source
code. Previously, the pragma Inspection point applied to only C code in Code Prover.

See also Find Relations Between Variables in Code.
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

-code-behavior-specifications takes only one file as argument
Behavior change

Starting in R2021a, this option only takes one XML file as argument. If you were specifying code
behaviors in multiple XML files, combine their content into one file and provide this file as argument
to the option.

See also -code-behavior-specifications.
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

-sources-encoding with value other than auto disables automatic detection of encoding
Behavior change

Starting in R2021a, if you explicitly specify a value with the option -sources-encoding (or use the
default value system which uses the default encoding of your OS), the analysis does not perform any
automatic detection of source file encoding. For instance, if you use -sources-encoding shift-
jis, the analysis internally converts your source files from Shift JIS (Shift Japanese Industrial
Standards) to UTF-8 encoding before processing them. If you see regressions from previous releases,
consider using - sources-encoding auto to reenable the automatic detection of source encoding.
Automatic detection is useful when your project contains, for instance, a mix of different encodings.

See also Source code encoding (-sources-encoding).

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
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polyspace-autosar does not support ARXML schema of AUTOSAR releases below 4.0
Behavior change

Starting in R2021a, the polyspace-autosar command can only parse ARXML files that follow the
XML schema of AUTOSAR releases 4.0 onwards.

See also Run Polyspace on AUTOSAR Code.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
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Verification Results

AUTOSAR Support (Software Integration): New checks for compliance
of RTE API usage with AUTOSAR standard

In R2021a, a new run-time check Noncompliance with AUTOSAR specification determines if the
arguments to a function from the RTE API follow the AUTOSAR standard specifications. For instance,
if a function expects an initialized buffer, the check is red if you pass an uninitialized buffer by
pointer.

You can run this check during verification at the software integration stage. To enable this check, use
the value autosar for the option Libraries used (- library) and run a regular Code Prover
analysis.

See also:

* Libraries used (-library)
* Noncompliance with AUTOSAR specification
* Choose Between Component-Based and Integration Analysis of AUTOSAR Code with Polyspace

With the new check in R20214, if you want to check only for compliance with the AUTOSAR standard
specifications or want to perform a verification at the software integration stage, you no longer
require an AUTOSAR-specific setup. You can run a regular Code Prover analysis with a single option
enabled.

Product: Polyspace Code Prover (Desktop).

Changes in Code Prover assumptions

In R2021a, Code Prover assumes that the memory allocation functions such as malloc, realloc or
memalign do not initialize the allocated memory. The previous assumption was that the allocated
memory might be initialized. The new assumption adheres strictly to the C Standard.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access

Compatibility Considerations

If you use one of these memory allocation functions, Non-initialized variable checks on reads of the
allocated regions that were previously orange might turn red.

4-9


https://www.mathworks.com/help/releases/R2021a/codeprover/ref/librariesusedlibrary.html
https://www.mathworks.com/help/releases/R2021a/codeprover/ref/noncompliancewithautosarspecification.html
https://www.mathworks.com/help/releases/R2021a/codeprover/ug/component-based-and-integration-analysis-of-autosar-code-with-polyspace.html

R2021a

Reviewing Results

4-10

Simulink Block Annotation : Add multiple Polyspace annotations
corresponding to multiple types of Polyspace results

In R20214, you can annotate a Simulink block with multiple annotations for multiple types of
Polyspace results through the Polyspace Annotation window. For instance, consider a block that is
annotated for a MISRA C violation. If this block is then flagged for a defect violation, you can add an
annotation corresponding to the defect violation without overwriting the previous annotation for the
MISRA C violation. To add these two annotations, open the Polyspace Annotation window twice and
each time, annotate for a specific type of result. These annotations are appended to each other and
can be seen in the Result Details pane of Polyspace User Interface. See Annotate Blocks to Justify
Issues

Previously, if you added a new annotation to an already annotated Simulink block, Polyspace
overwrote the existing annotation. Starting in R2021a, adding an annotation to a previously
annotated Simulink block appends the new annotation to the existing annotation.

Product: Polyspace Code Prover (Desktop).

Code Prover Result Messages: Redundant tooltips removed from +=
and similar operations

In R20214a, in code operations that use the shorthand form x+=y, x-=y, x*=y, and so on, if x contains
an operation that triggers an orange check, you see only this orange check and the associated tooltip
in the Code Prover results.

Previously, you saw a green check in addition to an orange check because the operation in x happens
twice, once on the left and once on the right side of the assignment. The orange check eliminated a
problematic path and resulted in a subsequent green check. You also saw two copies of essentially the
same tooltip. Starting in R20214a, these redundant tooltips have been removed.

For instance, this division operation previously triggered two checks and showed two copies of
essentially the same range information in the tooltip. Starting in R2021a, you see only the upper copy,
which represents range information before either of the two divisions are performed.

buf[i/3] |= 1:

operator / on type int 32
left: [0 .. 99]

right: [0 .. 2°1]
result: [0 .. 99]

phbuf [1

rpburf ||

return Operator / on type int 32
left: [0 .. 99]

right' [1 .. 2°1]
result: [0 .. 99]
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Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Access

Results Review Scope : Define and share custom families of filters

In R20214a, you can create custom families of filters to tailor the scope of your review to results that
are relevant to only your project or organization. You can then share the customized review scopes
with other Polyspace Access users. See Create Custom Filter Groups in Polyspace Access Web
Interface (Polyspace Code Prover Access).

For example, you might want to review your code for violations of a subset of only Numerical defects
and MISRA C: 2012 rules.

Custom filters

o Mew

Q

&y Saveas.. | |fi] Delete

Information | Configuration

customProjectFilter
Use this projfect for all external
vendors

myPrivateFilter
Filter for personal projects

<

O Defects

[@1] Run-time Checks
x| Global Variables
% Code Metrics

w Custom Rules

+ MISRA AC AGC
= MISRA C:2012
+ MISRA C++:2008

— MISRA C:2004

O Defects

View by Group = View by Category

Name

4 |H| Defects

» |v| Numerical

* v v v wv w w w w v wv w w

Static memory
Dynamic memary

Data flow

Resource management
Programming

Object oriented

w JSF AV C++
C++ Exceptions
- SEICERTC
Concurrency
~ SEI CERT C++ Security
~ ISO/IEC TS 17961 Cryptography
+ AUTOSAR C++14 Tainted data
Good practice
< Polyspace Guidelines
Performance

Category

Close

Product: Polyspace Code Prover Access.

Results Review Layout : Select view to prioritize review of code or

results list

In R2021a, the Polyspace Access interface has different layouts to match your results review

workflow.

The default Code Review layout enables you to focus on the Source Code while you investigate
issues in your code.
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The Results Review layout prioritizes the Results List and Result Details panes as you review and

triage findings.

v < - Code Met - '
@ emprmowl] B |2 st B SR = R P ey &
Dashbpaed T T erivimensee Defects = Open  ToDa |7 Fiteeout ity
. By Coding Standards - Pragress
APPS RUN CUSTOM FILTERS FAMILY FILTERS FILTERS ENVIRONMENT REVIEW =
Showing: 8600 / 8400
g || Results List Q Result Details @
§ Family D Type Group Check Information Det® [ virisrie trace Show In Results List View concurmency.c
gl o= 54 Defects Sacurity Unsafe call to a syste... Impact: High syst! stotu
E| o= | 57 |Defects Security Unsafe cal to 2 syste... Impact: High systl] || O Data race (impact: High) (3 atus
i Certain operations on variable bad_glob2' can interfere with sach other and cause unpredictable Unreviewed - |
] o= 72 Defects Programming Passibly unintended ... Impact: High CILCTs 3 ad g P
E R R values. Severity
| o= 77 | Defects Programming Invalid use of == op... Impact: High Use (et )
| In: -
9 o * 78 Defects Programming Wrong type used ins... Impact: High The Access Access Protections Task File Sca Aeeh at
z O * o6 Defects Static memory Buffer overflow from ... Impact: High Form o8 Write (Non atomic) . ==igned fo
& N © Mo protection bug_datarace_task3() concurrency.c bug_i -
o 0= | 6675 Defects Programming Declaration mismatch  Impact: High Glok | Operation might invo...
d| O= | 6676 Defects Programming Typedaf mismatch Impact: High size| % Read No pratection bug_datarace taskdl)  concurrency.c bug_ | Ticket
E 0% 6677 Defects Concurrency Data race Impact: High Cert we
|| o= 6678 Defects Concurrency Data race Impact: High Cert Comment
E O% | 6684 Defects Dynamic memary Deallocation of previ... |Impact: High Pain
2| o=* | 6692 Defects Aesource management | Resource leak Impact: High Stre <
i| o= 6693 Defects Static memory Fointer or reference t... Impact: High Add Source Code o
% O=* | 6722 Defects Data flow Non-initialized variable Impact: High Dere W
[ o= 6724  Defects Data flow MNon-initialized pointer  Impact: High Locz .
E— O =% | 6725 |Defects Data flow Non-initialized variable Impact: High Locz "+ NON-ATOMIC DATA RACE
E % | 6735 Defects Dynamic memary Use of previously fre... Impact: High Poin, v;1d == Longlong(long long ent !
E o#% | 6736 | Defects Dyynamic memary Invalid free of pointer  Impact: High Free long long bad glebd; /* Defec race wf
i . & . - .
% [s] 6740 Defects Numerical Invalid use of standa... Impact: High Star void bug_datarace task3(vaid) {
0= 6741 Defects Numerical Invalid use of standa... Impact: High Star, bad”gTan2 ™ T
O% | 6742 Defects Numerical Float conversion ove... | Impact: High Com
o* 6743  Defects Numerical Integer conversion o... Impact: High Con woid _btlg=%a_t_a!?ce_t_a_sk4l:vclid:l i
- . . long Tong Lo Var;
[s] 6746  Defects Numerical Absorption of float o...  Impact: High The local var = bad glob2;
O =% | 6736 |Defects Numerical Invalid use of standa... Impact: High Star use_longleng{local varl;
O =% | 6766 |Defects Programming Character value abso... Impact: High Com, }
" e | RIRT_ Dafactc Oroarzmminn ariakls Janath arrImnack Hink Size

Product: Polyspace Code Prover Access.
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Code Quality Comparison Between Runs: Filter and view information
for previous findings fixed in the current run

In R2021a, if you compare two project runs and some of the findings from the Baseline run are
Fixed in the Current run, you can filter for and view the source code and result details for these
findings. See Compare Analysis Results to Previous Runs (Polyspace Code Prover Access).

Polyspace Access considers a finding Fixed if either:

* You make changes to your code that fix an issue.
* The source code that contains an issue is deleted or is not part of the current analysis.

- - | CodeMetrics = L
| Current| ID 6089 - Job 1.0 | = <] e s a H Show anly Y
Dashboard | [7] Baseline 10 6010 1ob 10 | = || APPiy/ Mansge |2 Defects |~ Open [ Filter st Open in Desktop
- Mg Coding Standards - ragress
Showing: 243 / 2800 | Defects  ano  Fixed | 5
Result Detxls

Group Check Information 0@ This finding from Baseline run (10 8010} is not in Currend run (10 G083)
LiyNammec memary WMEMOTY 123K IMPECT. MEOIEm

A B - e i Show In Results List Wiew dynamicmemnory.c | bug_memleak_amay()
Drynamic memany Memary lzak Impact: Mediem : - - N

- i L4
Drynamic memary Memaory leak Impact: Medism Memery leak (Impact: Medium) (3) & Status
Dynamic memary Memary lesk Impact: Medium Pointer 'pi’ paints te dynamically allocated memeony.
Programming Function called from sig... | Impact Mediem It has not been freed before the end of its scope Saverity
Programming Function called from sig...  Impact Medium -
. Event File Scope [+]
Programming .. | Impact Medism 5 - Ascigned to
) 1 Dynamic slacation dynamicmemony.c: bug_memieak_array()
Programming .. Impact. Medium L
2 Assignment 1o lozal poi.. SMICMEeMan.c bug_memleak_arrs;
Programming Function called from sig... | Impact Mediem - R Ticket
3 Memory leak dynamicmemony.c bug_memleak_array()}
Programming Function called from sig...  Impact Medium 5 r-4
Resource mansgement  Clpening previ .. Impact Medism . Comement >
Security ulnersble pse .| Impact: Medism Saurce Cade
Cryptography Monsecure parameters . Impact Mediem - —
Cryptography Inconsistent cipher oper... | Impact: Medium This e [s not in Currant run
xze i L,

Cryptography Mizs r ke Impact Mediem 153 int j; . . -

" nt= pi } agflint
Cryptography Miss rameters for ... | Impact Medium int® pr 1zeatlintli;
Cryptography Mizs ==r ey Impact: Mediem
Cryptography Context initalized incarr... | Impact: Medium
Cryptography Weak padding for RS4 .. | Impact Mediem
Cryptography Missing ciphes Impact: Medium
Cryptography Incomect ks . Impact Medism
Cryptography Missing zipl Impact: Mediem -

4 3 v

Previously, you had to open the Baseline run as a separate tab to view the source code and result
details for Fixed findings.

Product: Polyspace Code Prover Access.

Functionality being removed: Automatic Orange Tester

The Automatic Orange Tester will be removed in a future release. You get a warning at the start of
the analysis if you use this feature.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access
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Compatibility Considerations

If you use the Automatic Orange Tester with your Polyspace projects, unset the corresponding
options. In the desktop interface, you set these options in the Configuration pane under the
Advanced Settings node.

If you use these command-line options in your scripts, remove them:

* -automatic-orange-tester

* -automatic-orange-tester-loop-max-iteration

* -automatic-orange-tester-tests-number

* -automatic-orange-tester-timeout

If you use these properties in your MATLAB scripts, remove them
(opts=polyspace.Options('C')):

* opts.Advanced.AutomaticOrangeTester

* opts.Advanced.AutomaticOrangeTesterLoopMaxIteration
* opts.Advanced.AutomaticOrangeTesterTestsNumber

* opts.Advanced.AutomaticOrangeTesterTimeout
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Polyspace Access Installation

License Management : Uploading of results to Polyspace Access no
longer requires a license checkout

In R2021a, the upload of analysis results to the Polyspace Access database does not trigger a
Polyspace Access license checkout.

If you upload results as part of an automation script, you no longer consume a license when you run
the script. Previously, each results upload triggered a license checkout.

Product: Polyspace Code Prover Access.

User Manager : Enable pagination when requesting large set of users
from LDAP server

In R2021a, if you use an LDAP server to retrieve user profiles and authenticate user logins, you can
enable pagination to retrieve a large set of users from the LDAP server. See Authenticate Users from
Your Organization LDAP Server (Polyspace Code Prover Access).

Typically, LDAP servers limit the number of entries that they return in a result set. If the number of
entries exceed that limit, the result set is truncated. When you enable pagination, the number of
results is broken up into smaller sets. You are able to retrieve all entries from the LDAP server when
you query a large set of users.

Product: Polyspace Code Prover Access.

Bug Tracking Tool : Create Jira tickets for Jira projects that use single
select custom fields

In R20214, if you integrate the Jira software bug tracking tool (BTT) with Polyspace Access, you can
create Jira tickets for Jira projects that are configured with single select custom fields. See Configure

Jira Software Bug Tracking Tool (Polyspace Code Prover Access).

Previously, Polyspace Access did not support the creation of Jira tickets in projects that used single
select custom fields.

Product: Polyspace Code Prover Access.

Admin Interface : Improved logging for Polyspace Access services

In R2021a, when you view the logs for the Polyspace Access services in the Admin user interface, the
logs are automatically refreshed. You do not need to reload the page to view new events.

Product: Polyspace Code Prover Access.
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R2020b

Verification Setup
Compiler Support: Set up Polyspace analysis for code compiled with
Renesas SH C compilers

If you build your source code by using Renesas® SH C compilers, in R2020b, you can specify the
target name sh, which corresponds to SuperH targets, for your Polyspace analysis.

Target Environment

Compiler renesas o

Target processor type |sh R

See also Renesas Compiler (-compiler renesas).

You can now set up a Polyspace project without knowing the internal workings of Renesas SH C
compilers. If your code compiles with your compiler, it will compile with Polyspace in most cases
without requiring additional setup. Previously, you had to explicitly define macros that were implicitly
defined by the compiler and remove unknown language extensions from your preprocessed code.
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Cygwin Support: Create Polyspace projects automatically by using
Cygwin 3.x build commands

In R2020b, the polyspace-configure command supports version 3.x of Cygwin™ (versions 3.0,
3.1, and so on).

See also Check if Polyspace Supports Build Scripts.
Using the polyspace-configure command, you can trace build scripts that are executed on a
Cygwin 3.x command line and create a Polyspace project with the source files and compilation

options automatically specified.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

C++17 Support: Run Polyspace analysis on code with C++17 features

In R2020b, Polyspace can interpret the majority of C++17-specific features.

Target Language
Source code language |CPP “
C4++ standard version |pp17 L
See also:

* (C++ standard version (-cpp-version)
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* C/C++ Language Standard Used in Polyspace Analysis
* C++17 Language Elements Supported in Polyspace

You can now set up a Polyspace analysis for code containing C++17-specific language elements.
Previously, some C++17 specific language elements were not recognized and caused compilation
erTors.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

AUTOSAR Support: Analysis more resilient to ARXML errors

In R2020Db, specific types of ARXML errors do not stop a Code Prover analysis. Despite the errors, the
analysis attempts to model the software component behaviors as far as possible and continue into the
code extraction and code verification phases.

See also Interpret Errors and Warnings in Polyspace Analysis of AUTOSAR Code.

You can run a Code Prover analysis more easily on in-progress and incomplete ARXMLs. The ARXML
parsing phase reports the errors for each software component behavior. If any of these errors lead to
downstream errors during the code extraction phase, you can return to the reports for each software
component behavior and track down and fix the ARXML errors.

Product: Polyspace Code Prover (Desktop).

AUTOSAR Support: Specify file and folder patterns to exclude from
analysis

In R2020b, you can avoid errors in Polyspace analysis from AUTOSAR projects by excluding specific
subfolders and files in the source folders up front. For each source folder that you specify, using a
Linux-find-like syntax, you can specify patterns for file paths that must be excluded.

You can also use a similar file exclusion strategy to exclude files from the ARXML folder.

For more information, see:

* Select AUTOSAR XML (ARXML) and Code Files for Polyspace Analysis
* polyspace-autosar Command

Previously, you could only specify a root folder for your ARXML and source files. The finer file-
selection allows you to avoid folders that might cause errors in project setup.

Product: Polyspace Code Prover (Desktop).
AUTOSAR Support: Specify AUTOSAR software component behaviors
and data types using more refined syntax

In R2020b, you can use a more refined syntax when specifying AUTOSAR software component
behaviors to analyze or when importing data types. Using a Linux-find-like syntax, you can specify
inclusion or exclusion patterns for the fully qualified names of behaviors or types.

For more information, see polyspace-autosar Command.
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Product: Polyspace Code Prover (Desktop).

Configuration from Build System: Generate a project file or analysis
options file by using a JSON compilation database

In R2020D, if your build system supports the generation of a JSON compilation database, you can
create a Polyspace project file or an analysis options file from your build system without tracing your
build process. After you generate the JSON compilation database file, pass this file to polyspace-
configure by using the option -compilation-database to extract your build information.

For more information on compilation databases, see JSON Compilation Database.

Previously, you had to invoke your build command and trace your build process to extract the build
information. For some build systems such as Bazel, polyspace-configure could not always trace
the build process, resulting in errors when running an analysis by using the generated options file.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Configuration from Build System: Specify how Polyspace imports
compiler macro definitions

In R2020b, when you use polyspace-configure to create a Polyspace project file or to generate an
analysis options file from your build system, you can specify how Polyspace imports the compiler
macro definitions.

Use option -import-macro-definitions and specify:

* none — Skip the import of macro definition. You can provide macro definitions manually instead.
+ from-whitelist — Use a Polyspace white list to query your compiler for macro definitions.

+ from-source-token — Use all non-keyword tokens in your source files to query your compiler
for macro definitions.

See also polyspace-configure.

Previously, Polyspace used all non-keyword tokens in your source files to query your compiler for
macro definitions each time that you traced your build command. You now have greater control on
the import of macro definitions.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Configuration from Build System: Compiler configuration cached from
prior runs for improved performance

In R2020b, when you use polyspace-configure to create a Polyspace project file or to generate an
analysis options file from your build system, Polyspace caches your compiler configuration. If your

compiler configuration does not change, Polyspace reuses the cached configuration during
subsequent runs of polyspace-configure.

See also polyspace-configure.

Previously, Polyspace did not cache your compiler configuration. Instead, during every run of
polyspace-configure, Polyspace queried your compiler for the size of fundamental types,
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compiler macro definitions, and other compiler configuration information. Starting R2020b, the
caching improves the later polyspace-configure runs.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

polyspacePackNGo Function : Generate and package Polyspace option
files from a Simulink model

In R2020b, you can package Polyspace option files along with code generated from a Simulink model,
and then analyze the code on a different machine in a distributed workflow. After packaging the
generated code, create and archive options files required for a Polyspace analysis by using the
polyspacePackNGo function.

See also:

* polyspacePackNGo
* Run Polyspace Analysis on Generated Code by Using Packaged Options Files

In a distributed workflow, a Simulink user generates code from a model and sends the code to
another development environment. In this environment, a Polyspace user analyzes the generated
code by using design ranges and other model-specific information. Previously, in this distributed
workflow, you configured the Polyspace analysis options manually. Starting in R2020b, you do not
have to manually create the option files when analyzing generated code by using Polyspace in a
distributed workflow.

Product: Polyspace Code Prover (Desktop).

Polyspace and MATLAB Integration : Integrate Polyspace with MATLAB
programmatically without user interaction

In R2020b, use simpler steps to integrate Polyspace and MATLAB. Instead of browsing to a specific
subfolder of the Polyspace installation folder, and then running the polyspacesetup function, run
polyspacesetup from any folder:

polyspacesetup('install', 'polyspaceFolder', folder);

folder is the location of the Polyspace installation in your machine. To integrate Polyspace with
MATLAB without user interaction, use:

polyspacesetup('install', 'polyspaceFolder', folder, 'silent', true);
See:

* polyspacesetup
» Integrate Polyspace with MATLAB and Simulink

Previously, integrating Polyspace with MATLAB required user interaction. Starting in R2020b, you
can perform the integration programmatically and silently.

Product: Polyspace Code Prover (Desktop).
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polyspace.ModelLinkOptions Object : Configure object to analyze code
generated as a model reference

In R2020b, you can configure a polyspace.ModelLinkOptions object to analyze code generated
as a model reference by using the new optional argument asModelRef. To run a Polyspace analysis
on the code generated as a model reference, create a polyspace.ModelLinkOptions object and
set the asModelRef flag to true. See also:

* polyspace.ModelLinkOptions

* Analyze Code Generated as Model Reference

Previously, the class polyspace.ModelLinkOptions did not support analyzing code generated as
model reference. Starting in R2020b, you can run a Polyspace analysis on code generated as a model
reference by using the class polyspace.ModelLinkOptions. You can also set the options for the
Polyspace analysis by using a pslinkoptions object.

Product: Polyspace Code Prover (Desktop).

Offloading Analysis : Submit Polyspace analysis jobs from ClI server to
a dedicated analysis cluster

In R2020b, you can set up a continuous integration (CI) system to offload a Polyspace analysis to a
dedicated cluster and download the results after analysis. The cluster performing the analysis can be
one server or several servers where a head node distributes the jobs to several worker nodes which
perform the analysis. In this workflow:

* MATLAB Parallel Server™ is required on all servers involved in distributing jobs or running the
analysis.

* You install the Polyspace Server products both on the client and server side, but you do not
require licenses for job submission on the client side.

See Offload Polyspace Analysis from Continuous Integration Server to Another Server.

When running static code analysis with Polyspace as part of continuous integration, you might want
the analysis to run on a server that is different from the server running your continuous integration
(CI) scripts. For instance, you might want to perform the analysis on a server that has more
processing power. You can then offload the analysis from your CI server to the other server.

Product: Polyspace Code Prover Server.

Offloading Analysis : Server-side errors reported back to client side

If you run a Polyspace analysis on a MATLAB Parallel Server cluster, in R2020b, server-side errors are
reported back in the client-side log.

The log contains this additional information reported back from the server side:
* Errors that occurred during the server-side analysis.

For instance, if a Polyspace Server license has not been activated, you see a license checkout
failure reported from the server side.


https://www.mathworks.com/help/releases/R2020b/codeprover/ref/polyspace.modellinkoptions-class.html
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» Path to the Polyspace Server instance that runs the analysis.

Information reported from the server side appears in the log between the Start Diary and End
Diary lines.

Starting R2020b, you can troubleshoot server-side errors more easily by using the log reported on the
client side.

Product: Polyspace Code Prover Server.

Changes in analysis options and binaries
Option -consider-external-arrays-as-unsafe also applies to C code
In R2020Db, the option -consider-external-arrays-as-unsafe also applies to C code. The

option removes the default Code Prover assumption that external arrays of unspecified size can be
safely accessed at any index. Previously, the option was available only for C++ code.

See also -consider-external-array-access-unsafe.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
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Verification Results

Changes in run-time checks

Summary: In R2020b, you see these changes in the results of Code Prover run-time checks.

Check

Change

Non-initialized variable and Non-
initialized local variable

If all fields of a structure are unused and
uninitialized, checks for initialization on this
structure are orange.

Previously, if none of the fields of a structure
were used later, the checks considered the
structure as initialized. For instance, in this code:

typedef struct { int a; char c; } S;

void foo(void) {
S s;
S s1;

s = sl;

}

the Non-initialized local variable check on s1
in s = sl is orange. Prior to R2020b, the check
was green because even though the structure
fields are uninitialized, they are not used later.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover

Access

Compatibility Considerations

You can see a change in the number of results flagged by the updated run-time checks.

Updated code metrics specifications

In R2020b, these code metrics specifications have been updated.
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Code Metric

Update

Number of Called Functions

These metrics now accounts for function calls in a
C++ constructor initializer list.

For instance, in this code snippet, the number of
called functions of Derived: :Derived() is one.
Previously, the number was computed as zero.

class Base
{
int b;
public:
Base() {
b =0;
T
IE
class Derived : public Base
{
int d;
public:
Derived() : Base() {
d =0;
T
e

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover

Access

Compatibility Considerations

If you compute these code metrics, you can see a difference in results compared to previous releases.
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Results Export: Export Polyspace results to external formats such as
SARIF JSON

In R2020b, you can use the new polyspace-results-export command to export Polyspace results
to formats such as JSON and CSV.

* The JSON object follows the Static Analysis Results Interchange Format or SARIF notation.

* The CSV file has the same fields as produced by using the earlier polyspace-report-
generator command with the -generate-results-list-file option.

Use the polyspace-report-generator command to generate PDF or Word reports in a
predefined format. To package results using your own format, export them using the polyspace-
results-export command and read the resulting JSON object or CSV file.

You can use this command with results generated locally or with results uploaded to Polyspace
Access.

See also polyspace-results-export.

Using the JSON object or CSV file, you can display results in a convenient format. For instance, you
can group defects found by Bug Finder based on their impact. Because the JSON object follows a
standard notation, you can also use this format to display Polyspace results with results from other
tools.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access

Simulink Block Annotation : Annotate Simulink blocks from Polyspace
user interface to justify Polyspace results

In R2020b, you can annotate a Simulink block directly from the Polyspace user interface. See
Annotate Blocks to Justify Issues.

Previously, when annotating a check on generated code from the Polyspace user interface, you had to
locate the corresponding block in the Simulink Editor and annotate the block again. Starting in
R2020b, you can annotate a check in the Polyspace user interface and have the annotations carry
over to the Simulink blocks by using the traceable elements of the code. You do not have to go back to
the model to re-enter the annotation.

Product: Polyspace Code Prover (Desktop).

User Authentication : Use a credentials file to pass your Polyspace
Access credentials at the command line

In R2020D, if you use a command that requires your Polyspace Access credentials, you can save these

credentials in a file that you pass to the command. If you use that command inside a script, you no
longer need to store your credentials in the script.
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To create a credentials file, enter a set of credentials, either as - login and -encrypted-password
entries on separate lines, for example:

-login jsmith
-encrypted-password LAMMMEACDMKEFELKMNDCONEAPECEEKPL

Or as a -api-key entry:
-api-key keyValuel23

For more information on generating API keys, see Configure User Manager (Polyspace Code Prover
Access).

Save the file and pass it to the command by using the -credentials-file flag. You can use the
credentials file with these Polyspace commands:

* polyspace-access
* polyspace-results-export
* polyspace-report-generator

For increased security, restrict the read/write permissions for the credentials file.

Previously, you could provide your Polyspace Access credentials in a script only by passing them
directly to the command. Starting R2020b, when the command that requires the credentials runs,
someone who is inspecting currently running processes, for instance, by using the command ps aux
on Linux, can no longer see your credentials.

Product: Polyspace Code Prover Access.

Importing Review Information: Accept information in source or
destination results folder in case of merge conflicts

In R2020b, when importing review information such as severity, status, and comments at the

command line, if the same result has different review information in the source and destination folder,
you can choose one of the following:

* That the review information in the destination folder is retained.

This behavior is the default behavior of the polyspace-comments-import command.

* That the review information in the source folder overwrites the information in the destination
folder.

You can switch to this behavior using the new option -overwrite-destination-comments.
See also polyspace-comments-import.
Previously, newer review information in the destination folder was retained and could not be
overwritten. Now, when merging review information, you can choose whether the source or
destination folder takes precedence in case of merge conflicts.
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover

Access
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Functionality being removed: Polyspace Metrics

The Polyspace Metrics web dashboard will be removed in a future release.

Compatibility Considerations

To continue monitoring the quality of your code in a web browser, use Polyspace Access instead. In
addition to a more intuitive dashboard, with Polyspace Access you can:
* Review and justify results directly from your web browser.

» Integrate a bug tracking tool such as Jira with the web interface and create tickets to track
Polyspace findings.

* Monitor the quality of your code against coding standards such as AUTOSAR C++14, CERT C/C+
+, and MISRA C.

* Define custom Quality Objectives definitions and apply them to specific projects.
For more information, see Polyspace Code Prover Access .

See also Migrate Results from Polyspace Metrics to Polyspace Access (Polyspace Code Prover
Access).

Code Quality Improvement Progress: Compare results from current
run to previous runs and determine progress in code quality
improvement

In R2020Db, you can select any two runs of a project in the Polyspace web interface (current and
baseline runs) and compare them. You can compare a current run to only older baseline runs.


https://www.mathworks.com/help/releases/R2020b/polyspace_code_prover_access/index.html
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Reviewing Results

Current D?—Josl.D-Uolo...l - E Q}
/) Beseline[ |06 -ob1L0-Uplowe| < | G050 PR LR QR Gotdeimes || idew | OpeninDesktop Review
RUN DASHBOARDS ENVIRONMENT REVIEW
¥ Project Explorer Project Overview
» 3 ProjectsWaitingForDeletion Bl summary Bug_Finder_Example (
+ 3 public
Bug_Finder_Example (Bug Finder) Comparison Baseline Run Current Run
[ ] Number of Files 14 14
Mumber of Lines Without Comm... 5201 5201
Defects - Total 242
Defects - Density 36 0
Coding Standards - Total 49
Coding Standards - Density 9 0
El Details
Name Resolved New Unre:
O Defects 188
¥ Custom Rules 45
Project Details — Polyspace Guidelines 4

The comparison shows the number of analysis findings that are:

* Resolved. Findings from the baseline run no longer found in the current run.
* New. Findings in the current run that were not present in the baseline run.
* Unresolved. Findings from the baseline run that are still present in the current run.

Product: Polyspace Code Prover Access.

Code Quality Objectives: Define custom quality objectives definitions
and apply them to specific projects

In R2020b, you can create custom quality objectives definitions and apply those definitions to specific

projects. For instance, if you want to track the compliance of a project with a coding standard, you
can create Quality Objective thresholds for that coding standard and apply them to your project.
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Quality Objectives Settings

oh New &, Saveas. fill Delete

4, Search Information = Configuration = Project Assignment

Polyspace Software Quality Object...

These defaul lity objectives were O Defects < MISRA C:2012

created a Works in tion [ Run-time Chacks

View by Group ~ View by Category

MISRA C 2012 x| Global Variables

Quality objectives for automotive Coda Mt Name Category SQ01 5Q02 SQO3 SQ04 SQO5 SQO6 Exhaust

project ¥ Lode Metrics 4[| MISRA C:2012 u [ n 5 % %
¥ Custom Rules + [ Dir 1 The implementation v v k4 |
< MISRAAC AGC ¥ [v] Dir 2 Compilation and build v | | |

< MISRA C:2012 '

v [] 10 The essential type model

+ [] 11 Pointer type conversions

v [v] Dir 4 Code design L] [] | |
= MISRA C++2008 N
+ [] 1 Astandard C environment L] [] | |
= MISRA C:2004 » [ 2 Unused code u [l 7 7
= JSFAV C++ ¥ [v] 3 Comments v v | v
< SEICERTC » [/ 4 Character sets and lexical conventions L] [ ] ! !
» [/] 5 Identifiers L] [ ] ! !
+ SEICERT C++
v [v] 6 Types v ¥ | |
~ ISONECTS 17961 » [/] 7 Literals and constants | V| M M
< AUTOSAR C++14 ¥ [v] & Declarations and definitions ] [] V| ]
+ [/ 9 Initialization L] L] V| V| M M
[] [] ¥ ¥
[] [] /! \/
[] [] ] ]

» ] 12 Expressions [] L]

To create custom quality objectives definitions, you must be an Administrator or Owner.
Previously, custom quality objectives applied to all projects.
Product: Polyspace Code Prover Access.

Project Selection: Find a project in the Project Explorer through a text
filter

In R2020b, you can use a text filter in the Project Explorer to find projects that are not visible in a
folder hierarchy. The text filter is not case sensitive.

PROJECT EXPLORER PROJECT EXPLORER
Fl ter r‘l'l';.'_l:|
i Projects\VaitingForDeletion + | public

+ | public my_cpp_project
Bug_Finder_Exampie (Bug Finder)

Bug_Finder_Example_Cpp (Bug Finder
my_cpp_project

Product: Polyspace Code Prover Access.

Functionality being removed: Automatic Orange Tester

The Automatic Orange Tester will be removed in a future release.
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Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access.

Compatibility Considerations

If you use the Automatic Orange Tester with your Polyspace project, unset the corresponding options.
In the desktop interface, you set these options in the Configuration pane under the Advanced
Settings node.

If you use these command-line options in your scripts, remove them:

* -automatic-orange-tester

* -automatic-orange-tester-loop-max-iteration

* -automatic-orange-tester-tests-number

* -automatic-orange-tester-timeout

If you use these properties in your MATLAB scripts, remove them
(opts=polyspace.Options('C')):

* opts.Advanced.AutomaticOrangeTester

* opts.Advanced.AutomaticOrangeTesterLoopMaxIteration
* opts.Advanced.AutomaticOrangeTesterTestsNumber

* opts.Advanced.AutomaticOrangeTesterTimeout
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Bug Tracking Tool: Integrate with Jira Software Cloud

In R2020b, you can integrate Jira Software Cloud with Polyspace Access. After you configure
Polyspace Access, you can create a Jira ticket to track Polyspace findings. The ticket is populated with
details of the finding and a link to open that finding in Polyspace Access. See Configure Issue Tracker
(Polyspace Code Prover Access).

Previously, you could integrate Polyspace Access with only self-managed Jira Software.

Product: Polyspace Code Prover Access.

Cluster Admin Settings: Validate values of settings on demand or on
save

In R2020b, the Cluster Admin validates the settings that you enter in the Cluster Settings when
you save those settings. You can also validate the settings before you save by clicking Validate now
at the bottom of the page.

Product: Polyspace Code Prover Access.

HTTPS Configuration: Configure services without specifying ports or
SSL certificates

In R2020D, if you install Polyspace Access on a single node, the ports of the Polyspace Access services
are no longer exposed. You do not need to specify port numbers for the services or to provide SSL
private keys and certificates for the HTTPS configuration. See Configure Polyspace Access for HTTPS
(Polyspace Code Prover Access).

Previously, you had to check the availability of the ports for the services, and then you provided a
private key and SSL certificate file to enable the HTTPS protocol for Polyspace Access.

Product: Polyspace Code Prover Access.

Functionality Replaced: Polyspace Access embedded LDAP

The Polyspace Access embedded LDAP is removed in R2020b. To continue using custom login
credentials for Polyspace Access, use the User Manager internal directory instead. See Authenticate
Users from Internal Directory (Polyspace Code Prover Access).


https://www.mathworks.com/help/releases/R2020b/polyspace_code_prover_access/gs/configure-issue-tracker.html
https://www.mathworks.com/help/releases/R2020b/polyspace_code_prover_access/gs/configure-and-start-the-cluster-operator.html#mw_b7514171-e399-4302-9e7f-3577d682cc43
https://www.mathworks.com/help/releases/R2020b/polyspace_code_prover_access/gs/configure-the-user-manager.html#mw_9d5be066-c809-463b-9fa8-b6a6a3ba2a8f
https://www.mathworks.com/help/releases/R2020b/polyspace_code_prover_access/gs/configure-the-user-manager.html#mw_9d5be066-c809-463b-9fa8-b6a6a3ba2a8f
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User Manager admin~

Dashboard

Sign-in ID Display Name
admin (LI admin

jdoe John Doe
jsmith Jane Smith
rroll Richard Roll

Email

admin@email.com 3
p
-
o

Product: Polyspace Code Prover Access.

Compatibility Considerations

In the User Manager interface, create users to transfer the user names and passwords that you
stored in the embedded LDAP LDIF file to the User Manager database.

Changes in Polyspace Access docker containers, options, and binaries

In R2020Db, the following docker containers, options, and binaries have been renamed:

* The cop-docker-agent binary is now called the admin-docker-agent

. HTTPS Options

Previous Option Name

Current Option Name

--https-certificate-file

--ssl-cert-file

--https-private-key-file

--ssl-key-file

--https-trusted-certificates-file

--ssl-ca-file

. Containers

Previous Container Name

Current Container Name

polyspace-db

polyspace-access-db-main

polyspace-etl

polyspace-access-etl-main

polyspace-gateway

gateway

polyspace-issuetracker

issuetracker-server-main

polyspace-web-server

polyspace-access-web-server-main
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Product: Polyspace Code Prover Access.

Compatibility Considerations
In your scripts, replace instances of the previous names with the current names. You cannot reuse a

settings configuration file (settings. json) from a previous release of Polyspace Access with the
R2020Db software.
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Checking Initialization Code: Analyze initialization code alone before
checking remaining program

In R2020a, you can mark off a section of code as initialization code and check for run-time errors only
in this section.

For instance, in this example, the initialization code starts from the beginning of main and continues
up to the pragma polyspace end of init. The verification stops when the pragma is
encountered.

#include <limits.h>

int aVar;
const int aConst = INT MAX;
int anotherVar;

int main() {
aVar = aConst + 1;
#pragma polyspace end of init
anotherVar = aVar - 1;
return 0;

}

For more information, see Verify initialization section of code only (-init-only-
mode).

Often, issues in the initialization code can invalidate the analysis of the remaining code. For instance,
in the preceding example, the overflow in the line aVar = aConst+1 must be fixed first before the
value of aVar is used in subsequent code. Now, you can check the initialization code alone and fix the
issues found before verifying the remaining program.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compiler Support: Set up Polyspace analysis easily for code compiled
with MPLAB XC8 C compilers

If you build your source code by using MPLAB XC8 C compilers, in R2020a, you can specify the
compiler name for your Polyspace analysis.

Target Environment

Compiler microchip o

Target processor type |pic e

See also MPLAB XC8 C Compiler (-compiler microchip).

You can now set up a Polyspace project without knowing the internal workings of MPLAB XC8 C
compilers. If your code compiles with your compiler, it will compile with Polyspace in most cases
without requiring additional setup. Previously, you had to explicitly define macros that were implicitly
defined by the compiler and remove unknown language extensions from your preprocessed code.


https://www.mathworks.com/help/releases/R2020a/codeprover/ref/verifyinitializationsectionofcodeonlyinitonlymode.html
https://www.mathworks.com/help/releases/R2020a/codeprover/ref/verifyinitializationsectionofcodeonlyinitonlymode.html
https://www.mathworks.com/help/releases/R2020a/codeprover/ref/mplabxc8ccompilercompilermicrochip.html

Verification Setup

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Compiler Support: Set up Polyspace analysis to emulate MPLAB XC16
and XC32 compilers

If you use MPLAB XC16 or XC32 compilers to build your source code, in R2020a, you can easily
emulate these compilers by using the Polyspace GCC compiler options. See Emulate Microchip
MPLAB XC16 and XC32 Compilers.

For each compiler, you can emulate these target processor types:

*+ MPLAB XC16: Targets PIC24 and dsPIC.
*+ MPLAB XC32: Target PIC32.
You can copy the analysis options required for emulating MPLAB XC16 or XC32 compilers and paste

into your Polyspace options file (or specify in a Polyspace project in the user interface), and avoid
compilation errors from issues specific to these compilers.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Source Code Encoding: Non-ASCII characters in source code analyzed
and displayed without errors

In R2020a, if your source code contains non-ASCII characters, for instance, Japanese or Korean
characters, the Polyspace analysis can interpret the characters and later display the source code
correctly.

If you still have compilation errors or display issues from non-ASCII characters, you can explicitly
specify your source code encoding using the option Source code encoding (-sources-
encoding).

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Simulink Support : Analyze custom C code in C Function blocks
In R2020a, Polyspace can check custom C code in C Function blocks for bugs and run-time errors.

The analysis checks the C code in context of the model. In other words, the analysis uses design
ranges and other context information specified in the model.

To analyze custom C code in C Function block, select Custom Code Used in Model instead of Code
Generated as Top Model (meant for generated code) on the Polyspace tab in Simulink and then
start the analysis. In addition to functions called from C Caller blocks and Stateflow charts, the
custom code in C Function blocks are also checked for run-time errors. See Run Polyspace Analysis
on Custom Code in C Function Block.

The Polyspace analysis of custom code now includes individual scripts in C Function blocks (block
introduced in Simulink in R2020a). In a single run, you can analyze all handwritten C code invoked
from your model and check for bugs, run-time errors or coding rule violations.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
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Project Creation from AUTOSAR Configuration: Troubleshoot project
creation more easily with resolution hints

In R2020a, when creating a Polyspace project from your ARXML and source files, if you run into
errors during code extraction, the analysis provides helpful resolution hints for these common code
extraction issues:

* Undefined data types
* Include files not found

To see the resolution hints, in the file psar project.xhtml, click the EI button on the upper
left, then click Behaviors. On the Behaviors tab, below the errors in the code extraction phase, click
the link to see a summary of code-extraction diagnostics with possible resolution hints.

Extract implementation code for 89 AUTOSAR behaviors with proof artifacts:

% See summary of code-extraction diagnostics with possible resolution hints

Execution reported errors and warnings. @ Reported errors % See detailed log messages

error_noRunnablelmplementationTopFileError (3)
error_atLeastOneRunnablelnkileThatDoesMNotCompile (23)

allRunnablesImplementation (30)

The resolution hints are of two types:

* For undefined data types, the analysis proposes matches from the ARXML that could possibly be
used for the data types. You can specify these data types with the polyspace-autosar option -
autosar-datatype.

» For missing include files, the analysis proposes matches for the include files from subfolders of the
source folder. You can specify these include files with the polyspace-autosar option -I.

Instead of fixing individual code extraction errors using the resolution hints, you can download a file
with all options that implement the hints. On the summary page, click the link Download polyspace-
autosar options.

Summary of polyspace-autosar code-extraction diagnostics

Lists diagnostics that are reported when extracting the implementation-code of one or more AUTOSAR behaviors.
Each diagnostic may have "resolution-hints” which are specific to the class of error.
Resolution-hints can translate to polyspace-autosar options that you may add to your project % Download polyspace-autosar options

6-4

You can use the downloaded text file with the polyspace-autosar option -options-file to
implement the resolution hints in one shot.

For information on the options, see polyspace-autosar.



https://www.mathworks.com/help/releases/R2020a/codeprover/ref/polyspaceautosarcommand.html
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Most issues during the code extraction phase of Polyspace project creation come from data types not
found or missing include files. You can now address a significant fraction of these issues with a simple
one-click resolution.

Product: Polyspace Code Prover (Desktop).

Jenkins Support : Use sample Jenkins Pipeline script to run Polyspace
as part of continuous delivery pipeline

In R2020a, you can start from a template Jenkins Pipeline script to run Polyspace analysis as part of a
continuous delivery pipeline.

See Sample Jenkins Pipeline Scripts for Polyspace Analysis.

You can make simple replacements to adapt the template to your Polyspace Server and Access
installations, and include the script in a new or existing Jenkinsfile to get up and running with
Polyspace in Jenkins Pipelines.

Product: Polyspace Code Prover Server.

Changes in analysis options and binaries

Option -function-behavior-specifications renamed to -code-behavior-specifications and
capabilities extended
Warns

The option - function-behavior-specifications has been renamed to - code-behavior-
specifications.

Using this option, you could previously map your functions to standard library functions to work
around analysis imprecisions or specify thread creation routines. Now, you can use the option to
define a blacklist of functions to forbid from your source code.

See also -code-behavior-specifications.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Changes in MATLAB functions, options object and properties:

polyspaceCodeProverNodesktop removed
Errors

Use polyspaceCodeProver(projectFile, '-nodesktop') instead of
polyspaceCodeProverNodesktop(projectFile).

Product: Polyspace Code Prover (Desktop).

pslinksetup removed
Errors

Use polyspacesetup instead of pslinksetup to integrate between Polyspace and Simulink (in the
same release or across releases). See Integrate Polyspace with MATLAB and Simulink.


https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_server/ug/sample-jenkins-pipeline-scripts-for-polyspace-analysis.html
https://www.mathworks.com/help/releases/R2020a/codeprover/ref/codebehaviorspecifications.html
https://www.mathworks.com/help/releases/R2020a/codeprover/ug/integrate-polyspace-with-matlab-and-simulink.html

R2020a

Product: Polyspace Code Prover (Desktop).
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Verification Results

Checks on Initialization Code: Verify that global variables are
initialized after warm reboot

In R2020a, you can mark off a section of a C program as initialization code and verify if all non-const
global variables are explicitly initialized at declaration or in that section.

For instance, in this simple example, the initialization code starts from the beginning of main and
continues up to the pragma polyspace end of init. The global variable aVar is initialized in this
section but the variable anotherVar is not.

int aVar;
const int aConst = -1;
int anotherVar;

int main() {
aVar = aConst;

#pragma polyspace end of init
return 0;

}
For more information, see:

* Check that global variables are initialized after warm reboot (-check-
globals-init)

* Global variable not assigned a value in initialization code

In a warm reboot, to save time, the bss segment of a program, which might hold variable values from
a previous state, is not loaded. Instead, the program is supposed to explicitly initialize all non-const
variables without default values before execution. You can now delimit this initialization code and
verify that all non-const global variables are indeed initialized in a warm reboot.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access

Changes in run-time checks

In R2020a, you see these changes in the results of Code Prover run-time checks.


https://www.mathworks.com/help/releases/R2020a/codeprover/ref/checkthatglobalvariablesareinitializedafterwarmrebootcheckglobalsinit.html
https://www.mathworks.com/help/releases/R2020a/codeprover/ref/checkthatglobalvariablesareinitializedafterwarmrebootcheckglobalsinit.html
https://www.mathworks.com/help/releases/R2020a/codeprover/ref/globalvariablenotassignedavalueininitializationcode.html
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Check

Change

Uncaught exception

The check no longer flags the case where a function throws an exception
whose data type is not in the list of exception types in the function
declaration.

For instance, the function foo is declared to throw exceptions of type
int and std: :exception:

void foo2() throw(std::exception, int);

Code Prover used to check if the function can throw exceptions outside
the specified types. The check is not performed from R2020a onwards.

Dynamic exception specification using the above syntax is deprecated in
C++11 and removed in the later standard C++17. See also Dynamic
exception specification in the C++ standard.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover

Access

Compatibility Considerations

You can see a change in the number of results flagged by the updated run-time checks.



https://www.mathworks.com/help/releases/R2020a/codeprover/ref/uncaughtexception.html
https://en.cppreference.com/w/cpp/language/except_spec
https://en.cppreference.com/w/cpp/language/except_spec
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Reviewing Results

AUTOSAR Support: Navigate from Polyspace findings to AUTOSAR
ARXML specifications

In R2020a, if you run Polyspace on AUTOSAR code and upload the results to Polyspace Access, you
can navigate from the AUTOSAR finding to the corresponding AUTOSAR behavior specification.

asull Dedails it . AUTCOSAR Behavior Specification Mzt
& s e i - F-:u:us on: One Functian Specific
= - Parameter#836
Status | Unreviewed b
App.l.icatiancomponentﬂahaviar
Severity | Unsel = pkg.tst002.swc00l.bhv00l
Assigned to o Call_f{)ﬂ
& Venhes mplemeantation of runnable-function
@ Invald result of AUTOSAR runnable ||r||:-|1 rEnlaton U - started in response to Operation:[nvu:u kadeve
Error II"""'IIl"I'IIuIIL'I func ‘fon’ proyides an invalid result . -
Conditions on retum s-* SRS ) .
/ aRatum meets its = pETREETER * [ calls runnable-function: foo
pecification: 0. 1, 24, 42 o
Actual value (unsigned int 8): 0 O signature
BETURNS 8 Enumaration
Conditions on 'El'.‘.'un_'.l.:'1--|':l sl (588 parameler Spec) foo ApplicationErrox
o This W pararmider i$ tead-only henck and dois nal fisguee o ..._ L ;\ AR vt
enhicabon -

From the Result Details pane for an AUTOSAR finding, click parameter spec to open the
AUTOSAR behavior specification. You can use the information in the spec to further investigate
the cause of an AUTOSAR finding.

See also Review Polyspace Results on AUTOSAR Code.

Product: Polyspace Code Prover Access.

Bug Tracking Tool Support: Create Redmine tickets for Polyspace
Access results and assign to developers

In R2020a, Polyspace Access supports integration with the Redmine bug tracking tool. If you use
Redmine, after you configure Polyspace Access, you can create a Redmine ticket to track Polyspace
findings. The ticket is populated with details of the finding and a link to open that finding in Polyspace
Access. You can add the ticket to any existing Redmine project.
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Create Redmine ticket for finding #9 (10.1 The value of an expression...)

Project” v
Tracker® v
Subject” 10.1 The value of an expression of integer type shall not be implicitly converted to ¢

Implicit conversion of the expression of underlying type 'signed int’ to the type
'signed char' that is not a wider integer type of the same signedness.

Found in /localftest/sources/CP_C_R2019a/single file_analysis.c

Description

- Go to Polyspace finding here:

hitps://myAccess. company, com: 344 3imetrics(index html?

a=review&p=3&r=1&fid=9 -

i
Status® ¥
Priority® v
Assignee b
Estimated time
Cancel

Once you create a ticket, the Result Details pane displays a link that you can click to open the ticket
in the Redmine interface. See also Track Issue in Bug Tracking Tool.

Product: Polyspace Code Prover Access.

Simulink Support: Navigate from generated code in Polyspace Access
to blocks in model

In R2020a, if you run Polyspace on generated code in Simulink and upload the results to Polyspace
Access, you can navigate from the source code in Polyspace Access to blocks in the model.

6-10


https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_access/ug/track-issue-in-bug-tracking-tool.html

Reviewing Results

On the Source Code pane in the Polyspace Access web interface, links in code comments show
blocks that generate the subsequent lines of code. To see the block in the model:

1

2

Right-click a link and select Copy MATLAB Command to Highlight Block.

Source Code

test20a.c

(=

2 /* Real-time model */

29 RT_MODEL_test2@a T test2@a M _;

38 RT_MODEL_test2@a_T *const test2@a_M = &test2Ba M_;
31

32 f* Model step function */

32 woid test2@a_step(void)

34 [

35 /* Outport: 'fRoot>/0utl’ incorporates:
36 Gain: "£Root:/Gain®

37 * Inport: 'fRogt—"T-t

a8 ! Go To Line

33 test28a_Y.0utl :

_V-Outl = 4 Copy File Path To Clipboard

oo

Copy MATLAE Command to Highlight Block
/* Model initialize Sonocozon

J R

vndd toctImz Indeiclioalenddy

This action copies the MATLAB command required to highlight the block. The command uses the

Simulink.ID.hilite function.
In MATLAB, with the model open, paste and run the copied command.

Product: Polyspace Code Prover Access.

Results Review: See review history of findings

In R2020a, you can open the Review History pane to see all the changes to the review fields of
findings with a timestamp and the name of the user who made the change. On the Polyspace Access
toolstrip, select Layout > Show/Hide View.
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ENVIROMMENT REVIEW

Fesult Details Review History

Show | All -
Date and Time User What Chan Original value New value [+
412712020 - : . o .
3-35-15 PM ps_user Comment Reassigning to project owner Changing severity to low
ATI00
;%zﬁfﬁ M ps_user  Severity  High Low
ATI00
;éil-iézﬁpfq ps_user  Status To investigate To fix
42712020 . . - :
3-34:79 PM jdoe Comment Triage of data race defacts Reassigning to project owner
412712020
;%g?ézﬁ M jsmith Severity = Unset High
Al i Il'l |"'I
;%g%;zﬁp Y jsmith Status Unreviewed To investigate
Al i Il'l |"'I
;I-ggl-gézﬁm jsmith Comment Triage of data race defects

You can use this information to better understand how and why the Severity or Status of a finding
has changed, and retrieve previous comments that were overwritten.

For more information, see Review History.

Product: Polyspace Code Prover Access.

Results Review: See the configuration options used for analysis
In R2020a, you can open the Configuration Settings pane to view the Polyspace configuration

options that were enabled to generate the analysis results. On the Polyspace Access toolstrip, select
Layout > Show/Hide View.
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Results List Configuration Settings = L]
Verification Options | Checkers configuration
Options Value L+
-author MathWorks =

BAD _PLAIN_CHAR_USE, BITWISE_NEG,

FLDAT ABSORPTION, FLCIAT CDN‘U’ D"u"FL

FLDAT OVFL, FLOAT_STD | LIB, FLCIJ:".T EERO oI,
INT_CONST&NT_GUFL, INT_CGN"U’_G"U’FL, INT_DUFL,
INT_PRECISION_EXCEEDED, INT_STD_LIE,

checkers INT_TO_FLOAT PRECISION_LOSS, INT_ZERO DIV,
INVALID OPERATION _ON_BOOLEAM, SHIFT_NEG,
SHIFT_OVFL, SIGH_CHANGE,
UINT _CONSTANT _OWFL, UINT_CONV_OVFL,
UINT _OVFL
-compiler gnud &
BEGIN_CRITICAL SECTION:Cs10,
-critical-section-begin acquire_sensor:Cs11, acquire_printer:Cs12,
acquire_sensor2:Cs13, acquire_printer2:Cs14
END _CRITICAL SECTION:Cs10, release_sensor:Cs11,
-critical-section-end release printer:Cs12, release _sensor2:Cs13,
release printer2:Cs14
-date 081272019
-do-not-generate-results-for all-headers
-dos true

bug datarace taskl, bug_datarace task2

bug datarace task3, bug_datarace taskd,

bug_deacllcck task1, bug_deadlock taekE.

bug_doublelock _task, bug_ deubleunlcck task,

bug_badlock task, bug badunlock_task,

bug dataraceetdhb taskl, bug_ dataracestdllb task2,

bug_destroylocked | task, comected datarace | task1,
-entry-points corrected datarace task2, ccrrected_datarace_taekii

corrected datarace taskd, comrected deadlock_taskl,

corrected deadlock task?, corrected doublelock task,

corrected doubleunlock_task, corrected badlock task,

corrected badunlock_task,

corrected dataracestdllb task1,

cerrected_clataracestdllb_taekz

corrected destroylocked task

-lang c

-misral mandatory

-prog Bug_Finder_Example

-results-dir D:\Polyspace\Bug_Finder Example\BF_Result 1
-target *66 64

-verif-version 1.0
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Oa

You can use this information to better understand your results. For instance, you might expect to see
a certain coding rule violation but the checker for this rule is not enabled. Previously, you had to
parse the Run Log to see which options and checkers were enabled.

For more information, see Configuration Settings.

Product: Polyspace Code Prover Access.

Code Quality Objectives: Customize thresholds used to track the
quality of your code

In R2020a, if you use Quality Objectives to track the quality of your code, you can customize the
thresholds you use as pass/fail criteria to better align with your company or project requirements. For
instance, you can define quality gates to ensure adherence to a specific external coding standard.

Save

@]
(o]
-
#*

-

Project Overview Quality Objectives CQuality Objectives Settings

/N, Changes to settings apply to all projects.

B Quality Objectives Criteria

<= MISRA C:2012 49/170 v [ ] 4 Character sets (/2
< MISRA C++-2008 73/202 » (W] 5 Identifiers 1/7 ] V] V] V| V] V]
» (W] 6 Types 1/5 V| V|
~ MISRA C:2004 49/131 -
» [ 7 Constants 0/1
¥ JSFAV G+ 00157 » (W] 8 Declarations and definitions 3/12 [ [ [ (] 7 v
~ SEICERT C 0/203 » W] 9 Initialization 2/3 v v
< SEI CERT C++ 0/126 » (W] 10 Arithmetic type conversions 2/6 V] V]
. » (] 11 Pointer type conversions 4/5 [] [] [] [] V| V|
~ ISQ/IEC TS 17961 0/46 ; o
» (W] 12 Expressions 7/13 [] [] [] [] V| V|
¥ AUTOSAR C++14 0/251 » (W] 13 Control statement expressions 6/7 [] [] [] [] V| V|
» (] 14 Control flow 4/10 [ ] [ ] ] [ ]

Back to default

Defects 289/289 EANSHACI00

Run-time Checks 20/30 View by Group | View by Category

Global Variables 0/4 Category SQO1 SQ02 SQO03 SQ04 SQO5 SQO6 Exhaus
Code Metrics 13/31 4 [ MISRA C:2004 49/131 [] [] [] [] v v

a » | 1 Environment 0/1
Custom Rules 0/43 -
» [ |2 Language extensions 0/3

MISRAACAGC 11129 » [ | 3 Documentation 0/1
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To make changes to the quality objectives settings, you must have a role of Administrator.

Previously, you could track the quality of your code only against thresholds. See Customize Software
Quality Objectives.

Product: Polyspace Code Prover Access.

Project Dashboard: Open results by clicking Dashboard charts

In R2020a, you can click a section of a pie chart or the legend of a pie chart to open the
corresponding findings in the Results List and more easily narrow the scope of your review.


https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_access/ug/configuration-settings.html
https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_access/ug/quality-objectives-dashboard.html#mw_e58e2a5a-4471-40dd-a934-8db2de0951f1
https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_access/ug/quality-objectives-dashboard.html#mw_e58e2a5a-4471-40dd-a934-8db2de0951f1
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W8 Coding Standards 5= Open 6 Bhowing: 45 / 394 | Coding Standards awo  ToDo | &9
Results List
i | Family ID  Type Group
E - 517193... Custom Rules T Functions
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B - 517194... Custom Rules T Functions
I - B17184... Custom Rules T Functions
E - 517194... Custom Rules T Functions
c - 51T184... Cusiom Rules T Functions
; - 517194,,, Custom Rules T Functions

Product: Polyspace Code Prover Access.

Bug Tracking Tool Support: Manage tickets for multiple findings

In R20204, if you create a bug tracking tool ticket in Polyspace Access, you can select multiple
findings that you associate with the ticket. If a ticket already exists, you can add that ticket to
additional findings or you can detach the ticket from findings that are associated with the ticket.

Previously, you could create a ticket for only one finding at a time and you could not detach a ticket
from a finding.

For more information, see Track Issue in Bug Tracking Tool.

Product: Polyspace Code Prover Access.

Results Review: View error call graph

In R20204, if you review Run-Time Checks, click the icon to open the Error Call Graph pane.

The pane displays the call sequence that leads to the detected finding. Click a node on the graph to
navigate back to the source code.

Product: Polyspace Code Prover Access.

Results Review: View variable access graph
In R2020a, if you review Global Variables findings, click the icon to open the Variable Access
Graph pane.

The pane displays a graphical representation of the access operations on global variables. Click a
node on the graph to navigate back to the source code at the location of calling and called functions.

Product: Polyspace Code Prover Access.
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Exporting Results: Export only results that must be reviewed to
satisfy software quality objectives (SQOs)

Summary: In R2020a, when exporting Polyspace results from the Polyspace Access web interface to
a text file, you can export only those results that must be fixed or justified to satisfy your software
quality objectives. The software quality objectives are specified through a progressively stricter set of
SQO levels, numbered from 1 to 6.

See also:

* polyspace-access
* Send Email Notifications with Polyspace Code Prover Results
» Software Quality Objectives (Polyspace Code Prover Access)

Benefits: You can customize the requirements of each level in the Polyspace Access web interface,
and then use the option -open-findings-for-sqo with the level number to export only those
results that must be reviewed to meet the requirements.

Product: Polyspace Code Prover Access.

Report Generation: Configure report generator to communicate with
Polyspace Access over HTTPS

In R2020a, if you generate reports for results that are stored on Polyspace Access, you can configure
the polyspace-report-generator binary to communicate with Polyspace Access over HTTPS.

Use the -configure-keystore option to run this one-time configuration step. See polyspace-
report-generator.

Previously, you needed a Polyspace Bug Finder desktop license to generate reports if Polyspace
Access was configured with HTTPS.

Product: Polyspace Code Prover Server.
Report Generation: Navigate to Polyspace Access Results List from
report

In R2020a, if you generate a report for results that are stored on Polyspace Access, you can navigate
from the report to the Results List in the Polyspace Access web interface.


https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_server/ref/polyspaceaccess.html
https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_server/gs/sample-e-mail-templates-for-e-mails-with-polyspace-results.html
https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_access/ug/software-quality-objectives-or-sqo.html
https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_server/ref/polyspacereportgenerator.html
https://www.mathworks.com/help/releases/R2020a/polyspace_code_prover_server/ref/polyspacereportgenerator.html
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D11 Any implementation-defined behaviour on which the output of the prog File Scope
ram depends shall be documented and understood.
The abort function returns an implementation-defined termination stat
us to the host environment.

Guidel | Message Function
ine
)

686395 21.8 The library functions abort, exit and system of <stdlib.h= shall not be us  File Scope
ed.

68841 8.4 A compatible declaration shall be visible when an object or function wi  File Scope
th external linkage is defined.
Function 'bug datarace taskl' has no visible prototype at definition.

68835 B4 A compatible declaration shall be visible when an object or function wi  File Scope
th external linkage is defined.

Function "bug datarace task2’ has no visible prototype at definition.

Click the link in the ID column to open Polyspace Access with the Results List filtered down to the
corresponding finding.

Product: Polyspace Code Prover Server.
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Polyspace Access Installation

Installation and Configuration: Issue Tracker service

In R2020a, use the new Issue Tracker service to configure Polyspace Access to integrate with the
Jira software or Redmine bug tracking tools.

Issue Tracker
Node: master «
Port number: 5002
Use HTTPS protocol O
Trusted certificates file:
Provider: JIRA -
URL: MNone athworks.com
Authentication type: JIRA
Redmine

See Configure the User Manager and Issue Tracker.

Product: Polyspace Code Prover Access.

Installation and Configuration: Change in default location of Polyspace
Access data volume and working directories

In R2020a, the default location of the working directories of the Polyspace Access Web Server and
ETL services and of the data volume is inside the folder where you unzipped the Polyspace Access
ZIP file, under the polyspace folder.

Previously, the working directories of the Web Server and ETL were stored in the temporary files
folder of your system (/tmp on Linux or STEMPS% on Windows). The data volume was stored
under /var/lib/docker/volumes on Linux.

Product: Polyspace Code Prover Access.
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Shared Variables Mode: Run a less extensive Code Prover analysis on
complete application to compute global variable sharing and usage
only

In R2019b, you can run a less extensive Code Prover analysis on your complete application to see a
list of all global variables and their sharing and usage.

Code Prover Verification

(@) Verify whole application

Show global variable sharing and usage only

In this mode, the analysis stops before the run-time error detection phase and the results contain:

* Global variables (shared, unshared, used, unused)
* Coding rules, if coding rule checking is enabled
* Code metrics, if code metrics computation is enabled

The Variable Access pane shows all read and write operations on global variables.
See also Show global variable sharing and usage only (-shared-variables-mode).

You can now run Code Prover on your entire application to see global variable sharing and usage, and
then run Code Prover component-by-component for run-time error detection. Previously, global
variables were reported only in the full analysis that included run-time error detection. Run-time
error detection can sometimes take significantly longer for complete applications. If you want to
review only the global variable sharing and usage in your complete application, you no longer require
the full analysis.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
Compiler Support: Set up Polyspace analysis easily for code compiled
with Cosmic compilers

If you build your source code by using Cosmic compilers, in R2019b, you can specify the compiler
name for your Polyspace analysis.

Target Environment

Compiler COSMIC e

Target processor type |s12z b

See also Cosmic Compiler (-compiler cosmic).


https://www.mathworks.com/help/releases/R2019b/codeprover/ref/showglobalvariablesharingandusageonlysharedvariablesmode.html
https://www.mathworks.com/help/releases/R2019b/codeprover/ref/cosmiccompilercompilercosmic.html

Verification Setup

You can now set up a Polyspace project without knowing the internal workings of Cosmic compilers. If
your code compiles with your compiler, it will compile with Polyspace in most cases without requiring
additional setup. Previously, you had to explicitly define macros that were implicitly defined by the
compiler and remove unknown language extensions from your preprocessed code.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Simulink Support: Analyze generated code by using contextual
buttons on the Simulink Editor toolstrip

In R2019b, a toolstrip with contextual buttons replaces the menus and toolbars in the Simulink
Editor. For details, see release notes.

Code generation and verification tasks appear in separate tabs on the Simulink toolstrip.

* To generate code, open the C Code tab. To access this tab, on the Apps tab, select Embedded
Coder.

» To analyze the generated code, open the Polyspace tab. To access this tab, on the Apps tab,
select Polyspace Code Verifier.

POLYSPACE X

@ Analyze Code from L> \r_:l % :&

mSlcchMultiBlocks < i i i
Code Setfings Run Analysis Cpen Earier Code Q_ualrly _Rer_nwf.&
Prover - Code Generated as Top Model v Analysis Results Results Metrics Highlighting
MODE PREPARE ANALYZE REVIEW RESULTS

The Simulink toolstrip includes contextual tabs, which appear only when you need them.

Additional Considerations

All menu items available earlier in the submenu Code > Polyspace now appear on the Polyspace
tab. See Changes in Polyspace Analysis Workflows in Simulink in R2019b.

Product: Polyspace Code Prover (Desktop).

Simulink Support: Verify custom code called from C Caller blocks and
Stateflow charts in context of model

In R2019b, Polyspace can check functions called from C Caller blocks and Stateflow® charts for bugs
and run-time errors. The analysis extracts the functions' inputs and other call context information
from the model.
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Analyze Code from

mSlccMultiBlocks <

"2 Custom Code Used in Model ~ ;
COMPONENT ANALYSIS OPTIONS

= Code Generated as Top Model
Code generated for standalone use

= Code Generated as Model Reference
Code generated for referencing elsewhere

Custom Code Used in Model
Custom code in G Caller blocks and Siateflow charts

o

See Run Polyspace Analysis on Custom Code in C Caller Blocks and Stateflow Charts.

With support for custom code analysis, you can:
¢ Check whether handwritten code called from model has issues:

You typically use model verification software such as Simulink Design Verifier™ to check for bugs
and run-time errors in a model. The model verification software shows only a small subset of run-
time errors in handwritten code loaded on C Caller blocks and Stateflow charts. With Polyspace,
you can check for bugs, run-time errors, coding standard violations and many other issues in
handwritten code directly from your Simulink model and supplement the checks at the model
level.

* Use call context information for handwritten functions from signal ranges in model:

The analysis uses call context information from the model. For instance, in this simple model, the
function times n is called in two C caller blocks (named Multiply unbounded input and
Multiply bounded input).

L1} 2k
L2} ab

Multiply_unbounded_input

3
=- ‘

times_m g4

x
times_m 54

alil

: _/— Multiply_bounded_input

When you analyze custom code, in this case the function times n, the analysis shows that an
operation in the custom code can overflow. From the analysis results, you can determine that the


https://www.mathworks.com/help/releases/R2019b/codeprover/ug/run-polyspace-analysis-on-custom-code-in-c-caller-blocks-and-stateflow-charts.html
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overflow occurs only when the function is called in the Multiply unbounded input block but
not when it is called from the Multiply bounded input block.

Product: Polyspace Code Prover (Desktop).
Simulink Support: Compare two Polyspace result sets and see the
effect of changes in model or code generation parameters

In R2019b, you can open previous Polyspace results on a model directly from the Simulink Editor. You
can look at two Polyspace result sets for side-by-side comparison.

POLYSPACE X

1= Ql bt 23

Analysis Open Earlier | Code Quality Remove
Results Results Metrics Highlighting

REVIEW RESULTS

Previously, you could open only the latest result from the Simulink editor. To open a previous result,
you had to locate the result outside Simulink in your file explorer and open the result in the Polyspace
user interface. You can now perform these actions more easily:

* Change a section of the model or a code generation option, regenerate code, rerun Polyspace,
open the new results, and compare with a previous result.

* Change a Polyspace analysis option, rerun Polyspace, open the new results, and compare with a
previous result.

Product: Polyspace Code Prover (Desktop).

Configuration from Build System: Compiler version automatically
detected from build system

In R2019b, if you create a Polyspace analysis configuration from your build system by using the
polyspace-configure command or in the user interface, the analysis uses the correct compiler
version for the option Compiler (-compiler) for GNU® C, Clang, and Microsoft® Visual C++®
compilers. You do not have to change the compiler before starting the Polyspace analysis.

Target Environment

Compiler gnu4.8 w

Compiler Behavior

[ ] Division round dow

Pack alignment value | ggnu?.x W

7-3


https://www.mathworks.com/help/releases/R2019b/codeprover/ref/compilercompiler.html

R2019b

Previously, if you traced your build system to create a Polyspace analysis configuration, the latest
supported compiler version was used in the configuration. If your code was compiled with an earlier
version, you might encounter compilation errors and have to explicitly specify an earlier compiler
version before starting the analysis.

For instance, if the Polyspace analysis configuration uses the version GCC 4.9 and some of the
standard headers in your GCC version include the file x86intrin.h, you can see a compilation error
such as this error:
/usr/lib/gcc/x86_64-1linux-gnu/6/include/avx512bwintrin.h, line 2427:

error: invalid type conversion
| return (_ m512i)  builtin ia32 packssdw512 mask (( v16si) A,
|
You had to connect the error to the incorrect compiler version, and then explicitly set a different
version. Now, the compiler version is automatically detected when you create a project from your
build command.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Changes in analysis options and binaries

Check MISRA C:2012 (-misra3) option values CERT-rules, CERT-all, and 1SO-17961 are
removed
Warns

Check MISRA (C:2012 (-misra3) option values CERT-rules, CERT-all, and IS0-17961 are
removed. Previously, you used Check MISRA C:2012 (-misra3) with these options values to check
your code for violations of the CERT C and ISO/IEC TS 17961 coding standards. Use a Polyspace Bug
Finder analysis with the new Coding Standards & Code Metrics analysis options Check SEI
CERT-C (-cert-c) and Check ISO/IEC TS 17961 (-iso0-17961) instead.

The new analysis options simplify checking for violations of coding standards CERT C and ISO/IEC TS
17961. For more information, see Changes in Coding Standard Checking in R2019a (Polyspace Bug
Finder) (Polyspace Bug Finder)

You get a warning when you use the removed option values. Polyspace automatically replaces the
removed option value with the value indicated in this table.

Option Replace by

-misra3 CERT-rules -misra3 all

-misra3 CERT-all

-misra3 IS0-17961

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Check MISRA C++ rules (-misra-cpp) option values CERT-rules and CERT-all are removed
Warns

Check MISRA C++:2008 (-misra-cpp) option values CERT-rules and CERT-all are removed.
Previously, you used Check MISRA C++ rules (-misra-cpp) with these options values to check your
code for violations of the CERT C++ coding standards. Use a Polyspace Bug Finder analysis with the
new Coding Standards & Code Metrics analysis option Check SEI CERT-C++ (-cert-cpp)
instead.


https://www.mathworks.com/help/releases/R2019b/codeprover/ref/checkmisrac2012misra3.html
https://www.mathworks.com/help/releases/R2019b/bugfinder/ref/checkseicertccertc.html
https://www.mathworks.com/help/releases/R2019b/bugfinder/ref/checkseicertccertc.html
https://www.mathworks.com/help/releases/R2019b/bugfinder/ref/checkisoiects17961iso17961.html
https://www.mathworks.com/help/releases/R2019b/bugfinder/ug/changes-in-coding-standard-workflow-in-r2019a.html
https://www.mathworks.com/help/releases/R2019b/codeprover/ref/checkmisrac2008misracpp.html
https://www.mathworks.com/help/releases/R2019b/bugfinder/ref/checkseicertccertcpp.html
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The new analysis option simplifies checking for violations of the CERT C++ coding standard. For
more information, see Changes in Coding Standard Checking in R2019a (Polyspace Bug Finder)
(Polyspace Bug Finder)

You get a warning when you use the removed option values. Polyspace automatically replaces the
removed option value with the value indicated in this table.

Option Replaced by

-misra-cpp CERT-rules -misra-cpp all-rules

-misra-cpp CERT-all

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Changes in MATLAB functions, options object and properties

Direct file specification not allowed for CodingRulesCodeMetrics properties that denote
rule subsets
Errors

The properties of a polyspace.Project object that indicate coding rule subsets no longer take a
text file as argument. To specify a custom subset of rules, instead of specifying a text file directly, use
the value from-file and then specify an XML file using the CheckersSelectionByFile property.
For instance, if proj is a polyspace.Project object, instead of:

proj.Configuration.CodingRulesCodeMetrics.MisraCppSubset = 'C:\rules.txt';

use:

proj.Configuration.CodingRulesCodeMetrics.MisraCppSubset = 'from-file';
proj.Configuration.CodingRulesCodeMetrics.EnableCheckersSelectionByFile = true;
proj.Configuration.CodingRulesCodeMetrics.CheckersSelectionByFile = 'C:\rules.xml';

where rules.xml contains the same specifications as rules. txt.

You can convert existing text files into XML files in the Polyspace user interface. In the Coding

Standards & Code Metrics node of the Configuration pane, click 1 In the Findings selection
window, select the files then click Save Changes. Polyspace consolidates the files into a single XML
file, and saves this file as filename.xml, where filename is the name of the first selected file
alphabetically. For instance, if you select the text files foo.conf and bar. conf, they are saved as
bar.conf.xml.

The change affects these subproperties of the CodingRulesCodeMetrics property:

* AcAgcSubset

+ JsfSubset

* MisraC3Subset
* MisraCSubset

* MisraCppSubset

See also polyspace.Project.Configuration Properties.

Product: Polyspace Code Prover (Desktop).
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Format for specifying properties of polyspace.CodingRulesOptions object changed
Errors

The properties of the polyspace.CodingRulesOptions object are now grouped into sections.
Instead of specifying a rule directly, specify the containing section first and then the rule.

For instance, if rules is a polyspace.CodingRulesOptions object that specifies MISRA C:2012
rules, instead of:

rules.rule 2 1 = false;
use:
rules.Section 2 Unused code.rule 2 1 = false;

To find the section number for a rule, see Coding Standards. To find the property corresponding to
the section name, use auto-completion for MATLAB object properties.

See also polyspace.CodingRulesOptions.
Product: Polyspace Code Prover (Desktop).

Using checkers selection file required for polyspace.CodingRulesOptions object
Errors

If you assign a polyspace.CodingRulesOptions object to an analysis configuration, for instance:
misraRules = polyspace.CodingRulesOptions('misraC2012"');

proj = polyspace.Project;

proj.Configuration.CodingRulesCodeMetrics.MisraC3Subset = misraRules;

You must also enable the use of a checkers selection file, for instance:

proj.Configuration.CodingRulesCodeMetrics.EnableCheckersSelectionByFile = true;

You have to enable checkers selection by file because the Polyspace run uses an XML file underneath
to enable the coding rule checkers. The XML file is saved in a . settings subfolder of the results
folder.

See also polyspace.CodingRulesOptions.

Product: Polyspace Code Prover (Desktop).


https://www.mathworks.com/help/releases/R2019b/codeprover/coding-rules.html
https://www.mathworks.com/help/releases/R2019b/codeprover/ref/polyspace.codingrulesoptions-class.html
https://www.mathworks.com/help/releases/R2019b/codeprover/ref/polyspace.codingrulesoptions-class.html
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Function Stub Improvements: See fewer orange checks from default
conservative assumptions on pointer arguments

In R2019b, a Code Prover analysis assumes that stubbed function arguments passed by reference or
pointer cannot remain uninitialized on return from the function. A function is stubbed if its definition
is not available for the analysis. See Stubbed Functions.

You see fewer orange checks from the previous default assumption that stubbed function arguments
that are not initialized might remain uninitialized on return from the function.

For instance, in the following example, Code Prover assumes that i is initialized on return from the
function stub. With this assumption, the non-initialized variable check on i in the line j=1i appears
green.

int main(void)
{
int i, j;
stub(&i);
j =1
return 0;

}

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access

Compatibility Considerations

You see fewer orange non-initialized variable checks compared to previous releases. To revert to the
previous conservative assumptions for specific function stubs, specify external constraints. See
External Constraints for Polyspace Analysis.

MISRA C:2012 Directive 4.12: Dynamic memory allocation shall not be
used

In R2019b, you can look for violations of MISRA C:2012 Directive 4.12. The directive states that
dynamic memory allocation and deallocation packages provided by the Standard Library or third-
party packages shall not be used. The use of these packages can lead to undefined behavior.

See MISRA C:2012 Dir 4.12.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access


https://www.mathworks.com/help/releases/R2019b/codeprover/ref/stubbed-functions.html
https://www.mathworks.com/help/releases/R2019b/codeprover/ug/drs-configuration-settings.html
https://www.mathworks.com/help/releases/R2019b/codeprover/ref/misrac2012dir4.12.html
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Code Annotations: Justify Code Prover results by using annotations
spread over multiple lines

In R2019b, you can enter multi-line code annotations to justify Polyspace results. Subsequent runs
can use these annotations and automatically populate the severity, status, and comments fields for
previously reviewed results.

See Annotate Code and Hide Known or Acceptable Results.

Previously, the entire Polyspace annotation could span one line only. With the single-line constraint
removed, you can add more detailed explanations in code annotations and view the entire annotation
in your code editor, or let your code editor wrap the annotations. For instance, you can enter a code
annotation like this annotation:

x++; /* polyspace RTE:0OVFL "This operation
cannot overflow
because of
external constraints" */

Product: Polyspace Code Prover (Desktop).


https://www.mathworks.com/help/releases/R2019b/codeprover/ug/annotate-and-hide-known-or-acceptable-results.html
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Polyspace Access Installation

User Authentication : Use LDAP search filters to restrict number of
users to authenticate

In R2019D, if you use your organization's Lightweight Directory Access Protocol (LDAP) to
authenticate users, you can filter for and load a subset of users from your LDAP database when you
start Polyspace Code Prover Access. Previously, you loaded all LDAP users listed under the LDAP
base that you specified when you started Polyspace Code Prover Access.

To filter the LDAP users, use the new LDAP search filter field in the Cluster Operator settings for
the User Manager service. For more information, see Use Your Organization LDAP.

Product: Polyspace Code Prover Access.

User Management : Update list of users from LDAP database or LDIF
file

In R2019D, if you remove users from your organization's Lightweight Directory Access Protocol
(LDAP) database or from the Polyspace Access embedded LDAP LDIF file, you can update the list of
users stored in the Polyspace Access database. Previously, users that were removed from the LDAP
database or from the LDIF file were still visible in the list of users you selected when assigning
findings or managing project permissions.

To update the list of users stored in the Polyspace Access database, append /users/list/removed
to the URL that you use to Open the Polyspace Access Web Interface. Only an Administrator can
perform this operation. For more information, see Manage LDAP Users in Polyspace Access.

Product: Polyspace Code Prover Access.
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Polyspace-only Licenses: Install Polyspace without MATLAB
installation

In R2019a, you can install the Polyspace products without a MATLAB installation.

If you use Windows® or Linux® binaries to automate your Polyspace analysis and do not otherwise use
MATLAB in your workflow, you do not require a MATLAB installation. However, if you want to use the
conveniences of MATLAB scripting such as easy reading and visualization of Polyspace results and
syntax completion for functions, you can install MATLAB separately and link with your Polyspace
installation.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access.

Compatibility Considerations

If you use MATLAB scripts to run Polyspace, you can continue to run your scripts as before. However,
your initial set up is different from previous releases:

* Run the installer twice with separate licenses to install MATLAB and Polyspace in separate
folders.

» Perform a setup step to link your Polyspace installation with your MATLAB installation.

See Integrate Polyspace with MATLAB and Simulink.

New Polyspace Products Supporting Continuous Integration: Perform
automated code analysis after code submission with Polyspace Code
Prover Server and Polyspace Code Prover Access

R2019a brings new Polyspace products for automated runs on server class machines:

* Polyspace Bug Finder Server and Polyspace Bug Finder Access
* Polyspace Code Prover Server and Polyspace Code Prover Access

The current products, Polyspace Bug Finder and Polyspace Code Prover, can be used by individual
developers on their desktops.

The new Polyspace products are designed for automated runs in a continuous integration workflow.
With the new products, the Polyspace suite of products now supports all phases of a software
development process:

* Prior to code submission:

Developers can run the Polyspace desktop products to check their code during development or
right before submission to meet predefined quality goals.

The desktop products can be plugged in IDEs such as Eclipse or run with scripts, for instance
during compilation. The analysis results can be reviewed in IDEs such as Eclipse or in the
graphical user interface of the desktop products.


https://www.mathworks.com/help/releases/R2019a/codeprover/ug/integrate-polyspace-with-matlab-and-simulink.html
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» After code submission:

The Polyspace server products can run automatically on newly committed code as a build step in a
continuous integration process (using tools such as Jenkins). The analysis runs on a server using
the product Polyspace Bug Finder Server or Polyspace Code Prover Server and the results are
uploaded to the Polyspace Access web interface for collaborative review.
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Note: Depending on the specifications, the same computer can serve as both Server 1 and Server 2.

See Polyspace Products for Code Analysis and Verification.
For more information on the new products, see:

* Polyspace Bug Finder Server
* Polyspace Code Prover Server
* Polyspace Bug Finder Access
* Polyspace Code Prover Access

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access.

Code Prover Analysis Engine Separated from Viewer: Run Code Prover
analysis on server and view the results from multiple client machines

In R2019a, you can run Code Prover on a server with the new product, Polyspace Code Prover Server.
You can then host the analysis results on the same server or a second server with the product,
Polyspace Code Prover Access. Developers whose code was analyzed and other reviewers such as
quality engineers and development managers can fetch these results from the server to their
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desktops and view the results in a web browser, provided they have a Polyspace Code Prover Access
license.

dy &y &¢
Developer Team Lead/ QA
Manager Engineer

iy cceo

Code Build Engineer
Checkdns ‘ _____________________________________

Developer

Web Browser

; é‘.

Build automation tool

‘\\‘\\ i (e.g., Jenkins) —l i :___________________________________.
. [ Sl | ' i
~ | i ! |
|
. A\ 4 ' Results Code Prover I
e ™ & ——————! Results i
_ EE"  Source code PN L . ! ! |
-~ H polyspace-code-prover-server i H
Developer P Repository i ! Bug Finder i
i ! Results

polyspace-access -upload :

i i

e - ! | ‘ !

- | i i

&g ' | |

| ! !
| server 1: Products Installed: ! | Server2: Products Installed: |

Developer ' Runs Analysis *+ Polyspace Bug Finder Server ! | HostsResults  Polyspace Access i

* Polyspace Code Prover Server ' |

Note: Depending on the specifications, the same computer can serve as both Server 1 and Server 2.

You can run the Code Prover analysis on a few powerful server class machines but view the analysis
results from many terminals.

With the desktop product, Polyspace Code Prover, you have to run the analysis and view the results
on the same machine. To view the results on a different machine, you need a second instance of a
desktop product. The desktop products can now be used by individual developers on their desktops
prior to code submission and the server products used after code submission. See Polyspace Products
for Code Analysis and Verification (Polyspace Bug Finder Server).

Product: Polyspace Code Prover Server.

Continuous Integration Support: Run Code Prover on server class
computers with continuous upload to Polyspace Access web interface

In R2019a, you can check exhaustively for run-time errors on server class machines as part of
continuous integration. When developers submit code to a shared repository, a build automation tool
such as Jenkins can perform the checks using the new Polyspace Code Prover Server product. The
analysis results can be uploaded to the Polyspace Access web interface for review. Each reviewer with
a Polyspace Code Prover Access license can login to the Polyspace Access web interface and review
the results.


https://www.mathworks.com/help/releases/R2019a/polyspace_bug_finder_server/gs/polyspace-products-for-code-analysis-and-verification.html
https://www.mathworks.com/help/releases/R2019a/polyspace_bug_finder_server/gs/polyspace-products-for-code-analysis-and-verification.html
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Note: Depending on the specifications, the same computer can serve as both Server 1 and Server 2.

See:

+ Install Polyspace Server and Access Products
* Run Polyspace Code Prover on Server and Upload Results to Web Interface

The continuous integration support with the Polyspace Server and Access products enables the
following:

* Automated post-submission checks: In a continuous integration process, build scripts run
automatically on new code submissions before integration with a code base. With the new product
Polyspace Code Prover Server, a Code Prover analysis can be included in this build process. The
analysis can run Code Prover checks on the new code submissions and report the results. The
results can be reviewed in the Polyspace Access web interface with a Polyspace Code Prover
Access license.

* Collaborative review: The analysis results can be uploaded to the Polyspace Access web interface
for collaborative review. For instance:

* Each quality assurance engineer with a Polyspace Code Prover Access license can review the
Code Prover results for a project and assign issues to developers for fixing.

* Each development team manager with a Polyspace Code Prover Access license can see an
overview of Code Prover results for all projects managed by the team (and also drill down to
details if necessary).

For further details, see the release notes of Polyspace Code Prover Access .

Product: Polyspace Code Prover Server.


https://www.mathworks.com/help/releases/R2019a/polyspace_code_prover_server/gs/install-products-required-for-polyspace-analysis-on-server.html
https://www.mathworks.com/help/releases/R2019a/polyspace_code_prover_server/gs/run-code-prover-on-server.html
https://www.mathworks.com/help/releases/R2019a/polyspace_code_prover_access/release-notes.html
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Continuous Integration Support : Set up testing criteria based on
Code Prover static analysis results

In R2019a, you can run Code Prover on server class machines as part of unit and integration testing.
You can define and set up testing criteria based on Code Prover static analysis results.

For instance, you can set up the criteria that new code submissions must have zero red checks
(definite run-time errors) before integration with a code base. Any submission with red checks can
cause a test failure and require code fixes.

See:

* polyspace-code-prover-server for how to run Code Prover on servers.

* polyspace-access for how to export Code Prover results for comparison against predefined
testing criteria.

If you use Jenkins for build automation, you can use the Polyspace plugin. The plugin provides helper
functions to filter results based on predefined criteria. See Sample Scripts for Polyspace Analysis with
Jenkins.

The continuous integration support with the Polyspace Server and Access products enables the
following:

* Automated testing: After you define testing criteria based on Code Prover results, you can run the
tests along with regular dynamic tests. The tests can run on a periodic schedule or based on
predefined triggers.

* Prequalification with Polyspace desktop products: Prior to code submission, to avoid test failures,
developers can check their submission with the same criteria as the server-side analysis. Using an
installation of the desktop product, Polyspace Code Prover, developers can emulate the server-
side analysis on their desktops and review the results in the user interface of the desktop product.
For more information on the complete suite of Polyspace products available for deployment in a
software development workflow, see Polyspace Products for Code Analysis and Verification
(Polyspace Bug Finder Server).

To save processing power on the desktop, the analysis can also be offloaded to a server and only
the results reviewed on the desktop. See Install Products for Submitting Polyspace Analysis from
Desktops to Remote Server (Polyspace Bug Finder Server).

Product: Polyspace Code Prover Server.

Continuous Integration Support: Set up email notification with
summary of Code Prover results after analysis

In R2019a, you can set up email notification for new Code Prover results. The email can contain:

* A summary of new results from the latest Code Prover run only for specific files or modules.

e An attachment with a full list of the new results. Each result has an associated link to the
Polyspace Access web interface for more detailed information.
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Jenkins General Report - Code_Prover Example#51
To  John Smith

report.csv .
X 459 KB

The attached file contains 127 findings from Code_Prover_Example#51 that are assigned to you.
Number of findings: 127

Types of findings:

Run-time Checks (Color: Red)
MISRA C:2012 violations (Category: Required)

View findings in Polyspace Code Prover Access: http:my-host-name:5443/metrics/index.himl?a=review&p=187&r=1235

See Send E-mail Notifications with Polyspace Code Prover Results.

The continuous integration support with the Polyspace Server and Access products enables the
following:

» Automated notification: Developers can get notified in their e-mail inbox about results from the
last Code Prover run on their submissions.

* Preview of Code Prover results: Developers can see a preview of the new Code Prover results.
Based on their criteria for reviewing results, this preview can help them decide whether they want
to see further details of the results.

* Easy navigation from e-mail summary to Polyspace Access web interface: Each developer with a
Polyspace Code Prover Access license can use the links in the e-mail attachments to see further
details of a result in the Polyspace Access web interface.

Product: Polyspace Code Prover Server.

Offloading Polyspace Analysis to Servers: Use Polyspace desktop
products on client side and server products on server side

In R2019a, you can offload a Polyspace analysis from your desktop to remote servers by installing the
Polyspace desktop products on the client side and the Polyspace server products on the server side.
After analysis, the results are downloaded to the client side for review. You must also install MATLAB
Parallel Server on the server side to manage submissions from multiple client desktops.


https://www.mathworks.com/help/releases/R2019a/polyspace_code_prover_server/gs/sample-e-mail-templates-for-e-mails-with-polyspace-results.html
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See Install Products for Submitting Polyspace Analysis from Desktops to Remote Server.

You can also follow a workflow where Polyspace runs on a dedicated server after code submission and
uploads results to a web interface for review. In this case, you require one or more Polyspace Code
Prover Server license for running the analysis on dedicated servers and Polyspace Code Prover
Access licenses to review the results.

The Polyspace desktop products have a graphical user interface. You can configure options in the

user interface with assistance from features such as auto-population of option arguments and

contextual help. To save processing time on your desktop, you can then offload the analysis to remote
servers.

Product: Polyspace Code Prover (Desktop).

Compatibility Considerations

If you offloaded analysis results from your desktop to remote servers prior to R2019a, your initial
setup is different from previous releases.



https://www.mathworks.com/help/releases/R2019a/codeprover/gs/set-up-dispatch-of-polyspace-analysis-to-remote-servers-with-matlab-parallel-server.html
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On the client side, you do not require Parallel Computing Toolbox™. You only require the
Polyspace desktop product, Polyspace Code Prover.

On the server side, instead of the desktop product, Polyspace Code Prover, you must install the
server product, Polyspace Code Prover Server. You still require MATLAB Parallel Server
(previously called MATLAB Distributed Computing Server).

You install the Polyspace server products and MATLAB Parallel Server in separate folders and link
between them.

See Install Products for Submitting Polyspace Analysis from Desktops to Remote Server.

You do not have the quick start option to start the server with one worker (the Metrics and
Remote Analysis Server Settings interface). Instead you must use the Admin Center interface
in MATLAB Parallel Server. In this workflow, you first start the services on all remote computers,
then assign responsibilities to these computers as either the head node that schedules jobs or
worker nodes that run the analysis.

See Install Products for Submitting Polyspace Analysis from Desktops to Remote Server.

Collaborative Review Support : Upload results from Polyspace user
interface to Polyspace Access web interface and share results using
web links

In R2019a, you can upload Polyspace Code Prover results from the user interface of the desktop
products to the Polyspace Access web interface. Developers with a Polyspace Code Prover Access
license can review these results in the web interface and share the results using web links.

To upload results from the Polyspace user interface, select Tools > Preferences. On the Server
Configuration tab, enter the URL of the Polyspace Access web interface and the client keystore path
and password.
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Polyspace Preferences ot

Tools Menu Review Statuses Miscellaneous Character Encoding Review Scope
Server Configuration Project and Results Folder Editors
MATLAE Parallel Server duster configuration
Job scheduler host name (or Cluster Profile name): |localhost Cluster Profile Manager: Settings

Parallel computing username: jsmith

Localhost IP address;

Polyspace Metrics has been removed.
To continue managing code quality metrics in a web dashboard, use Polyspace Access instead.

See details in documentation

Polyspace Access web interface configuration

Review source code and monitor project metrics in an intuitive web interface that is integrated with your bug tradking tool.
Log in through a web browser to begin your collaborative review process,

Polyspace Access URL: https: /faccess-machine. company. com: 3443

For https protocol
Client keystore path: C:Wsersijsmith \certificates\dient-cert. jks i

Client keystore password: "-uuu-nu-|

Chedk Polyspace Access connection

Enable the launching of this desktop UI from the Polyspace Access web interface:

Register Polyspace UL

Ok Apply Cancel

After setting up communication between the Polyspace user interface and the Polyspace Access web
interface, the Access menu appears in the Polyspace user interface. You can use this menu to open
the web interface, open results from the web interface in the user interface of the desktop product or
upload results from the desktop product to the web interface.
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Open Result...
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Upload Result...
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For details about setting up and reviewing results in the Polyspace Access web interface, see
Polyspace Code Prover Access documentation.

Product: Polyspace Code Prover Access.

Compiler Support: Set up Polyspace analysis easily for code compiled
with ARM v5 and v6 compilers

If you build your source code using these compilers, in R2019a, you can specify the compiler name
for your Polyspace analysis:

* ARM®v5

Target Environment

Compiler

Target processor type

armec R

arm L

You can specify tar

See ARM v5 Compiler (-compiler armcc).

* ARMv6

get arm.

Target Environment

Compiler

Target processor type

armdang Ea

arm R

You can specify tar

See ARM v6 Compiler (-compiler armclang).

gets arm and armé4.

You can now set up a Polyspace project without knowing the internal workings of these compilers. If
your code compiles with your compiler, it will compile with Polyspace in most cases without requiring
additional setup. Previously, you had to explicitly define macros that were implicitly defined by the

compiler and remove unknown language extensions from your preprocessed code.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
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Updated GCC, Clang, and Visual C++ Compiler Support: Set up
Polyspace analysis easily for code compiled with GCC versions 7.x,
Clang versions 4.x or 5.x, or Microsoft Visual C++ 2017 compilers

In R2019a, if you build your source code using these version of GCC, Clang, or Microsoft Visual C++
compilers, you can specify the following compiler option values to setup your Polyspace analysis:

¢ |Target Environment

Compiler anu7.x o

Target processor type | x86_64 e

gnu7.x for GCC release 7.1, 7.2, and 7.3.

¢ |Target Environment

Compiler Hang4.x Lo

Target processor type | x86_64 e

clang4.x for LLVM release 4.0.0, and 4.0.1.

¢ |Target Environment

Compiler iHang5.x Lo

Target processor type | x86_64 o

clang5. x for LLVM release 5.0.0, and 5.0.1.

¢ |Target Environment

Compiler wisual15.x P

Target processor type | x86_64 w

visuall5. x for Microsoft Visual C++ 2017 versions 15.0 to15.7.

The analysis can interpret macros that are implicitly defined by the compiler and compiler-specific
language extensions such as keywords and pragmas.

For more information, see Compiler (-compiler).
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
Simulink Toolstrip: Analyze generated code using contextual buttons

in Simulink Editor

In R2019a, you have the option to turn on the Simulink Toolstrip.

* To enable the toolstrip, select File > Simulink Preferences. On the Editor node, select Replace
menus and toolbars with the Simulink Toolstrip (Tech Preview).


https://www.mathworks.com/help/releases/R2019a/codeprover/ref/compilercompiler.html
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» To disable the toolstrip, on the Modeling tab, select Environment > Simulink Preferences.
Clear the previous selection.

See Simulink Toolstrip Tech Preview replaces menus and toolbars in the Simulink Desktop for more
details.

The Simulink Toolstrip includes contextual tabs, which appear only when you need them. The
Polyspace contextual tab includes options for completing actions that apply only to Polyspace.

* To generate code, open the C Code tab. To access this tab, on the Apps tab, select Embedded
Coder.

» To analyze the generated code, open the Polyspace tab. To access this tab, on the Apps tab,
select Polyspace Code Verifier.

SIMULATION POLYSPACE

%

Verification
Objectives =

@ Analyze Code from l/ .__‘ E:;

psdemo_model_link_sl == . . -
Settings Run Analysis Code Quality Remaove
-

@ Component ¥ Analysis Results Metrics Highlighting

On the Polyspace tab:

1 After code generation, from the Verification Objectives menu, choose Find Bugs (Bug Finder)
or Prove Code (Code Prover).

2 Optionally, configure code analysis options. To configure the basic options related to the model,
select Settings > Polyspace Settings. To configure advanced options related to the generated
code, select Settings > Project.

3 To start an analysis, select Run Analysis. The analysis runs on the model element selected,
provided code has been generated earlier from the same element. The selected element appears
in the Analyze Code from field. To select the entire model, click anywhere on the canvas outside
a model element.

Product: Polyspace Code Prover (Desktop).

Compatibility Considerations

The Simulink Toolstrip included with R2019a is a tech preview. You may encounter performance
issues when you enable the toolstrip. Documentation does not reflect the addition of the Simulink
Toolstrip and toolstrip customization is not available.

Changes in analysis options and binaries

polyspace-code-prover-nodesktop renamed to polyspace-code-prover
Warns

The command-line options available with polyspace-code-prover are the same as those with
polyspace-code-prover-nodesktop (with the exception of changes mentioned below). Simply
replace polyspace-code-prover-nodesktop with polyspace-code-prover in your batch files
or shell scripts. This feature applies to Code Prover only.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server
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-report-template arguments changed for coding standard templates
Warns

If you used the template CodingRules. rpt for the option - report-template, use the new
CodingStandards. rpt template instead.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Check MISRA C:2012 (-misra3) option values CERT-rules, CERT-all, and 1SO-17961 are
removed
Warns

Check MISRA (C:2012 (-misra3) option values CERT-rules, CERT-all, and IS0-17961 are
removed. Previously, you used Check MISRA C:2012 (-misra3) with these options values to check
your code for violations of the CERT C and ISO/IEC TS 17961 coding standards. Use a Polyspace Bug
Finder analysis with the new Coding Standards & Code Metrics analysis options Check SEI
CERT-C (-cert-c) and Check ISO/IEC TS 17961 (-is0-17961) instead.

The new analysis options simplify checking for violations of coding standards CERT C and ISO/IEC TS
17961. For more information, see Changes in Coding Standard Checking in R2019a (Polyspace Bug
Finder)

You get a warning when you use the removed option values. This feature applies to Code Prover Only.
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Check MISRA C++ rules (-misra-cpp) option values CERT-rules and CERT-all are removed
Warns

Check MISRA C++:2008 (-misra-cpp) option values CERT-rules and CERT-all are removed.
Previously, you used Check MISRA C++ rules (-misra-cpp) with these options values to check your
code for violations of the CERT C++ coding standards. Use a Polyspace Bug Finder analysis with the
new Coding Standards & Code Metrics analysis option Check SEI CERT-C++ (-cert-cpp)
instead.

The new analysis option simplifies checking for violations of the CERT C++ coding standard. For
more information, see Changes in Coding Standard Checking in R2019a (Polyspace Bug Finder)

You get a warning when you use the removed option values. This feature Applies to Code Prover Only.
Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Syntax changed for options that take C++ templates as arguments
Errors

If you use options that take instantiations of C++ templates as arguments, you have to provide the
option arguments differently. For instance, for this template function getMax:

template <class T>

T GetMax (T a, T b) {
T result;
result = (a>b)? a : b;
return (result);

}

template int GetMax<int>(int, int); // explicit instantiation


https://www.mathworks.com/help/releases/R2019a/bugfinder/ref/checkmisrac2012misra3.html
https://www.mathworks.com/help/releases/R2019a/bugfinder/ref/checkseicertccertc.html
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If you previously specified the instantiation as argument for the option Functions to call (-
main-generator-calls) in this way:

-main-generator-calls custom="T1l getMax<T1>(T1,T1l) [with Tl=int]"
You now specify the option argument as:
-main-generator-calls custom="T1l getMax<int>(T1,T1)"

This syntax change applies to all options that take instantiations of templates as arguments.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server

Changes in MATLAB functions, options object and properties

Initial setup required for running Polyspace from MATLAB
Behavior change

If you use MATLAB scripts to run Polyspace, you can continue to run your scripts as before. However,
your initial setup is different compared to previous releases:

* Run the MathWorks® installer twice with separate licenses to install MATLAB and Polyspace in
separate folders.

* Perform a setup step to link your Polyspace installation with your MATLAB installation.
See Integrate Polyspace with MATLAB and Simulink (Polyspace Bug Finder).
Product: Polyspace Code Prover (Desktop).

polyspaceCodeProverNodesktop removed
Warns

Use polyspaceCodeProver(projectFile, '-nodesktop') instead of
polyspaceCodeProverNodesktop(projectFile).

Product: Polyspace Code Prover (Desktop).

CodeProverReportTemplate property value changed for coding standard compliance
reports
Warns

To update your MATLAB code, use the new template CodingStandards for the property
CodeProverReportTemplate:

proj = polyspace.Project;
proj.Configuration.MergedReporting.BugFinderReportTemplate = 'CodingStandards"';

instead of the old template CodingRules.
Product: Polyspace Code Prover (Desktop).

Property CustomRulesSubset is removed
Errors

CodingRulesCodeMetrics property CustomRulesSubset is removed. Previously, you used this
property to specify the path to the file where you defined custom naming conventions to check
against. Use the new property CheckersSelectionByFile instead.
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With the new property, you specify a file in . xml format where you define custom rules to match
identifiers in your code, and custom selections of checkers for all the coding standards that Polyspace
supports. See Set checkers by file (-checkers-selection-file).

To update your MATLAB code, see this table.

opts = polyspace.Project;

Property

Use Instead

opts.CodingRulesCodeMetrics. ..
.EnableCustomRules=1;
opts.CodingRulesCodeMetrics. ..
.CustomRulesSubset="custom rules.txt';

opts.CodingRulesCodeMetrics. ..
.EnableCustomRules=1;
opts.CodingRulesCodeMetrics. ..
.EnableCheckersSelectionByFile=1;
opts.CodingRulesCodeMetrics. ..
.CheckersSelectionByFile="'custom rules.xml;

For more information, see polyspace.Project.Configuration Properties.

Product: Polyspace Code Prover (Desktop).

Option values CERT-rules, CERT-all, and 1SO-17961 are removed for
CodingRulesCodeMetrics property MisraCSubset

Errors

MisraCSubset option values CERT-rules, CERT-all, and IS0-17961 are removed. Previously, you
used MisraCSubset with these options values to check your code for violations of the CERT C and
ISO/IEC TS 17961 coding standards. Use a Polyspace Bug Finder analysis with the new
CodingRulesCodeMetrics properties CertC and EnableIs017961 instead.

The new CodingRulesCodeMetrics properties simplify checking for violations of coding standards

CERT C and ISO/IEC TS 17961.

For more information, see polyspace.Project.Configuration Properties.

Product: Polyspace Code Prover (Desktop).

Option values CERT-rules and CERT-all are removed for CodingRulesCodeMetrics property

MisraCppSubset
Errors

MisraCppSubset option values CERT-rules and CERT-all are removed. Previously, you used
MisraCSubset with these options values to check your code for violations of the CERT C++ coding
standard. Use a Polyspace Bug Finder analysis with the new CodingRulesCodeMetrics property

CertCpp instead.

The new CodingRulesCodeMetrics property simplifies checking for violations of the CERT C++

coding standard.

For more information, see polyspace.Project.Configuration Properties.

Product: Polyspace Code Prover (Desktop).
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Recursion Detection: See list of recursion cycles in C/C++ project

In R2019a, the code metrics Number of Recursions and Number of Direct Recursions are
displayed along with a list of recursion cycles in your project.

* For the metric Number of Direct Recursions, the list shows all direct recursions (self recursive
functions or functions calling themselves).

* For the metric Number of Recursions, the list shows all direct recursions plus a partial list of
indirect recursion cycles. For details, see Number of Recursions.

* Number of Recursions (Value: 1) &
This metric shows the number of recursions, both direct and indirect.

Event File Scope Line

1 Recursion cyce: operation1 => operation3 == operation4 => operation5 recursion.c  recursion.c 3

The new display of recursion cycles enables the following:

» Easier navigation to recursion cycles: Each row in the list shows one recursion cycle. You can click
a row to navigate to one of the functions involved in the recursion cycle.

* Checking metric computation: You can check the value of the code metrics Number of
Recursions and Number of Direct Recursions.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover
Access

Compatibility Considerations

A slightly different algorithm is used to compute the number of recursions. You can see a different
value of this metric compared to previous releases. For computation details, see Number of
Recursions.

Infinite Recursions: Simple infinite recursions detected by checks for
non-terminating calls

In R2019a, Polyspace Code Prover can prove that a call to a function that contains an infinite
recursion does not terminate (in simple cases). The analysis shows a red Non-terminating call
check on these calls.

For instance, in this example, calls to Too() do not terminate:

void foo(int arg) {
foo(arg);
}
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Updated code metrics specifications

In R2019a, these code metric specifications have been updated.

Code Metric

Update

Number of Function Parameters

In cases where a C++ function returns an object,
you can see a decrease in number of function
parameters.

Previously, the metric incorrectly included
additional parameters corresponding to
Polyspace internal variables.

Number of Recursions

You can see a change in the number of recursions
in your project.

The algorithm to compute recursions is slightly
different from previous releases. The metric
reports the number of direct recursions plus the
number of strongly connected components
formed by the indirect recursion cycles.

The metric is also supported with events showing
the recursion cycles. For details, see the release
note about Recursion Detection.

Number of Paths

You can see a high value of the metric in some
cases where the metric value was previously
reported as zero.

The number of paths increases exponentially with
the branching in the code. If the number of paths
exceeds an internal limit, the metric calculation
stops and reports the value
9223372036854775807 (indicating the
hexadecimal value Ox7fffffffffffffff). Previously, the
metric value was reported as zero in those cases.
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Code Metric

Update

Code complexity metrics for C++ templates

If you use C++ templates, you can see a
difference in the value of certain metrics.

Each instantiation of a C++ template is
considered as a separate function. Code
complexity metrics are reported separately for
each instantiation.

For instance, consider the function template
GetMax instantiated twice in main:

// function template
#include <iostream>
using namespace std;

template <class T>

T GetMax (T a, T b) {
T result;
result = (a>b)? a : b;
return (result);

}

int main () {
int i=5, j=6, k;
long 1=10, m=5, n;
k=GetMax<int>(i,j);
n=GetMax<long>(1,m);
cout << k << endl;
cout << n << endl;
return 0;

}

In R2019a, the two instantiations of GetMax are
considered as separate functions. All code
metrics are reported separately for the two
instantiations. Further, the number of called
functions in main is 2.

Previously, the two instantiations were
considered as one.

Stack usage metrics, for instance, Minimum
Stack Usage and Maximum Stack Usage.

Stack usage takes into account variable
parameters of variable-argument or variadic
functions. Previously, only the fixed parameters
were taken into account.
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Code Metric

Update

Sizes of local variables and stack usage metrics

You see a decrease in the metrics for a function if
a local variable is an instance of a C++ class that
inherits virtually from another class. Previously, a
Polyspace internal variable was used to keep
track of the virtual inheritance and the internal
variable was taken into account in the size
metrics. The calculation no longer considers the
internal variable.

For instance, consider this example:

class A { virtual void f(); };
class B : virtual A { };

Previously, the size of an object of type A was
shown as 8 and B as 16. Now both sizes are
calculated as 8.

Products: Polyspace Code Prover (Desktop), Polyspace Code Prover Server, Polyspace Code Prover

Access

Compatibility Considerations

If you compute these code metrics, you can see a difference in results compared to previous releases.
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Reviewing Results

Source Code Navigation: Keep result pinned while navigating through
source code

In R2019a, clicking a result in the source code does not change the result selection on the Results
List and the details on the Result Details pane.

For instance, in this example, the result Non-terminating call is selected on the Results List pane.
The corresponding source code (line 150) appears on the Source pane and further details about the
result on the Result Details pane. If you then navigate through the source code and select a token
highlighting another result (for instance, the orange / operator in line 135), the selection in the
results list and the details still show the Non-terminating call result.
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To find the root cause of a result, you have to navigate through the source code. You can keep the
result pinned on the Results List and Result Details pane during this navigation.

Product: Polyspace Code Prover (Desktop).
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Compatibility Considerations

Previously, if you clicked a token in the source code showing a result, the selection on the Results
List pane and the information on the Result Details pane changed to the clicked result. To emulate
this behavior, Ct rl-click the token in the source code or right-click and select Select Results At
This Location.

Report Generation: Generate Polyspace reports faster than previous
releases

In R2019a, Polyspace report generation uses a more optimized algorithm.

You can now generate PDFE, HTML or Microsoft Word reports from Polyspace results much faster than
before. For large reports, report generation can be more than ten times faster than before.

Product: Polyspace Code Prover (Desktop).

Report Generation : Generate single file for HTML reports
In R2019a, if you generate an HTML report, a single HTML file is created.

The single HTML file allows easier archiving. Previously, several companion files were generated in
HTML reporting. You had to archive all files together to be able to view the HTML report.

Product: Polyspace Code Prover (Desktop).

Compatibility Considerations

The structure of the new HTML report is different from prior releases. If you used scripts to parse the
HTML reports, you might have to adapt the scripts to the new HTML structure.

Project Dashboard : Track progress of code quality via Polyspace
results

In R2019a, you can track the progress of the code quality of your projects using the new intuitive
Polyspace Code Prover Access DASHBOARD. When an analysis run is uploaded to the Polyspace
Access database, the dashboard updates to give a snapshot of all the available findings, including a
progress trend for number of findings compared to previous runs.
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» Prioritize reviews: See new and open issues that have not been fixed or justified, then open a
detailed results list for just those issues. You can drill down on a set of findings filtered by new,
open, unassigned, by family of findings, or by file.

» Aggregate results for multiple projects: If your team works on multiple projects, you can move all
of those under an umbrella project and view a snapshot of the code quality for all your team's

projects.

* Authenticate client access: The web interface is behind a login. Only users with a Polyspace Code
Prover Access license and the appropriate credentials can view the dashboard from their web

browser.

Product: Polyspace Code Prover Access.
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Project Dashboard : Compare Polyspace Code Prover results against
Software Quality Objectives

In R2019a, check the quality of your code against pre-defined quality objective thresholds using the
new Polyspace Code Prover Access Quality Objectives dashboard web interface. Use the thresholds
to establish PASS/FAIL criteria for the code quality of your projects. For instance, the dashboard
displays the progress and remaining open issues across thresholds and categories of findings. Use the
available dropdown menu to select a threshold and see a more detailed view of completion by

category of finding.
Project Overview Quality Objectives
EI@ Summary |@ Quality Objectives Settings |

Polyspace Software Quality Objectives

0
P 7%
@ .
% 1,983 F Exhaustive
Remaining Threshold

B Details
Group SQo1 $Qo2
SQ0 progress

0% I 12%
Total Open Issues 55 109
Code Metrics 55 55
Coding Rules
Defects 54

Progress

Done

Open

Code Metrics
0%
55

SQoO3

12%
109

Coding Rules
0%

1676

5Q04
/ 29%
165

10

Defects
38%
252

5Q05
/ 29%
165

110

SQ06

/ 34%

307

2562

Exhaustive @

7%
1,983

55
1,676

252

The Quality Objectives dashboard allows you to drill down to categories of open issues for each
threshold. Click a cell in the table to open a list of findings you need to address to pass a given quality

objective threshold.

Product: Polyspace Code Prover Access.

Collaborative Review Support : Review Polyspace Code Prover results
and source code in web browser

In R2019a, review Polyspace analysis findings and view the findings in your source code using the
new Polyspace Code Prover Access REVIEW web interface. You do not need to install a Polyspace

product on your machine to open and review analysis results.
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The REVIEW perspective of the Polyspace Access web interface:

* Facilitates collaborative review: The web interface streamlines the review efforts of your team. For
instance:

During a team meeting, findings can be assessed and assigned to developers.

Developers can log into the web interface to review findings assigned to them, and determine
whether to justify the findings or fix them.

A project manager can track the progress of the review by filtering the list of results for
findings that are still open.

» Authenticates client access: The web interface is behind a login. Only users with a Polyspace Code
Prover Access license and the appropriate credentials can view the results from their web
browser.

Product: Polyspace Code Prover Access.
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Collaborative Review Support : Share Polyspace Code Prover results
using web links

In R2019a, you can right-click an analysis result in the Polyspace Code Prover Access interface to
obtain a URL that you can share with other team members. The link that you provide opens the

Polyspace Code Prover Access interface and displays the finding along with the corresponding source
code.
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Product: Polyspace Code Prover Access.

Project Authorization Management : Create and enforce authorization

policies for access to project

In R2019a, you can manage project users in Polyspace Code Prover Access by right-clicking a project
in the PROJET EXPLORER and assigning roles to member of your team. The roles authorize or

forbid users from viewing projects.
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The ability to authorize access to projects allows you to:
* Restrict access to your source code: Use the authorization policy to restrict who can view the
source code you upload with your analysis results.

» Display relevant projects only: When they log in to Polyspace Access, users can only see projects
for which they are administrators, owners, or contributors. Use the authorization policy so that
team members only see projects that they are working on.

Product: Polyspace Code Prover Access.
Bug Tracking Tool Support : Create JIRA issues for Polyspace Code
Prover results and assign to developer

In R2019a, Polyspace Code Prover supports integration with the JIRA software. If you have an
instance of the JIRA software, after you configure Polyspace Code Prover, you can create a JIRA ticket
to track Polyspace findings. The ticket is populated with details of the finding and a link to open that
finding in Polyspace Access. You can add the ticket to any existing JIRA project.
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Once you create a ticket, the Result Details pane in the Polyspace Code Prover web interface
displays a link to the corresponding JIRA issue.

Product: Polyspace Code Prover Access.
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Configuration from Build System: Automatically generate Polyspace
configuration modules from build system

In R2018b, you can create a separate Polyspace analysis module for each binary in your build system.

Suppose a build system has the following dependencies and creates four binaries: the executables
foo0.exe and bar.exe, and the dynamic libraries util.d1ll and gui.dll.

Previously, you created a single Polyspace options file from this build system. You can now create a
separate Polyspace options file for each binary created in your build system.

See also:

* Modularize Polyspace Analysis by Using Build Command

* polyspace-configure

The ability to generate configuration modules from build system has the following benefits:

* More precise analysis: You can perform a separate Polyspace analysis for each binary in your build

system. The analysis does not mix files from distinct binaries.

* Automated modularization: You can reuse the modularization in your build system to create the
Polyspace analysis modules.

» Focused analysis: You can analyze only specific modules instead of your entire code base.

* Minimal knowledge of build system required: You do not need to know the details of your build
system. With a -module flag, a separate options file is created for each binary in your build
system. You can analyze only the code implementation of the binaries that you are interested in.

C11 and C++14 Support: Run Polyspace analysis on code with C11 or
C++14 features

In R2018b, Polyspace can interpret the majority of C11 or C++14-specific features.


https://www.mathworks.com/help/releases/R2018b/codeprover/ug/modularize-polyspace-analysis-using-build-command.html
https://www.mathworks.com/help/releases/R2018b/codeprover/ref/polyspaceconfigurecommand.html

Verification Setup

Target Language

Source code language C

C standard version

Target Language

Source code language CPP

ic11 |~ C++ standard version | cppl4 v

See also C/C++ Language Standard Used in Polyspace Analysis.

You can now setup a Polyspace analysis for code containing C11 or C++14-specific features.
Previously, some features were not recognized and caused compilation errors.

Autodetection of Concurrency Primitives: Multitasking model detected
from C11 multithreading functions

In R2018D, if you use C11 functions for multitasking, the Polyspace analysis can interpret them
semantically.

Polyspace interprets the following functions:

* thrd create: Thread is created.
+ mtx_ lock: Critical section begins.
* mtx_unlock: Critical section ends.

See also Auto-Detection of Thread Creation and Critical Section in Polyspace.

You do not have to adapt your code or specify your multitasking model manually through analysis
options. The analysis determines your multitasking model from the functions in your code and finds
data races or other concurrency defects.

Compiler Support: Set up Polyspace analysis easily for code compiled
with Renesas compilers

If you build your source code with the Renesas compiler, in R2018b, you can specify the compiler

name for your Polyspace analysis. The analysis can interpret macros that are implicitly defined by the
compiler and compiler-specific language extensions such as keywords and pragmas.

You can specify these target processors directly: r178, rh850, or rx. See Renesas Compiler (-
compiler renesas).

Target Environment

Compiler renesas D

Target processor type |rl78 £

You can now set up a Polyspace project without knowing the internal workings of the Renesas
compilers. If your code compiles with your compiler, it will compile with Polyspace in most cases
without requiring additional setup. Previously, you had to explicitly define macros that were implicitly
defined by the compiler and remove unknown language extensions from your preprocessed code.
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AUTOSAR Support: Provide multiple root folders for sources

In R2018Db, you can specify multiple root folders for source code when running Polyspace Code Prover
on AUTOSAR software components.

polyspace-autosar -create-project PROJECT FOLDER
-arxml-dir AUTOSAR FOLDER
-sources-dir CODE_FOLDER1 -sources-dir CODE_FOLDER2 ...
[OPTIONS]

See polyspace-autosar.

If you have source folders outside your main source hierarchy, for instance source code libraries, you
can specify them with the polyspace-autosar command.

AUTOSAR Support: Run Polyspace on AUTOSAR software components
by using MATLAB scripts

In R2018b, you can run Polyspace Code Prover on code implementation of AUTOSAR software
components using MATLAB scripts.

exampleDir = fullfile(matlabroot, 'help',...

‘toolbox', 'codeprover', 'examples', 'polyspace autosar');
arxmlDir = fullfile(exampleDir, ‘'arxml');
sourceDir = fullfile(exampleDir, 'code');

tempDir = tempdir;

projectDir = fullfile(tempDir, 'polyspace');

status = polyspaceAutosar('-create-project', projectDir,
"~arxml-dir', arxmlDir,
'-sources-dir', sourceDir);

See also polyspaceAutosar.

You can use MATLAB scripts to automate the modularized Polyspace analysis of AUTOSAR code.

AUTOSAR Support: Provide compiler options by tracing your build
command

In R2018b, you can trace your build command to gather compiler options, macro definitions and
paths to include folders, and provide this information for analysis of code implementation of
AUTOSAR software components.

1 Trace your build command (for instance, make) with polyspace-configure and generate an
options file for subsequent Code Prover analysis. Suppress inclusion of sources in the options file
with the -no-sources option.

polyspace-configure -output-options-file options.txt -no-sources make

2 Run Code Prover on AUTOSAR code with polyspace-autosar. Provide your ARXML folder,
source folders and other options. In addition, provide the earlier generated options file with the -
extra-options-file option.

polyspace-autosar -create-project projFolder \
-arxml-dir arxmlFolder \


https://www.mathworks.com/help/releases/R2018b/codeprover/ref/polyspaceautosarcommand.html
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-sources-dir codeFolder \
-extra-options-file options.txt

See also:

* Run Polyspace on AUTOSAR Code Using Build Command
* polyspace-configure and polyspace-autosar

You can now automate the Code Prover analysis of AUTOSAR code by reusing the infrastructure you
have already set up.

* Reusing build command: You reuse the compiler options specified in your build command for the
Code Prover analysis. Code Prover can emulate your compiler and recognize compiler-specific
macros and language extensions.

* Reusing ARXML specifications: You reuse the ARXML specifications to perform a modular Code
Prover analysis. Code Prover can modularize your code based on the software components in the
ARXML specifications. See also Benefits of Polyspace for AUTOSAR.

Function Pointer Calls: Verify functions called through function
pointers despite type mismatch

In R2018b, Code Prover can verify functions called through function pointers even if there is a type
mismatch between the function argument(s) and/or return type and the function pointer argument(s)
and/or return type.

For instance, in this example, function pointer obj fptr has an argument that is a pointer to a four-
element array. obj fptr points to a function foo whose corresponding argument is a pointer to a
three-element array.

typedef int array four_elements[4];
typedef void (*fptr)(array four elements*);

typedef int array three elements[3];
void foo(array_three elements*);

void main() {

array_four _elements arr[4] = {0,0,0,0};
array_four_elements *ptr;

fptr obj fptr;

ptr = &arr;
obj fptr = &foo;

obj fptr(&ptr);
}

void foo(array_three elements* x) {

}

By default, the analysis does not check functions called through mismatched function pointers. Use
the option Permissive function pointer calls (-permissive-function-pointer).

Only type mismatches between pointer types are allowed. Type mismatches between nonpointer
types cause compilation errors.


https://www.mathworks.com/help/releases/R2018b/codeprover/ug/run-polyspace-on-autosar-code-using-build-command.html
https://www.mathworks.com/help/releases/R2018b/codeprover/ref/polyspaceconfigurecommand.html
https://www.mathworks.com/help/releases/R2018b/codeprover/ref/polyspaceautosarcommand.html
https://www.mathworks.com/help/releases/R2018b/codeprover/ug/polyspace-for-autosar.html
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If you cannot fix type mismatches between a function pointer and the pointed function, you can still
analyze the function body. Previously, Code Prover displayed an orange check on the function call and
did not check the function body for run-time errors.

Check Behavior on Overflows: Fine-tune the behavior of checks based

on signedness of integer
Behavior change

In R2018Db, you can set different behaviors for checks of operations on signed or unsigned integers
that may overflow. For instance, signed integers should truncate and unsigned integers should wrap-
around.

Use the new options Overflow mode for signed integer (-signed-integer-overflows)
and Overflow mode for unsigned integer (-unsigned-integer-overflows) to fine-tune
the check behavior.

The options -scalar-overflows-checks and -scalar-overflows-behavior are no longer
supported. You get a warning if you use these options. For Polyspace projects starting R2014a,
instances of the -scalar-overflows-* options are replaced with the new options according to the
mapping of this table.

Option Use instead

-scalar-overflows-checks none -scalar- |-signed-integer-overflows allow

overflows-behavior truncate-on-error _ _
-unsigned-integer-overflows allow

-scalar-overflows-checks signed - -signed-integer-overflows forbid
scalar-overflows-behavior truncate-on-

error -unsigned-integer-overflows allow
-scalar-overflows-checks signed-and- -signed-integer-overflows forbid
unsigned -scalar-overflows-behavior

truncate-on-error -unsigned-integer-overflows forbid

-scalar-overflows-checks none -scalar- |-signed-integer-overflows allow

overflows-behavior wrap-around _ .
-unsigned-integer-overflows allow

-scalar-overflows-checks signed - -signed-integer-overflows warn-with-
scalar-overflows-behavior wrap-around |wrap-around

-unsigned-integer-overflows allow

-scalar-overflows-checks signed-and- -signed-integer-overflows warn-with-
unsigned -scalar-overflows-behavior wrap-around

wrap-around _ _ _
-unsigned-integer-overflows warn-with-

wrap-around

For Polyspace projects prior to R2014a, all combinations of the old -scalar-overflows-* options
map to -signed-integer-overflows forbid -unsigned-integer-overflows allow.


https://www.mathworks.com/help/releases/R2018b/codeprover/ref/overflowmodeforsignedintegersignedintegeroverflows.html
https://www.mathworks.com/help/releases/R2018b/codeprover/ref/overflowmodeforunsignedintegerunsignedintegeroverflows.html

Verification Setup

Changes in analysis options and binaries

Polyspace Code Prover has new Target & Compiler options
Behavior change

Polyspace Code Prover has new Target & Compiler configuration options C standard version
(-c-version) and C++ standard version (-cpp-version).

Use these options to specify the C and C++ language standards you follow in your source code.

Polyspace Code Prover has new Check Behavior options
Behavior change

Polyspace Code Prover has new Check Behavior configuration options Overflow mode for
signed integer (-signed-integer-overflows) and Overflow mode for unsigned
integer (-unsigned-integer-overflows).

Use these options to specify the behavior of checks for signed and unsigned integer overflows.

-compiler option has new value renesas
Behavior change

Compiler (-compiler) option has new value renesas. When you specify this option value, The
analysis can interpret macros that are implicitly defined by the compiler and compiler-specific
language extensions such as keywords and pragmas.

-no-def-init-glob overrides -main-generator-writes-variables
Behavior change

Ignore default initialization of global variables (-no-def-init-glob) option
overrides Variables to initialize (-main-generator-writes-variables) option. If you
specify the option -no-def-init-glob, global variables are considered as uninitialized until you
explicitly initialize them in the code. Even if you use the option -main-generator-writes-
variables to specify that the generated main initialize global variables, the analysis ignores the
initialization.

Target & Compiler options Respect C90 standard (-no-language-extensions), C++11
extensions (-cppll-extension), and are removed
Warns

Options Respect C90 standard (-no-language-extensions) and C++11 extensions (-cppll-
extension) are removed. Use options C standard version (-c-version) and C++ standard
version (-cpp-version) instead.

In the Polyspace user interface, if an option is replaced by another option, the replacement occurs
automatically in your configuration. To update your scripts, see this table.

Option Use Instead

Respect C90 standard (-no-language- Set the option C standard version (-c-

extensions) version) to c90.

C++11 extensions (-cppll-extension) Set the option C++ standard version (-
cpp-version) to cppll.

You get a warning when you use the removed options at the command line.


https://www.mathworks.com/help/releases/R2018b/codeprover/ref/cstandardversioncversion.html
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https://www.mathworks.com/help/releases/R2018b/codeprover/ref/cstandardversioncppversion.html
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Check Behavior options Detect overflow (-scalar-overflows-checks), Overflow computation
mode (-scalar-overflows-behavior wrap-around), and Ignore overflowing computations on
constants (-ignore-constant-overflows) are removed

Warns

Options Detect overflow (-scalar-overflows-checks) and Overflow computation mode (-
scalar-overflows-behavior wrap-around) are removed. Use options Overflow mode for
signed integer (-signed-integer-overflows) and Overflow mode for unsigned
integer (-unsigned-integer-overflows) instead.

Option Ignore overflowing computations on constants (-ignore-constant-overflows) is
removed. There is no replacement.

In the Polyspace user interface, if an option is replaced by another option, the replacement occurs
automatically in your configuration. To update your scripts, see this table.

Option Use Instead

Detect overflow (-scalar-overflows- See Check Behavior on Overflows release note.
checks)

Overflow computation mode (-scalar- See Check Behavior on Overflows release note.

overflows-behavior wrap-around)

Ignore overflowing computations on Overflows involving integer constants are
constants (-ignore-constant-overflows) |wrapped around by default without warning. To
detect integer constant overflows, use these Bug
Finder checkers:

* Integer constant overflow

* Unsigned integer constant overflow

You get a warning when you use the removed options at the command line.

polyspace-configure option -lang is removed
Warns

Starting in R2018b, polyspace-configure detects the language of your source code.

Option -lang will be removed in a future release. You get a warning when you use this option and
there is no replacement. To update your code, remove instances of - Lang.

-compiler option value clang3.5 is removed
Errors

Compiler (-compiler) option value clang3.5 is removed. Use clang3.x instead.

In the Polyspace user interface, if an option value is replaced by another option value, the
replacement occurs automatically in your configuration. To update your scripts, see this table.

Option Use Instead

-compiler clang3.5 -compiler clang3.x

You get an error when you use the removed option at the command line.
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Changes in MATLAB option object properties and option values

polyspace.Project.Configuration has new TargetCompiler properties
Behavior change

polyspace.Project.Configuration has new TargetCompiler properties CVersion and
CppVersion. Use these properties in your MATLAB code to specify the C and C++ language
standards you follow in your source code.

For more information, see Properties.

polyspace.Project.Configuration has new ChecksAssumption properties
Behavior change

polyspace.Project.Configuration has new ChecksAssumption properties
SignedIntegerOverflows and UnsignedIntegerOverflows. Use these properties in your
MATLAB code to specify the behavior of checks for signed and unsigned integer overflows.

For more information, see Properties.

TargetCompiler properties NoLanguageExtensions and Cppl1lExtension will be removed
Still runs

Properties NoLanguageExtensions and CppllExtension will be removed. Use CVersion and
CppVersion instead.

To update your MATLAB code, see this table.

opts = polyspace.Project;

Property Use Instead
opts.Configuration.TargetCompiler... opts.Configuration.TargetCompiler...
.NoLanguageExtensions = true; .CVersion = 'c90';
opts.Configuration.TargetCompiler... opts.Configuration.TargetCompiler...
.CppllExtension = true; .CppVersion = 'cppll';

Unlike NoLanguageExtensions and Cppl1lExtension which let you specify one version of the C
and C++ language standards, the new object properties CVersion and CppVersion let you specify
different versions of these standards.

For more information, see Properties.

ChecksAssumption properties ScalarOverflowsBehavior and ScalarOverflowsChecks will be
removed

Still runs

Properties ScalarOverflowsBehavior and ScalarOverflowsChecks will be removed. Use
SignedIntegerOverflows and UnsignedIntegerOverflows instead.

To update your MATLAB code, see this table.

opts = polyspace.Project;
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Property

Use Instead

.ScalarOverflowsBehavior

.ScalarOverflowsChecks

opts.Configuration.ChecksAssumption...

opts.Configuration.ChecksAssumption...

See Compatibility Considerations in the Check
Behavior on Overflow release note.

For more information, see Properties.

polyspaceConfigure option -lang is removed

Warns

Starting in R2018b, polyspaceConfigure detects the language of your source code.

Option -lang will be removed in a future release. You get a warning when you use this option and
there is no replacement. To update your code, remove instances of - Lang.

ChecksAssumption property IgnoreConstantOverflows is removed

Errors

Property IgnoreConstantOverflows is removed. There is no replacement.

Overflows involving integer constants are wrapped around by default without warning. To detect
integer constant overflows, use these Bug Finder checkers:

*+ Integer constant overflow

* Unsigned integer constant overflow

For more information, see Properties.
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C++ Specific Checks: View more pertinent results for incorrect object
oriented programming and exception handling checks

In R2018b, you see more pertinent results for the checks Incorrect object oriented programming
and Uncaught exception.

Object Oriented Programming Checks

In R2018b, the Incorrect object oriented programming check detects member function call using
an incorrect this pointer only if the member function is virtual.

You might call a member function using an incorrect this pointer, for instance, after you cast
between pointers to two objects. In this example of incorrect C++ polymorphism, you might intend to
call the derived class version of funcFoo but depending on your compiler, you call the base class
version or encounter a segmentation fault.
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Error: incorrect this-pointer type of funcFoo
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_Jﬁhmmp x|
$include <new:

class Foo |
puklic:
virtual woid funcFooc{) [}

b:

class Bar: public Foo |
puklic:
vold funcFoo() [}

br

vold main() {
Foo YFooPtr = new Foop

Bar *BarPtr = (Bar*) (wvoid*)FooPtr;

I 17 BarPrr->funcFoo() ;

For more examples, see Incorrect object oriented programming.

Calling a non-virtual function via an incorrect this pointer is a less likely scenario. Code Prover
now restricts the error detection to cases that are more likely to occur and might not be caught at
compile time.

Exception Handling Checks

In R2018b, the Uncaught exception check shows only those cases where the exception handling
fails and the std::terminate function is called. For instance:

* An exception is thrown and propagates uncaught to the main.
* An exception is thrown during construction of a global variable.

For the full list of cases, see Uncaught exception.


https://www.mathworks.com/help/releases/R2018b/codeprover/ref/incorrectobjectorientedprogramming.html
https://en.cppreference.com/w/cpp/error/terminate
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For instance, if your code has exceptions that propagate uncaught up to the main, the Uncaught
exception check shows the result only on the main. In the event traceback associated with the
check, you see the origin of the exception and its propagation up the function call tree to the main or
another entry-point function. Click each event to navigate to the corresponding point in the source

code.

o Uncaught exception 2
Error: unhandled exception propagates to main or entry-point function

File Scope Line
EXCP.Cpp initialVector::getvalue(int) 23

Event

1 Exception thrown
2 Return of function ‘initialVector: :getvalue(int)’ EXCP.Cpp initialVector::getvalue(int) 29
3 Exiting function ‘initialvector: :getValue(int)’ EXCP.Cpp miain 33
5 Error: unhandled exception propagates to main or entry-point function
£ >
V4 Source o
J EXCD.CPP X | 4 B
int initialVector::getValus(int index) throw(errcor) | ~
if{index >= 0 && index < sizeVector
return table[index];
else throw error():
}
wvoid main{) |
initialVector *vectorFtr = new initialVector(3):
vectorbFrr->getValue (5); w
>

The new specifications have the following benefits:

Fewer results from same root cause: If an exception propagates uncaught up to the main function,
you see only one result on the main function. Previously, you saw a separate result for each
function in the call tree from the point where the exception is thrown up to the main. You had to
review several results originating from the same root cause.

* Easier tracing of exception propagation: You can use the event traceback to track down an
uncaught exception to its origin. Previously, to find the root cause of a red Uncaught exception
check, you manually navigated the function call tree from the main or another entry-point

function.
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Compatibility Considerations

* Object oriented programming checks: You see fewer red or orange Incorrect object oriented
programming checks in C++ code. Because the blocking red or orange checks no longer appear,
subsequent code is now verified. You can see an increase in checks of other types.

* Exception handling checks: You see fewer Uncaught exception checks in C++ code.

Checks on List-Initialization of Arrays: Detect list-initialization with
excess initializer clauses (C++11 and beyond)

In R2018Db, the Invalid C++ specific operations check detects if the number of array initializer
clauses exceeds the number of elements to initialize.

For instance, the check detects an error if size is less than two.
arr_const = new int[size]{0,1};
See also Invalid C++ specific operations.

Compilers detect excess initializer clauses if the array size is a compile-time constant. If the array
size is dynamically determined at run-time, compilers can fail to detect the error. With Code Prover,
you can detect such situations.


https://www.mathworks.com/help/releases/R2018b/codeprover/ref/invalidcspecificoperations.html
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AUTOSAR Support: Focus review to specific software components with
queries based on regular expressions

In R2018Db, you can quickly filter specific software components when reviewing Code Prover results
for your complete AUTOSAR project. For instance, you can:

» Filter software components whose qualified names start with a specific string.

You can use regular expressions for the pattern matching.

 Filter software components whose code implementation compiled successfully.

» Filter software components that have red checks in the Code Prover results.

«
© Project-status
@ Behaviors

O Terminology

Behavior Selection

@ Saved Queries
€ all behaviors
€ up-to-date behaviors
€ up-to-date verified behaviors w
€ up-to-date verified behaviors w
© behaviors with error-status
@ "plke t:t002 swel01 * caze_ser
@ CreateEdit Query
~pkg.tst@@2.swceel.*®
S
@ casze zensitive
and (has no| full | partial | empty ext
and (has no|red | orange | green ver
and (is up-to-date | out-of-date)
and (has success | error status)
© Search

Matches 1 of 2
B Gal (all)
B & [ ]swc001 bh001

Behaviors with Unit-Prove Environment
State after last command execution: updated.® See detailed log messages

S5 See kev model elements

2 software-component behaviors are imported in the project. Implementation-code hg

ApplicationComponentBehavior - pkg.tst002.swc001.bhv001
State after last command execution: updated.% See detailed log messages

% See kev autosar definition for this behavior

Extracted implementation code

State after last command execution: updated.
Extraction of implementation completes with state allRunnablesimplementation. Foun
@ Implementation source files

Verification of extracted implementation code

State after last command execution: updated. % See detailed log messages

Execution returns with status execution_success.
Verification results are in summary: green check=84, , red check=1.
Polyspace Code-Verification results are available in file AUTOSAR pkg/tst002/swe001/

See also Review Polyspace Results on AUTOSAR Code.

The new AUTOSAR support has the following benefits:
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* More focused review: Because you provide your top level ARXML folder for analysis, the results
show all software components in your AUTOSAR project. You can quickly focus your review on the
software component-s that you are interested in.

» Easier troubleshooting: You can quickly find which software components have errors in ARXML
parsing or code compilation. See Troubleshoot Polyspace Analysis of AUTOSAR Code.

» Easier maintenance: You can quickly find which software components have results that have not
changed since the previous analysis.

AUTOSAR Support: See visual representation of runnables and
associated files for each software component

In R2018b, you can see a visual representation of your complete AUTOSAR project with all software
components along with an overview of Code Prover results for each software component.

You can drill down to these details for each software component behavior:

» Entry-point functions and their callees
* Files containing these functions

For instance, the project below contains two software components with full name
pkg.tst002.swc001.bhv001 and pkg.tst002.swc002.bhv.

=

pkg

= _
{51002 .

swe001. bhv00 1

swc002.bhv

A 4
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)

entry_point D
swolllt.c
entry_point
'n‘ caliee
entry_ point
=
o
callee
depl.c
calles

|

The code implementation of pkg.tst002.swc001.bhv001 has three entry point functions: foo,
init and step. All three functions are defined in the file swc@01. c. These entry-point functions call
other functions defined in the files dep.c, dep2.c and dep3. c.

See also Review Polyspace Results on AUTOSAR Code.

The new AUTOSAR support has the following benefits:

More focused review: Each software component is shown with the color of the worst verification
result. For instance, if the code implementation of a software component contains red checks, the

corresponding icon is red. You can use the icon colors to quickly focus on the software component-
s that need attention.

» Easier tracking of information: You can see at a glance the files involved in the code
implementation of software components.
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Header Files Access: Open your project header files directly from the
point of inclusion

In R2018b, you can open header files you reference in your code by right-clicking on the include
directive in the Source pane.

|\ Source : : : : :
'prugramming.cpp x
$include <stdimt.h> /¥ C8% standard types */
#include <limits.h>
#include <errnc.h>
#include <float.h>
#include <signal.h>
$include <sys/types.h>
#include <sys/soccket.h>
$include <arpa/inet.h>
#include <unistd.h>
#include <math.h>

#include "bf_examples_types.h”
#define fatal error() abort()
volatile int some_condition = 17

enum |
SIZE4 = 4
SIZES = 5§, Ié
SIZEE = &
SIZE20 = 2
SIZELl024 = 1024
ki

If Polyspace determines that the header file is available, the #include, #import, or
#include next preprocessor directive is underlined in the source code.

When you review results, you can quickly see the contents of a header file without leaving the
Polyspace user interface.
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AUTOSAR Support: Set up modular Polyspace analysis for AUTOSAR

software components automatically

In R2018a, Polyspace can read specifications for AUTOSAR software components (SWCs) and
modularize the corresponding C code implementation. A separate module is created for each
software component and checked for run-time errors. Polyspace also detects certain kinds of
mismatch that can happen between AUTOSAR specifications and the code implementation at run

time.

To perform this modular Polyspace analysis, you simply provide the folders containing the AUTOSAR

specifications (.arxml files) and the code implementation (. c files).

ARXML \ /

Polyspace for AUTOSAR

-~ -
7 ‘ T,

e

-
I I i
A/ \/) \/)

Polyspace Results

For details, see:
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Using Polyspace in AUTOSAR Software Development
Run Polyspace on AUTOSAR Code

The new AUTOSAR support has the following benefits:

Modularization based on AUTOSAR specs: The software reuses the modularization already
present in your AUTOSAR specifications and verifies the code implementation of each software
component (SWC) behavior independently. Previously, to emulate your AUTOSAR modularization,
you manually copied files to modules.

Minimal effort and knowledge required for configuration: You do not need to know the details of
the AUTOSAR specifications or the code implementation for running a Polyspace analysis. You
simply provide the two folders containing your .arxml and . c files. The software extracts the
code implementation of each SWC behavior, creates a prove environment to exercise each
runnable with all allowed inputs and checks for run-time errors or mismatch with AUTOSAR
specifications.

Automatic range specification and precise analysis: The data type specification in .arxml files
allows specifying a range constraint on values. The software reuses this range constraint to
constraint input variables to allowed values, allowing for a more precise analysis. Previously, for a
precise analysis, you had to manually specify range information for all input variables in your
code.

MATLAB Coder Support: Run Polyspace on C/C++ code generated from
MATLAB code without additional setup

In R2018a, if you install Embedded Coder and Polyspace, you can run Polyspace directly on C/C++
code generated from MATLAB code and check for defects (Bug Finder) or run time errors (Code

Prover).
2] MATLAB Coder - averaging_filter.prj - O *
P2 Generate Code GENERATE v  VERIFY CODE @ [E
¥ So
avel
Product mode: | Code Prover ~
Results type: | Based on Polyspace configuration ~

Output folder:  results_ScodegenMName$
b Advanced Settings

‘V‘“ " Run

For details, see:

Run Polyspace on C/C++ Code Generated from MATLAB Code
Configure Advanced Polyspace Options in MATLAB Coder App

The ability to analyze code generated with MATLAB Coder has the following benefits:
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» Seamless integration: You do not have to configure the Polyspace analysis manually, in the
Polyspace user interface or otherwise. The Polyspace analysis is seamlessly integrated with the
workflow in the MATLAB Coder App.

* Easier scripting: You do not have to know or specify names of files generated from your MATLAB
code. You can simply use a specific folder for code generation output and provide that folder for
code analysis. In this way, you can have end-to-end scripting for the code generation and analysis.

Compiler Support: Set up Polyspace analysis easily for code compiled

with Texas Instruments, IAR or CodeWarrior compilers

If you build your source code using these compilers, in R2018a, you can specify the compiler name
for your Polyspace analysis:

* Texas Instruments™
You can specify these target processors: c28x, c6000, arm and msp430.

See Texas Instruments Compiler (-compiler ti).
+ IAR

You can specify these target processors: arm, avr, msp430, rh850 and r178.

See IAR Embedded Workbench Compiler (-compiler iar-ew).
e CodeWarrior

You can specify these target processors: s12z or powerpc.
NXP CodeWarrior Compiler (-compiler codewarrior)

The analysis can interpret macros that are implicitly defined by the compiler and compiler-specific
language extensions such as keywords and pragmas.

Compiler

Target Environment Target Environment

Target Environment

i » Compiler

Compiler codewarrior v

Target processor type  arm w

10-4

You can now set up a Polyspace project without knowing the internal workings of these compilers. If
your code compiles with your compiler, it will compile with Polyspace in most cases without requiring
additional setup. Previously, you had to explicitly define macros that were implicitly defined by the
compiler and remove unknown language extensions from your preprocessed code.

Updated GCC and Clang Compiler Support: Set up Polyspace analysis
easily for code compiled with GCC versions 5.x or 6.x, or Clang version
3.x compilers

In R2018a, if you build your source code using these versions of GCC or Clang compilers, you can
specify the following compiler option values to setup your Polyspace analysis:
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Target Environment

Compiler anus.x P

Target processor type 1386 e

gnu5.x, for GCC release 5.1, 5.2, 5.3, and 5.4.

Target Environment

Compiler anue, x e

Target processor type [i386 e

gnu6. x, for GCC release 6.1, 6.2, and 6.3.

Starting GCC version 5, the version number increases by one for each major release, for
instance,.from 5.x to 6.x. Polyspace follows this new naming convention.

Target Environment

Compiler dang3.x e

Target processor type |i380 e

clang3.x, for LLVM release 3.5, 3.6, 3.7, 3.8, and 3.9.

The analysis can interpret macros that are implicitly defined by the compiler and compiler-specific
language extensions such as keywords and pragmas.

For more information, see Compiler (-compiler).

Configuration from Build System: Include or exclude sources when
generating Polyspace project using polyspace-configure

In R2018a, you can include or exclude source files or folders when generating a Polyspace project
from your build system.

To create a Polyspace project that does not contain all files from your build system:

1 Trace your build command. Do not create a project yet. Optionally store the build trace and
cache in specific locations (instead of the default).

polyspace-configure -no-project make -B \
-build-trace trace.txt -cache-path /tmp/cache

2 Create a Polyspace project using the build trace and cache. Include or exclude files as needed
using shell GLOB patterns.

polyspace-configure -no-build \
-build-trace trace.txt -cache-path /tmp/cache \
-include-sources 'src/' -exclude-sources '* test.c'

The preceding example includes sources in folder paths containing src and excludes . c files
ending with _test.
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3  Delete the build trace and cache.
For more information, see polyspace-configure.

The ability to include or exclude sources when using polyspace-configure has the following
benefits:

» Exclusion of irrelevant files: You can avoid cluttering your Polyspace project with files that you do
not want to analyze, for instance, files used for testing.

* Modular analysis: You can create a separate Polyspace project for each module covered by your
build system. Trace your build command once. When creating a Polyspace project, include only
files belonging to a specific module. Repeat the project creation step for each module.

Support for IBM Rational Rhapsody to be removed

The Polyspace integration with the IBM® Rational Rhapsody environment will be removed after
R2018b.

Compatibility Considerations

To continue using the latest releases of Polyspace, run code analysis in the Polyspace user interface
or using scripts.

Changes in analysis options and binaries

Polyspace Code Prover has a new Multitasking option
Behavior change

Polyspace Bug Finder has a new Multitasking configuration option ARXML files selection (-
autosar-multitasking).

Use this option to automatically detect the multitasking configuration from your AUTOSAR
specification.

Polyspace Code Prover has new -compiler option values
Behavior change

Use the new Compiler (-compiler) option values to interpret macros that are implicitly defined
by the compilers and compiler-specific language extensions such as keywords and pragmas..
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Option New Value

Compiler (-compiler) * New value ti added.
See Compiler Support
release note.

* Newvalue iar-ew
added. See Compiler
Support release note.

Use this value to
emulate IAR
compilers.

For older Polyspace
projects, you can still
use option value iar.

* New value
codewarrior added.
See Compiler Support
release note.

* New value gnu5.x
added. See Updated
GCC and Clang
Compiler Support
release note.

* New value gnu6.x
added. See Updated
GCC and Clang
Compiler Support
release note.

* New value clang3.x
added. See Updated
GCC and Clang
Compiler Support
release note.

-compiler option value clang3.5 is removed
Warns

Compiler (-compiler) option value clang3.5 is removed. Use clang3.x instead.

In the Polyspace user interface, if an option value is replaced by another option value, the
replacement occurs automatically in your configuration. To update your scripts, see this table.

Option Use Instead

-compiler clang3.5 -compiler clang3.x

You get a warning when you use the removed option value at the command line.

-compiler option values iso, none, gnu, and visual through visuall0 are removed
Errors

10-7


https://www.mathworks.com/help/releases/R2018a/codeprover/ref/compilercompiler.html
https://www.mathworks.com/help/releases/R2018a/codeprover/ref/compilercompiler.html

R2018a

10-8

Compiler (-compiler) option values iso, none, gnu, visual, visual6, visual7.0,
visual7.1, visual8, and visuall0 are removed.

In the Polyspace user interface, if an option value is replaced by another option value, the
replacement occurs automatically in your configuration. To update your scripts, see this table.

Option Use Instead

-compiler iso -compiler generic

-compiler none

-compiler gnu -compiler gnu3.4

-compiler visual -compiler visuall0.0
-compiler visual6

-compiler visual7.0
-compiler visual7.1

-compiler visual8

-compiler visuall@

You get a error when you use the removed options at the command line.

Check Behavior options Allow incomplete or partial allocation of structures (-size-in-bytes)
and Enable pointer arithmetic across fields (-allow-ptr-arith-on-struct) are updated
Behavior change

Option Allow incomplete or partial allocation of structures (-size-in-bytes) is
available for C++ projects.

Option Enable pointer arithmetic across fields (-allow-ptr-arith-on-struct) does
not automatically enable Allow incomplete or partial allocation of structures (-
size-in-bytes).

Target&Compiler options Set wchar_t to unsigned long (-wchar-t-is-unsigned-long) and Set
size_t to unsigned long (-size-t-is-unsigned-long) are removed
Errors

Option Set wchar _t to unsigned long (-wchar-t-is-unsigned-long) is removed. Set
Management of wchar t (-wchar-t-type-is) to unsigned-long instead.

Option Set size_t to unsigned long (-size-t-is-unsigned-long) is removed. Set Management
of size t (-size-t-type-1is)tounsigned-long instead.

In the Polyspace user interface, if an option is replaced by another option, the replacement occurs
automatically in your configuration. To update your scripts, replace each instance of the removed
option with the corresponding new option.

You get an error when you use the removed options at the command line.

Command-line option -static-headers-object is removed
Errors
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Analysis option -static-headers-object is removed. There is no replacement. The permissive
linking introduced by this option now happens by default.

In the Polyspace user interface Configuration pane, under Advanced Settings, remove the option
for the Other field. To update your scripts, remove instances of this option. If you use this option, you
get an error.

-enum-type-definition option value defined-by-standard is removed
Errors

Enum type definition (-enum-type-definition) option value defined-by-standard is removed.
Use defined-by-compiler instead.

In the Polyspace user interface, if an option value is replaced by another option value, the
replacement occurs automatically in your configuration. To update your scripts, see this table.

Option Use Instead
-enum-type-definition defined-by- -enum-type-definition defined-by-
standard compiler

You get an error when you use the removed option value at the command line.

Changes in MATLAB option object properties

polyspace.Project.Configuration has new Multitasking properties
Behavior change

polyspace.Project.Configuration has new Multitasking properties
EnableExternalMultitasking, ExternalMultitaskingType, and ArxmlMultitasking. Use
these properties to set up the multitasking configuration of your project from external files you
provide.

For more information, see Properties.

TargetCompiler property has a new Compiler option values
Behavior change

Use the new Compiler option values to interpret macros that are implicitly defined by the compilers
and compiler-specific language extensions such as keywords and pragmas.

opts=polyspace.Project;
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Property Description
opts.Configuration... * New value ti added. See Compiler Support
.TargetCompiler.Compiler release note.

* New value iar-ew added. See Compiler
Support release note.

Use this value to emulate IAR compilers.

For older Polyspace projects, you can still use
property value iar.

* New value codewarrior added. See
Compiler Support release note.

* New value gnu5.x added. See Updated GCC
and Clang Compiler Support release note.

* New value gnu6.x added. See Updated GCC
and Clang Compiler Support release note.

* New value clang3.x added. See Updated
GCC and Clang Compiler Support release
note.

For more information, see Properties.

Multitasking property EnableOsekMultitasking is removed
Errors

Property EnableOsekMultitasking is removed. To update your MATLAB code, see this table.

opts=polyspace.Project;

Property Description
opts.Configuration.Multitasking... opts.Configuration.Multitasking...
.EnableOsekMultitasking .EnableExternalMultitasking=1;

opts.Configuration.Multitasking...
.ExternalMultitaskingType='o0sek';

If you use the removed property, you get an error.
For more information, see Properties.

TargetCompiler properties WcharTlsUnsignedLong and SizeTlsUnsignedLong are removed
Errors

Properties WcharTIsUnsignedlLong and SizeTIsUnsignedLong are removed. To update your
MATLAB code, see this table.

opts=polyspace.Project;

Property Description
opts.Configuration.TargetCompiler... opts.Configuration.TargetCompiler...
.WcharTIsUnsignedLong .WcharTTypeIs="unsigned-long"
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Property Description
opts.Configuration.TargetCompiler... opts.Configuration.TargetCompiler...
.SizeTIsUnsignedLong .SizeTTypels="unsigned-long"

If you use the removed property, you get an error.

For more information, see Properties.

EnumTypeDefinition option value defined-by-dialect is removed

Errors

EnumTypeDefinition option value defined-by-dialect is removed. To update your MATLAB

code, see this table.

opts=polyspace.Project;

Property

Description

opts.Configuration.TargetCompiler...
.EnumTypeDefinition="defined-by-dialect"

opts.Configuration.TargetCompiler...
.EnumTypeDefinition="defined-by-compiler"

If you use the removed property, you get an error.

For more information, see Properties.
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AUTOSAR Support: Check for run-time mismatch between AUTOSAR
specifications and code implementation

In R2018a, in addition to regular checks for run-time errors, Polyspace can detect certain kinds of
mismatch between AUTOSAR specifications and the corresponding code implementation. For
instance, the software detects if certain variables in your code can acquire values outside their
specifications at run time.

The software performs these checks for two classes of variables.

Invalid use of AUTOSAR runtime environment function: The check applies to arguments of
functions supplied by the Run Time Environment (functions beginning with Rte ). See Invalid
use of AUTOSAR runtime environment function.

Invalid result of AUTOSAR runnable implementation: The check applies to output arguments
and return value from runnable entities (functions provided by the software components). See
Invalid result of AUTOSAR runnable implementation.

® |nvalid use of AUTOSAR runtime environment function ‘2
Error: Function 'Rte_Write_outRef_colorCount’' is called with invalid argument(s)
* Conditions on data (see speq):

* Conditions on self (see sped):

+ data meets its specification:
Specification: non-NULL

+ data meets its specification:
Specification: allocated

! data-=color does not meet its specification:
Specification: {4U,5U,9U%
Actual value (const unsigned int 8): 12

+ self meets its specification:
Specification: non-NULL

The new AUTOSAR support has the following benefits:

Runtime errors detected: Using static analysis, the software detects all possible invalid argument
values that can occur at run time. The analysis represents the most comprehensive testing
possible for this kind of mismatch with AUTOSAR specs.

Easy navigation between code and spec: If the software detects a mismatch for a specific variable,
you can navigate to an extract of the AUTOSAR specification that describes the variable data type
and allowed values. You can also see the application data type (with units) from which the

implementation data type and the software base type is derived and the computation method used
for this derivation.

Easy collaboration between AUTOSAR spec development and coding: If an argument acquires
invalid values, it is easy to see the variable data type in an extract of the AUTOSAR specs. In
situations where the code requires a change in the specs, for instance, if an enumeration requires
an additional value, it is easy to use the extract to request this change. In this way, the AUTOSAR
specification can be kept up-to-date with requirements from the code implementation. See also
Using Polyspace in AUTOSAR Software Development.
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MISRA C++ Support: Check for overriding of standard library
functions, missing const qualifiers and other MISRA C++ rules

In R2018a, you can look for violations of these MISRA® C++ rules.

Rule Description

0-1-3 A project shall not contain unused variables.

0-1-5 A project shall not contain unused type
declarations.

4-10-1 NULL shall not be used as an integer value.

4-10-2 Literal zero (0) shall not be used as the null-
pointer constant.

7-1-1 A variable which is not modified shall be const
qualified.

7-1-2 A pointer or reference parameter in a function

shall be declared as pointer to const or reference
to const if the corresponding object is not
modified.

9-3-3 If a member function cannot be made static then
it shall be made static, otherwise if it can be
made const then it shall be made const.

15-5-3 The terminate() function shall not be called
implicitly.
17-0-3 The names of standard library functions shall not

be overridden.

See also MISRA C++ Coding Rules.

MISRA C:2012 Directives: Detect opportunities for data hiding

In R2018a, you can look for violations of MISRA C:2012 Directive 4.8. The directive states that if a
pointer to a structure is never dereferenced in a translation unit, its implementation must be hidden
in that unit.

See MISRA (C:2012 Directive 4.8.

Using this check, you can find opportunities for defining opaque data types that hide the
implementation of a structure.

Rule for Source Line Length: Constrain number of characters per line
in your code

In R2018a, you can define a limit for number of characters per line in your code and use Polyspace to
check for lines that fall outside that limit.

Use custom rule 20.1 and specify the character limit as the rule pattern. See Group 20: Style.
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Concurrency Modeling: View all tasks and interrupts extracted from
code and Polyspace configuration in one view

In R2018a, you can see the tasks and interrupts extracted from your code and configuration in one
view.

After analysis, click the Concurrency modeling link on the Dashboard.

W Concurrency medeling ey

| O~ Type here to filter table

Entry point

= Interrupts (2)
210
Executes repeatedly after the main entry point completes Manually configured
220
Executes repeatedly after the main entry point completes Manually configured

Preemptable interrupts (2)

Mon-preemptable tasks (4)

= Tasks (12)
= ct1f
Executes repeatedly after the main entry point completes Manually configured
= et20
Executes repeatedly after the main entry point completes Manually configured

= dtid)
Starts in main at line 113 Automatically detected

= dt3a() (11 instances)
Starts 10 times in main at line 123 Automatically detected

Starts in main at line 132 Automatically detected

You can verify if Polyspace correctly detected your multitasking configuration from your code. For
instance, if you know a priori that a specific function acts as an interrupt, you can spot-check whether
Polyspace considers the function as an interrupt.

This information is also included in reports you generate from the analysis results.
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Variables Reporting: Export variable list to text file for automated
reading

In R2018a, you can export the list of global variables in your code to a text file, along with the read
and write operations on them.

You can parse the text file by using MATLAB or Excel® and generate graphs or statistics about your

global variables that you cannot readily obtain from the user interface. See Export Global Variable
List.
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Green Hills Compiler Support: Set up Polyspace analysis easily for
code compiled with Green Hills Compiler

If you build your source code with the Green Hills® compiler, in R2017b, you can specify the compiler

name for your Polyspace analysis. The analysis can interpret macros that are implicitly defined by the
compiler and compiler-specific language extensions such as keywords and pragmas.

You can specify these target processors directly: arm64, arm, 1386, x86 64, powerpc, powerpc64,
rh850 or tricore. See Green Hills Compiler (-compiler greenhills).

Target Environment

Compiler greenhills -

Target processor type |powerpc -

You can now set up a Polyspace project without knowing the internal workings of your Green Hills
compiler. If your code compiles with your compiler, it will compile with Polyspace in most cases
without requiring additional setup. Previously, you had to explicitly define macros that were implicitly
defined by the compiler and remove unknown language extensions from your preprocessed code.

OSEK Multitasking Support: Detect the multitasking configuration for
your OSEK application automatically
In R2017b, you can provide an OIL file that Polyspace parses to detect the multitasking configuration

for your OSEK application. Polyspace can interpret the OIL file definitions to set up your concurrency
model.

Lo

Bug_Finder_Example X

—---'I':argetﬁ-l':DmF'”EV Multitasking
-~ Macros
“ Environment Settings
----- Inputs & Stubbing

[ ] Enable automatic concurrency detection for Code Prover

----- Coding Rules & Code Metrics OSEK multitasking configuration
----- Bug Finder Analysis

L OIL files selection | custom -
I Code Prover Verification
- Verification Assumptions File
> Check Behawvior
Precision
“ Sealing

For more information, see OSEK multitasking configuration (-osek-multitasking).

You no longer need to configure multitasking manually to analyze your OSEK application. Polyspace
detects the tasks, interrupts, and critical sections of your model.
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Polyspace API in MATLAB: Configure analysis, run analysis, and read
analysis results with a single MATLAB object

In R2017b, you can use a single MATLAB object for the entire Polyspace analysis. The analysis has
two subobjects, one for configuring the analysis and another for reading the results.

obj = polyspace.Project

% Configure analysis

obj.Configuration.Sources = {fullfile(matlabroot, 'polyspace', ‘'examples',...
'cxx', 'Code Prover Example', 'sources', 'single file analysis.c')};
obj.Configuration.TargetCompiler.Compiler = 'gnu4.9';

obj.Configuration.ResultsDir = fullfile(pwd, 'results');
obj.Configuration.CodeProverVerification.MainGenerator = true;

% Run analysis
cpStatus = obj.run('codeProver');

% Read results
cpSummary = obj.Results.getSummary();

For more information, see polyspace.Project.

You need fewer variables for the Polyspace analysis. You can also use the same object for reading
both Bug Finder and Code Prover results.

Additional Considerations
Are the pre-R2017b ways of scripting a Polyspace analysis still supported?

The objects polyspace.Options, polyspace.BugFinderResults and
polyspace.CodeProverResults are still supported. For easier scripting, it is recommended that
you make the following replacements:

» To configure analysis, instead of the polyspace.0Options object, use the Configuration
subobject of the polyspace.Project object.

For instance, instead of:

opts = polyspace.Options

opts.ResultsDir = fullfile(pwd, 'results');
Use:

obj = polyspace.Project

obj.Configuration.ResultsDir = fullfile(pwd, 'results');

» To read results, instead of the polyspace.BugFinderResults and
polyspace.CodeProverResults objects, use the Results subobject of the
polyspace.Project object.

For instance, instead of:

resultsFolder = fullfile(pwd, 'results');

opts = polyspace.Options;
opts.Sources = {fullfile(matlabroot, 'polyspace', 'examples',...
'cxx', 'Code Prover Example', 'sources', 'single file analysis.c')};
opts.CodeProverVerification.MainGenerator = true;
opts.ResultsDir = resultsFolder;
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polyspaceCodeProver(opts);

resObj = polyspace.CodeProverResults(resultsFolder);
resSummary = resObj.getSummary();

Use:

resultsFolder = fullfile(pwd, 'results"');

obj = polyspace.Project;

obj.Configuration.Sources = {fullfile(matlabroot, 'polyspace', 'examples',...
'cxx', 'Code Prover Example', 'sources', 'single file analysis.c')};

obj.Configuration.CodeProverVerification.MainGenerator = true;

obj.Configuration.ResultsDir = resultsFolder;

cpStatus = obj.run('codeProver');

resSummary = obj.Results.getSummary();

Compiler-Specific Keywords: Nonstandard compiler-specific keywords
are only supported when you specify compiler

In R2017b, compiler-specific keywords are enabled only when you specify a supporting compiler. For
instance, far is a keyword for certain compilers but not a keyword for others.

When configuring your Polyspace project, it is sufficient to specify your compiler. Previously, certain
keywords were disabled irrespective of your compiler choice. If your compiler supported those
keywords, you had to explicitly enable them.

Compatibility Considerations

In existing projects that use the compiler option none (now generic), you can see compilation
errors. Previously, certain nonstandard keywords such as data were removed during preprocessing
because they were not relevant for the analysis. This syntax did not cause compilation errors.

data int tab[10];

Now, the nonstandard keywords are recognized based only on your choice of compiler. If you use a
generic compiler, the analysis does not recognize the nonstandard keywords as keywords and does
not remove them during preprocessing. For instance, the preceding syntax causes compilation errors.
For workarounds, see Errors Related to Generic Compiler.

POSIX and BSD Standards: Use functions from these standards
without additional setup

In R2017b, you can run analysis on code containing POSIX or BSD-specific functions without
additional setup, for instance, defining macros such as POSIX SOURCE. As an example, you can
analyze code that uses functions from unistd.h out of the box. You do not have to specify the
location of unistd.h or perform additional configuration.

You can quickly run analysis on code that uses functions specific to POSIX or BSD. If you do not
provide the headers, Polyspace uses its own implementation of the functions for analysis.

Changes in analysis options and binaries

In R2017b, the following options have been added, changed, or removed.
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New Options

Option

Description

OSEK multitasking configuration (-osek-multitasking)

See OSEK Multitasking
Support release note.

-xml-annotations-description

See Code Annotations
release note.

Compiler options:

* Management of size t (-size-t-type-1is)

* Management of wchar t (-wchar-t-type-is)

Replaces previous
options related to
size t andwchar t.

Updated Options

Option

Change

Compiler (-compiler)

* Option value none
changed to generic.

* New value
greenhills added.
See Green Hills
Compiler Support.

* Option value iso
removed. Use
generic instead.

* Option values
visual, visualé,
visual7.0,
visual7.1, visual8
and visuallO
removed. Use
visuallO. o0 instead.

* Option value gnu
removed. Use ghu3.4
instead.

Target processor type (-target)

Target powerpc64
added for Diab compiler.
See Diab Compiler (-
compiler diab).

Options related to packing of data structures:

* Ignore pragma pack directives (-ignore-pragma-pack)
* Pack alignment value (-pack-alignment-value)

Available for all
compilers.

Enum type definition (-enum-type-definition)

Option value defined-
by-standard changed
to defined-by-
compiler.

-asm-begin and -asm-end

Available for all
compilers.
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Removed Options

Option Status More Information
Management of 'for loop' index Warning Your choice of compilers determines the
scope (-for-loop-index-scope) specification of for loop index variables.
If you specify an older version of the Microsoft
Visual C++ compiler such as visual®o,
visual7.0 or visual7.1, the analysis
considers that a for loop index is visible
outside the loop. Otherwise, the analysis
considers that the index is visible only inside
the for loop.
Set size_t to unsigned long (- Warning Use the option Management of size t (-size-
size-t-is-unsigned-long) t-type-is).
-wchar-t-is-unsigned-long and |Warning Use the option Management of wchar t (-
-wchar-t-is wchar-t-type-is).
-wchar-t-
is has been
removed
from the
user
interface
only.
-static-headers-object Warning The permissive linking introduced by -

static-headers-object now happens by
default. The option is not required.

Compatibility Considerations

If you use scripts that contain the removed or updated options, update your scripts accordingly. In the
Polyspace user interface, if an option is replaced by another option, the replacement occurs

automatically in your configuration.
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Verification Results

Stack Size Computation: Determine maximum stack usage by a C
program and individual functions

In R2017h, the analysis computes the stack usage by each function in your program and the entire
program. The maximum stack usage by a function is the total size of all local variables in the function
plus the maximum stack usage by the function callees.

For more information, see:

* Maximum Stack Usage and Minimum Stack Usage
* Program Maximum Stack Usage and Program Minimum Stack Usage

See also Determination of Program Stack Usage.

You can now determine if the stack requirements of your program exceed the available size on the
call stack. If the stack requirements exceed the available stack size, you can determine which
variable or function is responsible and increase the available stack size or reduce the stack
requirements.

MISRA C:2012 Directive 1.1: Detect instances of implementation-
specific behavior in your code

In R2017b, you can detect possible violations of MISRA C:2012 Directive 1.1. The directive requires
that you understand and document any implementation-defined behavior that affects the program
output. See MISRA C:2012 Dir 1.1.

The analysis detects constructs that can have implementation-defined behavior. If you have such
constructs in your code, you can find how your compiler implements them. Once you understand and
document all implementation-defined behavior, you can be assured that all output of your program is
intentional and not produced by chance.

CERT C Support: Identify CERT C violations using run-time error
checks

In R2017b, CERT C rules and recommendations are mapped to Code Prover run-time checks. If you
run a Code Prover analysis, you can identify CERT C violations by using the mapping.
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¥ Chedk

Out of bounds array index
Tlegally dereferenced pointer

Man-terminating call
Mon-terminating loop

Invalid use of standard library routine

0

¥ CERTID

DCL38-C ARR30-C 5TR31-C 5TR.32-C M3C15-C
DCL38-C EXPOE-C EXP34-C EXP36-C EXP39-C ARR.30-C ARR37-C MEM10-C MEM35-C M53C15-C

M3C21-C

FLP32-C 5TRO3-C 5TROV-C 5TR31-C 5TR32-C

Unreachable code MSCO07-C MSC12-C
Unreachable code MSCO7-C MSC12-C
Unreachable code MSCO7-C MSC12-C
Unreachable code MSCO7-C MSC12-C
Unreachable code MSCO7-C MSC12-C
Unreachable code MSCO7-C MSC12-C
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You can now comply with the CERT C standard with Code Prover. Use a combination of run-time
checks and MISRA C:2012 checkers. See:

* Check C/C++ Code for Security Standards
* CERT C Coding Standard and Polyspace Results

Overlapping Memory Detection: Find cases where source and
destination arguments of memcpy overlap

In R2017b, Code Prover can detect memcpy usage where the source and destination memory regions
overlap.

For instance, in this example, Code Prover shows a red Invalid use of standard library routine
check on the use of memcpy.

#include <string.h>
int main() {
char arr[4];

memcpy (arr, arr + 3, sizeof(int));

}

According to the Standard, overlap in source and destination arguments of memcpy lead to undefined
behavior. Using Code Prover, you can detect these cases.

Changes to coding rule checking
Updated Specifications

In R2017h, the following changes have been made in checking of previously supported MISRA C and
MISRA C++ rules.

Rule Description Improvement

MISRA C: 2004
Rule 17.4 and
MISRA C++ Rule
5-0-15

Array indexing shall be the
only allowed form of pointer
arithmetic.

The rule checker flags array indexing on nonarray
pointers. Previously, the checker flagged only
explicit pointer arithmetic on pointers.
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Rule

Description

Improvement

MISRA C:2004

Rule 8.9, MISRA
C:2012 Rule 8.6
and MISRA C++

An identifier with external
linkage shall have exactly
one external definition.

The rule checkers flag multiple definitions only if
the definitions occur in different files. The checkers
do not consider tentative definitions as definitions.

Rule 3-2-4 For instance, this code does not violate the rule:
int val;
int val=l;
MISRA C:2004 The validity of values passed |The rule checker uses more precise Code Prover
Rule 20.3 and to library functions shall be |analysis to determine if the input to a standard
MISRA C:2012 checked. library function is within the allowed domain.

Directive 4.11
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Reviewing Results

Run-Time Error Cause: Navigate to and view the cause of red
nonterminating loops or function calls

In R2017b, you can determine the cause of a nonterminating loop over a few iterations, or a
nonterminating function call, if it is due to a run-time error. To navigate to the cause, right-click the
result, and select Go to Cause.

int a[l0]:

void foo{int x){

void func{) |

int =, ir

x=0;

for {i=0; i<=10; i++) |
s

foofi):

You can now view the sequence of events leading to the error, including the number of successful
iterations, in the Results Details pane.
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oo s M| £~ =

=1 Result Review

Status Unreviewed ~ | |Enter comment here...
Sewverity Unset e
o Non-terminating loop 2

The loop is infinite or contains a run-time error.
This check may be a path-related issue, which is not dependent on input values
Loop fails due to a run-time error {maximum number of iterations: &).

Event File Scope Line
1 Iterating on loop: loop ran 5 times iPaly.c func) 14
2 Entering function ‘foo(int)’ iPaly.c func) 16
3 Iterating on loop: loop ran 10 times iPaly.c foo(int) 4
4 Array index is outside its bounds : [0..9] iPaly.c foo(int) 5
5 The loop is infinite or contains a run-time error.  Poly.c

See also Identify Loop Operation with Run-Time Error.

Results Review Workflow: Sort and filter results by subtype

In R2017b, you can group your results by subtype through the new Detail column in the Results list
pane. This column shows the first line from the Results Details pane, which has additional

information about a result.

For instance, multiple issues can trigger the same coding rule violation. The Detail column shows the

specific issue that triggered the rule violation.
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TaNew [El» <o 5> @ showing 1,827/1,827 ¥

Farmily = Information “F Detai ~1 & File “  Function &
| [l-Tainted data 19
). MISRA C:2004 1614

I_iJ--l Environment 50

- 1.1 All code shall conform to 150 989%:1920 'Programming languages - C', amended and corrected by ISO/IEC $8%9/COR 1: 1995, 1S0/IEC 9899/AMD1: 1995, and ISO/IEC
L. ®  Category: Required ANSI C90 forbids Tong double' type. programrming. c bug_missingerrnoreset()
= *  Category: Required AMSI C30 forbids long double’ type. programming.c corrected_missingerrnoreset()
.= *  Category: Required ANSI C90 forbids Tong long int' type. CONCUITENCY.C corrected_datarace_task4()
.= *  Category: Required AMSI €390 forbids 'long long int’ type. CONCUITENCY.C File Scope
= *  Category: Required AMSI C30 forbids ‘long long int’ type. CONCUITENCY.C File Scope
*  (Category: Required AMSI C90 forbids 'long long int’ type. CONCUITENCY.C bug_datarace_task4()

51 C90 forbids designated initializer. numerical.c corrected_intstdlib()
0 forbids designated initializer. numerical.c corrected _intstdlib()

C90 forbids designated initializer. programming.c corrected_improperarrayinit()
C90 forbids designated initializer. programming.c corrected_improperarrayinit()
0 forbids designated initializer. programming.c bug_improperarrayinit()
C30 forbids designated initializer. programming.c bug_improperarrayinit()
0 forbids designated initializer. programming. c corrected_improperarrayinit()

0 forbids designated initializer. programming.c corrected_improperarrayinit()
AMSI C90 forbids designated initializer. programming.c bug_improperarrayinit()

*  (Category: Required AMSI €90 forbids long long integer constants. programming.c corrected_unsafestrtonumeric()
= *  Category: Required AMSI C30 forbids long long integer constants. tainteddata.c sanitize_atoil)
.= *  Category: Required ANSI C90 forbids mixed dedarations and code. goodpractice.c corrected_hardcodedmemsize ()
- *  Category: Required AMST C30 forbids mixed dedarations and code. goodpractice.c corrected_hardcodedloopboundary()

You can now easily mass-edit statuses or comments for results of the same subtype. In the Results
List pane, group results by family, then within a result family use the Detail column to sort and
select a subset.

Result Review Workflow: Hide results that you reviewed once and
justified through source code annotations

In R2017D, if you justify a result through source code annotations, subsequent analyses do not
redisplay result again. Although the result still appears in your source code, it does not appear in
your results list.

jtatic int get_oil pressure (void)
{
wolatile int wol_i;
int i
i=wol_ir /[* polyspace RTE:NIVL */
assert{i > 0);
return i;
}

If you want to revisit those justified results, you can make them visible in one-click.
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Review Scope: All results
New results only: Off

Showing 381 out of 381 possible results
Filtered results: 0
Hidden results: 0

Hide results justified from the source code

Columns with active filters:
Mo filtered columns

Clear active filters

When you decide not to fix a finding, you can justify it through source code annotations. That finding
does not clutter your subsequent analysis results.

Suppose the analysis flags an error-handling statement as unreachable code. You do not want to
remove the statement because future code can trigger the error and make the error-handling
necessary. You can justify the unreachable code and choose not to see it again.

Additional Considerations
* How can I use source code annotations to justify a result?

You can directly type source code annotations in the correct format. See Justify Results Through
Code Annotations.

Alternatively, you can copy annotations from information in the user interface.

* In Eclipse, right-click the result to insert a justification directly in the source code.

* In Eclipse and the Polyspace user interface, assign one of the statuses Justified, No action
planned, or Not a defect to a result. Right-click the result to copy your justification and
paste it in a source code editor. See Justify Results Through Code Annotations.

» Will the hidden results still appear in the report?
The hidden results still appear in the report. The results are hidden from view to save review

effort. The reports are meant for complete documentation of your results. You cannot hide analysis
results from the reports.

Code Annotations: Justify results or define your own format with a
new annotation format

In R2017b, you can justify your results with the new Polyspace annotation syntax, or by using your
own custom format. Polyspace also interprets existing code annotations that use a different syntax.

The new annotation format has the following benefits:

» Easier results review: With the new annotation format, you can provide a justification for multiple
types of results on the same line. Previously, you had to enter the justification for different types of
results, such as defects and coding rules violations, on different lines.

* Custom annotation format: You can use an XML file to define any annotation format and map it to
the Polyspace syntax. When you analyze your code, Polyspace can interpret the annotations
regardless of the format.
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Additional Considerations:

If you use the new annotation format and place your annotation on the line above the result you
annotate, the annotation is ignored.

To apply the annotation to the line of code below, add +1 after the polyspace keyword.

Polyspace still supports annotations that use the old syntax.

MISRA Comments and Code Annotations: Import your existing MISRA
C:2004 justifications to MISRA C:2012 results

In R2017h, when you check your code against MISRA C:2012 rules, Polyspace imports existing
justifications for MISRA C: 2004 violations.

List

Al results v | T New [E]v <@ 5» (& showing 10/20

Type = Chedk: (9) ~1 ' Status = Severity = Comment: {3) ¥
MISRA C:2004 6,3 Typedefs that indicate size and sig. .. Unreviewed Unset MISRAZ004-6,3 comment
MISRA C:2004 6,3 Typedefs that indicate size and sig... To fix Medium MISRAZ004-6,3
MISFA C:2004 &, 1 Functions shall have prototype de... To fix Low MISRAZ004-5.1
MISRA C:2004 11,3 A cast should not be performed b... Justified Low MISRAZ2004-11.3
MISRA C:2004  11.4 A cast should not be performed b... Unreviewed Unset MISRAZ2004-11.4 comment
MISRA C:2004 12,12 The underlying bit representatio. .. Unreviewed Unset MISRAZ004-12, 12 comm. ..
MISRA C:2004 13,2 Tests of a value against zero sho... Mot a defect Low MISRAZ004-13.2
MISRA C:2004 14,4 The goto statement shall not be ... Mot a defect Low MISRAZO004-14.4
MISRA C:2004 149 Anif (expression) construct shall ... Mot a defect Low MISRAZ2004-13.2

MISRA C:2004 [19.5Macros shall not be #define'd an... [Justified low  |MISRA2004-19.5

The analysis maps these justifications to the corresponding MISRA C: 2012 rules, if they exist.

List

All results v | TeNew [E]+ <@ 5> & showingsf14 w

Type = Check ~1 G Status = Severity =F Comment: (7) ¥
MISRA C:2012  Dir 4.6 typedefs that indicate size and... Unreviewed Unset MISRAZ004-6,3 comment
MISRA C:2012  Dir 4.6 typedefs that indicate size and... To fix Medium MISRAZ004-5.3
MISRA C:2012 8.4 A compatible dedaration shall be v... To fix Low MISRAZ004-3.1
MISRA C:2012 11,3 A cast shall not be performed bet. .. Unreviewed Unset MISRAZ2004-11.4 comment
MISRA C:2012 11,4 A conversion should not be perfo,., Justified Low MISRAZ004-11.3
MISRA C:2012  14.4The controling expression of ani... Mot a defect Low MISRAZ004-13.2
MISRA C:2012 15,1 The goto statement should not b... Mot a defect Low MISRAZOD4-14.4

For more information, see Import Existing MISRA C: 2004 Justifications to MISRA C: 2012 Results.
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You can transition from MISRA C:2004 to MISRA C:2012 compliance. If you have already justified a
coding rule violation for MISRA C: 2004, you do not need to review the same result for the
corresponding MISRA C:2012 rule.

Variable Relationships in Tooltips: Check if variables in operation are
related from previous operation

In R2017h, you can determine if the variables in any operation are related from some previous
operation.

For instance, if you want to know if the variables varl and var2 in the operation return(varl —
var2) are related, you can insert a pragma before the line and rerun the analysis:

#pragma Inspection Point varl var2

In the results, you see a tooltip on var2 in the pragma, which shows the relation between them, if
one exists.

=oC - MEE- fpeRC ood Inspection point on external variable 'wheel speed' (int 32): [0 .. 65000]

Relation(s): wheel speed_old<=wheel speed
Press "F2" for foous

You can use the pragmas as an additional tool for diagnosing results. At any point in your code, you
can tell if certain variables are related to each other. You do not have to manually inspect your code
to find if the variables have been previously related.

See Find Relations Between Variables in Code.

Result Status: Assign statuses that directly correspond to stages of
development workflow

In R2017b, you can assign these statuses to a result. Each status corresponds to a stage in your code
analysis workflow.

* Unreviewed (default status)

* To investigate

* To fix

* Justified

* No action planned

* Not a defect
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 Other

You can follow your review progress more easily.

Additional Considerations

* How can I use the statuses to follow my review progress?

You can follow your progress in the Polyspace user interface or the Polyspace Metrics web
interface.

* Polyspace user interface: You can filter all results that have a certain status.

* Polyspace Metrics: You can see the percentage of results reviewed and justified. If you assign a
status other than Unreviewed to a result, the software considers the result as reviewed. If you
assign one of these statuses, the software considers the result as justified: Justified, No
action planned, or Not a defect.

* Can I create my own status?

You can still create custom statuses. Select Tools > Preferences and create your own statuses on
the Review Statuses tab.

Compatibility Considerations

If you open results from a previous release, the statuses are updated to the new release. The updates
are:

* FixorInvestigate-To fixorTo investigate

* Improve-To fix

* Undecided — Unreviewed.

If you open results from a previous release, the severity Not a defect is updated to Unset.

If your source code annotations use statuses from a previous release, the software reads your
annotations using the updates. The software does not change the annotations themselves.

Function Call Hierarchy: View and navigate to function callers and
callees by clicking function name
In R2017b, you can click function names in your source code to see callers and callees of the

function. You can then click a caller or callee name to go to their definitions in the source code. The
Call Hierarchy pane shows the callers and callees.

When a function is defined, the source code shows the function name in blue. To see callers and

callees on the Call Hierarchy pane, click the function name. For details, see Call Hierarchy.

int func{int wval) |
"""""""" > 1
1% (val==0)

return 07

return 1;

Line

1 b 4 file.main &



https://www.mathworks.com/help/releases/R2017b/codeprover/ug/result-views-in-polyspace-user-interface.html#buqgvpv-9

Reviewing Results

Previously, the Call Hierarchy pane was updated only when you clicked on a run-time check. You can
now navigate the function call hierarchy more naturally by using function names in your source code.

Additional Considerations
Can I also click function calls to see the callers and callees?

When a function is called, the function call sometimes shows a run-time check color. If the function
does not have a run-time check color (see func2 below), click the function name to update the Call
Hierarchy pane.

int main{) { E.."-. i —
int wval = INIT VAL:
— 0) — | Calls Line

T

] i A file,main 10

If the function has a run-time check color (see func above), right-click the function and select Go To
Definition. The Call Hierarchy pane is updated to show the callers and callees.
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Verification Setup

Unified User Interface: Create and maintain a single Polyspace project
for Bug Finder and Code Prover analysis

In R2017a, you can run Bug Finder and Code Prover analysis on the same Polyspace project in the
same user interface.

File Reporting Metrics Tools Window Help
B ﬁ | L) Run Bug Finder | w| [ Stop | (o}
! Pro Bug Finder

+AO|™ % 2T

Code Prover

=3 Bug_Finder_Example
EI'_'_=| Project Source Files
- @ sources

Create new Bug Finder result folder
Create new Code Prover result folder

[#= Run All Modules

>|_'_=| Project Indude Folders

[ Confia

Bug_Finder_Ex...-MISRA-checker X

=i~ Target & Compiler
’ Macros
“ Environment Settings

----- Inputs & Stubbing

EI'_‘_'_'I Bug_Finder_Exampl
E|'_‘_=l Configuration

Bj Result

e

E Module Source Files

|2_| Results [Completed]

----- Multitasking

----- Coding Rules & Code Metrics

[~ Code Prover Verification
Verification Assumptions
> Check Behavior
> Precision
Scaling

----- Reporting

----- Run Settings

----- Advanced Settings

Bug Finder Analysis

Find defects | all =

P eeeeses

Defects
Mumerical
Static memory
Dynamic memory
Data flow
Resource management
Programming
Concurrency
Security
Tainted data
Good practice

The unified user interface has the following benefits:

» Single entry point for two products: You launch the Polyspace user interface only once from one
icon on your desktop.

» Easier switching between products: After you run a Bug Finder analysis, you can switch to the
more rigorous Code Prover analysis in one click.

* One project, one configuration: Add source files and specify your analysis options only once. After
you set up your project, you can switch between the products without having to reconfigure.

Additional Considerations:

* What if I only want to run a Bug Finder analysis?

You have to set the options that apply to a Bug Finder analysis. Most options are common between
Bug Finder and Code Prover. So, you still have the benefit that most of your options will be set if
you ever switch to Code Prover.

The options specific to Bug Finder appear in the Bug Finder Analysis node, and the ones specific
to Code Prover in the Code Prover Verification node and the nodes underneath.

* IfIrun analysis in the two products, will the two sets of results appear together?

Yes, but not in the same view. The two sets of results appear under the same project, both in the
user interface and in the physical folder locations.

In the user interface, in the Project Browser, the Bug Finder results appear with the =l icon

and the Code Prover results appear with the =l icon.

12-2




Verification Setup

* In your file explorer, you find the result folders for both analysis under one project folder.

However, after you run the two analyses, you have to open the two sets of analysis results
separately to review them. In the user interface, double-click one of the two result icons to open
the results corresponding to that product.

* Besides analysis options, are there other changes from pre-R2017a that I should be aware of?

If you were previously using only one of the two products, you will now notice the following
differences.

Bug Finder User:

* You can now create multiple modules in your Polyspace project to analyze separate
components of your source code.

When you create a project and add your source files, they are automatically added to the first
module. If you add source files later, you have to select them and using the right-click option
Copy to Module_n, copy them to the module that you want.

* You can now choose to create a new result folder for a second analysis on the same module.
Use the option Create new Bug Finder result folder from the Run button dropdown. Prior
to R2017a, there was one result folder for Bug Finder. If you ran a second analysis, it
overwrote the previous results. Note that the overwriting is still the default behavior.

¢ A new icon is used to denote defects.

Before R2017a:

v". Chedk

Assertion

Invalid use of == operator

Invalid free of pointer

Missing unlock

Bad order of dropping privileges

Bad order of dropping privileges

IUse of previously dosed resource

Writing to const qualified object

R2017a:

o Chedk
* Assertion

Invalid use of == operator

Invalid free of pointer

Missing unlock

Bad order of dropping privileges
Bad order of dropping privileges

* Character value absorbed into EQF

IUse of previously dosed resource

O000000O0:

Code Prover User:
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+ Ifyou run a second analysis on the same module, by default, it overwrites the previous results.
Prior to R2017a, a new result folder was created by default every time you ran an analysis.

You can change this default behavior and create a new result folder for the second analysis.
Use the option Create new Code Prover result folder from the Run button dropdown.

+ If some of your files do not compile, the analysis continues with the remaining files. If a file
with compilation errors contains a function definition, the analysis considers the function as
undefined and uses a function stub instead. You can see which files did not compile on the
Output Summary pane and also in the report generated from the verification results.

Previously, the default analysis required that all of your files must compile. To revert to this

default behavior, use the option Stop analysis if a file does not compile (-stop-if-compile-
error).

* A new icon is used to denote definite run-time errors or red checks.

Before R2017a:

F... & Check

1= COut of bounds array index

1= Ileqally dereferenced pointer

1= Mon-terminating call

1= Mon-terminating loop

1= Invalid use of standard library routine
R2017a:

F... & Check

] Out of bounds array index

[ I Ilegally dereferenced painter
@ Mon-terminating call

] Mon-terminating loop

Invalid use of standard library routine

» T use DOS/UNIX®/MATLAB scripts to launch the analysis. How does this change affect me?

The change does not affect you directly. For instance, you still use two separate commands
polyspace-bug-finder-nodesktop and polyspace-code-prover-nodesktop to run
analysis from the DOS/UNIX command line. However, if you specify your options in a Polyspace
project in the user interface and then create a script from the project, you have to specify your
options only once for both products.

Once you specify your options in the Polyspace project, you can easily create a script for the
individual products. For instance, to create a Windows batch file that runs a Code Prover analysis,
run the command:

polyspace -generate-launching-script-for myproject.psprj

To create a Windows batch file that runs a Bug Finder analysis, run the command:

polyspace -bug-finder -generate-launching-script-for myproject.psprj
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Improved Speed and Precision: Run analysis faster and receive fewer
orange checks as compared to previous releases

In R2017a, Polyspace analysis uses many improvements that increase precision and reduce analysis
time significantly, sometimes by as much as 30%. For instance, in presence of arrays and nested
structures, the analysis is faster and more precise.

The improved speed and precision has the following benefits:

* Less wait time: You are likely to spend less time waiting for the analysis to complete.

* Less review time: For most applications, you are likely to have fewer orange checks and spend
less time manually reviewing them.

TASKING Compiler Support: Set up Polyspace analysis easily for code
compiled with Altium TASKING compiler

If you build your source code with the Altium® TASKING compiler, in R2017a, you can specify the

compiler name for your Polyspace analysis. The analysis can interpret macros that are implicitly
defined by the compiler and compiler-specific language extensions such as keywords and pragmas.

You can specify the following target processors directly: tricore, c166, rh850 or arm. See
TASKING Compiler (-compiler tasking).

Target Environment

Compiler tasking L

Target processor type | tricore -

You can now set up a Polyspace project without knowing the internal workings of your TASKING
compiler. If your code compiles with your compiler, it will compile with Polyspace in most cases
without requiring additional setup. Previously, you had to explicitly define macros that were implicitly
defined by the compiler and remove unknown language extensions from your preprocessed code.

Updated Visual C++ Support: Set up Polyspace analysis easily for
code compiled with Microsoft Visual C++ 2015 compiler

If you build your source code with the Microsoft Visual C++ 2015 compiler, in R2017a, you can
specify the compiler name for your Polyspace analysis. The analysis can interpret macros that are
implicitly defined by the compiler and compiler-specific language extensions such as keywords and
pragmas.

Target Language

Source code language (CPP P

Target Environment

Compiler visuall4.0 -

For more information, see Compiler (- compiler).
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The updated Visual C++ support has the following benefits:

» Easier compilation: You can now set up a Polyspace project without knowing the internal workings
of your Microsoft Visual C++ 2015 compiler.

* More precise analysis: The analysis provides precise results when you use compiler-specific
extensions.

Autodetection of Concurrency Primitives: Multitasking model detected
from Windows or pC/OS Il multithreading functions

In R2017a, if you use the Windows or pC/OS II functions for multitasking, the Polyspace analysis can
interpret them semantically.

Polyspace interprets the following functions:

Family Thread Creation Critical Section Begins Critical Section Ends
Windows CreateThread EnterCriticalSection LeaveCriticalSection
nC/OS I1 0STaskCreate 0OSMutexPend OSMutexPost

You do not have to adapt your code or specify your multitasking model manually through analysis
options. The analysis determines your multitasking model from the functions in your code and checks
if shared variables are sufficiently protected.

Manual Multitasking Setup: Functions beginning and ending critical
sections do not need to be defined

In R2017a, if you specify that certain functions begin and end critical sections, you do not have to
provide their definitions to Polyspace.

If you use functions provided by your operating system whose definitions are not readily accessible,
you do not have to provide the definitions.

Manual Multitasking Setup: main Function Not Required
In R2017a, you can run verification on multitasking applications that do not have a main function.

Previously, Code Prover analysis required a main function for multitasking. If your code did not have
a main function, you had to add a main to your source code or preprocessed code just for the Code
Prover analysis.

The software now adds an empty main function for you. If your code has a main function, the
software continues to use that main function for analysis.

Specifying Function Names for Options: Choose from prepopulated list
in user interface instead of entering manually
In R2017a, for options that take function names, you can choose the names from a list.

For instance, to specify which functions act as entry points to your multitasking application, you can
choose the names from a list as follows:




Verificat

ion Setup

-

degree_computation
functional_ranges
generic_validation
get_oil_pressure
initialise_current_data
initregulate E]
interpolation

main

new_speed —
orderregulate
partial_init
polynomia

procl

proc2
reset_temperature
return_code

serverl
server2 b

m

T — h'
Entry points ﬁ
Quick Filter =
Task |
Q- Type here to filter functions procl
proc2
Detected Functions

serverl
41 out of 41 functions server?
OO OO ST
-~
compute_new_coordonates

[ OK H Cancel l

You do not have to enter the names manually. If the functions list is long, you can start typing the

function name to reduce the list.

Polyspace API in MATLAB: Create MATLAB objects from Polyspace
projects to run analysis

In R2017a, you can create a MATLAB object from a Polyspace project (. psrpj file). For instan
you have a file myProject.psprj in the current working folder, enter:

opts = polyspace.loadProject('myProject.psprj')
Use the object opts in MATLAB scripts to run a Polyspace analysis:
polyspaceCodeProver(opts);

You can now consider the following workflows:

ce, if

» Set options in GUI and script analysis: Use the Polyspace user interface to specify options in your
Polyspace project, or adjust options based on results from a trial run. After the options are stable,
create a MATLAB object opts from the project and store it in a MAT-file. As you move along in
your development cycle, simply load opts from your MAT-file, update opts.Sources to add new
source files, update other properties as required, and use opts to run analysis. For all properties

of the object, see polyspace.Options.
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* Create project from your build command and script analysis: Use the function
polyspaceConfigure to create a .psrpj file from your build command (makefile). Create a
MATLAB object from that file to run analysis. In this way, you can use a MATLAB script for the
entire Polyspace analysis workflow beginning from your makefile.

Additional Considerations:

* A single Polyspace project works for both Bug Finder and Code Prover. Can I likewise use the
object to run both a Bug Finder and Code Prover analysis?

Yes, once you create the MATLAB object from a Polyspace project, you can use it with both
functions polyspaceBugFinder and polyspaceCodeProver.

* Can I create an object from a project that I have from a pre-R2017a version of Polyspace?

Yes, you can.

Improved support for user implementations of standard library
functions

If the arguments or return value of a standard library function have data types that are defined in
your header files, Polyspace compilation now uses your type definitions. Polyspace compilation uses
its own implementation of standard library functions and previously, looked for specific type
definitions in specific header files. Compilation errors occurred if the definitions could not be found in
those specific header files.

For instance, the fopen function returns a FILE* pointer.

FILE * fopen ( const char * filename, const char * mode );

Suppose, you define FILE using a typedef in an included header file that is not stdio.h, as follows:
typedef int FILE[4];

Polyspace compilation uses this definition of FILE. Previously, the compilation looked for the
definition of FILE only in stdio.h.

The improved support for user implementations of standard library functions has the following
benefits:

» Compilation errors avoided: You see fewer compilation errors due to your implementations of
standard library functions.

* Better analysis: The analysis uses data types for your standard library functions the way you have
defined them. Therefore, it interprets your code more accurately.

Improvement in automatic project creation from build systems

In R2017a, by default, automatic project creation will throw an error if a project with the same name
exists in the output folder.

If you encounter an error, avoid the name conflict: change the project name, output folder, or remove
your older project.

You cannot overwrite existing projects by accident. If you use scripts that are intended to overwrite
existing projects, use the additional option -allow-overwrite.
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Changes in analysis options and binaries

In R2017a, these options have been added, changed, or removed.

Updated Options

Option Change More Information
Report template Renamed in |New name: Code Prover report
user
interface The command-line name is still - report-
template.
Batch Renamed in |New name: Run Code Prover analysis on a
user remote cluster
interface
The option is now in the Run Settings node in
your project configuration.
The command-line name is still -batch.
Add to results repository Renamed in |New name: Upload results to Polyspace
user Metrics
interface
The option is now in the Run Settings node in
your project configuration.
The command-line name is still -add-to-
results-repository.
Compiler (-compiler) New value |You can specify the following arguments:
added

* tasking

See TASKING Compiler Support on page
12-5.

e visuall4.o

See Microsoft Visual C++ Support on page
12-5.

Infinities (-check-infinite)

Available in
user
interface

Previously, this advanced option was available
only on the command line.

NaNs (-check-nan)

Available in
user
interface

Previously, this advanced option was available
only on the command line.
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Removed Options

Option Status More Information

Optimize large static initializers (- |[Removed The benefits that came with -no-fold now

no-fold) appear by default, without the associated
costs in precision. So the option is not
required.

Continue with compile error (- Removed The option is enabled by default in Code

continue-with-compile-error) Prover. In other words, if some files have
compilation errors, by default, the analysis
continues with the remaining files.
If you want analysis to stop from even a single
compilation error, use the option Stop analysis
if a file does not compile (-stop-if-
compile-error).

Green absolute address checks (- |Removed Absolute address usage checks are green by

green-absolute-address- default. To remove this assumption and

checks) produce an orange check, use the option -no-
assumption-on-absolute-addresses.

Files and folders to ignore (- Removed Use the option Do not generate results for (-

includes-to-ignore) do-not-generate-results-for) to
suppress results from headers and sources in
certain files or folders.

Ignore float rounding (-ignore- Removed

float-rounding)

-retype-pointer Removed

-retype-int-pointer Removed

- lwtm Removed

-support-FX-option-results Removed

No automatic stubbing (-no- Error Option will be removed in a future release.

automatic-stubbing)

-easy-setup-preprocess Error Option will be removed in a future release.

gui-api Error Binary will be removed in a future release.
Use polyspace-comments-import instead.

polyspace-automatic- Error Binary will be removed in a future release.

verification

polyspace-remote Error Binary will be removed in a future release.

polyspace-verifier Error Binary will be removed in a future release.

rte-kernel Error Binary will be removed in a future release.

Dialect (-dialect) Error Option will be removed in a future release.

Use Compiler (-compiler) instead.
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Option Status More Information
Target operating system (-0S- Error Option will be removed in a future release.
target)

If you use this option in scripts, see the list
below for replacements:

* Linux: If you get compilation errors, use
Compiler (-compiler) gnux. x.

Sometimes, you might also have to set
Preprocessor definitions (-D) to linux,
unix, or _ linux_ .

e Visual: Use Compiler (-compiler)
visualx.x

* Vxworks: Use the VxWorks® configured
template.

For more information, see Create Project
Using Configuration Template.

* Solaris: Remove -0S-target.

* no-predefined-0S: Remove -0S-
target.

Import folder (-import-dir) Warning Option will be removed in a future release.

Compatibility Considerations

If you use scripts that contain the removed or updated options, change your scripts accordingly.

Changes in MATLAB options object
These classes will be removed in a future release.

* polyspace.CodeProverOptions: To customize Polyspace analysis of handwritten code, use
polyspace.Options instead.

* polyspace.ModelLinkCodeProverOptions: To customize Polyspace analysis of generated
code, use polyspace.ModellLinkOptions instead.

The properties and methods of the new classes are almost the same as the original classes. If
optsOld is an object of the original class and optsNew is an object of the new class, the following
properties have changed.
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Reporting

Removed

Use instead

opts0ld.Reporting.
EnableReportGeneration

optsNew.MergedReporting.
EnableReportGeneration

opts0ld.Reporting.ReportTemplate

optsNew.MergedReporting.
CodeProverReportTemplate

optsOld.Reporting. ReportOutputFormat

optsNew.MergedReporting.
ReportQutputFormat

ComputingSettings

Removed

Use instead

opts0ld.ComputingSettings.Batch

optsNew.MergedComputingSettings.
BatchCodeProver

opts0ld.ComputingSettings.
AddToResultsRepository

optsNew.MergedComputingSettings.
AddToResultsRepositoryCodeProver

Compatibility Considerations

Replace instances of the old class names in your MATLAB scripts with the new class names. Then,

replace the properties accordingly.

Even if you continue to use the old class names, you must change the properties, as described above.

Change in temporary folder location

In R2017a, Polyspace looks for standard environment variables such as TMPDIR to store temporary
files during an analysis. Previously, Polyspace used the folders /tmp or C:\Temp during analysis.

You can also store Polyspace temporary files in a folder different from the standard temporary folders.
To learn how Polyspace determines the temporary folder location, see Storage of Temporary Files.

Compatibility Considerations

If your analysis seems slower than before, check if the new temporary folder is on a network drive.
For faster analysis, use a folder on a local drive instead.
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Integers in Floating Point: See improved analysis precision for
floating point variables that always take integer values

In R2017a, the analysis can detect float or double variables that take integer values.

For instance, in the following code, despite the cast to double, the verification detects that i takes
integer values.

“ID 11: Invalid use of standard library routine &

Function 'pow’ is called with valid argument(s)
« First argument is non-zero or second argument is positive or zero
« First argument is not negative or second argument is an integer value
+ 'pow' does not overflow

Configuration Result Details

test.c x

#include =math.h=

Jf Return 1 1f 1 1s even, -1 otherwise

Conversion from int 32 to float 64
I

| result: integer values in [-2.1475E

right: full-range [-231 .. 2

+09 +09

.-1.0] or [0.0 .. 2.1475E 1

Press 'F2' for focus

The improved analysis precision has the following benefits:

* Improved analysis precision: The analysis uses more precise integer arithmetic for these variables.

* Better understanding of results: The range tooltip on these variables show that they take integer
values only. You can use this information to interpret certain results.

New Code Metrics: See number of lines in header files and number of
local variables per function

In R2017a, Polyspace can provide the following new code complexity metrics:

* Number of lines and number of lines without comments in header files
* Number of local non-static variables for every function and method
* Number of local static variables for every function and method

You can determine the memory footprints of your code using these new metrics (along with other
already existing metrics).
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Checks Green by Definition: Distinguish operations that are safe by
definition from operations that are proven safe

In R2017a, certain numerical run-time checks clearly indicate whether the check is green by
definition.

The messages for such checks state that the operation is safe with respect to the run-time check,
whatever the operand values. For instance, the sqrt or cbrt function cannot return subnormal
values.

If an operation is safe by definition, you do not need to protect against unsafe behavior. If an
operation is safe only in the current context, you need to recheck the operation when reusing it in
another context. Being able to identify operations that are safe by definition helps you determine if
you need to protect against later unsafe behavior.

Additional considerations:
* Can I tell by visual inspection that an operation is safe by definition?

Sometimes, you can. In other cases, rigorous mathematical calculations are required to prove that
an operation is safe by definition. Polyspace verification shows you all such operations in green,
providing you the assurance that your usage is safe with respect to the run-time check.

* Which checks can be green by definition?

The following checks can be green by definition.

* Subnormal float: Checks green by definition highlight operations that cannot return subnormal
results, whatever the operand values.

* Overflow: Checks green by definition highlight operations that cannot overflow, whatever the
operand values.

* Invalid operation on floats: Checks green by definition operations that cannot return NaN,
whatever the operand values.

The meaning of green by definition depends on your analysis mode. For instance, in the warn-
first mode of the Subnormal float check, green means that an operation cannot return
subnormal results unless the operands themselves are subnormal. Green by definition
incorporates this change in meaning of green.

Function Pointer Signature Mismatch: View orange checks instead of
red when the mismatch cannot be proven

In R2017a, the Correctness condition check on calls through function pointers aligns more closely
with the general semantics of Code Prover checks. The check is red only if the verification proves that
the function pointer does not point to a function with matching signature.

You can follow the same review policy with Correctness condition checks as with other checks.
Previously, the Correctness condition checks could be red even if the analysis did not prove a
mismatch between the function pointer and the function that it points to. These red checks indicated
that the verification cannot identify which function to call, because of imprecisions or lack of external
information. In these cases, the checks are now orange.
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Compatibility Considerations

You can see a change in the number of red and orange Correctness condition checks.

Structures with Volatile Fields: See improved analysis precision and
apply constraints if necessary

In R2017a, the software analyzes volatile-qualified structure fields more precisely.

* The analysis can distinguish between volatile and nonvolatile fields. Previously, if one field of a
structure was volatile, the analysis either considered all fields as volatile or ignored the volatile
qualifier for all fields, depending on the option you select.

For instance, in the following code, the software previously considered both vall and val2 as
volatile or not.

typedef struct myStruct
{

volatile int vall;
int val2;

};

If the analysis considers the volatile qualifier for structure fields, they can take any value
allowed by their data type at any point in the code.

* You can specify permanent constraints on volatile-qualified structure fields to narrow down
their assumed range. See Constraints.

This improvement also applies to volatile-qualified arrays.

You have to review fewer orange checks from imprecise analysis of structures with volatile fields.

Compatibility Considerations

Unless you use the default assumption to ignore the volatile qualifier on structure fields, you can
see a reduction in the number of orange checks.

Changes to coding rule checking

In R2017a, the following changes have been made in checking of previously supported MISRA C
rules.
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Rule Rule Improvement
MISRA C: 2004  |Identifiers (internal and The rule checker shows all identifiers that have the
Rule 5.1 external) shall not rely on the |[same first 31 characters as one rule violation.

significance of more than 31
characters.

Previously, every pair of identifiers with same 31
characters was shown as a separate violation.

For instance, in the following code snippet, the rule
violation appears only once.

extern int

engine exhaust gas temperature raw;
static int

engine exhaust gas temperature scaled;
static int

engine exhaust gas temperature cutoff;

Previously, the violation was shown three times.

You have to review only one rule violation for every
group of identifiers with the same 31 characters.
You can still see all instances of conflicting
identifier names in the event history of that rule
violation.

MISRA C:2012
Rule 8.5

An external object or
function shall be declared
once in one and only one file.

The rule checker considers that variables or
functions declared extern in a non-header file
violates this rule.
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Reviewing Results

Easier Review: View verification assumptions, see unreachable and
aliased function calls in call graph

In R2017a, you can review Polyspace Code Prover checks more easily using new features in the
Polyspace user interface.

» Verification assumptions: You can see the assumptions that the software makes, collected in one
place.

If an assumption can be changed, the Analysis assumptions pane shows the assumption.

" Analysis assumptions =
=

Assumption How to Change Assumption Issuer
Absolute addresses can be safely dereferenced Consider all absolute addresses as unsafe (-no-assumption-on-absolute-addresses): Add this option. Product
External pointers cannot be null and point to allocated data of sufficient size to be safely dereferenced Consider environment pointers as unsafe (-stubbed-pointers-are-unsafe): Enable this option. Product
Monfinite floats such as infinities and Nals are not considered Consider non finite floats (-allow-non-finite-floats): Enable this option. Product
Results of floating-point arithmetic are rounded to nearest value Consider all possible rounding for floating-point arithmetic, and possible use of extended predsion (-float-... Product
Stack pointers can be safely dereferenced even outside the pointed variable's scope Detect stack pointer dereference outside scope (-detect-pointer-escape): Enable this option. Product
Structure fields are not volatile unless the entire structure is volatile-qualified Consider valatile qualifier on fields {-consider-volatile-qualifier-on-fields): Enable this option. Product

ee also Polyspace core assumptions list in documentation

The Polyspace documentation lists the core assumptions that you cannot change. See Polyspace
Software Assumptions.

You can also see the modifiable assumptions in reports generated using a Code Prover template.

* Improved function call hierarchy: The Call Hierarchy pane shows which function calls are
unreachable (shown in gray) and which calls are made through function pointers (shown with the
& icon).

For instance, in the following figure, the function main calls funcl directly, and calls func2,
func3 and func5 indirectly via function pointers. The call to func4 is unreachable.

B | <

Calls Line
----- F myFile._init_globals 11
----- P myFile.funcl 15
----- & myFile.func2 22
----- & myFile.func3 22
----- F myFile. func4 25
----- & myFile, funcs 28

The new features help you interpret analysis results more easily.
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» Verification assumptions: To interpret certain analysis results, you can now browse through the
list of analysis assumptions. If an analysis option is available to change the assumption, you can
find the option more easily.

* Improved function call hierarchy: To interpret certain analysis results, you can now check quickly
if an expected function call does not occur in practice.

Folder Names in Results: Filter or group analysis results by source
folder names

In R20174a, the source folder name is shown in the list of analysis results.

:.ﬁ.]l results v: U New [E]v <@ 5> (& Showing 215/215 w

Family = Chedk = | Folder F | Function =F
Red Check QOut of bounds array index (ally reset_temperature()

Red Chedk Ilegally dereferenced painter [ {Custom...) Pointer_Arithmetic()

Red Check Mon-terminating call (Empty) Recursion_caller()

Red Check Invalid use of standard library routine [W]H:\myProject\mySourceFiles\myFolder 1 Sguare_Root()

Gray Check Unreachable code [¥]H: \myProjectimySourceFiles\myFolder2 generic_validation()

Gray Check Unreachable code [ oK ] [ cancel ] generic_validation{)

Gray Check Unreachable code Painter_Arithmetic()

Gray Check Unreachable code H:\myProjectimySourceFiles\myFolder2 Unreachable_Code()

COrange Check Out of bounds array index H:\myProjectmySourceFiles\myFolder 1 generic_validation()

You can order your results by folders or filter results belonging to specific folders. Using custom
filters, you can filter out the subfolders of a folder in one click.

Code to Model Traceability: Switch easily between identifiers in
generated code and corresponding blocks in model

In R2017a, you can trace an instance of a variable in generated code back to your model.
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{
intlé T etk k:
intlé T rtb_x;
intlé T rthk_vl;

/* Product: "<Root>/k' incorporates:

* (Constant: "<Boot>/Conatant’

*/

rtb k = (intlg T) {(*rtu Inl / 100);
= Print Source Code: WhereAreTheErrors.c

~ b4, Search For "rtb_k" in Current Socurce File Ctrl+F |°°

: 4 Search For "rtb_k" in All Source Files

* Search For All References
[* Go To Definition
¥ Go To Line Ctrl+L
:: ¥ Go To Model |
rtk IlL:l Open Editor |High|ightsthe correspending block in M-:udel|
rth Add Pre-Justification Te Clipboard
Whi W Expand All Macros

1 Collapse All Macros
. Create Duplicate Code Window

The model shows the corresponding block highlighted in blue. If the block is in a subsystem, both the
subsystem and the block are highlighted in blue.

Constant3

Compare
To Constant# ol intls |—P T
Out1
abi
10% % [ (x-y)
x N | :
boalean| int16
** boalean AND
Boolean >
ikl | Outl
-y
While less than 10 Double and with range
Constant4
F

Swyitchl

The new ability to trace from code to model enables the following:

* More convenient navigation: Previously, you traced back from code to model via links in code
comments. You can now navigate from the code operations themselves.
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* More fine-grained navigation: You can easily identify which block in your model leads to which
operation in the generated code.

Polyspace APl in MATLAB: Read Polyspace analysis results from
MATLAB

You can read your Polyspace analysis results into a MATLAB table. For instance, if the folder
C:\MyResults contains results of a Polyspace analysis, enter the following:

resObj = polyspace.CodeProverResults('C:\MyResults"')
resSummary = getSummary(resObj)
resTable = getResults(resObj)

resSummary and resTable are two MATLAB tables containing summary and details of the
Polyspace results.

See also polyspace.CodeProverResults.

You can use the capabilities of MATLAB to obtain graphs and statistics about your Polyspace results.
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Verification Setup

Diab Compiler Support: Set up Polyspace verification easily for code
compiled with Wind River Diab compiler

If you build your source code using the Wind River® Diab compiler, in R2016b, you can easily set up a
Polyspace project to verify your code. After you specify the Diab compiler and your target processor,
the verification:

* Implicitly defines macros that are defined for the Diab compiler. Previously, you defined the
macros in your Polyspace project explicitly to avoid compilation errors.

* Understands language extensions such as keywords and pragmas that are specific to the Diab
compiler. Previously, you removed unknown language extensions explicitly from the preprocessed
code in your Polyspace project to avoid compilation errors.

You can now set up a Polyspace project manually without knowing the internal workings of your Diab
compiler. Specify the Diab compiler and your target processor, and run verification without facing
compilation errors. See Diab Compiler (-compiler diab).

The software supports version 5.9 and older versions of the Diab compiler.

Multitasking Code Verification Setup: Specify cyclic tasks and
nonpreemptable interrupts directly as verification options

In R2016b, you can specify which entry points in your code represent cyclic tasks and
nonpreemptable interrupts. Previously, to emulate the cyclic behavior of a task, you embedded
instructions in a loop. To emulate a nonpreemptable interrupt, you specified temporally exclusive
pairs where the interrupt was paired with all other interrupts.

For more information, see Cyclic tasks (-cyclic-tasks) and Interrupts (-interrupts).

Improved source and include folder management

Before R2016b, when you created a project, you added and removed source files and include folders
individually. If you moved your source files or added new files to your programming project, you re-
added the files into your Polyspace project.

Starting in R2016b, you create Polyspace projects with root source folders and include folders. The
root folder location represents the top of the hierarchy for your source files. Polyspace shows all files
relative to the root source locations. When you add a root source location, you can:

* See all source files under the root folder (and subfolders)

* Exclude files and subfolders in the hierarchy to change the active list of source files to analyze.

* Refresh the source file list to see new files or folders in the root source hierarchy.

* Modify the root source folder path.

» If you use a revision control system, change the root folder location to point to different versions
of your source files.
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For include folders, instead of adding individual folders, you add a root include folder location.
Polyspace adds all include folders underneath the root include location that contains include files. You
can refresh and modify the include folder path.

For more information, see Create Project.

Writable Examples: Modify example projects and restore original
versions

The examples projects under Help > Examples are now easier to use. The first time that you open
an example project, a writable version is saved in your Polyspace Workspace. In the writable
project, you can test configuration options, change sources, and rerun the example. If you want to
refresh the example with a clean version, select Help > Examples > Restore Default Examples.

Run verification on .psprj file from the command line

If you already have a project created in the Polyspace Interface, you can now use that .psprj file to
run your verification from a command line.

DOS or UNIX Command Line

Use the new option polyspace-code-prover -generate-launching-script-for <PSPRJ
FILE> to generate the files to run the analysis from the command line. These files are generated:
* source_command.txt — List of source files in the project
* options command.txt — List of analysis option settings

* launchingCommand.sh or launchingCommand.bat — Script that runs the verification using
options_command.txt, source command.txt. The script can also take additional analysis
options as parameters.

For more information, see Create Command-Line Script from Project File.
MATLAB Command Prompt

At the MATLAB command prompt, you can now give a .psprj file as an argument to
polyspaceCodeProver.

The syntax polyspaceCodeProver(PSPRJ file, 'nodesktop') runs a verification on the project.
If you have multiple modules or configurations, the active module and active configuration are
verified.

Polyspace API in MATLAB: Configure and run Polyspace using MATLAB
objects

In R2016b, Polyspace scripting from MATLAB is easier and more MATLAB-friendly. R2016b

introduces a set of classes, methods, and function improvements to help you run Polyspace from
MATLAB. For more information and examples, see the linked reference pages.
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Classes
Name Description
polyspace.CodeProverOptions An options object with properties that map to the Polyspace

environment configuration options. Use this object to customize
analysis options and run analysis.

polyspace.ModelLinkCodeProverOptio [Another version of the CodeProverOptions object with

ns properties specifically for model generated code. Use this object
to customize analysis options and run analysis.

polyspace.GenericTargetOptions A helper object for the CodeProverOptions classes. Use this
object to customize a generic target.

polyspace.CodingRulesOptions A helper object for the CodeProverOptions object. Use this
object to customize the list of coding rules checked during the
analysis.

Methods

Name Description

polyspace.Options.copyTo Copy settings between options objects. You can use this method

to copy options from a CodeProverOptions object to a
BugFinderOptions object and vice versa.

polyspace.Options.generateProject |Generatea .psprj file from an options object to open in the

Polyspace interface.
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Functions

Name Description

polyspaceCodeProver Run an analysis using CodeProverOptions objects or .psprj
files.

Configuration Parameters Help: View descriptions of Polyspace
options in Simulink configuration parameters

When you use the Simulink plugin, you must set Simulink configuration parameters to run your
analysis. If you need help setting the configuration parameters, you can now right-click a
configuration parameter and get What’s This help. When you select What’s This, a help window
opens with details about the different settings and limitations of the parameter.

For more information about the configuration parameters, see Configure Code Verification.

Eclipse Build Support: Set up Polyspace verification from Eclipse build
command

In R2016D, if you use a build command to build your source code in Eclipse or an IDE based on
Eclipse, you can easily set up your Polyspace verification. To obtain the compiler options required for
the verification, trace the build command inside the IDE. For more information, see Configure
Verification.
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Visual Studio 2010 add-in support to be removed from installation

In a future release, the Polyspace add-in for Visual Studio 2010 will not be included with the
installation.

To run Polyspace on code from Visual Studio, use the automatic configuration tool instead. See Create
Project Using Visual Studio Information.

If you still want to use the add-in, you will be able to download the add-in from MATLAB Answers.

Support for Rhapsody 8.1

Starting in R2016b, the Polyspace plugin for IBM Rational® Rhapsody® supports Rhapsody 8.1. For
more information, see Verify Code in IBM Rational Rhapsody Environment.

DOS Mode Warning on Linux: Compilation warning for DOS
inconsistencies

When using Polyspace on Linux, a new compilation warning may appear. On Windows, DOS is case-
insensitive meaning you cannot have two files with the same name but different capitalization. If you
select the option Code from DOS or Windows file system (-dos)Code from DOS or Windows file system
(-dos), Polyspace simulates this DOS behavior on Linux. If your source files include header files with
inconsistent capitalization and it is unclear which file should be included, Polyspace issues a
compilation warning.

For example, consider these two situations:

Include Statements Include Files

Situation 1 #include "myheader.h" myheader.h
#include "MYHEADER.h"
#include "MyHeader.h"

Situation 2 #include "myheader.h" myheader.h
#include "MYHEADER.h" MYHEADER. h
#include "MyHeader.h"

In the first situation, only one file exists with the name myheader . h. Because these include
statements can only refer to one file, it is obvious which file to include. A warning is not issued.

In the second situation, two files exist: myheader.h and MyHeader . h. Because they have the same
name and different capitalization, the capitalization in the include statement affects which file is
included. Polyspace can find perfect matches for the first and second include statements. The last
include statement is not a perfect match, so could refer to either header file. Because there is
ambiguity with the last include statement, Polyspace issues this compilation warning: warning:
could not find include file "MyHeader.h".

In a future release, this compilation warning will become a compilation error.
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Faster Restart for Remote Verification: Reuse compilation results from
a previous analysis

In R2016b, if a remote verification stops after compilation, for instance because of communication
problems between the server and client computers, you do not have to restart the verification from
the beginning. You can reuse compilation results from the previous failed analysis.

For more information, see -submit-job-from-previous-compilation-results.

Internal Memory Limits Removed: Expect fewer analysis failures from
memory-intensive processes

In R2016D, several internal limits on memory usage have been removed. Previously, if certain
processes consumed memory above a certain limit (around 5 GB per process), those processes were
stopped and the overall analysis failed. Now you are less likely to see failures from memory-intensive
processes.

If you were unable to complete analysis on large or complex projects because of failures from
memory-intensive processes, you are more likely to succeed in R2016b.

Support for local threads

Starting in R2016b, Polyspace adds support for these local thread modifiers:

*  thread — requires Compiler (-compiler) gnu4.8
*+  declspec(thread) — requires Compiler (-compiler) visual
* thread local — only for C++ code.

This support may eliminate compilation errors or change variable from shared to non-shared.

Changes in Target & Compiler analysis options

In R2016b, these Target & Compiler options have been added, changed, or removed.

Option Change More Information

Compiler (-compiler) New option

Dialect (-dialect) Removed from |Option will be permanently removed in a future release.
the user
interface. Replace -dialect with -compiler while retaining the

option argument. In the user interface, this replacement
If you use the |is done automatically for existing projects.

option in your
scripts, you see |If you use the Wind River Diab compiler to build your
a warning. source code, use the option Compiler (-compiler) with
argument diab.

Target processor type (- |Updated for the |In the user interface, if you select diab for Compiler (-

target) Wind River Diab |compiler), you see target processors that are tailored to
compiler. the Diab compiler. For the processor specifications, see

the contextual help.
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Option

Change

More Information

Target operating
system (-0S-target)

Removed from
the user
interface.

If you use the
option in your
scripts, you see
a warning.

Option will be permanently removed in a future release.

Remove the option from your scripts. For some option
arguments, you might have to perform these additional
steps:

Linux: If you get compilation errors, use a gnux. x
argument for Compiler (-compiler).

Sometimes, you might have to explicitly define
operating-system-specific macros such as linux,
unix, or _ linux__ . See Preprocessor definitions (-
D).

Visual: Use a visualx. x argument for Compiler (-
compiler).

Vxworks: Use the options from the VxWorks
templates.

Create a Polyspace project using one of the VxWorks
templates and generate a script from your project.
Copy the options related to the VxWorks template
from this script. For more information, see Create
Project Using Configuration Template and the
reference page for -generate-launching-
scripts-for.

Solaris: Just remove the option -0S-target.

no-predefined-0S: Just remove the option -0S-
target.

Changes in analysis options and binaries

In R2016Dh, these options have been added, changed, or removed.

For changes to Target & Compiler options, see “Changes in Target & Compiler analysis options” on
page 13-6. For other options, see the following table.
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New Options

Option

Description

Cyclic tasks (-cyclic-tasks)

Specify functions that represent cyclic tasks.

Interrupts (-interrupts)

Specify functions that represent nonpreemptable interrupts.

Consider environment pointers as
unsafe (-stubbed-pointers-are-unsafe)

Specify that stubbed pointers coming from external code can
be unsafe to dereference, unless otherwise constrained.

Consider volatile qualifier on fields (-
consider-volatile-qualifier-on-fields)

Consider that structures with volatile-qualified fields can
change between consecutive accesses.

Subnormal detection mode (-check-
subnormal)

Detect operations that result in subnormal floating point
values.

Generate stubs for Embedded Coder
lookup tables (-stub-embedded-coder-
lookup-table-functions)

Stub autogenerated functions that use lookup tables and
model them more precisely.

-preemptable-interrupts

Specify functions that represent preemptable interrupts.

-non-preemptable-tasks

Specify functions that represent nonpreemptable tasks.

-function-behavior-specifications

* Map your library functions to standard library functions
recognized by Polyspace.

* Specify functions that contain lookup tables with linear
interpolation and no extrapolation.

-submit-job-from-previous-compilation-
results

Specify that the analysis job must be resubmitted without
recompilation.

Updated Options

Option Change More Information
Detect stack pointer dereference Option now
outside scope (-detect-pointer-escape) |available in

user

interface.

Coding rule subsets single-unit-
rules and system-decidable-

These subsets are available for Check MISRA
C:2004 (-misra2), Check MISRA AC AGC (-

Subsets now
available in

rules the misra-ac-agc), and Check MISRA C:2012 (-
Polyspace misra3)
interface.

-check-infinite and -check-nan Option Use warn-first as option argument instead
argument of warn.
renamed.



https://www.mathworks.com/help/releases/R2016b/codeprover/ref/cyclictaskscyclictasks.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/interruptsinterrupts.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/considerenvironmentpointersasunsafestubbedpointersareunsafe.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/considerenvironmentpointersasunsafestubbedpointersareunsafe.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/considervolatilequalifieronfieldsconsidervolatilequalifieronfields.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/considervolatilequalifieronfieldsconsidervolatilequalifieronfields.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/subnormaldetectionmodechecksubnormal.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/subnormaldetectionmodechecksubnormal.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/generatestubsforembeddedcoderlookuptablesstubembeddedcoderlookuptablefunctions.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/generatestubsforembeddedcoderlookuptablesstubembeddedcoderlookuptablefunctions.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/generatestubsforembeddedcoderlookuptablesstubembeddedcoderlookuptablefunctions.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/preemptableinterrupts.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/nonpreemptabletasks.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/functionbehaviorspecifications.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/submitjobfrompreviouscompilationresults.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/submitjobfrompreviouscompilationresults.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/detectstackpointerdereferenceoutsidescopedetectpointerescape.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/detectstackpointerdereferenceoutsidescopedetectpointerescape.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checkmisrac2004misra2.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checkmisrac2004misra2.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checkmisraacagcmisraacagc.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checkmisraacagcmisraacagc.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checkmisrac2012misra3.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checkmisrac2012misra3.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checkinfinite.html
https://www.mathworks.com/help/releases/R2016b/codeprover/ref/checknan.html

Verification Setup

Removed Options

Option Status More Information
Green absolute address checks (- |Error Absolute address usage checks are green by
green-absolute-address- default. To remove this assumption and
checks) produce an orange check, use the option -no-
assumption-on-absolute-addresses.
Files and folders to ignore (- Error Use the option Do not generate results for (-
includes-to-ignore) do-not-generate-results-for) to
suppress results from headers and sources in
certain files or folders.
Ignore float rounding (-ignore- Error Option will be removed in a future release.
float-rounding)
-retype-pointer Error Option will be removed in a future release.
-retype-int-pointer Error Option will be removed in a future release.
-lwtm Error Option will be removed in a future release.
-support-FX-option-results Error Option will be removed in a future release.
polyspace-vcproj Removed Use polyspace-configure or the Polyspace
Add-In for Visual Studio instead.
polyspace-automatic- Warning Binary will be removed in a future release.
verification
polyspace-verifier Warning Binary will be removed in a future release.
rte-kernel Warning Binary will be removed in a future release.
polyspace-remote Warning Binary will be removed in a future release.
Import folder (-import-dir) Warning Option will be removed in a future release.
No automatic stubbing (-no- Warning Option will be removed in a future release.
automatic-stubbing)
-easy-setup-preprocess Warning Option will be removed in a future release.
gui-api Warning Binary will be removed in a future release.

Use polyspace-comments-import instead.

Compatibility Considerations

If you use scripts that contain the removed or updated options, change your scripts accordingly.
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Verification Results

Subnormal Float Detection: Identify loss of precision from operations
that lead to subnormal results

In R2016D, the verification detects operations that result in subnormal floating-point values. The
presence of subnormal numbers indicates loss of significant digits. This loss can accumulate over
subsequent operations and eventually result in unexpected values. Subnormal numbers can also slow
down the execution on targets without hardware support. If you run a Polyspace verification, you can
choose to see one of the following:

» All operations that lead to subnormal results.

* Only those operations that lead to subnormal results from normal operands.

For instance, the numbers MIN FLOAT and nextabove (MIN FLOAT) are normal, but their
difference is subnormal.

For more information, see:

* Subnormal detection mode (-check-subnormal): The option to specify subnormal detection.
* Subnormal float: The result of subnormal detection.

Local Variable Size Estimation: Find total size of local variables in a
function

In R2016b, you can compute the total size of local variables in a function by using these two metrics:

* Lower Estimate of Local Variable Size: Total size of local variables taking nested scopes into
account.

If a function has variable definitions in nested scopes, the software computes the total variable
size in each scope and uses whichever total is greatest. For instance, if a conditional statement
has variables definitions, the software computes the total variable size in each branch, and then
uses whichever total is greatest.

* Higher Estimate of Local Variable Size: Total size of all local variables.

Changes to coding rule checking
Expanded MISRA C++ Support

The following MISRA C++:2008 rules are now supported.

e 0-1-9: There shall be no dead code.
* 0-1-11: There shall be no unused parameters (named or unnamed) in nonvirtual functions.

* 0-1-12: There shall be no unused parameters (named or unnamed) in the set of parameters for a
virtual function and all the functions that override it.

* 0-2-1: An object shall not be assigned to an overlapping object.
* 16-6-1: All uses of the #pragma directive shall be documented.
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Updated Specifications

The Polyspace specifications for these rules have been updated.

Standard Rule Change
MISRA C++:2008 2-10-3 The violation is on the second instance of the duplicate
identifier instead of the first.
2-10-4 The violation is on the second instance of the duplicate
identifier instead of the first.
5-0-3 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
5-0-6 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
5-0-8 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
MISRA C:2004 and 5.3 The violation is on the second instance of the duplicate
MISRA AC AGC identifier instead of the first.
5.4 The violation is on the second instance of the duplicate
identifier instead of the first.
10.1 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
10.2 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
10.3 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
10.4 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
MISRA C:2012 5.3 The violation is on the second instance of the duplicate
identifier instead of the first.
5.4 The violation is on the second instance of the duplicate
identifier instead of the first.
10.3 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
10.6 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
10.7 If two types have the same size in the target configuration,
Polyspace does not raise a violation.
10.8 If two types have the same size in the target configuration,

Polyspace does not raise a violation.
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Metrics for C++ Templates: View code complexity metrics for
instances of C++ templates

In R2016b, you can compute code complexity metrics for C++ templates. If you instantiate a C++
template function and specify the option Calculate code metrics (-code-metrics), you now see function
metrics for the template in your analysis results.

The metrics appear on the template definition. The software uses the first instance of the template to
calculate the metrics. If you specialize a template, you see separate metrics for the original template
and its specialization.

For more information, see Code Metrics.

Mutual Exclusion Support: View precise ranges for shared variables
protected by critical sections and temporally exclusive tasks

In R2016b, when you check multitasking code for run-time errors, the error checking uses the
protections that you specify. Previously, the software only determined if the protections were
sufficient to prevent concurrent access of shared variables. The run-time error checking did not use
those protections and considered all shared variables as unprotected. The improved support for
protections in R2016b reduces the number of orange checks in multitasking code.

The following example illustrates the change. For a more detailed tutorial, see Manually Protect
Shared Variables from Concurrent Access.
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Prior to R2016b R2016b

In the following code, if you specify that task In the following code, the Overflow check on the
and interrupt handler are temporally addition considers the temporal exclusion of
exclusive, the shared variable shared var is task and interrupt handler. The check is

protected from concurrent access. However, the |green because the verification considers that the
Overflow check on the addition shared var += |addition cannot directly follow the assignment
2; does not consider this protection. The check is |shared var = INT MAX;. The assignment
orange because the verification considers that shared var=0 takes place in between the two
the addition can directly follow the assignment |operations.

shared var = INT MAX;.
- - #include <limits.h>

#include <limits.h> int shared var;

int shared var;
void inc() {

void inc() { /* Green overflow */
/* Orange overflow */ shared var+=2;
shared var += 2; }
}
void reset() {
void reset() { shared var = 0;
shared var = 0; }
}
void task() {
void task() { volatile int randomValue = 0;
volatile int randomValue = 0; while(randomValue) {
while(randomValue) { reset();
reset(); inc();
inc(); inc();
inc(); }
} }
}
void interrupt() {
void interrupt() { shared var = INT MAX;
shared var = INT MAX; }
) void interrupt _handler() {
void interrupt _handler() { volatile int randomValue = 0;
volatile int randomValue = 0; while(randomValue) {
while(randomValue) { interrupt();
interrupt(); }
}
}
void main() {
void main() { }
}

If the shared variable is a pointer or an array, this change in behavior does not occur. Run-time error
checking on shared pointers and arrays does not consider the protections.

Compatibility Considerations

If you use protections such as critical sections and temporal exclusion of tasks, you can see a
reduction from previous releases in the number of orange checks.
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Improved Embedded Coder Support: View more precise results when
generated code uses lookup tables or large data structures

Lookup Tables

In R2016D, the verification assumes more precise return values for generated functions that use a
lookup table in their body. If your model has Lookup Table blocks, such functions are generated .
Previously, the software assumed full range for the return values of those functions. To avoid orange
checks from this overapproximation, for certain kinds of lookup tables, the software now assumes
that the function return values are within the bounds of the lookup table. The software makes this
assumption only if the lookup table in the function uses linear interpolation and does not allow
extrapolation. For more information, see Generate stubs for Embedded Coder lookup tables (-stub-
embedded-coder-lookup-table-functions).

If the software does not detect functions that use lookup tables of this kind, you can also explicitly
specify such functions. For instance, if you use a lookup table function in an S-Function block, the
function name might not adhere to the naming convention for lookup table functions. If the software
assumes full range for its return value, you can explicitly specify that the function uses a lookup table
with linear interpolation and no extrapolation. For more information, see -function-behavior-
specifications.

Large Data Structures Accessed Via Pointers

In R2016b, when your code has a large global data structure and a function accesses its fields via
pointers, the verification is more precise than before. Previously, if a function modified one field via
pointers, in some cases, the verification lost precision on other fields and assumed full range for their
values.

Code generated from models can have large structures because all inputs to or outputs from the
model are placed in one structure. With this improved precision, you can see more precise results for
generated code in many cases.

Compatibility Considerations

If you run verification on generated code, you can see a reduction from previous releases in the
number of orange checks.

Precise Buffer Manipulation Functions: View more precise results on
complete copying of structures

In R2016D, if your code uses the memcpy, memmove, or bcopy function to copy structures, you can
see fewer orange checks. Previously, if you copied one structure to another with these functions, the
software assumed that each field of the destination structure had full range of values. The software
now considers precise values for the result of the copy.

Assumption for Stubbed Pointers: Review fewer warnings from
pointers coming from external code

In R2016Db, the default verification for C code assumes that stubbed pointers coming from external
code are safe to dereference. For instance, the pointer does not have a NULL value and pointer
dereference is within allowed bounds.
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Previously, the default verification assumed that stubbed pointers were unsafe to dereference. For
instance, if you dereferenced the pointer return value of a stubbed function without checking for
NULL, the Illegally dereferenced pointer check showed a warning in orange. With the change in
default assumption, orange Illegally dereferenced pointer checks in your verification results are
more likely to have a root cause within your code.

Compatibility Considerations

If you run verification on a Polyspace project from a previous release, you can see a reduction in the
number of orange checks.

You can also see an increase in the number of gray checks. If your code contains protections against
NULL values of environment pointers, for instance conditions such as if (ext ptr!=NULL), a gray
check appears on these protections.

To revert to the previous default assumption, use the option Consider environment pointers as unsafe
(-stubbed-pointers-are-unsafe). Alternately, you can individually change the default assumption on
certain pointers only in the Constraint Specification window. See the description for Initialize
Pointer in Constraints.

Assumption for Structures with Volatile Fields: Review fewer warnings
from partly volatile structures

In R2016Db, the default verification ignores the volatile qualifier on fields of a structure. Previously,
if a structure had a volatile-qualified field, the verification considered all fields of the structure as
volatile. As a result, the verification assumed that their values always spanned the full range of their
data types. This overapproximation sometimes caused false warnings in orange from the non-
volatile fields.

If you use a structure whose fields represent values read from hardware, add the volatile qualifier
to the structure definition instead of individual field definitions.

Compatibility Considerations

If you run verification on a Polyspace project from a previous release, you can see a reduction in the
number of orange checks. Occasionally, you can also see changes in red or gray checks. For instance,
if the field structInstance. field is volatile, branches of the condition
if(structInstance.field) were previously always reachable. With the new assumption,
depending on the value of structInstance.field, some of the branches can be unreachable.

To revert to the previous default assumption, use the option Consider volatile qualifier on fields (-
consider-volatile-qualifier-on-fields).

Expected Infinite Loop Detection: Avoid justifying run-time errors on
infinite loops that you introduce deliberately

In R2016D, the verification detects if an infinite loop is intentional. For these infinite loops, the
verification does not produce a red Non-terminating loop error on the loop statement. If you
deliberately introduce infinite loops, for instance, to emulate cyclic tasks, you do not have to justify
red checks. For example, if a loop has a trivial predicate while (1) and there are no exit statements
in the loop body, the verification considers the loop as intentional.
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For more information, see Non-terminating loop.

Compatibility Considerations

If you run verification on a pre-R2016b project, you see a reduction from previous releases in the
number of red Non-terminating loop checks. However, as in previous releases, any code following
the infinite loop shows gray checks. Though the infinite loop is expected, the verification considers
code following the infinite loop as unreachable.

Mapping to Standard Functions: View precise results by mapping
imprecisely analyzed functions to corresponding standard functions

In R2016b, if you encounter imprecisions in analysis of your custom library function, you can map the
function to a standard library function for more precise analysis.

Polyspace Code Prover cannot analyze certain code constructs because of inherent limitations with
static verification. If your custom library function uses one of those constructs, to avoid missing a
run-time error, the verification assumes all possible results from the function call. To avoid orange
checks from this overapproximation, you can map your custom library function to a standard library
function. Although the software does not analyze the body of your library function, in the various call
sites, the software emulates your function behavior more precisely. For instance, the software
assumes a more precise range for the function return value. The reason for this precise analysis is
that the software models effects of standard library functions extremely precisely.

For instance:

» If you have an implementation of a trigonometric function and the software assumes full range for
the return value, map your implementation to the corresponding standard library trigonometric
function.

» Ifyou have a function that copies contents of one memory location to another and the software
assumes that the destination location is still uninitialized, map your function to the memcpy
function.

You can map to only certain standard library functions from math.h and copying functions such as
memcpy. Additionally, you can map your functions to some internal Polyspace functions for more
precise analysis. For more information, see -function-behavior-specifications.
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Reviewing Results

Interactive Graphical Display: Click graphs on Dashboard to filter
results

In R2016h, you can narrow down the scope of your review by using a graphical display of analysis
results. Previously you used the graphs to obtain an overview of the analysis results and determine
which results to focus on. Now you can also select elements in the graphs to view only those results
that you want to focus on. To see all results again, clear your filters in one click.

To filter results, use the following graphs:
* Check distribution: If you click a colored region on this pie chart, the Results List pane shows

checks of that color only.

* Top 5 coding rule violations: If you click a column corresponding to a rule, the Results List
pane shows violations of that rule only.

» Top 5 orange sources: If you click a column corresponding to an orange source, the Results
List pane shows orange checks caused by that source only.

For more information, see Filter and Group Results.

Float Range Display: View float variables with narrow ranges more
clearly

In R2016Db, the tooltips on float variables show an improved display of the variable ranges. For
instance:

» If the lower and upper bounds of a float variable are close, the tooltip displays as many digits as
required to distinguish between them.

* The tooltips clearly indicate which values are shown with rounding. For instance, the value 1.0
does not involve rounding but 1.2345. .. shows a variable that is displayed with rounding
towards zero.

When rounded, at least 5 significant digits are displayed.

For more information, see Source.

Event History for Coding Rules: Navigate easily between two locations
in code that together cause a rule violation

In R2016D, for certain coding rules, the Result Details pane shows previous events causing the rule
violation. You can click an event and navigate to the corresponding location in the source code.

¥ MISRA C:2012 5.1 (Required) 2/
External identifiers shall be distinct.
External variable engine_temperature_scaled conflicts with the external identifier engine_temperature_raw (file.c line 1).

Event File Scope Line

1 Violation site file.c file.c 1
MISRA C:2012 5.1 file.c
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This event history is shown for those rules which are related to more than one location in the code.
For instance, the event history appears for the following rules:

e MISRA C:2004 Rule 5.2: Identifiers in an inner scope shall not use the same name as an identifier
in an outer scope, and therefore hide that identifier.

* MISRA C:2012 Rule 5.1: External identifiers shall be distinct.

* MISRA C++ Rule 2-10-1: Different identifiers shall be typographically unambiguous.

* JSF® C++ Rule 139: External objects will not be declared in more than one file.

Subcheck Display for Standard Library Routines: Determine easily
from visual inspection which subcheck failed

The Invalid use of standard library routine check consists of multiple subchecks. In R2016b, you
can determine visually from the Result Details pane which subchecks failed.

If a subcheck passes, it is marked with a +.
If a subcheck fails in all the cases that the verification considers, it is marked with a *!.

* If a subcheck fails only in some of the cases, it is marked with a ?.

For instance, in the following example, the first subcheck passed but the second one failed.

! ID 22: Invalid use of standard ibrary routine 2/
Error: function 'memcpy’ is called with invalid argument(s)
» Checks on first argument (destination):
¥ Mot null.
1 Is not a memory area that is accessible within the boundary given by the third argument.

In the following example, the subchecks on the first argument passed but the first subcheck on the
second argument failed sometimes.

ID 31: Invalid use of standard fibrary routine 2/
Warning: function 'memcpy' is called with possibly invalid argument(s)
= Checks on first argument (destination):
¥ Mot null.
+ Is a memory area that is accessible within the boundary given by the third argument.
= Checks on second argument (source):
? May be null.
+ Is a memory area that is accessible within the boundary given by the third argument.
This check may be a path-related issue, which is not dependent on input values

Results from Macros: Coding rule violations highlighted on macro
definitions instead of macro instances

When you run coding rules checking, violations from macro definitions can propagate throughout
your code causing many results. In R2016b, coding rule violations caused by a macro are now
highlighted on the macro definition. This change reduces the number of coding rule violations with
the same root cause, simplifying your review process.
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Verification Objectives in Eclipse: Create review scopes to focus your
review

From the Eclipse plugin, you can now create custom review scopes. Review scopes filter your results
to only the run-time checks, coding rules, or code metrics that you want to see. For more information,
see Limit Display of Results.

Filtered Report: Reuse result filters for generated report

In R2016b, if you apply filters to your results, you can reuse those filters for the generated report. For
instance, you can use filters to view only the following subset of results on the Results List pane and
then reuse those filters for the report.

* View only critical checks (red, gray, and critical orange) and create a report with those checks
only.

* View only new results found since the last analysis and create a report with the new results only.

* View only code metrics that exceed specified thresholds and create a report with those metrics
only.

On the Results List pane, you can apply complicated filtering criteria to show only the results that
are most meaningful to you. You can reuse these criteria for your generated report and show only the
results that you want the report reviewer to focus on. For more information on the filters you can use,
see Filter and Group Results.

The report shows which filters you have applied. Another person reviewing your report can see your
filtering criteria.

Results Export: Export results to text file for computing graphs and
statistics

In R2016b, you can export your results to a tab delimited text file. You can parse the text file by using
MATLAB or Excel and generate graphs or statistics about your results that you cannot readily obtain
from the user interface. For instance, for each check type (Division by zero, Overflow), you can
calculate how many checks are red, orange, or green.

For more information, see Export Results to Text File.

Coding Rule Graphs in Report: View breakdown of coding rules
violations by rule number and file

In R2016b, if you choose to report coding rule violations, the report contains two new graphs.

* The first graph shows the number of coding rule violations broken down by file.
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* The second graph shows the number of violations broken down by rule number.
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Constraints in Report: Add comments about external constraints and
view comments in report

In R2016b, when you specify external constraints for verification and add comments in the Constraint
Specification window, the comments appear in the generated report. Another person reviewing your
report can see your comments. You can use the comments to provide explanations for your
constraints.

The constraints, along with your comments, appear in the report appendix that lists your verification
options.

For more information, see:

* Constraints
* Generate Report

English Reports in Non-English Locales: Generate English reports on
operating systems with a different language

In R2016b, even if your operating system has a display language (Windows) or locale (Linux) such as
Japanese or Korean, you can still generate English reports. See Generate Report After Verification.
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Improved PDF report generation

In R2016Db, the generation of PDF reports is improved.

» The report generation is faster. For large results, the report generation is much less likely to cause
out-of-memory errors.

* The reports use an improved visual display.

Change in report template location

The location of the report template files has changed to matlabroot/toolbox/polyspace/
psrptgen/templates. Here, matlabroot is the MATLAB installation folder.

If you use the report templates provided by Polyspace, the change does not impact you. If you use
MATLAB Report Generator™ to modify the Polyspace report templates, you can open the templates
from this new location.

Changes in Polyspace User Interface

The following table lists minor changes to the user interface including new pane names and new
icons.

* Results List — Window showing list of results, previously called Results Summary.

@ — Button to remove items in the configuration or projects.
* The icons on the Results List pane have been rearranged.

In R20164a, the icons were arranged as follows.

-

E~ :AII results v: Ty New <2 5> (& Showing 368/368

In R2016b, the same icons are arranged as follows.

:AII results v: e Mew v <A 5> (& Showing 368/368 «
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Files to Review: Generate results for only specified files and folders

In R20164a, you have greater control over the files on which you want analysis results. The default
project configuration displays coding rule violations and code metrics on the set of files that are likely
to be most relevant to you. You can add files or folders to this set based on your requirements.

For instance, by default, coding rule violations and code metrics are generated on header files that
are located in the same folder as the source files. Often, other header files belong to a third-party
library. Though these header files are required for a precise analysis, you are not interested in
reviewing findings in those headers. Therefore, by default, results are not generated for those
headers. If you are interested in certain headers from third-party libraries, you can add those headers
to the subset on which results are generated.

For more information, see:

* Generate results for sources and (-generate-results-for)
* Do not generate results for (-do-not-generate-results-for)

Compatibility Considerations

In R2016a, by default, coding rule violations and code metrics are not generated for headers unless
they are in the same location as source files. Previously, if you ran verification at the command line,
by default, results were generated for all headers.

Due to the change in default behavior, if you rerun verification on a pre-R2016a project without
changing the options, you can lose review comments on findings in some header files. To avoid losing
the comments, set the option Generate results for sources and (-generate-results-for)toall-
headers.

Faster MISRA Rule Checking: Check coding rules more quickly and
efficiently

In R20164a, you can use two predefined subsets to perform a quicker and more efficient check for
coding rule violations. The new subsets turn on rules that have the same scope.

* single-unit-rules — Check rules that apply only to single translation units.

* system-decidable-rules — Check rules in the single-unit-rules subset and some rules
that apply to the collective set of program files. The additional rules can be checked only at the
integration level because the rules involve more than one translation unit.

Polyspace finds these subsets of rules in the early phases of the analysis. If your project is large,
before checking all rules, you can check these subsets of rules for a preliminary analysis.

For more information, see Coding Rule Subsets Checked Early in Analysis.

S-Function Analysis: Launch analysis of S-Function code from Simulink

With the Polyspace plug-in for Simulink, you can now start a Polyspace verification on S-Functions
directly from an S-Function block.
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To analyze an S-Function, right-click the S-Function block and select Polyspace > Verify S-
Function. If the S-Function occurs in your model multiple times, you can choose to analyze all
instances of the S-Function by verifying all signal range inputs, or just a single instance of the S-
Function by verifying the specific signal ranges for that block.

Polyspace Metrics Tomcat Upgrade: Use upgraded default Tomcat
server or custom Tomcat version

Polyspace Metrics now uses Tomcat 8.0.22 to run the Polyspace Metrics web interface.

If you want to use your own version of Tomcat, you can now specify a custom Tomcat server in the
daemon configuration file. To add your custom tomcat web server, add the following line to the
daemon configuration file.

tomcat install dir = <path/to/tomcat>
The daemon configuration file is located in:

* Windows — \%APPDATA%\Polyspace RLDatas\polyspace.conf
* Linux — /etc/Polyspace/polyspace.conf

Project Language Flexibility: Change your project language at any
time

Projects in the Polyspace interface are no longer fixed to C or to C++. When you create a project, you
can add any file to the project. After you add files, select the language for your analysis using the

Source code language (- Llang) option. If you add or change the files in your project, you can change
the language to reflect the most suitable analysis type.

Many options that were C only or C++ only are now available for both languages. To see which
analysis options have changed, see “Changes in analysis options” on page 14-7.

External Constraint on Pointers: Specify certain initialization with full
range for pointer arguments and return values of stubbed functions

In R20164, if a stubbed function in your code has a pointer argument or a return value, you can
specify certain constraints on the pointer outside your code. Using the constraints, you can reduce
the number of Non-initialized local variable checks. A function is stubbed if you do not provide the
function definition or if you specify the function name for the option Functions to stub (- functions-
to-stub). For instance, if you declare a function func and do not provide the function definition,
func is stubbed.

int* func (int* ptr);

You can specify the new external constraints for the pointer argument and the pointer return value of
func.

You can specify one of the following:
* The pointer points to a non-array variable and the variable is initialized.

The Init Allocated column in the constraint specification file supports a new entry
SINGLE CERTAIN WRITE that allows you to specify this constraint.
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* The pointer points to an array and all elements of the array are initialized.

The Init Allocated column in the constraint specification file supports a new entry
MULTI CERTAIN WRITE that allows you to specify this constraint.

The following table illustrates the change.

Prior to R2016a

R2016a

Without constraints, Polyspace assumes that x in
bar and and bar array are potentially
noninitialized when you read them. You cannot
specify that the functions foo and foo_array
initialize x with full-range values.

#define SIZE 5
void foo(int *ptr);

int bar (void) {
int x;
foo (&x);
return x;

}

void foo array(int *ptr);
void display(int val);

void bar _array(void) {
int x[SIZE],sum=0;
foo _array(x);
for(int i=0; i<SIZE;
display(x[i]);

i++)

If you specify the following constraints in the Init
Allocated column, Polyspace considers that x in
bar and bar_array are initialized.

» foo: Specify SINGLE _CERTAIN WRITE for the
argument of foo. In other words, foo writes a
value to *ptr.

* foo_array: Specify MULTI CERTAIN WRITE
for the argument of foo_array. In other
words, ptr points to an array and foo_array
writes a value to the array elements.

#define SIZE 5
void foo(int *ptr);

int bar (void) {
int x;
foo (&x);
return Xx;

}

void foo_array(int *ptr);
void display(int val);

void bar_array(void) {
int x[SIZE],sum=0;
foo_array(x);
for(int 1=0; i<SIZE;
display(x[i]);

i++)

For more information, see Constraints.

If your project uses a constraint specification file from a previous release, you do not see any change
in the verification results. If you generate a constraint specification file, by default, pointer arguments
of stubbed functions are constrained to point to an array that is initialized. Applying the default
constraint specification file can reduce the number of orange Non-initialized local variable checks.

Source Code Search: Search large applications more quickly

In R20164a, search results are produced more quickly. If you search for a string in a large application,

it takes less time for search results to appear.

You can search for a string either by entering the search string in the box on the Search pane, or by
right-clicking a word in your code on the Source pane, and then selecting a search option.
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Polyspace TargetLink plug-in supports data from structures

The Polyspace plug-in for TargetLink® can now import data from structures in the constraint
specifications (formerly called DRS) for your analysis.

Polyspace Eclipse plug-in results location moved

When you analyze projects using the Polyspace plug-in for Eclipse, your results used to be stored
inside your Eclipse project under eclipse project folder\polyspace. For new Eclipse
projects, Polyspace now stores results in the Polyspace Workspace under Polyspace Workspace
\EclipseProjects\Eclipse Project Name, where Polyspace Workspace is the default
project location specified in your Polyspace Interface preferences. For more information, see Results
Location.

Improvements in automatic project creation from build command

In R20164a, automatic project creation from build command is improved.

* Ifyou trace your build command and create a Polyspace project from the command line, you do
not have to specify a product name or project language. You can open the project in Polyspace Bug
Finder or Polyspace Code Prover. The project language is determined by using the following rules:

« Ifall your files are compiled as C, as C++03, or C++11, the corresponding language is
assigned to the project.

Language Options Set in Project

C Source code language: C

C++03 Source code language: CPP

C++11 Source code language: CPP
C++11 Extensions: On

+ If some files are compiled as C and the remaining files as C++03 or C++11, the Source code
language option is set to cpp.

The option C++11 Extensions is also enabled.

For more information, see Source code language (- lang) and C++11 Extensions (-cppll-
extensions).

Previously, you specified the product name by using options -bug-finder or -code-prover. If
you did not specify a project language and your source code consisted of both . c and . cpp files,
the language cpp was assigned to the project. The options -bug-finder and - code-prover
have been removed.

For more information, see Create Project Automatically.

» If header files in your project contain constructs that are not supported in Polyspace Code Prover,
a compilation error occurs. In R2016a, when you trace your build, Polyspace detects such header
files and does not add them to your project. Later, when you run verification on the project, you do
not face compilation errors because of unsupported constructs in header files.

* The support for IAR compilers has improved. All variations of IAR compilers are now supported for
automatic project creation from build command.
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Improvements in checking of previously supported MISRA C rules

In R20164, the following changes have been made in checking of previously supported MISRA C

rules.

MISRA C:2004 Rules

Rule

Description

Improvement

MISRA C:2004 Rule 10.3

The value of a complex
expression of integer type
may only be cast to a type
that is narrower and of
the same signedness as
the underlying type of the
expression.

The rule checker no longer raises a
violation of this rule if an expression with a
Boolean result is cast to a type that is also
effectively Boolean.

For instance, in your code, you define a
type myBool using a typedef and cast the
result of (a && b) to myBool. If you
specify to Polyspace that myBool is
effectively Boolean, the rule checker does
not consider this cast as a violation of rule
10.3. For more information on how to
specify effectively Boolean types, see
Effective boolean types (-boolean-types).

MISRA C:2004 Rule 12.2

The value of an
expression shall be the
same under any order of
evaluation that the
standard permits.

The rule checker no longer flags
expressions with the comma operator that
can be evaluated in only one order.

For instance, the statement ans = (val+
+, val++) does not violate this rule.

MISRA C:2012 Rules

Rule

Description

Improvement

MISRA C:2012 Rule 13.2

The value of an
expression and its
persistent side effects
shall be the same under
all permitted evaluation
orders.

The rule checker no longer flags
expressions with the comma operator that
can be evaluated in only one order.

For instance, the statement ans = (val+
+, val++) does not violate this rule.

Variables with constraints not counted as orange sources

In R20164a, once you constrain certain variables outside your code, those variables do not appear as
possible causes of orange checks on the Orange Sources pane.

This pane lists the variables that you can constrain outside your code to reduce orange checks.

» Previously, the pane listed variables even after you had constrained them, with the assumption
that you might constrain them further.

+ Starting in R20164a, Polyspace assumes that once you constrain variables to match real-world
values, you will not constrain them further.

Therefore, variables already constrained are not shown on the Orange Sources pane.
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For more information on constraining variables using the Orange Sources pane, see Create

Constraint Template After Analysis.

Changes in analysis options

In R20164a, the following options have been added, changed, or removed.

New Options

Option

Description

Generate results for sources and (-
generate-results-for)

Specify files on which you want analysis results.

Do not generate results for (-do-
not-generate-results-for)

Specify files on which you do not want analysis results.

Allow non finite floats (-allow-non-
finite-floats)

Enable a verification mode that incorporates infinities and
NaNs.

Float rounding mode (-float-
rounding-mode)

Assume all rounding modes and extended precision when
determining the results of floating point arithmetic.

-check-infinite

Specify how to handle floating point operations that result in
infinity.

-check-nan

Specify how to handle floating point operations that result in
NaN.

-no-assumption-on-absolute-
addresses

Make Absolute address usage checks orange by default.
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Updated Options

Option

Change

More
Information

Source code language (- lang)

Added to Polyspace Interface

Select your
project language
to set compilation
rules and enable
language specific
analysis options.

Dialect (-dialect)

Unified dialects for C and C++ projects.
All projects can use any dialect option.

Target processor type (-target)

Targets 1386 and x86 64 now allow any
alignment value.

Sfr type support (-sfr-types)

Allowed for both C and C++

Pack alignment value (-pack-
alignment-value)

Allowed for both C and C++

Import folder (-import-dir)

Allowed for both C and C++

Ignore pragma pack directives (-
ignore-pragma-pack)

Allowed for both C and C++

Division round down (-div-round-
down)

Allowed for both C and C++

Removed Options

Option Status More Information

Green absolute address checks (- |Warning Absolute address usage checks are green by

green-absolute-address- default. To remove this assumption and

checks) produce an orange check, use the option -no-
assumption-on-absolute-addresses.

Files and folders to ignore (- Warning Use the option Do not generate results for (-

includes-to-ignore) do-not-generate-results-for) to
suppress results from headers and sources in
certain files or folders.

Ignore float rounding (-ignore- Warning Option will be removed in a future release.

float-rounding)

-retype-pointer Warning Option will be removed in a future release.

-retype-int-pointer Warning Option will be removed in a future release.

- lwtm Warning Option will be removed in a future release.

-support-FX-option-results Warning Option will be removed in a future release.

polyspace-vcproj Error Binary has been removed.

Compatibility Considerations

If you use scripts that contain the removed or updated options, change your scripts accordingly.
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Floating-Point Support: Propagate ranges more precisely for long
double variables and enable verification mode to incorporate infinities
and NaNs

In R2016a, there are the following improvements on analysis of code involving floating-point
variables.

Long Doubles

If your code contains computations involving Llong double variables, you can see fewer orange
checks resulting from overapproximation. Previously, Polyspace assumed full-range value for long
double variables, irrespective of the actual values assigned to them. This assumption led to orange
checks that indicated potential numerical and other errors in computations involving long double
variables.

Polyspace now propagates ranges more precisely for Llong double variables. For information on the
number of bits that Polyspace uses for computations involving Llong double variables, see Target
processor type (-target).

Nonfinites in floating-point arithmetic

Polyspace verification supports nonfinite results such as infinities and NaNs from computations
involving floating-point variables. Using the option Allow non finite floats (-allow-non-finite-
floats), you can enable a verification mode that incorporates infinities and NaNs.

In this mode, Polyspace assumes that:
» Floating-point operations can produce results such as infinities and NaNs.

Using options -check-infinite and - check-nan, you can choose to highlight operations that
produce nonfinite results and stop the execution paths where the nonfinite results occur.

* Floating-point variables with unknown values, such as volatile variables and return values of
stubbed functions, can be infinite or NaN.

The following table illustrates the change.

14-9


https://www.mathworks.com/help/releases/R2016a/codeprover/ref/targetprocessortypetarget.html
https://www.mathworks.com/help/releases/R2016a/codeprover/ref/targetprocessortypetarget.html
https://www.mathworks.com/help/releases/R2016a/codeprover/ref/allownonfinitefloatsallownonfinitefloats.html
https://www.mathworks.com/help/releases/R2016a/codeprover/ref/allownonfinitefloatsallownonfinitefloats.html
https://www.mathworks.com/help/releases/R2016a/codeprover/ref/checkinfinite.html
https://www.mathworks.com/help/releases/R2016a/codeprover/ref/checknan.html

R2016a

14-10

Prior to R2016a

R2016a

In the following code, Polyspace produces a

Division by zero error and stops verification.

double func(void) {
double x=1.0/0.0;
double y=1.0/x;
double z=x-Xx;
return z;

In the following code, if you specify the option
Allow non finite floats, Polyspace does not
check for a Division by zero error.

double func(void) {
double x=1.0/0.0;
double y=1.0/x;
double z=x-Xx;
return z;

}

The verification assumes that dividing by zero
results in:

* Value of x equal to Inf

* Value of y equal to 0.0

* Value of z equal to NaN

In your verification results in the Polyspace user
interface, if you place your cursor on y and z, you

can see the nonfinite values Inf and NaN
respectively in the tooltip.

Rounding modes

Polyspace supports verification that considers all possible rounding modes when rounding the results
of floating point arithmetic. Using the option Float rounding mode (- float-rounding-mode), you

can enable a verification mode that allows these forms of rounding: round-to-nearest, round-towards-
zero, round-towards-positive-infinity and round-towards-negative-infinity. The default rounding mode

is round-to-nearest only.

Previously, the default verification assumed all rounding modes to determine the results of floating-
point arithmetic. The verification used the round-to-nearest mode only to determine if an Overflow

occurs.

The following table illustrates the change.
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Prior to R2016a R2016a

In the following code, Polyspace produces a green|In the following code, if you specify all for the
Overflow check because the addition does not option Float rounding mode, Polyspace
overflow if the result is rounded in to-nearest produces an orange Overflow check because the
mode. addition overflows if the result is rounded
towards positive infinity.

#include <float.h>

#include <float.h>
void func(void) {

double base = DBL MAX; void func(void) {
double acc = 1.247400193459199882 double base = DBL MAX;
285232945648024103792 double acc = 1.247400193459199882
1570377722e+291; 285232945648024103792
1570377722e+291;
base = acc + base;
} base = acc + base;
}

Absolute address usage valid by default

In R20164a, the Absolute address usage check is considered valid and therefore green by default. If
you assign an absolute address to a pointer in your code, the verification assumes that:

* The address is valid.

* The type of the pointer to which you assign the address determines the initial value stored in the
address.

If you assign the address to an int* pointer, the memory zone that the address points to is
initialized with an int value. The value can be anything that is allowed for the data type int.

Previously, the Absolute address usage check was considered possibly invalid and therefore orange
by default. You either justified the checks or turned them green by using the option Green absolute
address checks (-green-absolute-address-checks on command line).

Compatibility Considerations

If the code in your project uses absolute addresses, you see a decrease in the number of orange
checks from previous releases of the software. To turn the check orange by default for each absolute
address usage, use the command-line option -no-assumption-on-absolute-addresses. To use a
command-line option in the user interface, enter the option in the Other field.

Run-time checks renamed

In R20164a, the following checks have been renamed. The new names state the error in the code
instead of what the check looks for.

Old Name New Name

Absolute address Absolute address usage

C++ specific checks Invalid C++ specific operations
Exception handling Uncaught exception
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Old Name

New Name

Function Returns a Value

Function not returning value

Initialized Return Value

Return value not initialized

Non-null this-pointer in method

Null this-pointer calling method

Object Oriented Programming

Incorrect object oriented programming

Shift operations

Invalid shift operations
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Autocompletion for Review Comments: Partially type previous
comment to select complete comment

In R20164a, on the Results Summary or Result Details pane, if you start typing a review comment
that you have previously entered, a drop-down list shows the previous entry. Select the previous
comment from this list instead of retyping the comment.

If you want the autocompletion to be case sensitive, select Tools > Preferences. On the
Miscellaneous tab, select Autocomplete on Results Summary or Details is case sensitive.

Default Layouts: Switch easily between project setup and results
review in user interface

In R20164a, you have two default layouts of panes in the Polyspace user interface, one for project
setup and another for results review.

When setting up your projects, select Window > Reset Layout > Project Setup. When reviewing
results, select Window > Reset Layout > Results Review.

For more information, see Organize Layout of Polyspace User Interface.

Persistent Filter States: Apply filters once and view filtered results
across multiple runs

In R20164, if you apply a set of filters to your verification results and rerun verification on the project
module, your filters are also applied to the new results. You can specify your filters once and suppress

results that are not relevant for you across multiple runs.

The Results Summary pane shows the number of results filtered from the display. If you place your
cursor on this number, you can see the applied filters.

Showing 187365

Showing 187 out of 365 possible results
Hidden results: 178

Review Scope: Checks & Rules

Mew results only: On

Columns with active filters:
Information
Check

For instance, in the image, you can see that the following filters have been applied:

* The Checks & Rules filter to suppress code metrics and global variables.

. o 1]
The filter to suppress results found in a previous verification.
* Filters on the Information and Check columns.
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For more information, see Filter and Group Results.

Updated Polyspace Metrics Interface: View summary of project and
metrics

You can now view project-level metric summaries from the main Polyspace Metrics page using one of
the following methods:

* On the Projects tab, roll your mouse over the list of projects to open a window displaying a
summary of the project and project metrics.

* On the Projects or Runs tab, right-click the column headers to add new columns to the table.
new columns you can add include Coding Rules, Bug-Finder Checks, Code Metrics, and Review
Progress.

Improved Result Display for File-by-File Verification: View combined
summary of results for all files in user interface

In R20164, if you perform a file-by-file verification, you can see a summary of results for all files on
the Dashboard pane. You can open the results for each file directly from this summary table.
Previously, you obtained this synthesis in an external html file.

For more information, see Run File-by-File Local Verification.

Simplified Variable Access: View task nhames instead of aliases

In R20164a, on the Variable Access pane, in the Written by task and Read by task columns, you
see the task names. Previously, the columns contained aliases such as t1, t2, t3, ... You viewed the
task names using a legend for the aliases.
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Option to Suppress Non-initialization Checks: Customize verification
by suppressing non-initialization checks

In R2015b, you can use an analysis option to turn off the checks for non-initialization. If you turn on
this option, Polyspace assumes that, at declaration:

» Variables have full-range of values allowed by their type.
* Pointers can be NULL-valued or point to a memory block at an unknown offset.

When you use this option, the following checks are turned off:

* Non-initialized local variable: Local variable is not initialized before being read.

* Non-initialized variable: Variable other than local variable is not initialized before being read.
* Non-initialized pointer: Pointer is not initialized before being read.

* Return value not initialized: C function does not return value when expected.

For more information, see Disable checks for non-initialization (C/C++).

Autodetection of Multitasking Primitives: Analyze source code with
multitasking primitives from POSIX or VxWorks without manual setup

If you use POSIX® or VxWorks to perform multitasking, Polyspace can now interpret your
multitasking code without having to change your code or manually set multiple configuration options.

To turn on automatic detection, select the analysis option Multitasking > Enable automatic
concurrency detection. Polyspace detects thread creation and critical sections from supported
multitasking functions.

Functions Polyspace can interpret:

POSIX

* pthread create
* pthread mutex lock
* pthread mutex unlock

VxWorks

* taskSpawn
*+ semTake
* semGive

For more information, see Enable automatic concurrency detection (C/C++).
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Microsoft Visual C++ 2013 Support: Analyze code developed in
Microsoft Visual C++ 2013

You can analyze code developed in the Microsoft Visual C++ 2013 dialect.

To analyze code compiled with Microsoft Visual C++ 2013, set your dialect to visuall2.0. If you
specify the dialect, Polyspace allows language extensions specific to Microsoft Visual C++ 2013.
Otherwise, it produces a compilation error if you use those extensions. For more information, see
Dialect (C/C++) or Dialect (C++).

GNU 4.9 and Clang 3.5 Support: Analyze code compiled with GCC 4.9
or Clang 3.5

Polyspace now supports the GNU 4.9 and Clang 3.5 dialects for C and C++ projects.

To analyze code compiled with one of these dialects, set the Target & Compiler > Dialect option to
gnu4.9 or clang3.5.

For more information, see Dialect (C/C++) or Dialect (C++).

Improvements in automatic project creation from build command

In R2015b, automatic project creation from build command is improved.

* Ifyou build your source code from the Cygwin environment (using either a 32 or 64-bit
installation), Polyspace can trace your build and create a Polyspace project or options file.

* Support for the following compilers has improved:
* Texas Instruments C2000 compiler

This compiler is available with Code Composer Studio™.
¢ Cosmic HC08 C compiler
*+ MPLAB XC8 C Compiler

* With certain compilers, the speed of tracing your build command has improved. The software now
stores build information in the system temporary folder, thereby allowing faster access during the
build.

If you still encounter a slow build, use the advanced option -cache-path ./ps cache when
tracing your build. For more information, see Slow Build Process When Polyspace Traces the
Build.

» If the software detects target settings that correspond to a standard processor type, it assigns that
standard target processor type to your project. The target processor type defines the size of
fundamental data types and the endianness of the target machine. For more information, see
Target processor type (C/C++).

Previously, when you created a project from your build command, the software assigned a custom
target processor type. Although you saw the processor type in the form of an option such as -
custom-target

true,8,2,4,-1,4,8,4,8,8,4,8,1,little,unsigned int,int,unsigned short, you
could not identify easily how many bits were associated with each fundamental type. With this

15-3


https://www.mathworks.com/help/releases/R2015b/codeprover/ref/dialect.html
https://www.mathworks.com/help/releases/R2015b/codeprover/ref/dialect-1.html
https://www.mathworks.com/help/releases/R2015b/codeprover/ref/dialect.html
https://www.mathworks.com/help/releases/R2015b/codeprover/ref/dialect-1.html
https://www.mathworks.com/help/releases/R2015b/codeprover/ug/slow-build-process-when-tracing-builds.html
https://www.mathworks.com/help/releases/R2015b/codeprover/ug/slow-build-process-when-tracing-builds.html
https://www.mathworks.com/help/releases/R2015b/codeprover/ref/target-processor-type.html

R2015b

15-4

enhancement, when the software assigns a processor type, you can identify the number of bits for
each type. Click the Edit button for the option Target processor type.

* Automatic project creation uses a configuration file written for specific compilers. If your compiler
is not supported, you can adapt one of the existing configuration files for your compiler. The
configuration file, written in XML, is now simplified with some new elements, macros and
attributes.

* The preprocess options 1list element supports a new $(OUTPUT FILE) macro when the
compiler does not allow sending the preprocessed file to the standard output.

* Anew preprocessed output file element allows the preprocessed file name to be
adapted from the source file name.

* The semantic_options element supports a new isPrefix attribute. This attribute provides
a shortcut to specify multiple semantic options that begin with the same prefix.

* The semantic_options element supports a new numArgs attribute. This attribute provides a
shortcut to specify semantic options that take one or more arguments.
For more information, see Compiler Not Supported for Project Creation from Build Systems.

* Sometimes, the build command returns a non-zero status even when the command succeeds. The
non-zero status can result from warnings in the build process. However, Polyspace does not trace
the build and create a Polyspace project. You can now use an option -allow-build-error to
create a Polyspace project even if the build command returns an exit status or error level different
from zero. This option helps you understand the error in the build process.

For more information, see -option value arguments of polyspaceConfigure.

Start Page: Get quickly familiar with Polyspace Code Prover

In R2015b, when you open Polyspace Code Prover for the first time, a Start Page pane appears.
From this pane, you can:

* Open recent results and demo examples.

» Start a new project.

* Get additional help using the Getting Started, What’s New and Learn More tabs.

If you select the Show on startup box on the lower left of this pane, the pane appears each time you
open Polyspace Code Prover. Otherwise, if you close the pane once, it does not reopen. To open the
pane, select Window > Show/Hide View > Start Page.

Saved Layouts: Save your preferred layouts of the Polyspace user
interface

In R2015D, if you reorganize the Polyspace user interface and place the various panes in more
convenient locations, you can save your new layout. If you change your layout, you can quickly revert
to a saved layout.

With this modification, you can create customized layouts suitable for different requirements and
switch between saved layouts. For instance:

* You can have separate layouts for project configuration and results review.
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* You can have a minimal layout with only frequently used panes.

For more information, see Organize Layout of Polyspace User Interface.

Renaming of labels in Polyspace user interface

In the Polyspace user interface, the following labels have been renamed:

* On the Configuration pane, the node Coding Rules is changed to Coding Rules & Code
Metrics. The Coding Rules & Code Metrics node contains the option Calculate Code Metrics,
which appeared previously on the Advanced Settings node.

* On the Results Summary pane, the Category column title is changed to Group, avoiding
confusion with coding rule categories.

* On the Results Summary and Result Details pane, the field Classification is changed to
Severity. You assign a Severity such as High, Medium and Low to a defect to indicate how critical
you consider the issue.

» The labels associated with specifying constraints have changed as follows:

* On the Configuration pane, the field Variable/function range setup is changed to
Constraint setup.

*  When you click Edit beside the Constraint setup field, a new window opens. The window
name is changed from Polyspace DRS Configuration to Constraint Specification.

For more information, see Specify Constraints.

Including options multiple times

You can now specify analysis options multiple times. This feature is available only at the command
line or using the command-line names in the Advanced options dialog box in the user interface.
Customize pre-made configurations without having to find the changed options in the options file.

If you specify an option multiple times, only the last setting is used. For example, if your configuration
is:

-lang ¢

-prog test bf cp
-verif-version 1.0

-author username
-sources-list-file sources.txt
-0S-target no-predefined-0S
-target i386

-dialect none

-misra-cpp required-rules
-target powerpc

Polyspace uses the last target setting, powerpc, and ignores the other target specified, 1386.
The user interface also follows this rule. If you specify ¢18 for Target processor type and -target

1386 for Advanced options, this counts as multiple analysis option specifications. Polyspace uses
the target specified in the Advanced options box, 1386.
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Compatibility Considerations

If your current configuration specifies analysis options multiple times, change the configuration by
either:

* Removing the unnecessary analysis options.
* Moving the desired analysis options to the end of the configuration.
Updated Support for TargetLink

The Polyspace plug-in for TargetLink now supports versions 3.5 and 4.0 of the dSPACE® Data
Dictionary and TargetLink Code Generator.

dSPACE and TargetLink version 3.4 is no longer supported.

For more information, see TargetLink Considerations.

Improved handling of _declspec

For projects in Visual C, Polyspace Code Prover can now interpret the aligned size specified by the
keyword declspec( align( .. ) .. ).

For example, this structure uses the declspec keyword:
struct S1 { declspec(align(8)) char c; };

In R2015b Polyspace correctly interprets the size of S1 as 8 bytes.

Compatibility Considerations
In previous versions, Polyspace ignored the declspec keyword, so code with the
__declspec(align() ) keyword was verifiable using Dialect > None. To avoid compilation errors

with the R2015b support of declspec(align() ), set Dialect to one of the Visual C dialects. For
the list of supported Visual dialects, see Dialect (C/C++).

Changes in analysis options

In R2015D, the following options have been added or removed.
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New Options

Option Status More information

Respect C90 Standard New The analysis does not allow C language
extensions that do not follow the ISO/IEC

(-no-language-extensions) 9899:1990 standard.

Dialect visuall2.0 New Allows Microsoft Visual C++ 2013 (visual 12)
language extensions.

Dialect gnu4.9 New Allows GCC 4.9 language extensions.

Dialect clang3.5 New Allows Clang 3.5 language extensions.

Configure multitasking manually|New This option enables the previous multitasking

(C/C++) options (Entry points, Critical section
details, Temporally exclusive tasks) in the
user interface.

Enable automatic concurrency |New Enables automatic concurrency detection for

detection (C/C++) POSIX® and VxWorks® threading functions.

Disable checks for non- New Disables checks for non-initialization in your

initialization (C/C++)

code.
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Updated Options

Option Status More information
Calculate Code Metrics (C/C++) |Moved in user The option has been moved in the
interface Configuration panel from the Advanced

Settings pane to the Coding Rules and
Code Metrics pane.

-class-analyzer Updated syntax The syntax for -class-analyzer param has
been updated. Use -class-analyzer
custom=param

Signed right shift (C/C++) Now available in C
++ projects
(-logical-signed-right-
shift)

Division round down (C/C++) Now available in C

++ projects
(-div-round-down)

(-no-def-init-glob) Now available in C
++ projects

Optimize large static initializers |Now available in C

(C/IC++) ++ projects
(-no-fold)

-lightweight-thread- No longer
model available in the

user interface

Targets: Now available in C

++ projects
e tms320c3x

e ,sharc21x61l

* necv850
* hco8
* hcl2
*  mpc5xx
« 18
Enum type definition (C/C++)(- |Possible values The possible values for -enum-type-
enum-type-definition) updated definition are the same for C and C++.
Available values:
o defined-by-standard (default)
* auto-signed-first
e auto-unsigned-first
-asm-begin -asm-end Now available in C

++ projects
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Option

Status

More information

-support-FX-option-
results

No longer
available in the
user interface

-pointer-is-24bits

Available in C++
projects

Availably only if you use the Target setting
cl8.

Output format (C/C++)

-report-output-format

Possible values
updated

The output format RTF is deprecated and not
available on the Configuration pane.
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Removed Options

Option Status More information
-dialect cfront2 Removed Use a different dialect instead.
-dialect cfront3 Removed Use a different dialect instead.
-known-NTC Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-desktop Removed Use -main-generator instead.
-permissive Removed Use -allow-negative-operand-in-shift -
ignore-constant-overflows instead.
-automatic-stubbing Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-float-overflows Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-continue-with- Removed Polyspace includes this behavior by default.
exisiting-host Remove this option from existing configurations.
-allow-unsupported-linux |[Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-passes-time Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-ignore-missing-headers |Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-continue-with-red-error |Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-voa Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-machine-architecture Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-allow-non-int-bitfield |Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-allow-undef-variables Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-allow-unnamed-fields Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-permissive stubber Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-permissive-link Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-allow-language- Removed Polyspace includes this behavior by default.
extensions Remove this option from existing configurations.
-include-headers-once Removed Polyspace includes this behavior by default.
Remove this option from existing configurations.
-strict Removed This option is no longer supported. Remove this

option from existing configurations.
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Option Status More information

-discard-asm Removed This option is no longer supported. Remove this
option from existing configurations.

-quick Removed Use -to passO instead.

-detect-unsigned- Removed Use -scalar-overflows-checks-signed-and-

overflows unsigned instead.

-misra2 AC-AGC-OBL- Removed Use -misra-ac-agc OBL-rules instead.

subset

Compatibility Considerations

If you use scripts that contain a removed or updated option, change your scripts accordingly.

Binaries removed

The following binaries have been removed.

Binary name Use instead

polyspace-automatic -orange-tester.exe |From the Polyspace environment, select Tools >
Automatic Orange Tester

polyspace-c.exe polyspace-code-prover-nodesktop -lang c

polyspace-cpp.exe polyspace-code-prover-nodesktop -lang cpp

polyspace-remote-c.exe polyspace-code-prover-nodesktop -lang c -
batch

polyspace-remote-cpp.exe polyspace-code-prover-nodesktop -lang cpp -
batch

polyspace-remote.exe polyspace-code-prover-nodesktop -batch

polyspace-rl-manager.exe polyspace-server-settings.exe

polyspace-spooler.exe polyspace-job-monitor.exe

polyspace-ver.exe polyspace-code-prover-nodesktop -ver

The binaries to use are located in matlabroot/polyspace/bin.

Support for Visual Studio 2008 to be removed

The Polyspace Add-In for Visual Studio 2008 is no longer supported and will be removed in a future
release.

Compatibility Considerations

To analyze your Visual Studio projects, use either:

* The Polyspace Add-in for Visual Studio 2010. See Install Polyspace Add-In for Visual Studio.

* The polyspace-configure tool to create a project using your build command. See Create
Project Using Visual Studio Information.
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Import Visual Studio project removed
The Tools > Import Visual Studio project has been removed.

To import your project information from Visual Studio, use the Create from build system option
during new project creation. For more information, see Create Project Using Visual Studio
Information.

15-12


https://www.mathworks.com/help/releases/R2015b/codeprover/ug/configuring-polyspace-project-using-visual-studio-project-information.html
https://www.mathworks.com/help/releases/R2015b/codeprover/ug/configuring-polyspace-project-using-visual-studio-project-information.html

Verification Results

Verification Results

Improved Concurrency Detection: View more precise sharing and
protection results based on dynamic information such as data flow in
branching statements and protection on individual fields of a
structure

In R2015b, Polyspace Code Prover uses dynamic information such as data flow in branch statements
to determine whether a variable is shared and protected. Previously, sharing and protection were

determined statically resulting in overapproximation of the actual behavior. For more information on
shared variables and multitasking options, see Multitasking.

The following examples illustrate the change. For more examples, see Global Variables.
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Data Flow in Branch Statements

Prior to R2015b

R2015b

In the following code, if you specify taskl and
task?2 as entry points, the verification
determines that var 1 and var_ 2 are shared,
potentially unprotected variables. However,
because of the if statement, taskl can operate
only on var 1 and task2 only on var_ 2. When
determining sharing, the verification does not
consider the branching in the if statement and
therefore determines that var 1 and var_ 2 are
shared.

unsigned int var 1;
unsigned int var 2;
volatile int randomVal;

void taskl(void) {
while(randomVal)
operation(1l);

}

void task2(void) {
while(randomVal)

operation(2);
}
void operation(int i) {
if(i==1) {
var_ 1++;
}
else {
var_2++;
}

}

int main(void) {
return 0;
}

In the following code, if you specify taskl and
task?2 as entry points, the verification
determines that var 1 and var_2 are not
shared.

unsigned int var 1;
unsigned int var 2;
volatile int randomVal;

void taskl(void) {
while(randomVal)
operation(1l);

}

void task2(void) {
while(randomVal)

operation(2);
}
void operation(int i) {
if(i==1) {
var_ 1++;
}
else {
var_ 2++;
}

}

int main(void) {
return 0;
}
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Shared Structures

Prior to R2015b

R2015b

In the following code, if you specify taskl and
task?2 as entry points, the verification
determines that the structure variable
sharedStruct is a potentially unprotected
variable. However, taskl can operate only on
sharedStruct.var_ 1 and task2 only on
sharedStruct.var 2. The verification
considers sharedStruct as a whole and ignores
the sharing and protection on individual fields of
sharedStruct.

struct S {
unsigned int var 1;
unsigned int var 2;

};
volatile int randomVal;
struct S sharedStruct;

void taskl(void) {
while(randomVal)
operationl();

}

void task2(void) {
while(randomVal)
operation2();

}

void operationl(void) {
sharedStruct.var 1++;
}

void operation2(void) {
sharedStruct.var 2++;
}

int main(void) {
return 0;
}

In the following code, if you specify taskl and
task?2 as entry points, the verification
determines that the structure variable
sharedStruct is a shared, protected variable. If
you select the result, the Result Details pane
states that all operations on the variable are
protected by access pattern. For the variable
sharedStruct, the Protection column on the
Variable Access pane contains Access pattern.

struct S {
unsigned int var 1;
unsigned int var 2;

};
volatile int randomVal;
struct S sharedStruct;

void taskl(void) {
while(randomVal)
operationl();

}

void task2(void) {
while(randomVal)
operation2();

}

void operationl(void) {
sharedStruct.var 1++;
}

void operation2(void) {
sharedStruct.var 2++;
}

int main(void) {
return 0;
}

Additional MISRA C:2012 Support: Detect violations of all MISRA

C:2012 rules except rules 22.x

In R2015b, Polyspace Code Prover supports the following MISRA C: 2012 coding rules.

For complete MISRA C: 2012 support, including rules 22.1-22.4 and 22.6, use Polyspace Bug Finder.
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Rule

Description

MISRA C:2012 Directive 2.1

All source files shall compile without any compilation errors.

MISRA C:2012 Directive 4.5

Identifiers in the same name space with overlapping visibility
should be typographically unambiguous.

MISRA C:2012 Rule 2.6

A function should not contain unused label declarations.

MISRA C:2012 Rule 2.7

There should be no unused parameters in functions.

MISRA C:2012 Rule 17.5

The function argument corresponding to a parameter declared to
have an array type shall have an appropriate number of elements.

MISRA C:2012 Rule 17.8

A function parameter should not be modified.

MISRA C:2012 Rule 21.12

The exception handling features of <fenv.h> should not be used.

MISRA C:2012 Rule 22.5

A pointer to a FILE object shall not be dereferenced.

Improved precision for mathematical functions

Polyspace Code Prover has more precise implementations for mathematical functions defined in

math.h.

Improvements in checking of previously supported MISRA C rules

In R2015Db, the following changes have been made in checking of previously supported MISRA C

rules.

MISRA C:2004 Rules

Rule

Description

Improvement

MISRA C:2004 Rule 2.1

Assembly language shall
be encapsulated and
isolated.

If an assembly language statement is
entirely encapsulated in macros, Polyspace
no longer considers that the statement
violates this rule.

MISRA C:2004 Rule 8.8

An external object or
function shall be declared
in one file and only one
file.

Polyspace considers that variables or
functions declared extern in a non-header
file violate this rule.

MISRA C:2004 Rule 10.1

The value of an
expression of integer type
shall not be implicitly
converted to a different
underlying type if it is not
a conversion to a wider
integer type of the same
signedness.

Polyspace no longer raises violation of this
rule on operations involving pointers.
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Rule

Description

Improvement

MISRA C:2004 Rule 19.2

Nonstandard characters
should not occur in
header file names in
#include directives.

Polyspace no longer raises violation of this
rule if the character \ or \\ occurs
between the < and > in #include
<filename> (or between " and " in
#include "filename").

Therefore, you can use Windows paths to
files in place of filename without
triggering a rule violation.

MISRA C:2012 Rules

Rule

Description

Improvement

MISRA C:2012 Directive
4.3

Assembly language shall
be encapsulated and
isolated.

If an assembly language statement is
entirely encapsulated in macros, Polyspace
no longer considers that the statement
violates this rule.

MISRA C:2012 Rule 1.1

The program shall contain
no violations of the
standard C syntax and
constraints, and shall not
exceed the
implementation's
translation limits.

If a rule violation occurs because your . c
file contains too many macros, instead of
placing the rule violation on the last macro
usage, Polyspace places the rule violation
at the beginning of the file.

Therefore, you can add a comment before
the first line of the . c file justifying the
violation. Previously, you had to place the
comment before the last macro usage. If
you added another use of the macro later,
the comment did not apply. For information
on adding code comments to justify results,
see Add Review Comments to Code.

MISRA C:2012 Rule 10.4

Both operands of an
operator in which the
usual arithmetic
conversions are
performed shall have the
same essential type
category.

o If one of the operands is the constant
zero, Polyspace does not raise a
violation of this rule.

* If one of the operands is a signed
constant and the other operand is
unsigned, the rule violation is not raised
if the signed constant has the same
representation as its unsigned
equivalent.

For instance, the statement u8b = u8a
+ 3;, where u8a and u8b are
unsigned char variables, does not
violate the rule because the constants 3
and 3U have the same representation.
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Checking Coding Rules Using Text Files

In R2015D, if your coding rules configuration text file has an incorrect syntax, the analysis stops with
an error message. The error message states the line numbers in the configuration file that contain the
incorrect syntax.

For more information on checking for coding rules using text files, see Select Specific MISRA or JSF
Coding Rules.

Change in Correctness Condition Check

In R2015Db, the specification of the Correctness Condition check has changed in the following way.
For more information on the check, see Correctness condition.

When you use a function pointer to call a function and Polyspace cannot determine which function the
pointer points to, the Correctness Condition check is orange instead of red. This situation can
occur, for instance, if:

» The function pointer points to an absolute address. The check is orange because the verification
cannot determine from the code whether the absolute address contains a well-typed function.

* The function pointer contains the return value of a stubbed function. For information on stubbing,
see Assumptions About Stubbed Functions.

Following the orange check, the verification assumes that the following variables can have the full
range of values allowed by their type:

* Variable storing the return value from the function call.

* Variables that can be modified through the function arguments.

Compatibility Considerations

If your code contains function pointers that point to an absolute address for instance, you can see a
change in the number of results from a previous version of the product. Because red checks stop
further verification of the code in the current block and orange checks do not, this change of the
Correctness Condition check from red to orange can expose more of your code to verification.
Therefore, the number of checks in your code can change.
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Improved Review Capability: View result details and add review
comments in one window

In R2015b, the Check Details pane is renamed Result Details. On this pane, in addition to viewing
details about a result, you can now enter review information such as Classification, Status, and
comments. For more information, see Add Review Comments to Results.

k4 Resdtbetas ="
2 Dﬁ": =) (. | fx X single_file_analysis.c / reset_temperature()

Status

[E Result Review

Classification .High - r:: perform checks for array index,

Fix -

= Dut of bounds array index

Error: array index is outside its bounds : [0..38]
array size: 39

array index value: [-25% .. -39]

Enhanced Review Scope: Filter coding rule violations from display in
one click

In R2015b, you can suppress a certain number or percentage of coding rule violations from the
display using custom options in the Show menu on the Results Summary pane. You can:

* Suppress violations of coding rules that are not relevant for you.
» Focus your results review by seeing only a certain number of coding rule violations in your display.

* Predefine a percentage of coding rule violations that you intend to review. View only that
percentage in your analysis results.

You define an option on the Show menu only once. The option is available for one-click use every time
that you open your results. For more information, see Suppress Certain Rules from Display in One
Click.

Previously, using custom options on the Show menu, you suppressed orange checks and code metrics
(if they fell below a certain threshold). With this enhancement, you can use the Show menu to display
only those results that must be justified to reach a certain Software Quality Objective (SQO) level. For
instance, you can reach predefined SQO levels 4, 5, and 6 using the options on the Show menu. For
more information, see Software Quality Objectives.

Additional Call Graph Showing Task Creation
For global variables, the call graph provides a visual representation of the function call sequence

leading to operations on the variable. In R2015b, the call graph for shared global variables has been
augmented with a supporting call graph that shows task creation.
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Previously, Polyspace modeled multitasking code by assuming that all tasks begin after the main
completes execution. This model has been relaxed for POSIX thread creation functions allowing
creation of tasks in the main and in functions called from the main. Therefore, the call sequence
leading to the creation of a task can be nontrivial. The task creation call graph provides you a visual
representation of this call sequence.

For more information, see Review Global Variable Usage.

Improvements in Polyspace Metrics workflow

In R2015b, the Polyspace Metrics workflow has improved in the following ways:

* You can justify code complexity metrics in the Polyspace user interface and upload the
justifications to Polyspace Metrics. If a code metric value violates quality thresholds and appears

red, after justification, it appears green with the v icon.

For more information about justifying Polyspace results starting from the Polyspace Metrics
interface, see Compare Metrics Against Software Quality Objectives.

* You can define custom SQO levels specific to a project. In the file Custom-SQ0-
Definitions.xml, if you specify a project name, in the Polyspace Metrics web dashboard, the
custom SQO level appears only for that project. You can choose this SQO level to compare the
project against quality thresholds that you defined. For more information, see Customize Software
Quality Objectives.

» In the Polyspace user interface, the same menu item Metrics > Upload to Metrics allows you to
upload your results initially and also upload comments and justifications in the results later.

Previously, you used a different menu item Save comments to Metrics to save your review
comments and justifications in a result.

For more information on uploading comments and justifications from the Polyspace user interface
to the Polyspace Metrics web interface, see Review Metrics for Particular Project or Run.

Improvements in Polyspace Plugin for Eclipse

In R2015D, the following improvements have been made to the Polyspace plugin for Eclipse:

*  When you select a result in the Results Summary view, the Result Details view displays

additional information about the result. In the Result Details view, if you click the "L+ button
next to the result name, you can see a brief description and examples of the result.

* You can switch to a Polyspace perspective that shows only the information relevant to a Polyspace
Code Prover verification. To open the perspective, select Window > Open Perspective > Other.
In the Open Perspective dialog box, select Polyspace.

Improvements in Report Templates

In R2015b, the major improvements in report templates include the following:

* Instead of filenames, absolute paths to files appear in the reports.
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» Ifyou check for coding rules, the appendix about coding rules configuration states all rules along
with the information whether they were enabled or disabled. Previously, the appendix only stated
the enabled rules.

For more information on templates, see Report template (C/C++).

Configuration Associated with Result Not Opened by Default

In R2015b, when you open your result, the Configuration pane does not automatically display a
read-only form of the associated configuration.

To view the configuration associated with the result, select the link View configuration for results
on the Dashboard pane. If a corresponding project is open on the Project Browser pane, you can
also right-click the result under the Results node in the project and select Open Configuration.

XML and RTF report formats removed

The formats XML and RTF for report generation are no longer available from R2016a onwards. If you
generated reports using one of these formats, use an alternative format instead.

For more information, see Output format (C/C++).
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Simplified workflow for project setup and results review with a unified
user interface

In R2015a, the Project and Results Manager perspectives are now unified. You can run verification
and review results without switching between two perspectives.

The major changes are:
* You can start a new verification during your results review. Previously, you started a new

verification only from the Project Manager perspective.

» After a verification, the result opens automatically. If you are looking at a previous result when a
verification is over, you can load the new result or retain the previous one on the Results
Summary pane. If you retain the previous results, you can later open the new results from the
Project Browser. The new results are highlighted.

* You can have any of the panes open in the unified interface.

Previously, you could open the following panes only in one of the two perspectives.



Verification Setup

Project Manager

Results Manager

Project Browser: Set up project.
Configuration: Specify analysis options
for your project.

Output Summary: Monitor progress of
verification.

Run Log: Find detailed information about
a verification.

Results Summary: View Polyspace
results.

Source: View read-only form of source
code color coded with Polyspace results.

Check Details: View details of a particular
result.

Check Review: Comment on a particular
result.

Variable Access: View global variables
and read/write operations on them.

Call Hierarchy: View callers and callees
of a function.

Results Properties: Same as Run Log,
but associated with results instead of a
project. This pane has been removed.

To open the log associated with a result,
with the results open, select Window >
Show/Hide View > Run Log.

Settings: Same information as
Configuration, but associated with results
instead of a project. This pane has been
removed.

To open the configuration associated with a
result, with the results open, select
Window > Show/Hide View >
Configuration.

Orange Sources: View sources of orange
checks.

Sensitivity Context: For a check that has
a different color for different function calls,
view the check color for each function call.

Improvements in search capability in the user interface

In R2015a, the Search pane allows you to search for a string in various panes of the user interface.

To search for a string in the new user interface:

1 Ifthe Search pane is not visible, open it. Select Window > Show/Hide View > Search.

2 Enter your string in the search box.

3 From the drop-down list beside the box, select names of panes you want to search.

The Search pane consolidates the search options previously available.
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Support for GCC 4.8

Polyspace now supports the GCC 4.8 dialect for C and C++ projects.

To allow GCC 4.8 extensions in your Polyspace Code Prover verification, set Target & Compiler >
Dialect option gnu4.8.

For more information, see Dialect (C) and Dialect (C++).

Polyspace plug-in for Simulink improvements
In R2015a, there are three improvements to the Polyspace Simulink plug-in.
Integration with Simulink projects

You can now save your Polyspace results to a Simulink project. Using this feature, you can organize
and control your Polyspace results alongside your model files and folders.

To save your results to a Simulink project:

1 Open your Simulink project.
From your model, select Code > Polyspace > Options.

3 In the Polyspace parameter configuration tab, select the Save results to Simulink project
option.

For more information, see Save Results to a Simulink Project.

DRS file format changed to XML

By default, the DRS files generated in Simulink are saved in XML.

For more information, see XML File Format for Constraints

If you want to used a customized . txt DRS file, contact customer support.

Back-to-model available when Simulink is closed

In the Polyspace plug-in for Simulink, the back-to-model feature now works even when your model is

closed. When you click a link in your Polyspace results, MATLAB opens your Simulink model and
highlights the appropriate block.

Note This feature works only with Simulink R2013b and later.

For more information about the back-to-model feature, see Identify Errors in Simulink Models.

Polyspace binaries being removed

The following Polyspace binaries will be removed in a future release. The binaries are located in
matlabroot/polyspace/bin. You get a warning if you run them.
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Binary name

Use instead

polyspace-automatic -orange-tester.exe

From the Polyspace environment, select Tools >
Automatic Orange Tester

polyspace-c.exe polyspace-code-prover-nodesktop -lang c

polyspace-cpp.exe polyspace-code-prover-nodesktop -lang cpp

polyspace-remote-c.exe polyspace-code-prover-nodesktop -lang c -
batch

polyspace-remote-cpp.exe polyspace-code-prover-nodesktop -lang cpp -

batch

polyspace-remote.exe

polyspace-code-prover-nodesktop -batch

polyspace-rl-manager.exe

polyspace-server-settings.exe

polyspace-spooler.exe

polyspace-job-monitor.exe

polyspace-ver.exe

polyspace-code-prover-nodesktop -ver

Import Visual Studio project being removed

The File > Import Visual Studio project will be removed in a future release. Instead, use the
Create from build system option during New Project creation. For more information, see Trace

Visual Studio Build.
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Detection of stack pointer dereference outside scope

In R2015a, the Illegally dereferenced pointer check can detect stack pointer dereference outside
scope. Such dereference can happen, for example, when a pointer to a variable that is local to a
function is returned from the function. Because the scope of the variable is limited to the function,
dereferencing the pointer outside the function can cause undefined behavior.

This enhancement is not available by default. Use the option -detect-pointer-escape to detect
such dereferences. To provide command-line options in the user interface:

1 On the Configuration pane, select Advanced Settings.

2 Enter the option in the Other field.

Before R2015a

R2015a

In the following code, ptr points to ret. Because
the scope of ret is limited to funcl, when ptr is
accessed in func2, the access is illegal.

In the following code, Polyspace Code Prover
produces a red Illegally dereferenced pointer
check on *ptr.

Polyspace Code Prover did not detect such

pointer escapes. void func2(int *ptr) {

*ptr = 0;
void func2(int *ptr) { }
*ptr = 0; . .
} int* funcl(void) {
int ret = 0;
int* funcl(void) { return &ret ;
int ret = 0; P _ _
return &ret ; void main(void) {
} int* ptr = funcl() ;
void main(void) { func2(ptr) ;
int* ptr = funcl() ; }
func2(ptr) ;

The Check Details pane displays a message indicating that ret is accessed outside its scope.

1 ID 1: Tllegally dereferenced pointer

Error: pointer is outside its bounds
This check may be a path-related issue, which is not dependent an input values

Dereference of parameter ‘ptr' (pointer to int 32, size: 32 bits):
Pointer is not null.
Points to 4 bytes at offset 0 in buffer of 4 bytes, so is within bounds {if memory is allocated).
Paointer may point to variable or field of variable:

'ret’, local to function 'funcl’. et is accessed outside its scope.

Isolated ellipsis for variable number of function arguments supported

In R2015a, for C++ code, Polyspace Code Prover supports the ellipsis in the function definition
syntax void foo(...){} to mean variable number of arguments. Previously, the use of ellipsis in
isolation was not supported. You could use only the syntax where the ellipsis was preceded with other
parameters.
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Before R2015a

R2015a

In the following code, Polyspace considers that
foo has no arguments. Therefore, it produces a
red Correctness condition error on the second
function call. The Check Details pane indicates
that the wrong number of arguments were used
in the function call.

void foo(...) {
/* Function body */

}
void main() {
foo();
foo(1,2); //Red COR

}

In the following code, Polyspace considers that
foo takes a variable number of arguments. It
does not produce a red Correctness condition
error on the second function call.

void foo(...) {
/* Function body */
}

void main() {
foo();
foo(1,2); //No COR

}

Improvement in pointer comparisons

In R2015a, Polyspace is more precise on pointer comparisons. In certain cases, if the software can
determine that a pointer comparison is always true or false, it provides that result. Previously,

Polyspace did not check pointer comparisons.
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Before R2015a

R2015a

In the following code, Polyspace does not check
the comparison ptr==&invalid. Therefore, it
considers that check can return either 0 or 1. In
the main function, it verifies both branches of the
if-else statement.

#include <stdlib.h>
typedef unsigned char
U8 invalid;

#define TEST DISABLED &invalid

us;

U8 check(U8 cnt, U8* ptr)

{
U8 ret=0;
if (ptr == &invalid)
{
ret=1;
}
return ret;
}

void main()
{ U8 isDisabled;
isDisabled = check(1U,\
TEST DISABLED);
if(isDisabled == 1) {
/* Do not perform test */

}
else {

/* Perform test */
}

In the following code, Polyspace checks the
comparison ptr===&invalid and determines
that it is always true. Therefore, it considers that
the if test is redundant and the function check
returns 1 only. In the main function, it verifies the
if branch and considers the else branch as
unreachable.

#include <stdlib.h>
typedef unsigned char
U8 invalid;

#define TEST DISABLED &invalid

us;

U8 check(U8 cnt, U8* ptr)

{
U8 ret=0;
if(ptr == &invalid)
{
ret=1;
}
return ret;
}

void main()
{ U8 isDisabled;
isDisabled = check(1U,\
TEST DISABLED);
if(isDisabled == 1) {
/* Do not perform test */

}
else {

/* Perform test */
}

Improvements in coding rules checking

MISRA C:2004 and MISRA AC AGC

Rule Number Effect More Information

Rule 12.6 More results on noncompliant #if MISRA C:2004 Rules — Chapter 12:
preprocessor directives Expressions
Fewer results for variables cast to
effective Boolean types.

Rule 12.12 Fewer results when converting to an |MISRA C:2004 Rules — Chapter 12:
array of float Expressions
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MISRA C:2012

Rule Number

Effect

More Information

Rules 10.3

Fewer results on enumeration
constants when the type of the
constant is a named enumeration type.
Fewer results on user-defined
effective Boolean types.

MISRA C:2012 Rule 10.3

Rule 10.4

Fewer results on enumeration
constants when the type of the
constant is a named enumeration type.
Fewer results for casts to user-defined
effective Boolean types.

MISRA C:2012 Rule 10.4

Rule 10.5

Fewer results on enumeration
constants when the type of the
constant is a named enumeration type.
Fewer results on user-defined
effective Boolean types.

MISRA C:2012 Rule 10.5

Rule 12.1

More results on expressions with
sizeof operator and on expressions
with ? operators.

Fewer results on operators of the
same precedence and in
preprocessing directives.

MISRA C:2012 Rule 12.1

Rule 14.3

No results for non-controlling
expressions.

MISRA C:2012 Rule 14.3

MISRA C++:2008

Rule Number

Effect

More Information

Rule 5-0-3

Fewer results on enumeration
constants when the type of the
constant is the enumeration type.

MISRA C++ Rules — Chapter 5

Rule 6-5-1

Fewer results on compliant vector
variable iterators.

MISRA C++ Rules — Chapter 6

Rule 14-8-2

Fewer results for functions contained
in the Files and folders to ignore (C+
+) option.

MISRA C++ Rules — Chapter 14

Rule 15-3-2

Fewer results for user-defined return
statements after a try block.

MISRA C++ Rules — Chapter 15
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Context-sensitive help for code complexity metrics, MISRA-C:2012,
and custom coding rules

In R2015a, context-sensitive help is available in the user interface for code complexity metrics,
MISRA C:2012 rule violations, and custom coding rule violations.

To access the contextual help, see Getting Help.

For information about these results, see:

¢ Code Metrics
o MISRA C:2012 Directives and Rules
* Custom Coding Rules

Review of code complexity metrics and global variable usage in user
interface

* “Code Complexity Metrics” on page 16-10
* “Global Variables” on page 16-10

Code Complexity Metrics

In R2015a, you can view code complexity metrics in the Polyspace user interface. For more
information, see Code Metrics. Previously, this information was available only in the Polyspace
Metrics web interface.

In the user interface, you can:

» Specify a limit for the value of a metric. If the metric value for your source code exceeds this limit,
the metric appears red on the Results Summary pane.

+ Justify the value of a metric. If a metric value exceeds specified limits and appears red, you can
add a comment with the rationale.

Combining these actions, you can enforce coding standards across your organization. For more
information, see Review Code Metrics.

Reducing the complexity of your code improves code readability, reduces the possibility of coding
errors, and allows more precise Polyspace verification.

Global Variables
In R2015a, you can comment and justify global variable usage on the Results Summary pane.
Previously, you viewed global variable usage on the Variable Access pane, but could not comment on

them.

On the Results Summary pane, global variables are classified into one of the following categories.
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Category Color Meaning

Shared Potentially unprotected |Orange Global variables shared
between multiple tasks
but possibly not

protected from
concurrent access by
the tasks

Protected Green Global variables shared
between multiple tasks
and protected from
concurrent access by
the tasks

Not shared Used Black Global variables used in
a single task

Unused Gray Global variables
declared but not used

For more information, see Global Variables.

For code that you do not intend for multitasking, all variables are nonshared and can be either used
or unused. For code that you intend for multitasking, you can specify tasks and protections through
the analysis options for multitasking. For more information, see Multitasking.

You can still view the global variables on the Variable Access pane.

* To comment and justify potentially unprotected and unused global variables, use the Results
Summary pane.

» To find the read and write operations on a global variable, use the Check Details or Variable
Access pane. On the Variable Access pane, you can also see the variable range and other
information.

For more information, see Review Global Variable Usage.

Review of latest results compared to the last run
In R2015a, you can review only new results compared to the previous run.

If you rerun your verification, the new results are displayed with an asterisk (*) against them on the
Results Summary pane. To filter only these new checks, select the New results box.

If you make changes in your source code, you can use this feature to see only the checks introduced
due to those changes. You can avoid reviewing checks in the source code that you did not change.

Guidance for reviewing Polyspace Code Prover checks in C code

In R2015a, the context-sensitive help for checks provides guidance about how to review the check.
The help describes:

* Information available in the software for the check.
» In your source code, how to navigate to the root cause of the check.
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* Common causes of the check.
To open the context-sensitive help for a check:

* On the Results Summary or Source pane, select the check.

Select the "L/ button.
» Select the link in the section Diagnosing This Check.

This additional guidance is not available for C++-specific checks.

Simplified results infrastructure

Polyspace results folders are reorganized and simplified. Files have been removed, combined,
renamed, or moved. The changes do not affect the results that you see in the Polyspace environment.

Some important changes and file locations:

* The main results file is now encrypted and renamed ps_results.pscp. You can view results only
in the Polyspace environment.

* Thelog file, Polyspace R2015a project date-time.log has not changed.

For more information, see Results Folder Contents.
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Improved verification speed

In R2014b, the following two changes improve the verification speed:

* Polyspace Code Prover can run the compilation phase of your verification in parallel on multiple
processors. The software detects available processors and uses them to compile different source
files in parallel.

Previously, the software ran post-compilation phases in parallel but compiled the source files
sequentially. Starting in R2014b, the software can use multiple processors for the entire
verification process.

To explicitly specify the number of processors, use the command-line option -max-processes.
For more information, see -max-processes.

* Polyspace Code Prover has an improved engine for verification. This engine typically improves
verification speed by 25%. However, in some cases, verification can take the same amount of time
or longer.

Compatibility Considerations

In most cases, you do not see significant change in the number of checks resulting from the improved
engine. If you see a major increase in the number of orange checks, contact technical support. For
more information, see Obtain System Information for Technical Support.

Support for Mac OS

You can install and run Polyspace on Mac OS X. Polyspace is supported for Mac OS 10.7.4+, 10.8, and
10.9.

You can use Polyspace Metrics on Safari and set up your Mac as a Metrics server. However, if you
restart your Mac machine that is setup as a Metrics server, you must restart the Polyspace server
daemon.

The Automatic Orange Tester is not supported for Mac.

Support for C++11

Polyspace can now fully analyze C++ code that follows the ISO/IEC 14882:2011 standard, also called
C++11.

Use two new analysis options when analyzing C++11 code. On the Target & Compiler pane, select:

* C++11 extensions to allow the standard C++11 libraries and functions during your analysis.
* Block char 16/32_t types to not allow charl6 t or char32_ t types during the analysis.

For more information, see C++11 Extensions (C++) and Block char16/32 t types (C++).
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Code Editor for editing source files in Polyspace user interface

In R2014b, by default, you can edit your source files inside the Polyspace user interface.

* In the Project Manager perspective, on the Project Browser tree, double-click your source file.
* In the Results Manager perspective, right-click the Source pane and select Open Source File.

Your source files appear on a Code Editor tab. On this tab, you can edit your source files and save
them.

To use an external text editor, change your preferences.

1 Select Tools > Preferences.
2 Specify an external editor on the Editors tab.

For more information, see Specify External Text Editor.

Local file-by-file verification

In R2014b, you can verify your source code file by file on your local installation of Polyspace Code
Prover. Each file is verified independently of the other files in your module. Previously, you performed
file-by-file verification only on a remote server. The verification required:

» Parallel Computing Toolbox on the client side
 MATLAB Parallel Server on the server side

For more information on file-by-file verification, see:

* Run File-by-File Verification
* Open Results of File-by-File Verification

For information on file-by-file verification in batch mode, see:

* Run File-by-File Batch Verification
* Open Results of File-by-File Batch Verification

Simulink plug-in support for custom project files

With the Polyspace plug-in for Simulink, you can now use a project file to specify the verification
options.

On the Polyspace pane of the Configuration Parameters window, with the Use custom project file
option you can enter a path or browse for a .psprj project file.

For more information, see Configure Polyspace Analysis Options.

TargetLink support updated

The Polyspace plug-in for Simulink now supports TargetLink 3.4 and 3.5. Older versions of TargetLink
are not supported.

For more information, see TargetLink Considerations.
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AUTOSAR support added

In R2013Db, the Polyspace plug-in for Simulink added support for AUTOSAR generated code with
Embedded Coder. If you use autosar.tlc as your System target file for code generation, when you
run Polyspace, the verification can use the data range information from AUTOSAR.

The Polyspace verification uses the same default options and parameters as it does for Embedded
Coder.

For more information, see Embedded Coder Considerations.

Default verification level changed

In R2014b, unless you specify a verification level explicitly, Polyspace Code Prover verification
performs two passes on your source code instead of four. For instance:

* In the user interface, on the Output Summary tab, you can see that the verification continues to
Level2. For more passes, on the Configuration pane, under the Precision node, select a higher
Verification level.

* At the command line, the verification implicitly uses -to pass2. For more passes, use the -to
option explicitly with a higher pass value.
The default verification is completed in much less time.

For more information, see:

* Verification level (C)
* Verification level (C++)

Compatibility Considerations

If you do not specify a verification level explicitly in your polypsace-code-prover-nodesktop
command, your verification runs to Software Safety Analysis Level 2.In most cases, this
verification level produces only slightly more orange checks than Software Safety Analysis
Level 4. However, if you see a significant change in your results, to reproduce your earlier results:

* Inthe user interface, select Software Safety Analysis Level 4 for Verification level.

* At the command line, use the option -to pass4 with the polypsace-code-prover-nodesktop
command.

Default mode changed for C++ code verification in user interface

When you create a new Polyspace Code Prover project with C++ as the project language, the
following options are selected in the user interface by default. The options appear on the
Configuration pane under the Code Prover Verification node.

Option Value
Verify Module On
Class all
Functions to call within the specified classes |unused
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Option Value
Functions to call unused
Variables to initialize uninit

These options replace the default selection of Verify whole application on the Polyspace user
interface.

If your C++ code does not contain a main function, Polyspace generates a main by default during
verification from the user interface.

For more information on the main generation options, see Provide Context for C++ Code Verification.

Improved global menu in user interface

The global menu in the Polyspace user interface has been updated. The following table lists the
current location for the existing global menu options.

Goal Prior to R2014b R2014b

Open the Polyspace Metrics File > Open Metrics Web Metrics > Open Metrics

interface in your web browser. |Interface

Upload results from the File > Upload in Polyspace Metrics > Upload to Metrics

Polyspace user interface to Metrics repository

Polyspace Metrics.

Update results stored in File > Save in Polyspace Metrics > Save comments to

Polyspace Metrics with your Metrics repository Metrics

review comments and

justifications.

Generate a report from results |Run > Run Report > Run Reporting > Run Report

after verification. Report

Open generated report. Run > Run Report > Open Reporting > Open Report
Report

Partition source code into Run > Run Modularize Tools > Run Modularize

modules.

Import review comments from |Review > Import Tools > Import Comments

previous verification.

Specify code generator for Review > Code Generator Tools > Code Generator

generated code. Support Support

Specify settings that apply to all |Options > Preferences Tools > Preferences

Polyspace Code Prover projects.

Specify settings for remote Options > Metrics and Metrics > Metrics and

verification. Remote Server Settings Remote Server Settings

Improved Project Manager perspective
The following changes have been made in the Project Manager perspective:

* The Progress Monitor tab does not exist anymore. Instead, after you start a verification, you can
view its progress on the Output Summary tab.
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» Instead of a single progress bar showing all the stages of verification, you can see two progress
bars. The top bar shows progress in the current stage of verification and the lower bar shows
overall progress.

Level2: 0% Elapsed time: 00:00:00
Total: 75%: Total elapsed time: 00:00:17

After verification, you can see the overall time taken. To see the time taken in each stage of

verification, click the (4 icon.
» In the Project Browser, projects appear sorted in alphabetical order instead of order of creation.

Changed analysis options

Changes have been made to the following analysis options:

* On the Configuration pane, the analysis option Files and folders to ignore has been moved
from Coding Rules Checking to Inputs & Stubbing. The functionality in Polyspace Code Prover
has not changed.

* On the Configuration pane, the Interactive option has been removed from the graphical
interface. To use interactive mode, use the -interactive flag at the command line or in the
Advanced Settings > Other text field.

*  You cannot use batch mode or interactive mode with Verification Level > C/C++ source
compliance checking.

To run only to code compliance, run Polyspace Code Prover locally.

To perform batch or interactive verifications, use Software Safety Analysis level O or higher.

Remote launcher and queue manager renamed

Polyspace has renamed the remote launcher and the queue manager.

Previous name New Name More information

polyspace-rl-manager.exe polyspace-server-settings.exe |Only the binary name has
changed. The interface title,
Metrics and Remote Server
Settings, is unchanged.

polyspace-spooler.exe polyspace-job-monitor.exe The binary and the interface
titles have changed. Interface
labels have changed in the
Polyspace interface and its
plug-ins.

Queue Manager or Spooler Job Monitor

pslinkfun('queuemanager') pslinkfun('jobmonitor"') See pslinkfun.

Compatibility Considerations

If you use the old binaries or functions, you receive a warning.
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Polyspace binaries being removed

The following Polyspace binaries will be removed in a future release. Unless otherwise noted, the
binaries to use are located in matlabroot/polyspace/bin.

Binary name What Use instead
happens
polyspace-automatic -orange- Warning |From the Polyspace environment, select Tools >
tester.exe Automatic Orange Tester
polyspace-c.exe Warning |polyspace-code-prover-nodesktop -lang c
polyspace-cpp.exe Warning |polyspace-code-prover-nodesktop -lang
cpp
polyspace-remote-c.exe Warning polyspace-code-prover-nodesktop -lang c
-batch
polyspace-remote-cpp.exe Warning |polyspace-code-prover-nodesktop -lang
cpp -batch
polyspace-remote.exe Warning |polyspace-code-prover-nodesktop -batch
polyspace-rl-manager.exe Warning |polyspace-server-settings.exe
polyspace-spooler.exe Warning polyspace-job-monitor.exe
polyspace-ver.exe Warning |polyspace-code-prover-nodesktop -ver
setup-remote-launcher.exe Warning |matlabroot/toolbox/polyspace /

psdistcomp/bin/setup-polyspace-cluster

Import Visual Studio project being removed

The File > Import Visual Studio project will be removed in a future release. Instead, use the
Create from build system option during New Project creation. For more information, see Trace

Visual Studio Build.
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Support for MISRA C:2012

Polyspace can now check your code against MISRA C:2012 directives and coding rules. To check for
MISRA C:2012 coding rule violations:

On the Configuration pane, select Coding Rules.
Select Check MISRA C:2012.

The MISRA C:2012 guidelines have different categories for handwritten and automatically
generated code.

If you want to use the settings for automatically generated code, also select Use generated
code requirements.

For more information about supported rules, see MISRA C:2012 Coding Directives and Rules.

Improved verification precision for non-initialized variables

Polyspace Code Prover performs the following checks for initialization:

* Non-initialized local variable or NIVL
* Non-initialized variable or NIV

In R2014b, the following changes appear in these checks.
Read Operations on Structures

When you read structured variables, Polyspace Code Prover performs a check for initialization. This
check helps detect partially initialized and non-initialized structures earlier in the code.
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Prior to R2014b

R2014b

*  When you read structured variable, a check
for initialization was not performed.

* The checks occurred only when you read
individual fields of a structured variable,
provided the fields themselves were not
structured variables.

When you read structured variables, a check for
initialization occurs. The check turns:

e Green, if all fields of the structure that are
used are initialized. If no field is used, the
check is green by default.

* Red, if all fields that are used are not
initialized.

* Orange, if only some fields that are used are
initialized. Following the check, Polyspace
considers that the uninitialized fields have the
full range of values allowed by their type.

Polyspace considers a field as used if there is a
read or write operation on the field anywhere in
the code. Polyspace does not check for
initialization of fields that are not used.

To determine which fields Polyspace checked for
initialization:

1 Select the NIV or NIVL check on the Results
Summary pane or Source pane.

2 View the message on the Check Details

pane.

Example: Example:
typedef struct S { typedef struct S {

int a; int a;

int b; int b;

1S;

void funcl(S);
void func2(int);

void main() {
S vars;
funcl(varS);
func2(varS.a);

}

A check was not performed when the non-
initialized structure varS was read. When the
field a of varS was read, a red NIVL check
appeared.

1S;

void funcl(S);
void func2(int);

void main() {
S vars;
funcl(varS);
func2(varS.a);

}

When the non-initialized structure vars is read, a
red NIVL check appears.

For more examples, see:

* Partially initialized structure — All used fields
initialized

 Partially initialized structure — Some used
fields initialized
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Other Operations

The specification of Non-initialized variable checks has changed for the following operations. These
operations are not commonly used. Therefore, it is likely that these changes do not affect your
Polyspace verification.

Prior to R2014b R2014b

If you initialized only the high bits of a variable |If you initialize only the high bits of a variable

through a pointer, an orange check for through a pointer, a green check for initialization

initialization appeared when the variable was appears when the variable is read.

read.

If you performed an operation on a C++ object |If you perform an operation on a C++ object after

after it was destroyed, a red check for it is destroyed, the check for initialization has the

initialization appeared on the operation. The same color as before the destruction. Polyspace

check indicated that the object was destroyed. does not introduce a red check on this type of
access.

Compatibility Considerations

If you use an earlier version of Polyspace Code Prover, it is possible that you see the following
changes in your results.

* Read operation on structures: You see an increase in the total number of checks.

However, some red or orange NIV or NIVL checks on the fields of structures turn green. Instead,
you see some new red or orange checks on the structures themselves.

* Other operations:
+ Ifyou have operations that initialize only the high bits of a variable through a pointer, you can
see a reduction in orange NIV or NIVL checks.

+ Ifyou have operations that access an object after it is destroyed, you can see a reduction in red
NIV or NIVL checks.

New checks for functions not called

Two new checks in Polyspace Code Prover detect C/C++ functions that are defined but not called
during execution of the code.

Check Purpose

Function not called Detects functions that are defined but not called
in the source files.

Function not reachable Detects functions that are defined but called only
from an unreachable part of the source.

You can choose to activate these checks using the following options:
* In the user interface, on the Configuration pane, under Check Behavior, select a value for the
option Detect uncalled functions.

* At the command line, use the option -uncalled-function-checks with an appropriate
argument.
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Goal

Option Value

Do not detect uncalled functions.

none

Detect functions that are defined but not called.

never-called

Detect functions that are defined and called only
from an unreachable part of the code.

called-from-unreachable

Detect all uncalled functions.

all

Improved precision level

In R2014b, certain internal limits have been removed from verification that uses a Precision level of
3. Because of this improvement, you can use this Precision level to significantly reduce orange
checks, especially for multitasking code that uses shared variables. However, if you use this level, the

verification can take significantly longer.

To set Precision level to 3, do one of the following:

* In the user interface, on the Configuration pane, select Precision. From the Precision level

drop-down list, select 3.

* At the DOS or UNIX command prompt, use the flag -03 with the polyspace-code-prover-

nodesktop command.

* At the MATLAB command prompt, use the argument '-03"' with the polyspaceCodeProver

function.

For more information, see Precision level (C/C++).
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Context-sensitive help for verification options and checks

In R2014b, contextual help is available for verification options in the Polyspace interface and its plug-
ins. To view the contextual help:

Hover your cursor over a verification option in the Configuration pane.
Inside the tooltip, select the “More Help” link.

The documentation for that option appears in a dockable window.

Contextual help is available in the Polyspace interface for run-time errors. To view the contextual help
for checks:

1 In the Results Manager perspective, select a run-time error from the results.

Inside the Check Details pane, select "L+,
The documentation for that check appears in a docked window.

For more information, see Getting Help.

Updated Software Quality Objectives

In R2014b, the Software Quality Objectives or SQOs have been updated to include MISRA C++: 2008
coding rule violations.

Using the predefined SQO levels, you can specify quality thresholds for your project or individual files
in your project. With the updated SQOs, you can now specify that your project must not violate
certain MISRA C++ rules.

For more information, see Predefined SQO Levels.

Improved Results Manager perspective

The following changes have been made in the Results Manager perspective:
* On the Source pane, the following code appears in gray:

* Code deactivated due to conditional compilation. Polyspace assigns a lighter shade of gray to
this code.
* Code in an unreachable branch. Polyspace assigns a darker shade of gray to this code.

For the difference between the two cases, see the code below. To reproduce the colors, before
verification, on the Configuration pane, enter Polyspace= for Preprocessor definitions.
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|
Dashboard = |test file.c x

#include <limits.h>
int getWVal():

volid main{) [

int a=getVal(},b;

#ifdef Polvyspace

b=z'a;

E 1£(5<0)

#elae

#endif

To prioritize your orange check review, use the Show menu on the Results Summary pane. This
menu replaces the previously available methodologies for the same purpose.

+ To display red, gray, and orange checks likely to be run-time errors, from the Show menu,
select Critical checks. This option replaces the First checks to review methodology.

* To display all checks, from the Show menu, select All checks. This option replaces the All
checks methodology.

* The methodologies Methodology for C/C++ > Light and Methodology for C/C++ >
Moderate have been removed.

* To create your own subset of orange checks to review, select Tools > Preferences. On the
Review Scope tab, specify the number or percentage of orange checks of each type to review.
The options on this tab replace the options on the Review Configuration tab.

To group your checks, use the Group by menu on the Results Summary pane.

* To leave your checks ungrouped, instead of List of Checks, select Group by > None.

» To group checks by check color and type, instead of Checks by Family, select Group by >
Family.

» To group checks by file and function, instead of Checks by File/Function, select Group by >
File.

To view the percentage of checks that you have justified, instead of the Review Statistics pane,

use the Justified column on the Results Summary pane. On this pane:

+ To view the percentage of checks that you justified broken down by color/type, select Group
by > Family.

+ To view the percentage of checks that you justified broken down by file/function, select Group
by > File.
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Error mode removed from coding rules checking

In R2014b, the Error mode has been removed from coding rules checking. Therefore, coding rule
violations cannot stop a verification.

Compatibility Considerations

For existing coding rules files, rules having the keyword error are treated in the same way as the
keyword warning. For more information on warning, see Format of Custom Coding Rules File.
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Automatic project setup from build systems

In R2014a, you can set up a Polyspace project from build automation scripts that you use to build
your software application. The automatic project setup runs your automation scripts to determine:
* Source files.

* Includes.

» Target & Compiler options.

To set up a project from your build automation scripts:

* On the DOS or UNIX command line: Use the polyspace-configure command. For more
information, see Create Project from DOS and UNIX Command Line.

* In the user interface: When creating a new project, in the Project - Properties window, select
Create from build command. In the following window, enter:
* The build command that you use.
* The directory from which you run your build command.
* Additional options. For more information, see Create Project in User Interface.

Click ‘M. In the Project Browser, you see your new Polyspace project with the required
source files, include folders, and Target & Compiler options.

* On the MATLAB command line: Use the polyspaceConfigure function. For more information,
see Create Project from MATLAB Command Line.

Support for GNU 4.7 and Microsoft Visual Studio C++ 2012 dialects

Polyspace supports two additional dialects: Microsoft Visual Studio C++ 2012 and GNU 4.7. If your
code uses language extensions from these dialects, specify the corresponding analysis option in your
configuration. From the Target & Compiler > Dialect menu, select:

* gnu4.7 for GNU 4.7
* visualll.o for Microsoft Visual Studio C++ 2012

For more information about these and other supported dialects, see Dialects for C or Dialects for C+
+.

Documentation in Japanese
The Polyspace product, including the documentation, is available in Japanese.
To view the Japanese version of Polyspace Code Prover documentation, go to https://

www.mathworks.co.jp/jp/help/codeprover/. If the documentation appears in English, from the country
list beside the globe icon at the top of the page, select Japan.


https://www.mathworks.com/help/releases/R2014a/codeprover/ug/create-a-configuration-from-your-build-environment.html#bt9_wgg
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https://www.mathworks.com/help/releases/R2014a/codeprover/ug/create-a-configuration-from-your-build-environment.html#bt9_wh0
https://www.mathworks.com/help/releases/R2014a/codeprover/ref/dialect.html
https://www.mathworks.com/help/releases/R2014a/codeprover/ref/dialect-1.html
https://www.mathworks.com/help/releases/R2014a/codeprover/ref/dialect-1.html
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https://www.mathworks.co.jp/jp/help/codeprover/
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Preferences file moved

In R2014a, the location of the Polyspace preferences file has been changed.

Operating Location before R2014a Location in R2014a

System

Windows %APPDATA%\Polyspace %APPDATA%\MathWorks\MATLAB\R2014a\Polyspace
Linux /home/$USER/ .polyspace /home/$USER/ .matlab/$RELEASE/Polyspace

For more information, see Storage of Polyspace Preferences.

Support for batch analysis security levels

When creating an MDCS server for Polyspace batch analyses, you can now add additional security
levels through the MATLAB Admin Center. Using the Metrics and Remote Server Settings, the
MDCS server is automatically set to security level zero. If you want additional security for your
server, use the Admin Center button. The additional security levels require authentication by user
name, cluster user name and password, or network user name and password.

For more information, see MDCS documentation.

Interactive mode for remote verification

In R20144, you can select an additional Interactive mode for remote verification. In this mode, when
you run Polyspace Code Prover on a cluster, your local computer is tethered to the cluster through
Parallel Computing Toolbox and MATLAB Parallel Server.

To run verification in this mode

* Inthe user interface: On the Configuration pane, under Distributed Computing, select
Interactive.

* On the DOS or UNIX command line, append -interactive to the polyspace-code-prover-
nodesktop command.

* On the MATLAB command line, add the argument ' -interactive' to the
polyspaceCodeProver function.

For more information, see Interactive.

Default text editor

In R2014a, Polyspace uses a default text editor for opening source files. The editor is:

*  WordPad in Windows
e viin Linux

You can change the text editor on the Editors tab under Options > Preferences. For more
information, see Specify Text Editor.

Support for Windows 8 and Windows Server 2012

Polyspace supports installation and analysis on Windows Server® 2012 and Windows 8.

18-3


https://www.mathworks.com/help/releases/R2014a/codeprover/ug/storage-of-polyspace-preferences.html
https://www.mathworks.com/help/releases/R2014a/mdce/set-mjs-cluster-security.html
https://www.mathworks.com/help/releases/R2014a/codeprover/ref/polyspacecodeprover.html
https://www.mathworks.com/help/releases/R2014a/codeprover/ref/interactive.html
https://www.mathworks.com/help/releases/R2014a/codeprover/ug/specify-text-editor.html

R2014a

For installation instructions, see Installation, Licensing, and Activation.

Check model configuration automatically before analysis

For the Polyspace Simulink plug-in, the Check configuration feature has been enhanced to
automatically check your model configuration before analysis. In the Polyspace pane of the Model
Configuration options, select:

* On, proceed with warnings to automatically check the configuration before analysis and
continue with analysis when only warnings are found.

* 0On, stop for warnings to automatically check the configuration before analysis and stop if
warnings are found.

* Off to never check the configuration automatically before an analysis.
If the configuration check finds errors, Polyspace always stops the analysis.

For more information about Check configuration, see Check Simulink Model Settings.

Function replacement in Simulink plug-in

The following functions have been replaced in the Simulink plug-in by the function pslinkfun. These
functions be removed in a future release.

Function What Use This Function Instead
Happens?
PolyspaceAnnotation Warning pslinkfun('annotations',...)
PolySpaceGetTemplateCFGFile Warning pslinkfun('gettemplate')
PolySpaceHelp Warning pslinkfun('help"')
PolySpaceEnableCOMServer Warning pslinkfun('enablebacktomodel')
PolySpaceSpooler Warning pslinkfun('queuemanager')
PolySpaceViewer Warning pslinkfun('openresults',...)
PolySpaceSetTemplateCFGFile Warning pslinkfun('settemplate',...)
PolySpaceConfigure Warning pslinkfun('advancedoptions')
PolySpaceKillAnalysis Warning pslinkfun('stop')
PolySpaceMetrics Warning pslinkfun('metrics')

Polyspace binaries being removed

The following Polyspace binaries will be removed in a future release:

* polyspace-automatic-orange-tester.exe
* polyspace-c.exe

* polyspace-cpp.exe

* polyspace-modularize.exe

* polyspace-remote-c.exe
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polyspace-remote-cpp.exe
polyspace-remote.exe
polyspace-report-generator.exe
polyspace-results-repository.exe
polyspace-rl-manager.exe
polyspace-spooler.exe
polyspace-ver.exe
setup-remote-launcher.exe
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Support for additional Coding Rules (MISRA C:2004 Rule 18.2, MISRA
C++ Rule 5-0-11)

The Polyspace coding rules checker now supports two additional coding rules: MISRA C 18.2 and
MISRA C++ 5-0-11.
* MISRA C 18.2 is a required rule that checks for assignments to overlapping objects.

* MISRA C++ 5-0-11 is a required rule that checks for the use of the plain char type as anything
other than storage or character values.

¢ MISRA C++ 5-0-12 is a required rule that checks for the use of the signed and unsigned char
types as anything other than numerical values.

For more information, see MISRA C:2004 Coding Rules or MISRA C++ Coding Rules.

Improvement of floating point precision

In R2013b, Polyspace improved the precision of floating point representation. Previously, Polyspace
represented the floating point values with intervals, as seen in the tooltips. Now, Polyspace uses a
rounding method.

For example, the verification represents float arr = 0.1; as,

* Pre-R2013b, arr = [9.9999E"-2,1.0001E-1].
e Now, arr = 0.1.


https://www.mathworks.com/help/releases/R2014a/codeprover/ug/misra-c-coding-rules.html
https://www.mathworks.com/help/releases/R2014a/codeprover/ug/misra-c-coding-rules-1.html
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Results folder appearance in Project Browser

In R2014a, the results folder appears in a simplified form in the Project Browser. Instead of a folder
containing several files, the result appears as a single file.

* Format before R2014a:

=3 Demo_C [(]
'.B Source
#-13 Include
=3 Module_1
'.E Source
'.B Configuration
=3 Result
E}-—j Result_1 [Verification Completed]

i[¥g options

il Demo_C.pscp

- ----- || MISRA-C-reportxml
b | Custom-rules-reportaml

* Format in R2014a:

=3 Demo_C [(]
'.5 Source
ﬁ Include
=3 Module_1
'Ij Source
'.B Configuration
EI'Ij Result

| Result_1 [Verification Completed]

The following table lists the changes in the actions that you can perform on the results folder.

Action 2013b 2014a
Open results. In the result folder, double-click Double-click result file.
result file with extension .pscp.
Open analysis options used for In the result folder, select options. |Right-click result file and select
result. Open Configuration.
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Action 2013b 2014a

Open metrics page for batch In the result folder, select Metrics |Double-click result file.

analyses if you had used the Web Page.

analysis option Distributed If you had used the option
Computing > Add to results Distributed Computing > Add to
repository. results repository, double-clicking

the results file for the first time
opens the metrics web page instead
of the Result Manager perspective.

Open results folder in your file Navigate to results folder. Right-click result file and select

browser. Open Folder with File Manager.
To find results folder location, select

Options > Preferences. View
result folder location on the Project
and Results Folder tab.

Results Manager improvements

* In R2014a, you can view the extent of a code block on the Source pane by clicking either its
opening or closing brace.

‘f_

Dashboard = |tasksl.c 4 [ &
atatic vold initregulate (void) -~

{

int tmp = 07

while (random int() < 1000;{5

tmp = orderregulate():

Begin CS5(); E
=l

End C5{):

thp = Get Powerlewvel():

Compute_ Injection():
1 7% end loop: */

}
4 I

[¥] Source El Data Range Configuration

Note This action does not highlight the code block if the brace itself is already highlighted. The
opening brace can be highlighted, for instance, if there is an Unreachable code error on the code
block.

* In R2014a, the Verification Statistics pane in the Project Manager and the Results Statistics
pane in the Results Manager have been renamed Dashboard.

On the Dashboard, you can obtain an overview of the results in a graphical format. For more
information, see Dashboard.
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* In R2014a, on the Results Summary pane, you can distinguish between violations of predefined
coding rules such as MISRA C or C++ and custom coding rules.
* The predefined rules are indicated by = .
* The custom rules are indicated by + .
In addition, when you click on the Check column header on the Results Summary pane, the
rules are sorted by rule number instead of alphabetically.

* In R2014a, you can double-click a variable name on the Source pane to highlight all instances of
the variable.

Simplification of coding rules checking

In R2014a, the Error mode has been removed from coding rules checking. This mode applied only to:
* The option Custom for:

* Check MISRA C rules
* Check MISRA AC AGC rules
* Check MISRA C++ rules
* Check JSF C++ rules
* Check custom rules

The following table lists the changes that appear in coding rules checking.

Coding Rules 2013b 2014a

Feature

New file wizard for |For each coding rule, you can select three For each coding rule, you can select two
custom coding results: results:

rules.

* Error: Analysis stops if the rule is violated. |* On: Analysis continues even if the

rule is violated.
The rule violation is displayed on the Output

Summary tab in the Project Manager The rule violation is displayed on the
perspective. Results Summary pane in the Result

« Warning: Analysis continues even if the rule |  Manager perspective.

is violated. * Off: Polyspace does not check for

violation of the rule.
The rule violation is displayed on the

Results Summary pane in the Result
Manager perspective.

» Off: Polyspace does not check for violation of
the rule.
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Coding Rules
Feature

2013b

2014a

Format of the
custom coding
rules file.

Each line in the file must have the syntax:

rule off|error|warning #comments
For example:

# MISRA configuration - Projl
10.5 off #don't check 10.5
17.2 error

17.3 warning

Each line in the file must have the syntax:
rule off|warning #comments

For example:

# MISRA configuration - Projl

10.5 off #don't check 10.5

17.2 warning
17.3 warning

Compatibility Considerations

For existing coding rules files that use the keyword error:

+ If you run analysis from the user interface, it will be treated in the same way as the keyword
warning. The verification will not stop even if the rule is violated. The rule violation will however

be reported on the Results Summary pane.

» If you run analysis from the command line, the verification will stop if the rule is violated.

Additional back-to-model support for Simulink plug-in

As you click the different links, the corresponding block is highlighted in the model. Because of
internal improvements, the back-to-model feature is more stable. Additionally, support has been
added for Stateflow charts in Target Link and Linux operating systems.

For more information about the back-to-model feature, see Identify Errors in Simulink Models.
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Proven absence of certain run-time errors in C and C++ code

Use Polyspace Code Prover to prove the absence of overflow, divide-by-zero, out-of-bounds array
access, and certain other run-time errors in source code. To verify code, the software uses formal
methods-based abstract interpretation techniques. The code verification is static. It does not require
program execution, code instrumentation, or test cases. Before compilation and test, you can verify
handwritten code, generated code, or a combination of these two types of code.

Identification of variables exceeding specified range limits

By default, Polyspace Code Prover performs a robustness verification of your code. The verification
proves that the software works under all conditions. As the verification assumes that all data inputs
are set to their full range, almost any operation on these inputs can produce an overflow.

To prove that your code works in normal conditions, use the Data Range Specification (DRS) feature
to perform contextual verification. You can set constraints on data ranges, and verify your code within
these ranges. The use of DRS can substantially reduce the number of orange checks in verification
results.

You can use DRS to set constraints on:

* Global variables
* Input parameters for user-defined functions called by the main generator

¢ Return values for stub functions

For a global variable, if you specify the globalassert mode, the software generates a warning
when the variable exceeds your specified range.

For more information, see Data Range Configuration.

Graphical display of variable reads and writes

A Polyspace Code Prover verification generates a data dictionary with information about global
variables and the read and write access operations on these variables. You can view this information
through the Variable Access pane of the Results Manager perspective.

For more information, see Exploring Results Manager Perspective.

Calculation of range information for variables, function parameters
and return values

Polyspace Code Prover calculates and displays range information associated with, for example,
variables, function parameters and return values, and operators. The displayed range information

represents a superset of dynamic values, which the software computes using static methods.

For more information, see Interpret Results.


https://www.mathworks.com/help/releases/R2013b/codeprover/data-range-configuration.html
https://www.mathworks.com/help/releases/R2013b/codeprover/ug/exploring-results-manager-perspective.html
https://www.mathworks.com/help/releases/R2013b/codeprover/results-understanding.html
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Color-coding of run-time errors directly in code

Polyspace Code Prover uses color coding to indicate the status of code elements.

* Green — Proved to never have a run-time error.

* Red — Proved to always have a run-time error.

* Gray — Proved to be unreachable, which can indicate a functional issue.
* Orange — Unproven, and can have an error.

Errors detected include:

* Overflows, underflows, divide-by-zero, and other arithmetic errors

* Out-of-bounds array access and illegally dereferenced pointers

* Always true/false statement due to dataflow propagation

* Read access operation on uninitialized data

* Dead code

* Accesstonull this pointer (C++)

* Dynamic errors related to object programming, inheritance, and exception handling (C++)
* Uninitialized class members (C++)

* Unsound type conversions

For more information, see Interpret Results.

Quality metrics for tracking conformance to software quality
objectives

You can define a quality model with reference to coding rule violations, code complexity, and run-time
errors. By observing these metrics, you can track your progress toward predefined software quality
objectives as your code evolves from the first iteration to the final version.

By confirming the absence of certain run-time errors and measuring the rate of improvement in code
quality, Polyspace Code Prover enables developers, testers, and project managers to produce, assess,

and deliver code that is free of run-time errors.

For more information, see Quality Metrics.

Web-based dashboard providing code metrics and quality status
Polyspace Code Prover provides Polyspace Metrics, a Web-based dashboard for tracking submitted
verification jobs, reviewing progress, and viewing the quality status of your code. Polyspace Metrics
provides an integrated view of project metrics, displaying code complexity, coding rule violations,
run-time errors, and other code metrics.

For more information, see Quality Metrics.
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Guided review-checking process for classifying results and run-time
error status

In the Results Manager perspective, Polyspace Code Prover provides you with several options to
organize your review process.

* You can use review methodologies to specify the number and type of checks displayed on the
Results Summary pane. With each methodology, you review only a subset of checks.

For example, if you are reviewing verification results for the first time, select First checks to
review. The software displays all red and gray checks but only a subset of orange checks. These
orange checks are the ones most likely to be run-time errors. For more information, see Review
Checks Using Predefined Methodologies.

* You can group checks by File/Function or Check:
* Grouping by Check classifies checks by color. Within each color, this grouping classifies checks

by categories related to the origin of the check, such as Control flow, Data flow, and
Numerical.

* Grouping by File/Function classifies checks by the file where they originated. Within each
file, this grouping classifies checks by functions where they originated.

* For C++ files, you can also group checks by Class. This grouping classifies checks by the
class definition where they originated.
For more information, see Organize Check Review Using Filters and Groups.

* You can filter checks using any of the column information criteria on the Results Summary pane.
For example, you can filter out checks that you have already justified using the filter icon on the
Justified column header. If you have applied a filter, the column heading changes to indicate that
all results are not displayed. You can also define custom filters. For more information, see
Organize Check Review Using Filters and Groups.

* You can navigate through the Results Summary pane using the keyboard or UI buttons. Both
means of navigation respect the grouping, filters, and methodology used to display results.

Comparison with R2013a Polyspace products

Polyspace Code Prover is a single product that replaces the following R2013a products:

* Polyspace Client™ for C/C++
* Polyspace Server for C/C++

Polyspace Bug Finder, which is available with the Polyspace Code Prover, incorporates the following
R2013a products:

* Polyspace Model Link™ SL
* Polyspace Model Link TL
* Polyspace UML Link™ RH

For a summary of differences and similarities in remote verification, results review and other features
and options, expand the following:
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Remote verification

Category

R2013a

R2013b

Products required

Install:

* Polyspace Client for C/C++ on local
computer

* Polyspace Server for C/C++ on
network computers, which are
configured as Queue Manager and
CPUs.

Install:

* MATLAB, Polyspace Bug Finder, and
Parallel Computing Toolbox on local
computer.

* MATLAB, Polyspace Bug Finder,
Polyspace Code Prover, and MATLAB
Parallel Server on head node of
computer cluster. For information
about setting up a cluster, see Install
Products and Choose Cluster
Configuration.

Configuring and
starting services

On the Polyspace Preferences > Server
Configuration tab:

* Under Remote configuration, specify
host computer for Queue Manager and
Polyspace Metrics server and
communication port.

* Under Metrics configuration, specify
other settings for Polyspace Metrics.

On the Polyspace Preferences > Server
Configuration tab:

* Under MDCS cluster configuration,
specify computer for cluster head
node, which hosts the MATLAB job
scheduler (M]S). The MJS replaces the
R2013a Polyspace Queue Manager.

Under Metrics configuration:

* Specify host computer for Polyspace
Metrics server and communication
port.

* Specify other settings for Polyspace
Metrics.
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Category

R2013a

R2013b

In the Remote Launcher Manager dialog
box:

1 Under Common Settings, specify
Polyspace communication port, user
details, and results folder for remote
verifications.

2 Under Queue Manager Settings,
specify Queue Manager and CPUs.

3 Under Polyspace Server Settings,
specify available Polyspace products.

4 To start the Queue Manager and
Polyspace Metrics service, click Start
Daemon.

In the Metrics and Remote Server Settings
dialog box:

1 Under Polyspace Metrics Settings,
specify user details, Polyspace
communication port, and results
folder for remote verifications.

2 Under Polyspace MDCS Cluster
Security Settings, you see the
following options with default values:

* Start the Polyspace MDCE
service — Selected. The mdce
service, which is required to
manage the MJS, runs on the MJS
host computer and other nodes of
the cluster.

* MDCE service port — 27350.

* Use secure communication -
Not selected. Communication is
not encrypted. You may want to
use communication with security.
For information about MATLAB
Parallel Server cluster security, see
Cluster Security.

3 To start the Polyspace Metrics and
mdce services, click Start Daemon.

Use the Metrics and Remote Server
Settings dialog box to start and stop mdce
services only if you configure the MDCS
head node as the Polyspace Metrics
server. Otherwise, clear the Start the
Polyspace MDCE service check box, and
use the MDCS Admin Center. To open the
MDCS Admin Center, run:

matlabroot/toolbox/distcomp/bin/admincenter

For information about the MDCS Admin
Center, see Cluster Processes and Profiles.
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Category

R2013a

R2013b

Running a remote
verification

In the Project Manager perspective:

1 On the Configuration > Machine
Configuration pane, select the
following check boxes:

* Send to Polyspace Server

* Add to results repository —
Allows viewing of results through
Polyspace Metrics.

2  On the toolbar, click Run.

The Polyspace client performs code
compilation and coding rule checking on
the local, host computer. Then the
Polyspace client submits the verification to
the Queue Manager on your network.

In the Project Manager perspective:

1  On the Configuration > Distributed
Computing pane, select the Batch
check box. By default, the software
selects the Add to results
repository, which enables the
generation of Polyspace Metrics.

2  On the toolbar, click Run.

The Polyspace Code Prover software
performs code compilation and coding
rule checking on the local, host computer.
Then the Parallel Computing Toolbox
client submits the verification job to the
M]S of the MATLAB Parallel Server
cluster.

Managing remote
verifications

Use the Queue Manager to monitor and
manage submitted jobs from Polyspace
clients.

On the Web, you can monitor jobs through
Polyspace Metrics. If you have installed
Polyspace Server for C/C++ on your local
computer, through Polyspace Metrics, you
can open the Queue Manager .

Use the Queue Manager to monitor and
manage jobs submitted through Parallel
Computing Toolbox clients.

Accessing results of
remote verifications

When you run a verification on a
Polyspace server, the Polyspace software
automatically downloads the results to
your local, client computer. You can view
the results in the Results Manager
perspective.

In addition, you can use the Queue
Manager to download results of
verifications submitted from other
Polyspace clients.

On the Web, use Polyspace Metrics to view
verification results stored in results
repository. If Polyspace Client for C/C++
is installed on your local computer, you
can download verification results. For
example, in Polyspace Metrics, clicking a
cell value in the Run-Time Checks view
opens the corresponding verification
results in the Results Manager.

On the Web, use Polyspace Metrics to view
verification results. If Polyspace Bug
Finder is installed on your local computer,
you can download verification results. For
example, in Polyspace Metrics, clicking a
Project cell in the Runs view opens the
corresponding verification results in the
Results Manager.
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Results review

Category

R2013a

R2013b

Results Explorer

Available. Allows navigation through
checks by the file and function
where they occur. To view, select
Window > Show/Hide View >
Results Explorer.

Removed. To navigate through
checks by file and function, on
Results Summary pane, from the
drop-down menu, select File/
Function.

Filters on the Results Summary
pane

Filters appear as icons on the
Results Summary pane. You can
filter by:

* Run-time error category

* Coding rules violated

* Check color

* Check justification

* Check classification

* Check status

You can filter by the information in
all the columns of the Results
Summary pane. In addition to
existing filters, the new filtering
capabilities extend to the file,
function and line number where the
checks appear. You can also define
your own filters.

The filters appear as the = icon on
each column header. To apply a
filter using the information in a
column:

1  Place your cursor on the
column header. The filter icon
appears.

2 (Click the filter icon and from
the context menu, clear the All
box. Select the appropriate
boxes to see the corresponding
checks.

For more information, see Organize
Check Review Using Filters and
Groups.

Code Coverage Metrics

In the Results Explorer view, the
software displays two metrics for
the project:

* unp — Number of unreachable
functions as a ratio of total
number of functions

* cov — Percentage of elementary
operations covered by
verification

The unreachable procedures are
marked gray in the Results
Explorer view.

The new Results Statistics pane
displays the code coverage metrics
through the Code covered by
verification column graph.

To see a list of unreachable
procedures, click this column graph.

For more information, see Results
Statistics.
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Other features

Product

Feature

R2013a

R2013b

Polyspace Client and
Server for C/C++

Installation

Separate installation
process for Polyspace
products

Polyspace Code Prover
software installed during
MATLAB installation process.

Project configuration

On host, for example, using
Polyspace Client for C/C++
software.

On host, using Polyspace
Code Prover software.

Local verification

On host, run Polyspace
Client for C/C++
verification.

Review results in Results
Manager.

On host, run Polyspace Code
Prover verification.

Review results in Results
Manager.

Export of review
comments to Excel,
and Excel report
generation

Supported

Not supported.

Line command

polyspace-c

polyspace-cpp ...

polyspace-code-prover-
nodesktop ...

Project configuration
file extension

project name.cfg

project name.psprj

Results file extension

results name.rte

results name.pscp

Configuration >
Machine
Configuration pane

Available

Replaced by Configuration >
Distributed Computing
pane.

Configuration > Post |Available Renamed Configuration >
Verification pane Advanced Settings

goto blocks Not supported Supported

Run verifications from |Supported Not supported, produces a

multiple Polyspace
environments

license error -4, 0.

Non-official options
field

Available in Configuration
> Machine Configuration
pane

Renamed Other and moved to
Configuration > Advanced
Settings pane

Polyspace Model Link SL

and TL

Default includes

Includes specific to the
target specified.

Generic includes for C and C+
+. These includes are target
independent.
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R2013b

Coder/Target Link

* Verify Generated Code

* Verify Generated Model
Reference Code

Also right-clicking on a
subsystem and selecting
Polyspace > Polyspace
for Embedded Coder/
Target Link

Product Feature R2013a R2013b
Running a verification |Code > Polyspace > Code > Polyspace > Verify
Polyspace for Embedded |[Code Generated for

* Selected Subsystem
¢ Model
¢ Referenced Model

* Selected Target Link
Subsystem

Also right-clicking on a
subsystem and selecting
Polyspace > Verify Code
Generated for > Selected
Subsystem / Selected
Target Link Subsystem

Product Mode

Not available.

Choose between Code

Prover or Bug Finder
depending on the type of
analysis you want to run.

Settings

Available. Called
Verification Settings
from

Available. Called Settings
from. Functionality the same.

Open results

Option Open Project
Manager and Results
Manager opened the
Polyspace Project Manager.

Option Open results
automatically after
verification opens Polyspace
Metrics (batch verifications)
or Polyspace Results Manager
(local verifications).

Polyspace plug-in for
Visual Studio 2010

Support for C++11
features

Partial support.

Added support for:

¢ TLambda functions

¢ Rvalue references for
*this and initialization of
class objects by rvalues

* Decltype

* Auto keyword for multi-
declarator auto and
trailing return types

¢ Static assert
*  Nullptr

* Extended friend
declarations

* Local and unnamed types
as template arguments
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Options

Product

Option

R2013a

R2013b

-code-metrics

Available. Not selected by
default.

Removed. Code complexity
metrics computed by
default.

Polyspace Client and
Server for C/C++

-dialect Available. Default unchanged, but
new value gnu4.6
available for C and C++.

-max-processes Specify through Machine |Specify from command

Configuration > Number
of processes for
multiple CPU core
systems or command

line .

line, or through Advanced
Settings > Other.

-allow-language-
extensions

Available. Selected by
default.

Removed. By default,
software supports subset
of common C language
constructs and extended
keywords defined by the
C99 standard or supported
by many compilers.

-enum-type-
definition

Available with three
values. First value called
defined-by-standard.

Available with three
values.

For C, first value renamed
signed-int.

For C++, first value
renamed auto-signed-
int-first.

Polyspace Model Link SL
and TL

-scalar-overflows-
behavior wrap-around

Available. Not selected by
default.

Default.

This option identifies
generated code from
blocks with saturation
enabled.

However, this option might
lead to a loss of precision.
For models without
saturation, you can choose
to remove this option.

-ignore-constant-
overflows

Available. Not selected by
default.

Default.
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